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1  Welcome to the fading simulator
The hardware option R&S SMW-B14/B15 in combination with the firmware applications
R&S SMW-K71/-K72/-K73/-K74/-K75/-K820/-K821/-K822/-K823 add functionality to
simulate fading propagation conditions.

Key features

The most important features at a glance:
● Simulation of real time fading conditions in SISO and MIMO modes.
● Main characteristics in SISO mode:

– Maximal bandwidth Bmax = 160 MHz (R&S SMW-B14),
200 MHz (R&S SMW-B15), 400 MHz (R&S SMW-K822) and
800 MHz (R&S SMW-K823)

– Up to 20 fading paths in SISO mode in two independent channels
● Support of versatile MIMO configurations, like 2x2, 2x8 and 4x4 MIMO channels

with up to 64 MIMO channels
– 20 paths per MIMO channel
– Sampling rate and maximal bandwidth depend on the MIMO mode and the

installed option (R&S SMW-B14/-B15/-K822/-K823)
● Simulation of multiple entity MIMO scenarios, like 4x2x2 MIMO or 8xSISO (8x1x1)

configurations
● A wide range of presets based on the test specifications of the major mobile radio

standards, incl. Rel. 15 and Rel. 16 5G new radio channel models
● Graphical presentation of the defined fading paths

For more information, see data sheet.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMW user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMW200A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMW service manual.

https://www.rohde-schwarz.com/manual/smw200a
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1.1  Accessing the fading simulator

To access and configure the "Fading Simulator" settings

Depending on the installed options:

1. Option: R&S SMW-B14

a) In the block diagram of the R&S SMW, select "Fading > Fading Settings".

2. Option: R&S SMW-B15

a) In the block diagram of the R&S SMW, select "I/Q Stream Mapper > Fading/
Baseband Config > Mode = Advanced".

b) Select "Signal Outputs = Analog & Digital"
c) Confirm with "Apply".
d) In the block diagram of the R&S SMW, select "Fading > Fading Settings".

A dialog box opens that display the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "Fading > State > On".

For information, see:
● Chapter 2, "About the fading simulator", on page 18
● Chapter 3, "Fading settings", on page 28
● Chapter 4, "Signal routing settings", on page 90
● Chapter 5, "Multiple input multiple output (MIMO)", on page 94

1.2  What's new

This manual describes firmware version FW 5.20.043.xx and later of the
R&S®SMW200A.

Compared to the previous version, it provides the following new features:
● Fading profiles added for 5G NR MIMO scenarios and 5GNR moving propagation

scenarios, see "Standard / Test Case" on page 31:
– Non-terrestrial network (NTN) TDLA and TDLC fading profiles: "NTN

TDLA100-200 Low/Med/High" and "NTN TDLC5-200 Low/Med/High"
See Chapter A.23.7, "FR1 NTN TDLA100-200 Low/Med/High", on page 340
and Chapter A.23.8, "FR1 NTN TDLC5-200 Low/Med/High", on page 341.

– 5G NR moving propagation fading profiles: "MP Y 120kHz SCS" and "MP NTN
X 15kHz/30kHz SCS"
See Chapter A.26.2, "MP Y 15kHz/30kHz/120kHz SCS", on page 346 and
Chapter A.26.4, "MP NTN X 15kHz/30kHz SCS", on page 347.

● Updated comparison of fading characteristics R&S SMW-B14 and R&S SMW-B15,
see Chapter 2.4, "Characteristics of R&S SMW-B14 and R&S SMW-B15",
on page 25.

What's new
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● R&S SMW-K71 High-speed traing Doppler frequencies of up to 190 KHz for pure
Doppler fading profile, see Example"Querying doppler shifts for high-speed train
profiles" on page 188.

1.3  Documentation overview

This section provides an overview of the R&S SMW user documentation. Unless speci-
fied otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smw200a

1.3.1  Getting started manual

Introduces the R&S SMW and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.3.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMW is not included.

The contents of the user manuals are available as help in the R&S SMW. The help
offers quick, context-sensitive access to the complete information for the base unit and
the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.3.3  Tutorials

The R&S SMW provides interactive examples and demonstrations on operating the
instrument in form of tutorials. A set of tutorials is available directly on the instrument.

Documentation overview

http://www.rohde-schwarz.com/manual/smw200a
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1.3.4  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.3.5  Instrument security procedures

Deals with security issues when working with the R&S SMW in secure areas. It is avail-
able for download on the internet.

1.3.6  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.3.7  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMW. It also lists the
options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smw200a

1.3.8  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smw200a

1.3.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smw200a and www.rohde-schwarz.com/
manual/smw200a

Documentation overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/smw200a
http://www.rohde-schwarz.com/firmware/smw200a
http://www.rohde-schwarz.com/application/smw200a
http://www.rohde-schwarz.com/manual/smw200a
http://www.rohde-schwarz.com/manual/smw200a
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1.3.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-1: Product search on YouTube

1.4  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW user manual.

1.5  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots

https://www.youtube.com/@RohdeundSchwarz
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2  About the fading simulator
Equipped with the required options, the R&S SMW allows you to superimpose real
time fading on the baseband signal at the output of the baseband block. In R&S SMW
equipped with standard baseband (R&S SMW-B10) and fitted with all the possible fad-
ing options, there are up to 20 fading paths in SISO mode available. There are also 20
fading paths per MIMO channel in 4x4 MIMO mode available.

2.1  Required options

R&S SMW equipped with standard baseband (R&S SMW-B10)

The equipment layout for simulating fading effects in non-MIMO configurations:
● Option baseband generator (R&S SMW-B10) per signal path
● Option baseband main module, one/two I/Q paths to RF (R&S SMW-B13/B13T)
● Option fading simulator (R&S SMW-B14) per signal path

(sufficient for simulation of fading paths with standard delay and paths with
enhanced resolution)

● Additional options that extend the fading functionality:
– Option dynamic fading (R&S SMW-K71) per signal path

(required for the simulation of dynamic fading conditions, like birth death propa-
gation, moving propagation, two-channels interferes, high-speed train and cus-
tomized fading conditions)

– Option extended statistic functions (R&S SMW-K72) per signal path
(required for additional fading profiles and some of the predefined test scenar-
ios)

– Option MIMO-OTA enhancements (R&S SMW-K73) per signal path
(required for full support of antenna radiation patterns, inverse channel matrix
and the geometric-based channel model)

– Option customized fading (R&S SMW-K820) per signal path
(required for import of dynamic fading list)

The equipment layout for simulating fading effects in MIMO configurations:
● Two options baseband generator (R&S SMW-B10)
● Option two I/Q paths to RF (R&S SMW-B13T)
● At least two options fading simulator (R&S SMW-B14)
● Option MIMO fading (R&S SMW-K74)

(required for the configuration of LxMxN MIMO scenarios, with L ≤ 2 and up to 16
channels, like 1x2x8 or 1x4x4 scenarios)

● Option higher-order MIMO (R&S SMW-K75)
(required for the configuration of higher-order LxMxN MIMO scenarios, with L ≤ 2
and up to 32 channels like 2x4x4)

● Option multiple entities (R&S SMW-K76)

Required options
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(required for the configurations with more than two entities, like 8x1x1 scenarios)

The equipment layout for simulating fading effects in higher-order MIMO configura-
tions, like 1x8x8:
● Two options baseband generator (R&S SMW-B10)
● Option two I/Q paths to RF (R&S SMW-B13T)
● Four options fading simulator (R&S SMW-B14
● Option MIMO fading (R&S SMW-K74)
● Option higher-order MIMO (R&S SMW-K75)
● Option MIMO subsets (R&S SMW-K821)

(required for the simulation of up to 32 channels (i.e. a subset of the MIMO chan-
nels) in a 1x8x8 MIMO scenario)

For more information, see data sheet.

R&S SMW equipped with wideband baseband (R&S SMW-B9)

● Option baseband wideband generator (R&S SMW-B9) per signal path
● Option baseband main module (R&S SMW-B13XT)
● Option fading simulator (R&S SMW-B15) per signal path

(sufficient for simulation of fading paths with standard delay and paths with
enhanced resolution)

● Additional options that extend the fading functionality:
– Option dynamic fading (R&S SMW-K71) per signal path

(required for the simulation of dynamic fading conditions, like birth death propa-
gation, moving propagation, two-channels interferes, high-speed train and cus-
tomized fading conditions)

– Option extended statistic functions (R&S SMW-K72) per signal path
(required for additional fading profiles and some of the predefined test scenar-
ios)

– Option MIMO-OTA enhancements (R&S SMW-K73) per signal path
(required for full support of antenna radiation patterns, inverse channel matrix
and the geometric-based channel model)

– Option-customized fading (R&S SMW-K820) per signal path
(required for import of dynamic fading list)

The equipment layout for simulating fading effects in MIMO configurations:
● Option baseband wideband generator (R&S SMW-B9) per signal path
● Option baseband main module (R&S SMW-B13XT)
● At least two options fading simulator (R&S SMW-B15)
● Option MIMO fading (R&S SMW-K74)

(required for the configuration of MIMO scenarios with up to 16 channels, like
1x2x8 or 1x4x4 scenarios)

● Option higher-order MIMO (R&S SMW-K75)
(required for the configuration of higher-order MIMO scenarios with up to 64 chan-
nels)

● Option multiple entities (R&S SMW-K76)

Required options
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(required for the configurations with more than two entities, like 2x1x1 scenarios)
● Option 400 MHz fading bandwidth (R&S SMW-K822)
● Option 800 MHz fading bandwidth (R&S SMW-K823)

The equipment layout for simulating fading effects in higher-order MIMO configura-
tions, like 1x8x8 or 1x4x4 with one instrument:
● Two options baseband generator (R&S SMW-B9)
● Option baseband main module (R&S SMW-B13XT)
● Four options fading simulator (R&S SMW-B15)
● Option MIMO fading (R&S SMW-K74)
● Option higher-order MIMO (R&S SMW-K75)

(required for 1x8x8 MIMO configurations with one instrument)
● Option MIMO subsets (R&S SMW-K821)

(required for simulating of all MIMO channels simulated)
● Option MIMO subsets (R&S SMW-K822)

(required for the configuration of 1x4x4 MIMO scenarios, all MIMO channels simu-
lated)

For more information, see data sheet.

2.2  Overview of the functions provided by the fading sim-
ulator

This section summarizes the key functions of the fading simulator to emphasize the
way it is suitable for test setups during research, development, and quality assurance
involving mobile radio equipment.

Flexible configuration for support of different test scenarios

You can use the provided fading channels and configure them differently for different
test scenarios. Use the same input signal and two separate output signals, for exam-
ple, to simulate a frequency diversity. Or use separate input signals and sum them
after fading, to simulate a network handover, for instance.

See also Chapter 4, "Signal routing settings", on page 90.

Predefined fading scenarios

The fading simulator is equipped with a wide range of presets based on the test speci-
fications of the major mobile radio standards. For more complex tests, all the parame-
ters of the supplied fading configurations can be user-defined as required.

See also "Standard / Test Case" on page 31.

Repeatable test conditions

To ensure the repeatability of the tests, the fading process is always initiated from a
defined starting point.

Overview of the functions provided by the fading simulator
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A restart can be triggered from internal baseband trigger, so that the start of the base-
band signal generation and the fading processes are synchronized.

See also Chapter 3.2, "Restart settings", on page 38.

Graphical presentation

The path graph displays the current defined fading paths and supports you to configure
the desired fading channel.

See also Chapter 3.5, "Path graph", on page 56.

Simulation of diverse fading effects

During transmission of a signal from the transmitter to the receivers, diverse fading
effects occur. In the fading simulator, you can simulate these effects separately or in
combination.

Using the fading configurations for example, you can define up to 20 fading paths with
different delays as they would occur on a transmission channel due to different propa-
gation paths.

See also Chapter 3.4, "Path table", on page 44.

Predefined fast fading profile for different fading scenarios

The fading simulator provides a wide range of fast fading profiles. You can define the
fading conditions per generated fading path. The fast fading profiles simulate fast fluc-
tuations of the signal power level which arise due to variation between constructive and
destructive interference during multipath propagation.

See also "Configuration" on page 31 and "Profile" on page 49

Simulation of slow fading effect

"Lognormal" and "Suzuki Fading" are slow fading profiles suitable to simulate slow
level changes which can occur, due to shadowing effects (for example tunnels, build-
ings blocks or hills).

See also Chapter 3.4, "Path table", on page 44.

Simulation of dynamic configurations

Delay variations (whether sudden or slow) do not become important until we reach the
fast modulation standards, such as the 3GPP FDD or EUTRA/LTE standards. The
delay variations start to play a role if they are on the order of magnitude of the transmit-
ted symbols so that transmission errors can arise.

The provided dynamic configurations simulate dynamic propagation in conformity with
test cases defined in the 3GPP and MediaFlo specifications.

See also:
● Chapter 3.6, "Birth death propagation", on page 57
● Chapter 3.7, "Moving propagation", on page 63
● Chapter 3.10, "High-speed train", on page 81

Overview of the functions provided by the fading simulator
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● Chapter 3.8, "Two channel interferer", on page 71

Insertion loss for correct drive at the baseband level

The insertion loss is a method to provide a drive reserve and to keep the output power
constant. In the R&S SMW, the used insertion loss is not a fixed value but is dynami-
cally adjusted for different measurement tasks. Thus, you can define the way the range
for insertion loss is determined.

See also Chapter 3.3, "Insertion loss configuration, coupled parameters and global
fader coupling", on page 39.

Support of versatile MIMO configurations

See also Chapter 5, "Multiple input multiple output (MIMO)", on page 94.

2.3  Definition of commonly used terms

Fading Simulator

Each option R&S SMW-B14 provides the hardware of one fading simulator, i.e. for
each installed fading simulator option, one hardware fader board is available. One, two
or four fading simulators can be installed. The provided fading functionality, however,
depends on the installed firmware options.

Fading channel

A fading channel is the term describing the signal between a transmit (Tx) and a
receive (Rx) antenna, scattered in various paths.

In a 2x2 MIMO fading configuration, there are four fading channels between the trans-
mit (Tx) and the receive (Rx) antennas. In this description, each fading channel is rep-
resented as a block with name following the naming convention "F<Tx><Rx>", where Tx
and Rx are the antennas (e.g. A and B in a 2x2 MIMO configuration).

An instrument equipped with the R&S SMW-K74 option simulates up to 16 MIMO fad-
ing channels, as it is, for instance required for 4x4 MIMO receiver tests.

If the option R&S SMW-K75 is installed, the number of MIMO channels increases to
32.

Fading path (tap)

Each fading channel consists of up to 20 fading paths.

The Figure 2-1 illustrates an example of single-channel fading with three transmission
paths.

Definition of commonly used terms
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Figure 2-1: Example of single-channel fading with three transmission paths (SISO configuration)

Path 1 = Represents the discrete component that is a direct line-of-sight (LOS) transmission between
the transmitter and receiver (pure Doppler fading profile)

Paths 2 and 3 = Represent the distributed components that are signals which are scattered due to obstacles
(Rayleigh fading profile).

Distributed components, like the paths 2 and 3, consists of several signal echoes and
are referred to as "taps".

The Figure 2-2 illustrates an example of two-channel fading with three transmission
paths (taps) per channel.

Figure 2-2: Example of two-channel fading with three transmission paths each

The R&S SMW supports 20 fading paths per installed fading simulator.

Definition of commonly used terms
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Path group

In this implementation, a group of paths builds a "path group". In the R&S SMW, the 20
fading paths are divided in 4 path groups. Each group consists of 3 fine and 2 standard
delay paths.

A basic delay can be set per path group and an additional delay per path. The total
delay per path is the sum of the basic delay of the respective group and of the addi-
tional delay of the path.

For more information, see:
● Chapter 2.4, "Characteristics of R&S SMW-B14 and R&S SMW-B15", on page 25
● "Basic Delay" on page 51.

Fading profile

The fading profile determines which transmission path or which radio hop is simulated.

The following is a list of the basic fading profiles implemented in the Fading Simulator.
● Static Path

A static path is an unfaded signal that is a signal with constant amplitude and no
Doppler shift; though this signal can undergo attenuation (loss) or delay.

● Constant Phase
A suitable fading profile to simulate a reflection of an obstacle. Simulated is a
transmission signal with constant amplitude and no Doppler shift, but with rotating
phase.

● Pure Doppler
A fading profile that simulates a direct transmission path on which Doppler shift is
occurring due to movement of the receiver.
See Path 1 on the Figure 2-1.

● Rayleigh
A suitable fading profile to simulate a radio hop which arises as a result of scatter
caused by obstacles in the signal path, like buildings.
See also the conditions of the Paths 2 and 3 on the Figure 2-1.
The resulting received amplitude varies over time. The probability density function
for the magnitude of the received amplitude is characterized by a Rayleigh distribu-
tion. This fading spectrum is "Classical".

● Rice
A fading profile that simulates a Rayleigh radio hop along with a strong direct sig-
nal, i.e. applies a combination of distributed and discrete components (see Fig-
ure 2-1).
The probability density of the magnitude of the received amplitude is characterized
by a Rice distribution. The fading spectrum of an unmodulated signal involves the
superimposition of the classic Doppler spectrum (Rayleigh) with a discrete spectral
line (pure Doppler).
The ratio of the power of the two components (Rayleigh and pure Doppler) is con-
figurable, see parameter Power Ratio.
Example: The Figure 2-3 shows a baseband signal with QPSK modulation and a
rectangular filter which was subjected to Rician fading (one path). As a result of the

Definition of commonly used terms
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luminescence setting on the oscilloscope, the variation in phase and amplitude of
the constellation points caused by the fader is clearly visible.

Figure 2-3: Effect of a Rician fading on a baseband signal with QPSK modulation

MIMO correlation models

The R&S SMW supports the following ways to simulate spatial correlated MIMO chan-
nels:
● By description of transmit and receive correlation matrix with direct definition of

matrix coefficients or based on the Kronecker assumption
● By definition of clusters at the transmitter and receiver end using channel parame-

ter like angle spread or angle of arrival/departure (AoA/AoD).

See Chapter 5.3, "Fading settings in MIMO configuration", on page 98

2.4  Characteristics of R&S SMW-B14 and R&S SMW-B15

The fading simulator includes hardware boards that influence several signal character-
istics. This section lists the characteristics that influence the value ranges of major sig-
nal parameters.

For details and characteristics on each of the options, see data sheet.

Characteristics of R&S SMW-B14 and R&S SMW-B15
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Table 2-1: R&S SMW-B14

Fading channels
(depends on
LxMxN)

Fading
clock rate

Signal
band-
width

Basic delay
range

Basic delay
resolution

Additional delay range Additional delay reso-
lution

1 to 8 200 MHz 160 MHz Group 1:

0 s

Group 2 to 4:

0 s to 0.671 s

5 ns Fine delay path 1:

0 to 40.9 us

Fine delay paths 2 to 3:

0 to 20 us

Std. delay paths 4 to 5:

0 to 20 us

Fine delay paths 1 to 3:

2.5 ps

Std. delay paths 4 to 5:

5 ns

9 to 16 100 MHz 80 MHz  10 ns  Fine delay paths 1 to 3:

5 ps

Std. delay paths 4 to 5:

10 ns

17 to 32 50 MHz 40 MHz  20 ns  Fine delay paths 1 to 3:

10 ps

Std. delay paths 4 to 5:

20 ns

Table 2-2: R&S SMW-B15, without R&S SMW-K822

Fading channels
(depends on
LxMxN)

Fading
clock rate

Signal
band-
width

Basic delay
range

Basic delay
resolution

Additional delay range Additional delay reso-
lution

1 to 8 250 MHz 200 MHz Group 1:

0 s

Group 2 to 4:

0 s to 0.536 s

4 ns Fine delay path 1:

0 to 32.72 us

Fine delay paths 2 to 3:

0 to 16 us

Std. delay paths 4 to 5:

0 to 16 us

Fine delay paths 1 to 3:

2 ps

Std. delay paths 4 to 5:

4 ns

9 to 16 250 MHz 200 MHz  10 ns  Fine delay paths 1 to 3:

4 ps

Std. delay paths 4 to 5:

8 ns

17 to 32 125 MHz 100 MHz  20 ns  Fine delay paths 1 to 3:

8 ps

Std. delay paths 4 to 5:

16 ns

33 to 64 62.25 MHz 50 MHz - - - -

Characteristics of R&S SMW-B14 and R&S SMW-B15
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Table 2-3: R&S SMW-B15 and R&S SMW-K822/-K823

Fading channels
(depends on
LxMxN)

Fading
clock rate

Signal
band-
width

Basic delay
range

Basic delay
resolution

Additional delay range Additional delay reso-
lution

1 to 8

R&S SMW-B15/-
K822

500 MHz 400 MHz Group 1:

0 s

Group 2 to 4:

0 s to 0.536 s

4 ns Std. delay path 1:

0 to 32.72 us

Fine delay paths 2 to 3:

0 to 16 us

Std. delay paths 4 to 5:

0 to 16 us

Std. delay path 1:

2 ns

Std. delay paths 2 to 5:

4 ns

1 to 4

R&S SMW-B15/-
K823

1000 MHz 800 MHz    Std. delay path 1:

1 ns

Std. delay paths 4 to 5:

8 ns

Related settings

● LxMxN settings: Chapter 5.1, "Multiple entity MxN MIMO test configurations",
on page 95

● "Fading Clock Rate" on page 34
● "Basic Delay" on page 51
● "Additional Delay" on page 51

The difference in the system clocks and the delay resolutions also affects the used fad-
ing paths and the preset values in some of the predefined fading profiles, see Chap-
ter A, "Predefined fading settings", on page 242.

2.5  Further signal processing

During further signal routing, you can also offset the faded signals or apply noise to
them.

For more information, refer to sections "Adding Noise to the Signal" and "Impairing the
Signal" in the R&S SMW User Manual.

Further signal processing
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3  Fading settings
The "Fading" dialog allows you to configure multipath fading signals. Regardless of the
current "System Configuration > Mode", to access this dialog, proceed as follows:

► Select "Block Diagram > Fading > Fading Settings".

The "Fading" dialog opens and displays the general settings.

The dialog is divided into several tabs, logically grouping the available setting.

The remote commands required to define these settings are described in Chapter 6,
"Remote-control commands", on page 149.

Settings:

● General settings......................................................................................................29
● Restart settings....................................................................................................... 38
● Insertion loss configuration, coupled parameters and global fader coupling.......... 39
● Path table................................................................................................................44
● Path graph...............................................................................................................56
● Birth death propagation...........................................................................................57
● Moving propagation.................................................................................................63
● Two channel interferer.............................................................................................71
● Customized dynamic fading....................................................................................77
● High-speed train......................................................................................................81
● Custom fading profile.............................................................................................. 87
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3.1  General settings

► To access this dialog, select the "Fading > Fading Settings".

Apart from the standard "Set to Default" and "Save/Recall" functions, the dialog
provides the settings to:
● In "System Configurations" with more than two entities, the dialog consists of

more than one side tabs; one tab per entity. The tab name indicates the fader
state the settings are related to.
See also Chapter 5.1, "Multiple entity MxN MIMO test configurations",
on page 95.

● Select a predefined fading profile according to the common mobile radio stand-
ards

Settings:

State..............................................................................................................................30
Copy To / Entity............................................................................................................. 30
Set to Default................................................................................................................ 30
Save/Recall................................................................................................................... 31
Standard / Test Case.....................................................................................................31
Configuration.................................................................................................................31
Moving Channels.......................................................................................................... 34
Fading Clock Rate.........................................................................................................34
Signal Dedicated To...................................................................................................... 34
Dedicated Frequency.................................................................................................... 37
Dedicated Connector.................................................................................................... 37
Virtual RF...................................................................................................................... 37
Ignore RF Changes < 5PCT..........................................................................................37
Freq. Hopping............................................................................................................... 38

General settings
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State
● Option: R&S SMW-B14

Enables the fading simulator.
● Option: R&S SMW-B15

Enabled if "System Config > Fading/Baseband Config > Mode = Advanced" is
selected and "Apply" executed.

If activated, the fading process is initiated for the enabled paths.
A selectable trigger ("Restart > Mode") can be used to restart the fading process. The
fading process always begins at a fixed starting point after each restart. This helps to
achieve repeatable test conditions.
Remote command: 
[:SOURce<hw>]:FSIMulator[:STATe] on page 169

Copy To / Entity
Option: R&S SMW-K76
In "System Configurations" with multiple entities, copies the settings of the current fad-
ing simulator to all or to the selected entities.
See also Chapter 5.1, "Multiple entity MxN MIMO test configurations", on page 95.
Remote command: 
[:SOURce<hw>]:FSIMulator:SISO:COPY on page 152

Set to Default
Activates the default settings of the fading simulator.
By default, a path is activated with a Rayleigh profile and a slow speed. All the other
paths are switched off.
The following table provides an overview of the settings. The preset value is indicated
for each parameter in the description of the remote-control commands.
Table 3-1: Default values

Parameter Value

State Off

Standard User

Configuration Standard Delay

Signal Dedicated to RF Output

Speed Unit km/h

Restart Event Auto

Ignore RF Changes Off

Frequency Hop. Mode Off

Insertion Loss  

Insertion Loss Mode Normal

Coupled Parameters  

All States Off

General settings
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Parameter Value

Path Configuration  

State of path 1 On

State of all other paths Off

Profile Rayleigh

Delays 0

Speed of path 1 Slow

Speed of all other paths 0

Remote command: 
[:SOURce<hw>]:FSIMulator:PRESet on page 156

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMW user manual.
The R&S SMW stores fading configurations in files with file extension *.fad.

The dialog displays the name of a currently loaded user settings file. The file name is
displayed as long as you do not modify the settings.
Remote command: 
[:SOURce]:FSIMulator:CATalog? on page 169
[:SOURce<hw>]:FSIMulator:LOAD on page 170
[:SOURce<hw>]:FSIMulator:STORe on page 170
[:SOURce]:FSIMulator:DELETE on page 170

Standard / Test Case
Selects predefined fading settings according to the test scenarios defined in the com-
mon mobile radio standards.
For an overview of the predefined standards, along with the underlying test scenarios,
the enabled settings and the required options, see Chapter A, "Predefined fading set-
tings", on page 242.
If one of the predefined parameters is modified, "User" is displayed. "User" is also the
default setting.
Remote command: 
[:SOURce<hw>]:FSIMulator:STANdard on page 161
[:SOURce<hw>]:FSIMulator:STANdard:REFerence on page 168

Configuration
Selects the fading configuration.

General settings
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Note: The dynamic fading configurations "Birth Death Propagation", and "2 Channel
Interferer" are disabled in MIMO configurations.
Depending on which configuration is selected, the further settings the "Fading" dialog
change, particularly the path table.
Note: A separate path table is associated with each configuration, i.e. each time you
select a new configuration, the instrument changes not only the bandwidth but loads a
new path table.
Each changing in the configuration interrupts the fading process and restarts the calcu-
lation. If the instrument is fitted with more than one fading simulators, they are all affec-
ted.
"Standard/Fine Delay"

In the R&S SMW, the 20 fading paths are divided in 4 path groups.
Each group consists of 3 fine and 2 standard delay paths. The stan-
dard and fine delay configurations differ in terms of the resolution of
the path-specific delay, see Chapter 2.4, "Characteristics of
R&S SMW-B14 and R&S SMW-B15", on page 25.
The "Standard/Fine Delay" configuration is sufficient for classical fad-
ing with simulation of the level fluctuations. A delay configuration with
the provided characteristics occurs in the received signal as a result
of a typical multipath propagation and the propagation conditions.
The propagation conditions themselves vary depending on the loca-
tion and timing.

"Birth Death Propagation"
Option: R&S SMW-K71
In the "Birth Death Propagation" configuration, the fading simulator
simulates dynamic propagation conditions in conformity with the test
case 3GPP, 25.104-320, annex B4. Two paths are simulated which
appear ("Birth") or disappear ("Death") in alternation at arbitrary
points in time (see Chapter 3.6, "Birth death propagation",
on page 57).
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"Moving Propagation"
Option: R&S SMW-K71
In the "Moving Propagation" configuration and number of "Moving
Channels" set to "One", the fading simulator simulates dynamic prop-
agation conditions in conformity with the test case 3GPP TS25.104,
annex B3. Two paths are simulated: Path 1 has fixed delay, while the
delay of path 2 varies slowly in a sinusoidal fashion.
Two additional predefined moving propagation scenarios according to
the 3GPP TS36.141, annex B.4 can be configured: the "ETU200Hz
Moving" and the "Pure Doppler Moving". To configure one of these
scenarios for 3GPP or LTE, select the corresponding item under
"Standard > 3GPP or LTE > Moving Propagation".
Note: The moving propagation conditions enabled by selecting the
"Standard > 3GPP or LTE > Moving Propagation > Ref. + Mov. Chan-
nels" are identical to the conditions configured by enabling of "Moving
Propagation Configuration" and number of "Moving Channels" set to
"One".
See Chapter 3.7, "Moving propagation", on page 63 for more infor-
mation.

"2 Channel Interferer"
Option: R&S SMW-K71
In the "2 Channel Interferer" configuration, the fading simulator simu-
lates test case 5 and 6 from MediaFlo.
Two paths are simulated: Path 1 has fixed delay, while the delay of
path 2 varies slowly in a sinusoidal fashion or appears or disappears
in alternation at arbitrary points in time (hopping).
See Chapter 3.8, "Two channel interferer", on page 71 for more
information.

"High Speed Train"
Option: R&S SMW-K71
In the High-Speed Train configuration, the fading simulator simulates
propagation conditions in conformity with the test case 3GPP 25.141,
annex D.4A and 3GPP 36.141, annex B.3.
The instrument simulates all the three scenarios as defined in the test
specification. Additionally, user-defined HST conditions can be config-
ured by selecting different profile and setting up the speed and the ini-
tial distances.
See Chapter 3.10, "High-speed train", on page 81 for more informa-
tion.

"Customized Dynamic"
Option: R&S SMW-K820
In this configuration, you can load dynamic fading list files that
describe the variation of the fading parameters path loss, Doppler
shift and delay over time. With suitable fading lists, customized High-
Speed Train scenarios can be simulated.
See Chapter 3.9, "Customized dynamic fading", on page 77.
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Remote command: 
[:SOURce<hw>]:FSIMulator:CONFiguration on page 151
[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe on page 187
[:SOURce<hw>]:FSIMulator:MDELay:STATe on page 197
[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] on page 219
[:SOURce<hw>]:FSIMulator:HSTRain:STATe on page 192
[:SOURce<hw>]:FSIMulator:CDYNamic:STATe on page 237

Moving Channels
Option: R&S SMW-K71
This parameter determines whether only one or several moving channels are simula-
ted.
"One" In this mode, the fading simulator simulates dynamic propagation

conditions in conformity with the test case 3GPP TS25.104, annex
B3.

"All" Per default, one moving channel with Rayleigh distribution and one
tap is simulated.
Additional taps and paths can be enabled and configured in the "Path
Table".

Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE on page 193

Fading Clock Rate
Displays the clock rate used by the fading simulator for the signal processing.
The value depends on the selected "System Configuration" and influences the band-
width of the generated signal.
Remote command: 
[:SOURce<hw>]:FSIMulator:CLOCk:RATE? on page 153

Signal Dedicated To
Defines the frequency to that the signal of the whole Fader block is dedicated.
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Example: How the R&S SMW determines the frequency used for the calculation
of the Doppler Shift
This example shows how the R&S SMW determines the fader frequency in "Signal
Dedicated To > Auto Detect Output" mode.
● In the "System Configuration > Fading/Baseband Config" dialog, enable a 2x2x2

MIMO configuration with "Baseband Sources > Coupled per Entity".
● In the "I/Q Stream Mapper":

– route "Stream A/B > RF A/B", "Stream A/D und > BBMM 2" and "Stream B/C >
BBMM 1" ("Combination > Add")

– enable a "Frequency Offset = 5 MHz" for Stream D
● Connect an R&S®SGT100A to the BBMM2 connector of the R&S SMW.

In the "External RF and IQ" dialog, configure this connection and set the frequency
of the connected instrument, e.g. "RF Frequency = 1.950 GHz".

● In the Status Bar, set "Freq A = 2.143 GHz"
The settings of your instrument should resemble the example on Figure 3-1.

Figure 3-1: Settings influencing the calculation of the Doppler Shift

1a, 1d = Routing of Stream A ("primary" for "Fading 1")
1b = Routing of Stream D ("primary" stream for "Fading 2" but not for "Fading 1")
1c = Routing of Stream C; an external device is not connected
2a = Frequency RF A, i.e. the frequency of Stream A
2b = Parameters influencing the frequency of Stream D

In this configuration, Stream A is the "primary" stream for the "Fading 1"; Stream D is
the "primary" for "Fading 2", because of the connected external device.
Note that:
● Although Stream C is first stream of "Fading 2" it is not the "primary" one, because

there is no external device connected to the BBMM1 or to the FAD3 connector.
● Although an external device is connected to BBMM2, it is not the "primary" for the

"Fading 1", because the streams are evaluated "left to right" and "up to down".
Observe the values of the parameter "Dedicated Frequency" for Fader 1 and Fader 2.
The settings of your instrument should resemble the example on Figure 3-2.
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Figure 3-2: "Dedicated Frequency" and "Dedicated Connector": understanding the displayed infor-
mation

1 = Fader 1
2 = Fader 2
1a = "Dedicated Connector = RF A" because Stream A ("primary") is routed to RF A
1b = "Dedicated Connector = BBMM 2" because Stream D is routed to BBMM 2 and an external instrument

is connected to this interface
2a = "Dedicated Frequency = Freq A = 2.143 GHz"
2b = "Dedicated Frequency = RF FrequencyExternal RF instrument + Frequency Offset = 1.95 GHz + 5 MHz =

1.955 GHz"

"Auto Detect Output"
The Doppler shift is calculated based on the actual RF frequency, that
is dynamically detected depending on:
● The current signal routing in the "Stream Mapper", in particular

the routing and the enabled "Frequency Offset" of the first ("pri-
mary") stream of each "Fader"
Note: The RF frequencies and the "Frequency Offset" of all other
streams are ignored.

● The external instrument connected to the output interface the "pri-
mary" stream is routed to
("System Configuration > External RF and I/Q")

● The "RF Frequency" of the connected instrument
("System Configuration > External RF and I/Q")

The R&S SMW continuously monitors these parameters, calculates
the frequency and displays:
● The Dedicated Frequency
● The Dedicated Connector
A warning message informs you if the detection fails; the "Dedicated
Frequency" is set to 1 GHz.

"Baseband Output"
Sets the fader frequency manually. The Doppler shift is calculated
based on a select "Virtual RF" frequency.
If you use an external I/Q modulator to upconvert the generated
faded baseband signal, set the value of the parameter Virtual RF to
the modulation frequency of the external I/Q modulator.

Remote command: 
[:SOURce<hw>]:FSIMulator:SDEStination on page 160
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Dedicated Frequency
In Signal Dedicated To > "Auto Detect Output" mode, displays the dedicated RF fre-
quency (incl. enabled "Frequency Offset" in the "I/Q Stream Mapper"), used for the cal-
culation of the Doppler Shift.
A warning message informs you if the estimation fails; the "Dedicated Frequency" is
set to 1 GHz.
See also:
● Example"How the R&S SMW determines the frequency used for the calculation of

the Doppler Shift" on page 35
● Dedicated Connector.
Note: The "Dedicated Frequency" cannot be updated if the RF frequency varies fast,
for example if an "RF Frequency Sweep" or a "List Mode" is active and the parameter
Ignore RF Changes < 5PCT is disabled.
For more details, see the data sheet.
Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency on page 153

Dedicated Connector
In Signal Dedicated To > "Auto Detect Output" mode, displays the connector used to
determine the Dedicated Frequency.
See Example"How the R&S SMW determines the frequency used for the calculation of
the Doppler Shift" on page 35.
Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency:DETect? on page 160

Virtual RF
In Signal Dedicated To > "Baseband Output" mode, sets manually the frequency used
for the calculation of the Doppler shift.
This parameter is useful if:
● A user-defined Fader frequency is required
● An external I/Q modulator is used to upconvert the generated faded baseband sig-

nal.
Remote command: 
[:SOURce<hw>]:FSIMulator:FREQuency on page 153

Ignore RF Changes < 5PCT
This function is password-protected. Unlock the protection level 1 to access it.
Selects whether variation in the RF frequency (also in the frequency of connected
external devices) that are smaller than 5% are to be ignored or not for the fading.
"On" Enables faster frequency hopping because small frequency changes

do not result in a short-term switch-off of the fader and a restart of the
fading process.

Remote command: 
[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges on page 154
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Freq. Hopping
This function is password-protected. Unlock the protection level 1 to access it.
Activates frequency hopping and determines the behavior of the fading simulator after
a frequency hop.
In real-world receivers, one of the reasons for frequency hopping could be that due to a
change in the location of the receiver, the original carrier is no longer accessible.
In the fading simulator, frequency hopping is implemented by switching of the carrier
frequency. The fading simulator is temporarily deactivated until the variation in the RF
frequency is completed. The fading process starts then again at the new frequency.
The instrument provides two modes for frequency hopping, that mainly differ in terms
of the behavior when hopping back to a prior frequency.
Prior to activating frequency hopping, list mode must be activated in the "List Mode"
dialog (State On). The target frequencies of the hops are determined by the frequency
values in the selected list. The time until the next frequency hop is determined by the
entered "Dwell Time". The HOP signal which marks the time point of the frequency hop
can be output on one of the USER connectors. These settings are available only for
the delay configurations.
For detailed information, refer to sections "Varying the RF Signal in List or Sweep
Mode" and "Local and Global Connectors" in the R&S SMW user manual.
Remote command: 
[:SOURce<hw>]:FSIMulator:HOPPing:MODE on page 154

3.2  Restart settings

Access:

► Select "Fading > Restart".

Mode............................................................................................................................. 38
Synchronization.............................................................................................................39

Mode
Selects the event which leads to a restart of the fading.
To achieve repeatable test conditions, after each restart the fading process starts at a
fixed starting point. The fading process then passes through identical random pro-
cesses for a particular setting.
"Auto" The modulation signal is continually faded.

Restart settings
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"Baseband Trigger"
In MIMO scenarios, this setting restarts the fading process synchro-
nous with the baseband trigger signal. Thus, the start of the base-
band signal generation and the fading processes are synchronized.
This setting is useful in the following situations:
● If repeatability of tests with baseband and fading signal is

required.
● For triggering of the fading simulations in multi-instruments set-

ups, for example when calculating 8x8 or 4x4 MIMO signals with
two R&S SMW.

See R&S SMW User Manual, section "How to Generate a 8x8 MIMO
Signal with Two R&S SMW"

"Armed Auto" Not supported in the current version.
Remote command: 
[:SOURce<hw>]:FSIMulator:RESTart:MODE on page 156

Synchronization
Couples the fading simulators so that if both blocks are active, a subsequent restart
event in any of them causes a simultaneous restart of the other.
Restart event can be caused by a start/stop alternation or a parameter change that
results in a signal recalculation and therefore a process restart.
Remote command: 
[:SOURce]:FSIMulator:SYNChronize:STATe on page 159

3.3  Insertion loss configuration, coupled parameters and
global fader coupling

The fading process increases the crest factor of the signal, and this increase must be
considered in the drive at the baseband level. Especially when multiple paths are
superimposed or if there is statistical influences on a path, an insertion loss is required
to provide a drive reserve. If the full drive level is reached nevertheless, the I/Q signals
are limited to the maximum available level (clipping).

This section describes the setting, provided to control of the insertion loss and to sim-
plify the operation in dual-channel fading.

Impact of the Fading Simulator on the Crest Factor of the Signal

The crest factor is a figure that measures the difference in level between the peak
envelope power (PEP) and average power value (RMS) in dB. Hence, either increas-
ing the peak value or decreasing the RMS value results in a higher crest factor. In this
implementation, the instrument keeps the peak value as close as possible to the full
drive level (multiplier peak > 1) but the fading simulator reduces the RMS value by the
additional crest factor due to fading (multiplier RMS ). The ratio of these two multipliers
is a value, known as the insertion loss.

Insertion loss configuration, coupled parameters and global fader coupling
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The instrument derives the crest factor of the signal at the output of the fading simula-
tor based on the crest factor of the signal at the input of the "Fading" block and the
insertion loss.

Overview of the provided modes and the main differences between them

In the R&S SMW, the used insertion loss is not a fixed value but is dynamically adjus-
ted for different measurement tasks. For any of the predefined standards/test cases,
the instrument selects an optimal range for the insertion loss. In a user-defined fading
configuration, you define the way the range for insertion loss is determined.

From the following available modes, select the one most fitting to your application:
● "Normal"

In this mode, the instrument calculates the required insertion loss value in a way,
that a full drive is permitted, i.e the signal is not clipped at the maximum level.
The mode results in a high signal quality, but the RMS level is lower than the maxi-
mum level. Adjacent channel power (ACP) measurements, however, require a
higher dynamic range and a lower insertion loss.

● "Low ACP"
In this mode, the instrument outputs the signal with a higher level relative to the
maximum drive, i.e. greater S/N ratio. However, this mode decreases the signal
quality because of a higher percentage of clipping.
It is recommended that you enable this mode only for fading paths with Rayleigh
profile, as only this profile ensures a statistical distribution of level fluctuation. The
other fading profiles are characterized by a non-statistical level fluctuations and a
"Low ACP" mode leads to an enormous increase of clipping.
Irrespectively of the selected fading profile, you still can and have to monitor the
percentage of clipped samples.

● "User"
This mode relays on a manually defined value. Depending on your particular appli-
cation, you can find a favorable insertion loss configuration with the desired signal
dynamic range and acceptable clipping rate.

Regardless of the selected mode and the path loss settings, the instrument adjust the
insertion loss within this range to keep the output power constant. However, the maxi-
mum available output power of the R&S SMW is reduced by up to 18 dB.

Prerequisites for correct insertion loss adaptation

For correct automatic adaptation of the insertion loss, the processes involved in the
fading simulation have to be statistically independent of each other. This applys to the
paths among themselves as well as the paths relative to the input signal. Correct auto-
matic adaptation of the insertion loss is not possible, if statistically correlated pro-
cesses occur. Examples if statistically correlated processes are the fading of modula-
tion signals with symbol rates approximating the delay differences of the fading paths.
A correlation requires, that you measure the level again and manually corrected it, e.g.
by enabling of a suitable level offset.

Insertion loss configuration, coupled parameters and global fader coupling
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The following are two examples explaining the possible reasons for correlation.

Example: Correlated processes resulting from the used modulation signal and
the selected fading configuration
The instrument is configured to generate a QPSK signal with a symbol rate of 1
Msymb/s is generated and the PRBS 9 sequence as the data source.
Enabled is a fading configuration, consisting of two paths with a Rayleigh profile, identi-
cal speed and a resulting delay of 0 us and 1 us, respectively.
The symbol rates of the modulation signal are in the range of the delay differences of
the fading paths. The autocorrelation of the modulation data (PRBS 9) to the adjacent
symbol is not equal to 0. The fading process is therefore statistically not independent of
the process of generating the modulation signal. The automatic calculation of the inser-
tion loss is not correct.

Example: Correlated processes within the fading simulator
Enabled is a fading configuration, consisting of two paths with a pure Doppler profile
and a resulting Doppler shift of 100 Hz. The start phases of the two paths differ.
This causes super impositions, which in the worst case (e.g. with a phase setting of 0°
and 180°) can lead to the deletion of the signal. Automatic calculation of the insertion
loss is not possible.

The related settings are summarized in dialog "Fading > Insertion Loss Config/Coupled
Parameters > Insertion Loss Configuration", see Chapter 3.3.1, "Insertion loss configu-
ration settings", on page 41.

Coupling Fading Parameters

In standard mode ("System Configuration > Mode > Standard"), you can couple a sub-
set of parameters and adjust them jointly. With enabled coupling, the setting of one of
the Fading blocks are transferred to the second fading simulator. A subsequent change
in the settings of one of the fading simulators results in settings adaptation in the other.

Logically, coupled parameters are available in instruments equipped with more than
one Fading Simulator (i.e. more than one R&S SMW-B14 options).

The related settings are grouped in dialog "Fading > Insertion Loss Config/Coupled
Parameters > Coupled Parameters", see Chapter 3.3.2, "Coupled parameters and
global fader coupling settings", on page 43.

3.3.1  Insertion loss configuration settings

Access:

► Select "Fading > Insertion Loss Config/Coupled Parameters".

Insertion loss configuration, coupled parameters and global fader coupling
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Insertion Loss Mode......................................................................................................42
Insertion Loss................................................................................................................43
Clipped Samples........................................................................................................... 43
0 ... 100 %..................................................................................................................... 43

Insertion Loss Mode
Sets the mode for determining the insertion loss.
"Mode Normal" The insertion loss for a path of the fading simulator is automatically

chosen so that even when lognormal fading is switched on, overdrive
occurs only rarely in the fading simulator. This setting is recommen-
ded for bit error rate tests (BERTs). The current insertion loss is dis-
played under "Insertion Loss".

"Mode Low ACP"
The insertion loss is automatically chosen so that an overdrive occurs
with an acceptable probability. "Low ACP" mode is only recommen-
ded for fading paths with Rayleigh profile as only in this case statisti-
cal distribution of level fluctuation is ensured. For other fading pro-
files, non-statistical level fluctuations occur which lead to an enor-
mous increase of clipping. However, monitoring the percentage of
clipped samples is recommended for Rayleigh paths also.
The current insertion loss is displayed under "Insertion Loss".

"Mode User" Any value for the minimum insertion loss in the range from 0 dB to 18
dB can be selected. Desired value is entered under "Insertion Loss".
This mode is provided to ensure optimization of the dynamic range
and signal quality for any application. Display of the clipping rate for
any value which is entered enables estimation of the signal quality for
the specified signal dynamic range.

Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs:MODE on page 155
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Insertion Loss
Displays the current insertion loss in the "Normal" and "Low ACP" modes.
Entry of the insertion loss in "User" mode.
Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS] on page 155

Clipped Samples
Displays the samples whose level is clipped as a %.
If the full drive level is reached for an insertion loss which is too low, the I/Q signals are
limited to the maximum available level (clipping).
Remote command: 
[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples? on page 155

0 ... 100 %
Graphically displays the samples whose level is clipped as a %. The scale resolution is
determined by entering the maximum value as a %.

3.3.2  Coupled parameters and global fader coupling settings

Access:

► Select "Fading > Insertion Loss Config/Coupled Parameters".

Coupled Parameters..................................................................................................... 44
└ Speed Setting Coupled...................................................................................44
└ Local Constant Coupled..................................................................................44
└ Standard Deviation Coupled...........................................................................44

Start Seed..................................................................................................................... 44
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Coupled Parameters
(available in "System Configuration > Mode > Standard")

Speed Setting Coupled ← Coupled Parameters
Sets the speed of the paths for both faders. The parameter Common Speed For All
Paths is also coupled.
Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:SPEed on page 171

Local Constant Coupled ← Coupled Parameters
With lognormal fading, the parameter Local Constant is coupled for the paths of both
faders.
Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant on page 170

Standard Deviation Coupled ← Coupled Parameters
With lognormal fading, the parameter Standard Deviation is coupled for the paths of
both faders.
Remote command: 
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD on page 170

Start Seed
Enters the start seed for random processes inside the fading simulator. This value is
global for the instrument but each fading path uses a different start seed. The autocor-
relation of different seeds is more than seven days apart. If two instruments run with
the same seed, fading processes will be identical after a retrigger of the fading simula-
tor.
While working in MIMO mode that requires two instruments, set the start seeds of the
instruments to different values.
Remote command: 
[:SOURce<hw>]:FSIMulator:GLOBal:SEED on page 154

3.4  Path table

Access:

1. Select "Fading > Fading Settings > Path Table".

The path table provides the individual path and group parameters.

Path table
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Figure 3-3: Fading Path Table: Understanding the displayed information

1a/1b = Path group number (displayed in the first row) and path number (second row in the table
header). The example shows 4 groups with different number of active paths (the first group is
marked with a blue border).

2 = Fading profile, assigned per fading path
3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the

other groups (light grey background)
4 = Resulting delay per path, calculated as the sum of the common group delay and the path-spe-

cific delay
5 = Adjustable parameter for paths with Rice, WM Rice of Gauss Doppler fading
6 = Adjustable parameter for paths with Pure Doppler and constant Phase fading
7 = For moving receivers, selected speed ν or calculated as a function of the resulting Doppler shift

fD
8 = Set resulting Doppler shift fD or calculated as fD=fRF*ν/c, where fRF is the selected RF and c the

speed of light
9 = Frequency ratio cosφt is ratio of the actual Doppler shift fA and the resulting Doppler shift fD
10 = Actual Doppler shift fA calculated as fA=fD*cosφt
10 = Pure display parameters are on a dark background
11 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the chan-

nels

2. To display all five paths per each group, change the settings as follows:

a) Select "Table Settings".

Path table
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b) In the "Path Table Settings" dialog, select "Path Filter > All Paths".

Cross-reference between the fading parameters

Consider the following interdependencies:
● Delay parameters

Resulting Delay = Basic Delay + Additional Delay
● Parameters influencing the Doppler shift calculation:

Resulting Doppler Shift fD calculated as:

fD = (ν/c)*fRF, where:

– ν is the Speed of the moving receiver
– fRF is the frequency of the RF output signal or the Virtual RF

– c=2.998*108m/s is the speed of light
For "Fading Profile > Pure Doppler, Gauss Doppler or Rice", the Actual Doppler
Shift fA calculated as:

fA = fD*cosφt, where:

– cosφt is the Frequency Ratio and φ is the angle of incidence
– fD is the Resulting Doppler Shift

3.4.1  Table settings

► To access this dialog, select "Fading > Fading Settings > Path Table > Table Set-
tings".

The provided functions facilitate settings configuration and navigation in the path
table, like suppression of the indication of disabled paths, quick change of the
speed unit.

Path Filter......................................................................................................................47
Speed Unit.................................................................................................................... 47
Keep Constant.............................................................................................................. 47
Common Speed For All Paths.......................................................................................47

Path table
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Path Filter
Suppresses the indication of the disabled paths.
Remote command: 
n.a.

Speed Unit
Toggles between the available units for speed. The value always remains unchanged
but the display is automatically adapted to the selected unit.
Note: The remote control command changes only the units displayed in the graphical
user interface. While configuring the speed via remote control, the speed units must be
specified.
Remote command: 
[:SOURce<hw>]:FSIMulator:SPEed:UNIT on page 161

Keep Constant
Selects whether to keep the speed or the resulting Doppler shift constant in case of fre-
quency changes. If a constant speed is selected, the Doppler shift is calculated as
function of the speed and the frequency and vice versa.
Remote command: 
[:SOURce<hw>]:FSIMulator:KCONstant on page 156

Common Speed For All Paths
In delay configurations, activates/deactivates the same speed in all paths.
If Speed Setting Coupled is enabled, this parameter is also coupled in both faders.
"On" In this default state, a change of speed in a path automatically results

in a change of speed in all of the other paths.
"Off" When switching from "Off" to "On", the speed entry for path 1 of

group 1 is used for all of the paths.
Remote command: 
[:SOURce<hw>]:FSIMulator:CSPeed on page 171

3.4.2  Copy path group settings

The provided "Copy Path Group" settings enable you to copy the settings of one to a
second fading group.

Copy Path Group.......................................................................................................... 47
To.................................................................................................................................. 48
Copy..............................................................................................................................48

Copy Path Group
Selects a group whose settings are to be copied.
Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:SOURce on page 152

Path table



Fading settingsFading Simulation

48User Manual 1175.6826.02 ─ 29

To
Selects a group whose setting is to be overwritten.
Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:DESTination on page 152

Copy
Triggers a copy procedure.
Remote command: 
[:SOURce<hw>]:FSIMulator:COPY:EXECute on page 152

3.4.3  Path table settings

State Path..................................................................................................................... 48
Profile............................................................................................................................ 49
Path Loss...................................................................................................................... 50
Basic Delay................................................................................................................... 51
Additional Delay............................................................................................................ 51
Resulting Delay............................................................................................................. 51
Power Ratio...................................................................................................................51
Frequency Spread.........................................................................................................51
Frequency Shift............................................................................................................. 52
Const. Phase.................................................................................................................52
Start Phase................................................................................................................... 52
Speed............................................................................................................................52
Resulting Doppler Shift................................................................................................. 53
Frequency Ratio............................................................................................................53
Actual Doppler Shift...................................................................................................... 54
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State Path
Activates a fading path.
After activating, the fading process is initiated for this path with the selected fading pro-
file. However, the fading simulator must be switched on.
Remote command: 
[:SOURce<hw>]:FSIMulator[:STATe] on page 169
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe
on page 182
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe
on page 182
[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe on page 190
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Profile
Determines the fading profile for the selected path. The fading profile determines which
transmission path or which radio hop is simulated.
See also "Fading profile" on page 24.
Depending on which profile is selected, certain parameters are available in the path
table and others are not available.
With correlated paths, the profile setting must agree. When correlation is activated, the
setting of the path for which correlation is switched on is accepted for both paths. After-
wards, the most recent modification applies to both paths (no matter in which path it
was made).
"Static Path" Simulated is a static transmission path which can undergo attenua-

tion (loss) or delay.
"Pure Doppler" Simulated is a transmission path with an individual direct connection

from the transmitter to the moving receiver (discrete component).
The actual Doppler shift is determined by the Speed and Frequency
Ratio parameters.
Tip: In MIMO configuration, use the Relative gain vector matrix set-
tings to configure beamforming.

"Rayleigh" Simulated is a radio hop in which many highly scattered subwaves
arrive at a moving receiver.

"Rice" Simulated is a radio hop in which a strong direct wave (discrete com-
ponent) arrives at a moving receiver in addition to many highly scat-
tered subwaves.
Use the parameter Power Ratio to set the ratio of the power of the
two components (Rayleigh and pure Doppler).

"Const. Phase" Simulated is one transmission path with the set constant phase rota-
tion, attenuation (loss) or delay.

"Gauss1" Option: R&S SMW-K72
Sum of two Gaussian functions and is used for excess delay times in
the following range:
0.5 µs to 2 µs, (0.5 µs < τI < 2 µs).
S(τI,f) = G(A, -0.8fd, 0.05fd) + G (A1, +0.4fd, 0.1fd)
where A1 is 10 dB below A.

"Gauss2" Option: R&S SMW-K72
Sum of two Gaussian functions and is used for paths with delays in
excess of 2 µs, (τI > 2 µs).
S(τI,f) = G(B, +0.7fd, 0.1fd) + G (B1, -0.4fd, 0.15fd)
where B1 is 15 dB below B.

"Gauss DAB" Option: R&S SMW-K72
Composed of a Gaussian function and is used for special DAB pro-
files.
S(τI,f) = G(A, ±0.7fd, 0.1fd)
where + 0.7fd applies for even path numbers and 0.7fd for odd, except
path 1.
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"Gauss Doppler"
Option: R&S SMW-K72
Sum of a Gaussian function and a pure Doppler component.
S(τI,f) = G(0.1A; 0; 0.08fd) + δ(f-0.5fd)

"Gauss (0.08 fd)"
Option: R&S SMW-K72
Composed of a Gaussian function with a standard deviation of
0.08*fd.
S(τI,f) = G(A; f; 0.08fd)

"Gauss (0.1 fd)"
Option: R&S SMW-K72
Composed of a Gaussian function with a standard deviation of 0.1*fd.
S(τI,f) = G(A; f; 0.1fd)

"Gauss (Watters)"
Option: R&S SMW-K72
Gauss (Watterson) fading profile.

"WM Doppler" Option: R&S SMW-K72
The WiMAX Doppler fading profile is a rounded Doppler PSD model
according to IEEE 802.16a.

"WM Rice" Option: R&S SMW-K72
The WiMAX Rice fading profile is according to IEEE 802.16a.

"Bell Shape tgn Indoor/Bell Shape tgn Moving Vehicle"
Both Bell Shape fading profiles describe the indoor wireless channels
according to IEEE 802.11n and IEEE 802.11ac.
The profiles are called after the resulting Doppler power spectrum
that has a shape very similar to a "Bell". The second fading profile
includes a Doppler component that represents a reflection from a
moving vehicle.

"SCM" Option: R&S SMW-K73
The SCM profile is a geometry-based channel model that improves
the accuracy of the simulated channel model.
To access the settings, select "SCM Profile > SCM Data", see Chap-
ter 5.3.7, "SCM fading profile", on page 116

"Custom" Option: R&S SMW-K72
Customized Doppler fading profile developed by Cohda-Wirless; the
profile describes the channels for testing of IEEE 802.11p signals.
To access the required settings, select "Custom", see Chapter 3.11,
"Custom fading profile", on page 87.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile
on page 181
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile
on page 181

Path Loss
Enters the loss for the selected path.
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Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS
on page 180

Basic Delay
Option: R&S SMW-B14
Sets the basic delay.
Within a path group, all of the paths are jointly delayed by this value.
The path delay is calculates as:
Resulting Delay = Basic Delay + Additional Delay
The "Basic Delay" for group 1 is always 0. Thus, for the paths in group 1, the "Result-
ing Delay" is equal to the "Additional Delay".
See also Chapter 2.4, "Characteristics of R&S SMW-B14 and R&S SMW-B15",
on page 25.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
on page 173

Additional Delay
Sets the Additional Delay per path.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay
on page 172

Resulting Delay
Displays the Resulting Delay for the path.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?
on page 173

Power Ratio
("Fading Profile > Rice, WM Rice, Gauss Doppler")
Enters the power ratio of the discrete component and distributed component.
The total power consisting of the two components is always constant. At a high power
ratio, the discrete (Doppler) component prevails. At a low power ratio, the distributed
(Rayleigh) component prevails.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio
on page 180

Frequency Spread
("Fading Profile > Gauss Watterson")
Sets the frequency spread for the Gauss Watterson fading.
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Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead
on page 179

Frequency Shift
("Fading Profile > Gauss Watterson")
Enters the frequency shift for the Gauss Watterson fading.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift
on page 178

Const. Phase
Enters the phase by which the path is multiplied.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 175

Start Phase
("Fading Profile > Pure Doppler, WM Doppler")
A transmission path with the set start phase rotation is simulated which can undergo
attenuation (loss) or delay.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
on page 175

Speed
Enters the speed ν of the moving receiver.
The Resulting Doppler Shift fD is calculated as:

fD = (ν/c)*fRF, where

fRF is the frequency of the RF output signal or the virtual RF frequency and
c=2.998*108m/s is the speed of light

Example: 
If ν = 100 km/h and fRF = 1 GHz, the fD = 92.66 Hz

Consider the following interdependencies:
● If the speed is changed, the resulting Doppler shift is automatically modified.
● If "Path Table Settings > Common Speed in All Paths > On", a change of speed in

one path automatically results in a change of speed in all of the other paths of the
fader.

● In the "Fading Profile > Pure Doppler/Rice/Gauss Doppler", the actual Doppler
Shift fA is a function of the selected speed ν and also of the parameter Frequency
Ratio.
See also "Cross-reference between the fading parameters" on page 46

● In "System Configuration > Mode > Standard", you can couple the speed for the
paths of both faders.
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● With correlated paths, the speed setting must agree. When correlation is activated,
the settings of the path for which correlation is switched on are accepted for both
paths. Afterwards, the most recent modification applies to both paths (no matter in
which path it was made). The same applies to all paths of the two faders when
coupling is activated.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed
on page 182

Resulting Doppler Shift
If "Table Settings > Keep Constant > Speed", this parameter displays the resulting
Doppler shift fD.

The value depends on the selected:
● Speed
● RF frequency fRF or the Virtual RF
● For "Fading Profile > Pure, Gauss Doppler or Rice", the "Actual Doppler Shift"

depends also on the selected Frequency Ratio.
See "Cross-reference between the fading parameters" on page 46.
To set the Doppler shift, enable "Table Settings > Keep Constant > Resulting Doppler
Shift". In this case, the "Speed" is calculated as a function of the selected "Resulting
Doppler Shift" and the RF frequency fRF.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:
RESulting] on page 176

Frequency Ratio
("Fading Profile > Pure, Gauss Doppler or Rice")
Sets the ratio of the actual Doppler Shift fA to the Resulting Doppler Shift fD.

The actual Doppler shift is a function of the simulated angle of incidence of the discrete
component (see Figure 3-4) and is calculated as:
fA = fD*cosφt, where:

cosφt is the "Frequency Ratio" and fD= (v/c)*fRF is the Resulting Doppler Shift.

Negative values indicate a receiver that is going away from the transmitter, and posi-
tive values a receiver that is approaching the transmitter.
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Figure 3-4: Doppler shift as a function of the angle of incidence

See also "Cross-reference between the fading parameters" on page 46
With correlated paths, the speed setting of the Frequency Ratio must agree. When cor-
relation is activated, the settings of the path for which correlation is switched on are
accepted for both paths. Afterwards, the most recent modification applies to both paths
(no matter in which path it was made).
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio
on page 178

Actual Doppler Shift
("Fading Profile > Pure Doppler, Gauss Doppler, Rice")
Displays the actual Doppler shift fA. The value depends on Frequency Ratio and
Resulting Doppler Shift.
See also "Cross-reference between the fading parameters" on page 46.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual? on page 177

Correlation Path
Switches on correlation to the corresponding path of the second fader for dual-channel
fading.
Setting correlation necessitates synchronous signal processing on both channels. This
means the settings of the following parameters for the correlated fading paths must
agree:
● "Profile"
● "Speed"
● "Frequency Ratio"
● "Lognormal Parameters"
● "Resulting Doppler Shift"
● "Actual Doppler Shift"
When correlation is activated, the settings of the path for which correlation is switched
on are accepted for both paths. Afterwards, the most recent modification applies to
both paths (no matter in which path it was made).
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Correlated paths in dual-channel fading with the same input signal simulate the receiv-
ing conditions experienced by a receiver having two antennas in which the received
signals exhibit a certain degree of correlation due to a similar environment.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:STATe on page 175

Correlation Coefficient
Sets the magnitude of the complex correlation coefficient as a percentage.
The higher the entered percentage, the greater the correlation of the statistical fading
processes for the two correlated paths. Highly correlated ambient conditions for the
signal are simulated in this manner.
Each fader has a maximum of 20 paths.
With correlated paths, the coefficient setting must agree. When correlation is activated,
the setting of the path for which correlation is switched on is accepted for both paths.
Afterwards, the most recent modification applies to both paths (no matter in which path
it was made).
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:COEFficient on page 174

Correlation Coefficient Phase
Sets the phase of the complex correlation coefficient in degrees.
With correlated paths, the coefficient phase setting must agree. When correlation is
activated, the setting of the path for which correlation is switched on is accepted for
both paths. Afterwards, the most recent modification applies to both paths (no matter in
which path it was made).
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:
CORRelation:PHASe on page 175

Lognormal State
Switches lognormal fading on/off (slow fading).
Simulated is an additional slow fluctuation of the received amplitude of a moving
receiver. This can occur due to peculiarities in the landscape or topography (e.g. when
driving through a depression). Lognormal fading has a multiplicative effect on the path
loss. The multiplication factor is time-variable and logarithmically normally distributed. If
a Rayleigh profile is set simultaneously, what we obtain is Suzuki fading.
Note: Since the slow level fluctuation is not taken into account statistically in the com-
putation of the insertion loss, the output power can deviate from the displayed power.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
STATe on page 180

Local Constant
Enters the Local Constant for lognormal fading.
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The Local Constant L and the speed v of the moving receiver determine the limit fre-
quency fL for lognormal fading:

fL = v/L.

The power density spectrum of an unmodulated carrier consists of a discrete spectral
line at fRF and a frequency-dependent continuous component for which the following
applies:

The lower setting limit is a function of the (virtual) RF frequency fRF and is calculated as
follows:

Lmin = 12*109 / fRF

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
LCONstant on page 179

Standard Deviation
Enters the standard deviation in dB for lognormal fading.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
CSTD on page 179

3.5  Path graph

To access the graphical representation of the configured path,

► select "Fading > Path Graph".

The path graph provides a quick overview of the paths as they are configured in
the delay modes.
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The signal delay is plotted on the x-axis. The minimum value is 0 s. The maximum
value is equal to the maximum delay, determined by the sum of max. Basic Delay and
max. Additional Delay. The relative path power is plotted on the y-axis, with 0 dB corre-
sponding to the maximum power on the path (path loss = 0 dB).

Each path is represented by a bar. The color of the bar indicates the fading profile of
the path. The color coding for the individual profiles is shown right next to the graphics.
The "Path Loss" can be read off from the height of the bar. The minimum value is 0 dB,
and the maximum value is – 50 dB.

3.6  Birth death propagation

In the "Birth Death Propagation" configuration, the fading simulator simulates dynamic
propagation conditions in conformity with the test case 3GPP, 25.104-xxx, annex B4.
Here, the behavior of a receiver is tested when it is confronted with the sudden disap-
pearance and reappearance of a signal. This can occur, for example, when a pedes-
trian making a call walks around the corner of a building.

Two paths are simulated which appear ("Birth") or disappear ("Death") in alternation at
arbitrary points in time. The points in time fall within a grid of integer delays [-5, -4, -3,
-2, -1, 0, 1, 2, 3, 4, 5] µs. After a certain time ("Hopping Dwell"), a path disappears from
a given grid position and appears simultaneously at another randomly chosen grid
position. During this hop, the second path remains stable at its grid position. After a fur-
ther "Hopping Dwell" elapses, the second path changes its position. Now, the first path
remains at its position and so on. The two paths never appear at the same time posi-
tion at the same time (see Figure 3-5).
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Figure 3-5: Example of a sequence of hops in Birth Death Propagation

Since it is not possible to generate negative time values (delays), the actual hop range
is from 0 to 10 µs.

According to annex B4, each path has the same loss and phase and no Doppler shift.
The time until the position of a path is changed is also specified (see Table 3-2).
Table 3-2: Default parameter values (Birth Death Propagation)

"Profile" Pure Doppler

"Path Loss" 0 dB

"Min. Delay" 0 μs

"Delay Grid" 1 μs

"Positions" 11

"Max. Delay" 10 μs

"Hopping Dwell" 191 ms

"Speed" 0 m/s

"Frequency Ratio" 1.0

Path Graph

The graphical display of the fading paths in Birth Death Propagation mode shows as
an example the changing positions of the two paths within the delay grid. The dis-
played position change does not correspond to the actual delay hops of the real signal.
An arrow indicates the direction of the delay hop of the path that will next change its
position, with the head of the arrow marking the new position.

The delay grid is plotted on the x-axis. The permissible delay range and the delay off-
set are shown in the graphics (see the "Min Delay" and the "Delay Range" indication
on the graph). The path power is plotted on the y-axis, with 0 dB corresponding to the
maximum power on the path (path loss = 0 dB). The scaling of the axes and the dis-
played path power match the real settings.

The scaling of the x-axis depends on the set delay range. It always starts at 0 µs and
rages up to 40 µs at the most (= maximum for delay range). The minimum delay corre-
sponds to the start value of the delay range. The maximum delay is defined by the min-
imum delay, the delay grid and the number of possible hop positions.

Max Delay = (Positions – 1) x Delay Grid + Min. Delay
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The (mean) delay offset is calculated from the minimum and maximum delay ((max.
delay - min. delay)/2).

The Table 3-2 lists the default values for Birth Death Propagation. However, these
parameters can also be set for further tests in the fading path table.

Settings:

Profile............................................................................................................................ 60
Path Loss...................................................................................................................... 60
Min Delay...................................................................................................................... 60
Delay Grid..................................................................................................................... 60
Positions........................................................................................................................60
Maximum Delay............................................................................................................ 61
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Start Offset.................................................................................................................... 61
Hopping Dwell............................................................................................................... 61
Speed............................................................................................................................62
Resulting Doppler Shift................................................................................................. 62
Frequency Ratio............................................................................................................62
Actual Doppler Shift...................................................................................................... 63

Profile
Displays the fading profile for birth death propagation. The fading profile has a fixed
setting to "Pure Doppler".
A transmission path is simulated in which there is an individual direct connection from
the transmitter to the moving receiver (discrete component). The Doppler frequency
shift is determined by the "Speed" and "Frequency Ratio" parameters.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile on page 184

Path Loss
Enters the loss for the selected path.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS on page 184

Min Delay
Enters the minimum delay for the two fading paths.
The minimum delay corresponds to the start value of the delay range.
The delay range is defined by the minimum delay, the delay grid and the number of
possible hop positions. It can be in the range between 0 and 40 us.
0 us < (Positions – 1) x Delay Grid + Min. Delay < 40 us
The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 58).
Invalid entries are rejected, the next possible value is entered.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum on page 183

Delay Grid
Enters the delay grid. The value defines the resolution for the possible hop positions of
the two fading paths in the delay range.
The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 58).
Invalid entries are rejected, the next possible value is entered.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID on page 183

Positions
Enters the number of possible hop positions in the delay range.
The scaling of the X-axis is adapted according to the entry (see "Path Graph"
on page 58).
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Invalid entries are rejected, the next possible value is entered.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions on page 185

Maximum Delay
Indication of the maximum delay. The maximum delay corresponds to the stop value of
the delay range (see "Path Graph" on page 58).
The maximum delay is defined by the minimum delay, the delay grid and the number of
possible hop positions.
Max Delay = (Positions – 1) x Delay Grid + Min. Delay
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum? on page 183

Start Offset
Enters the timing offset by which the start of "Birth Death Propagation" is offset with
respect to when fading is switched on or a restart as a result of a restart trigger.
This allows the user to precisely displace birth death events with respect to one
another during two-channel fading. This is required in some 3GPP base station tests.
If the same hopping dwell time is entered in both faders, the offset will take place by a
constant value.

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset on page 185

Hopping Dwell
Enters the time until the next change in the delay of a path (birth death event).
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During two-channel fading, the dwell times of the two channels can be set independ-
ently. This causes the hop time points of the two channels to coincide repeatedly. This
is a way of simulating tough receiving conditions as arise when two receiving channels
simultaneously change frequency (see figure).

Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl on page 184

Speed
Enters the speed v of the moving receiver.
The resulting Doppler shift is dependent on the speed v and the entered ratio of the
actual Doppler shift to the set Doppler shift fD. This ratio is determined in the "Fre-
quency Ratio" line. The resulting Doppler frequency can be read off from the "Res.
Doppler Shift" line. It may not exceed the maximum Doppler frequency.
If the speed is changed, the resulting Doppler shift is automatically modified.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed on page 185

Resulting Doppler Shift
Displays the resulting Doppler shift.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler? on page 186

Frequency Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed"
parameter.
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio on page 186
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Actual Doppler Shift
Displays the actual Doppler shift.
The actual Doppler frequency is determined by the selected "Speed" and "Frequency
Ratio" (i.e. the ratio of the actual Doppler frequency to the resulting Doppler fre-
quency).
Remote command: 
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?
on page 187

3.7  Moving propagation

In the "3GPP/LTE Moving Propagation" configuration, the fading simulator simulates
dynamic propagation conditions in conformity with the test case 3GPP TS25.104,
annex B3 or 3GPP TS36.141, annex B.4.

The fading simulator enables configuration according to three predefined moving sce-
narios. The first one represents moving conditions with one reference and one moving
channel whereas in the other two all paths are moving.

The predefined scenarios are as follow:
● "Ref. + Mov. Channel" - Simulation of moving propagation conditions in accordance

to the 3GPP TS25.104, annex B3.
(see Chapter 3.7.1, "Moving propagation conditions for testing of baseband perfor-
mance", on page 63)

● "ETU200Hz Moving" - Simulation of moving propagation conditions in accordance
to the scenario 1 described in 3GPP TS36.141, annex B.4.
(see Chapter 3.7.2, "Moving propagation conditions for testing the UL timing
adjustment performance", on page 66)

● "Pure Doppler Moving" - Simulation of moving propagation conditions in accord-
ance to the scenario 2 described in 3GPP TS36.141, annex B.4.
(see Chapter 3.7.2, "Moving propagation conditions for testing the UL timing
adjustment performance", on page 66)

It is also possible to adjust some of the parameters of these predefined scenarios and
simulate user-definable moving propagation conditions.

3.7.1  Moving propagation conditions for testing of baseband perfor-
mance

Simulating moving propagation conditions for testing of baseband performance

► To simulate moving propagation conditions for testing of baseband performance in
accordance to the 3GPP TS25.104, annex B3:

a) select "Configuration > Moving Propagation" and "Moving Channels > One" or
b) select "Standard > 3GPP > Moving Propagation > Ref. + Mov. Channel".
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Here, the behavior of a receiver is tested in response to slow delay variations in a sig-
nal. Two paths are simulated: Path 1 has fixed delay (Reference Path, P1), while the
delay of path 2 varies slowly in a sinusoidal fashion (Moving Path, P2). The two paths
have no fading profile. They have the same level, the same phase and no Doppler
shift.

The following figure illustrates a baseband signal with ASK modulation (only one 1 bit,
then many 0 bits) which was subjected to moving propagation. Path P1 remains still
while path P2 moves in time relative to it. As a result of the luminescence setting on
the oscilloscope, the way in which P2 wanders over time is clearly visible.

The graphical display of the fading paths in Moving Propagation mode shows as an
example the changing positions of the moving path with respect to the stationary refer-
ence path. The displayed position change does not correspond to the actual delay
changes of the real signal.

The delay grid is plotted on the x-axis. The permissible delay range for the moving path
is shown in the graphics by the horizontal arrow. The grey path indicates the set start
delay for the Moving Path. The path power is plotted on the y-axis, with 0 dB corre-
sponding to the maximum power on the path (path loss = 0 dB). The scaling of the
axes and the displayed path power match the real settings.
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The delay Δτone of the moving path obeys the following equation:

Where the values relate to the values proposed in the test case 3GPP, 25.104xxx,
annex B3 as follows:
● Variation (Peak-Peak) = A
● Delay = B + A/2
● Variation Period = 2π /Δ ω

The Table 3-3 list the settings required to attain the values proposed in the test case
3GPP TS25.104, annex B3.

Table 3-3: Default parameter values (Moving Propagation)

Reference Path: "Delay" 0 us

 "Path Loss" 0 dB

 "State" On

Moving Path: "Variation (Pk Pk)" 5 us

 "Variation Period" 157 s

 "Delay" 3.5 us

 "Path Loss" 0 dB

 "State" On

These default values can be changed in the Path Table dialog.
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3.7.2  Moving propagation conditions for testing the UL timing adjust-
ment performance

The purpose of the uplink timing adjustments testing is to verify whether the base sta-
tion sends timing advance commands and whether the base station estimates appro-
priate the uplink transmission timing.

Simulating moving propagation conditions

To simulate moving propagation conditions for testing the UL timing adjustment perfor-
mance in conformity with the test cases "Moving propagation conditions", as defined in
3GPP 36.141, annex B.4:

► Select "Standard > LTE > Moving Propagation > ETU200Hz Moving or Pure Dop-
pler Moving"

The Figure 3-6 illustrates the moving propagation conditions for the test of the UL tim-
ing adjustment performance.

Figure 3-6: Moving Propagation Conditions

Use the parameter "Additional Delay" to configure the relative timing among all paths.
The time difference between the reference timing and the first path is according to the
following equation:

The 3GPP specification defines the uplink timing adjustments requirements for normal
and extreme conditions. The following two scenarios for the testing of UL timing
advance are specified:
● Scenario 1: ETU200 ("ETU200Hz Moving") is the scenario for testing in normal

conditions.
This scenario considers ETU channel model and UE speed of 120km/h.

● Scenario 2: AWGN ("Pure Doppler Moving") is the extreme conditions optional sce-
nario.
The scenario corresponds to AWGN channel model and UE speed of 350km/h.
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The fading simulator generates the signals for these scenarios in according to the
parameters defined in the 3GPP specification (see table Table 3-4). However, the fad-
ing simulator also allows the re-configuration of some of the predefined values.
Table 3-4: Default parameter values

Parameter Scenario 1 Scenario 2

Channel Model ETU200Hz Moving Pure Doppler

UE speed 120 km/h 350 km/h

CP length Normal Normal

"Variation (Peak-Peak)" 10 μs 10 μs

Δω 0.04 1/s 0.13 1/s

"Variation Period" = 2π/Δω 157.1 s 48.3 s

3.7.2.1  Scenario 1

Here, the behavior of a moving receiver is tested, i.e. the simulated scenario repre-
sents a moving receiver that changes its distance to the base station. The Fading Sim-
ulator generates the signal as a sequence of complete cycles of approach towards to
the BS antenna and moving away from it.

Per default, three Rayleigh path groups with three paths each are simulated. All paths
move.

The path group 1 has a fixed delay ("Basic Delay = 0 s"); the "Basic Delay" of the other
two path groups can be configured. The relative timing among all paths is determined
by the parameter "Additional Delay".

The three path groups have the same phase and speed; the Doppler shift is calculated
as a function of the selected speed.

Moving propagation



Fading settingsFading Simulation

68User Manual 1175.6826.02 ─ 29

3.7.2.2  Scenario 2

One path without a fading profile (Pure Doppler) is simulated. The path has constant
level and constant speed.

3.7.3  Path tables moving propagation

The parameters available for configuration depend on the selected number of Moving
Channels, one or all.

3.7.3.1  One moving channel

► To access the settings for configuring the moving and the reference path for the
moving propagation with one moving channel, perform on of the following:

a) select "Fading > Standard > 3GPP > Ref. + Mov. Channel"
b) select "Fading > Configuration > Moving Propagation" and "Moving Channels >

One".

Settings:

Reference Path Settings............................................................................................... 69
└ State................................................................................................................69
└ Path Loss........................................................................................................69
└ Delay...............................................................................................................69

Moving Path Settings.................................................................................................... 69
└ State................................................................................................................69
└ Path Loss........................................................................................................69
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└ Delay...............................................................................................................69
└ Variation (Peak-Peak)..................................................................................... 69
└ Variation Period...............................................................................................70

Reference Path Settings
The following settings are provided:

State ← Reference Path Settings
Activates reference path P1 for moving propagation.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe on page 196

Path Loss ← Reference Path Settings
Enters the loss for the reference path.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS on page 196

Delay ← Reference Path Settings
Enters the delay for the reference path.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay on page 196

Moving Path Settings
The following settings are provided:

State ← Moving Path Settings
Activates moving fading path P2 for moving propagation.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe on page 195

Path Loss ← Moving Path Settings
Enters the loss for the moving fading path.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS on page 195

Delay ← Moving Path Settings
Enters the average delay for the moving fading path.
The delay of the moving path slowly varies sinusoidal within the set variation range
around this delay.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN on page 194

Variation (Peak-Peak) ← Moving Path Settings
Enters the range for the delay of the moving fading path for moving propagation. The
delay of the moving path slowly varies sinusoidal within this range around the set mean
delay.
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Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation on page 194

Variation Period ← Moving Path Settings
Period duration for delay variation. A complete variation cycle is passed through in this
time.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod on page 195

3.7.3.2  All moving channels

► To access the settings for configuring the moving path groups and their paths, per-
form one of the following:

a) select "Fading > Standard > LTE > Moving Propagation > ETU200Hz Moving"
b) select "Fading > Standard > LTE > Moving Propagation > Pure Doppler Mov-

ing"
c) select "Fading > Configuration > Moving Propagation" and "Moving Channels >

All".

The number and the parameters of the predefined paths depend on the selected
scenario.

The most parameters in the "Path Table" correspond to the parameters described in
Chapter 3.4, "Path table", on page 44.
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Settings:

Delay Variation (Peak-Peak)......................................................................................... 71
Variation Period.............................................................................................................71

Delay Variation (Peak-Peak)
Enters the range for the delay of the moving fading paths for moving propagation with
all moving channels. The delay of the moving path slowly varies sinusoidal within this
range around the set mean delay.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation
on page 193

Variation Period
Period duration for delay variation. A complete variation cycle is passed through in this
time.
Remote command: 
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod on page 192

3.8  Two channel interferer

In the "2 Channel Interferer" configuration, the fading simulates dynamic propagation in
conformity with the test cases 5 and 6 from MediaFlo. Here, path 1 has a fixed delay
while the delay of path two either varies slowly in a sinusoidal way or appears in alter-
nation at arbitrary points in time. Thus, 2 channel interferer fading can be considered
as a combination of birth death propagation fading and moving propagation fading. The
main difference is the broader range of propagation obtainable with 2 channel inter-
ferer fading.

Each of the fading profiles "Static Path", "Pure Doppler" and "Rayleigh" can be alloca-
ted to the two paths.

Predefined Setting

The Table 3-5 and Table 3-6 list the settings required to attain the values proposed in
the MediaFlo test case 5 and 6.
Table 3-5: Test Case 5

Reference Path: "Profile" Static Path

 "Relative Delay" 10 us

 "Average Power" -3 dB

 "Fading Type" Rayleigh, 60 km/h

 "Doppler Spectrum" Classic 6 dB

 "Static Delay" 40 us

Moving Path: "Profile" Hopping
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 "Relative Delay" 0/110 us

 "Average Power" -3 dB

 "Fading Type" Static

 "Doppler Spectrum" N/A

 "Dwell Time" 2.9 s

Table 3-6: Test Case 6

Reference Path: "Profile" Static Path

 "Relative Delay" 100 us

 "Average Power" -3 dB

 "Fading Type" Static

 "Doppler Spectrum" N/A

Moving Path: "Profile" Sliding

 "Relative Delay" 0/200 us

 "Average Power" -3 dB

 Fading Type Rayleigh, 3 km/h

 "Doppler Spectrum" Classic 6 dB

 "Period" 160 s

How to use the provides settings and configure a 2 channel interfering signal

The following are two examples on how to configure a "2 Channel Interferer" condi-
tions. See how to:
● "To enable a hopped moving mode" on page 72
● "To enable a sliding moving mode" on page 73

To enable a hopped moving mode

Enable a 2 channel interfering signal with the following settings:

1. Reference Path:

a) "Delay Min = 30 μs"
b) "Profile = Static Path"
c) "Path Loss = 0 dB"

2. Moving Path:

a) "Delay Min = 0 μs"
b) "Profile = Static Path"
c) "Path Loss = 0 dB"
d) "Delay Max = 100 μs"
e) "Moving Mode > Hopping"

3. Enable "Reference Path > State > On" and "Moving Path > State > On"
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4. Open the "Fading > Path Graph" view.

The following figure shows the resulting path graph.

To enable a sliding moving mode

1. Use the settings of "To enable a hopped moving mode" on page 72.

2. Change the "Moving Mode > Sliding".

3. Open the "Fading > Path Graph" view.

The moving path slides from the minimum delay (30 us) to the maximum delay
(100 us) and back. The grey bar indicates the mean delay of the moving path. The
horizontal arrow indicates the permissible delay range for the moving path.
The displayed position change does not correspond to the actual delay changes of
the real signal.
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2 Channel Interferer Settings

The Table 3-5 and Table 3-6 list the default values for "2 Channel Interferer" configura-
tion. You can use these default values and/or adjust the provided settings in the fading
path table.

Settings:

State..............................................................................................................................74
Profile............................................................................................................................ 75
Path Loss...................................................................................................................... 75
Speed............................................................................................................................75
Freq. Ratio.................................................................................................................... 75
Res. Doppler Shift......................................................................................................... 75
Act. Doppler Shift.......................................................................................................... 76
Delay Min...................................................................................................................... 76
Delay Max (Moving Path)..............................................................................................76
Moving Mode (Moving Path)......................................................................................... 76
Period/Dwell.................................................................................................................. 76

State
Activates/deactivates either the reference path or the moving path for 2 channel inter-
ferer fading.
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Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] on page 219
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe
on page 222

Profile
Selects the fading profile either for the reference path or the moving path to be used for
2 channel interferer fading.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?
on page 221

Path Loss
Sets the attenuation of either the reference path or moving path to be used for 2 chan-
nel interferer fading.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS
on page 222

Speed
(Rayleigh only)
Enters the speed v of the moving receiver. The unit for entering the speed under
"Speed Unit" can be chosen in the upper section of the menu.
The resulting Doppler shift is dependent on the speed v and the entered ratio of the
actual Doppler shift to the set Doppler shift fD. This ratio is determined in the "Fre-
quency Ratio" line. The resulting Doppler frequency can be read off from the "Res.
Doppler Shift" line. It may not exceed the maximum Doppler frequency.
If the speed is changed, the resulting Doppler shift is automatically modified.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed on page 220

Freq. Ratio
Enters the ratio of the actual Doppler shift to the Doppler shift set with the "Speed"
parameter.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio
on page 221

Res. Doppler Shift
Displays the actual Doppler shift.
The actual Doppler frequency is determined by the entered "Speed" and the entered
ratio of the actual Doppler frequency to the set Doppler frequency ("Frequency Ratio").
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?
on page 221
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Act. Doppler Shift
Displays the actual Doppler shift.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler:
ACTual? on page 221

Delay Min
Enters the minimum delay for either the reference path or the moving path.
The minimum delay of the moving path corresponds to the start value of the delay
range.
The delay range is defined by the minimum delay and the maximum delay.
The scaling of the x-axis is adapted according to the entry.
Invalid entries are rejected, the next possible value is entered.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:
MINimum on page 220

Delay Max (Moving Path)
Enters the maximum delay for the moving path.
The maximum delay of the moving path corresponds to the end value of the delay
range.
The delay range is defined by the minimum delay and the maximum delay.
The scaling of the x-axis is adapted according to the entry.
Invalid entries are rejected, the next possible value is entered.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:
MAXimum on page 219

Moving Mode (Moving Path)
Selects the Type of moving applied to the moving path.
"Sliding" The reference path has a fix delay while the delay of the moving path

varies slowly in a sinusoidal way.
"Hopping" The reference path has a fix delay while the delay of the moving path

appears or disappears in alternation at arbitrary points in time.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:MMODe
on page 219

Period/Dwell
Enters either the dwell time or the period of a complete cycle for the moving path
depending on the selected Moving Mode (Moving Path).
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"Moving Mode" "Period Dwell"

"Sliding" sets the period for a complete cycle of the moving path

"Hopping" sets the dwell time of the moving path

The gradient of the delay/period ratio may not fall below 6μs/s, that is, the minimum
value of the period depends on the value of the delay.
If the value for the delay is increased in a way that the value for the gradient falls below
6μs/s, the value for the period is recalculated automatically.

Example: 
"Delay Min" = 20 us, "Delay Max" = 120 us, "Moving Mode = Sliding"
[("Delay max" - "Delay min")/2]*2π)/"Period/Dwell" = 6
"Period/Dwell" = 314/6 = 52.36 s

The value cannot be decreased below this value.
Remote command: 
[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod on page 220

3.9  Customized dynamic fading

Option: R&S SMW-K820

Customized dynamic fading (CDF) allows you to import dynamic fading list files and to
vary the fading parameters path loss, Doppler shift and delay over time.

Customized dynamic fading is a suitable solution in the following cases:
● If advanced dynamic fading models like the customized high-speed train scenarios

(cHST) are required.
● If a simulation based on measured real-world channel conditions is required

Such requirements are, for example, the UE tests in the context of performance
analysis.

Depending on the used configuration, the following types of dynamic fading list files are
supported:
● "Customized dynamic fading with *.fad_udyn files for SISO and MIMO configura-

tions" on page 77
● "Human-readable customized dynamic fading files for SISO configurations"

on page 78

Customized dynamic fading with *.fad_udyn files for SISO and MIMO configura-
tions

This fading configuration consists of up to 12 fading paths that you can activate individ-
ually. All fading paths use Rayleigh fading profile but you can also assign a pure Dop-
pler profile or static fading profile to the first four paths.
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The dynamic fading list files are application-specific list files in a Rohde & Schwarz pro-
prietary file format in binary form and with the predefined file extension *.fad_udyn.
Such files can originate, for example, from drive test measurements. Convert the mea-
surement results in the required binary file format before loading the files in fading sim-
ulator.

Human-readable customized dynamic fading files for SISO configurations

Fading configurations like 1x1x1 or 2x1x1 SISO consist of one fading channel or up to
12 fading paths. You can assign the dynamic fading list files to the second, third or
forth fading paths. These paths can use a pure Doppler, Rayleigh or static fading pro-
file.

The following applies for the dynamic fading list files:
● Mandatory keyword customer in the filename.

*customer*.fad_udyn, where * stays for user-defined filename.
● Mandatory file extension *.fad_udyn.
● Predefined file structure, see Example"Customized dynamic fading file content"

on page 78.
– Mandatory file heading with syntax

Interval[us] Delay[ms] Fd[kHz] Pathloss[dB], where:
Interval[us] gives the time in μs, relative to the fader start. File content is
repeated when last time interval is reached.
Delay[ms] is the actual delay in ms
Fd[kHz] is the Doppler frequency in kHz
Pathloss[dB] is the path loss in dB

– File contains four columns separated by blanks
Each file row can vary the fading parameters delay, Doppler shift and path loss
over time

Example: Customized dynamic fading file content
Interval[us] Delay[ms] Fd[kHz] Pathloss[dB]
100 7.534877 47.055121 15.554548
100 7.534874 47.055121 15.554545
100 7.534873 47.055121 15.554542
...

Creating and converting human-readable customized dynamic fading files

1. Create a human-readable customized dynamic fading file with any text editor.

2. Rename the file afterwards to follow the naming convention. Add the mandatory
extension.
See "Human-readable customized dynamic fading files for SISO configurations"
on page 78.

3. Load the file in the fading simulator. See "Configuring and enabling "Customized
Dynamic" fading profiles" on page 79.
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4. In the "Path Table", select "Convert > On" to convert the file into the
Rohde & Schwarz proprietary file format.

5. Enable fading simulator. Set "Fading > General > State > On".

The R&S SMW converts the file into the Rohde & Schwarz proprietary file format
and saves on the hard drive.
As long as the file content remains unchanged, converting the file once, after it is
loaded for the first time, is sufficient. Each time you start the fading simulator with
enabled custom fading, the R&S SMW loads the file automatically from the hard
drive.

Configuring and enabling "Customized Dynamic" fading profiles

1. Select "Fading > General Setting > Configuration > Customized Dynamic"

2. Select "Path Table".

The displayed settings and the number of fading paths depend on the configuration
(SISO or MIMO).

3. To load a fading list file, select "Filename > Select Predefined File".
Select on of the predefined files, e.g. CDF_PathLoss.

4. To load user-defined *.fad_udyn files, transfer them to the R&S SMW. Load
them accordingly.

5. Only if you load a custom fading list with filename like *customer*.fad_udyn for
the first time, set "Convert > On".

6. Enable fading simulator. Set "Fading > General > State > On".
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Settings:

State..............................................................................................................................80
Profile............................................................................................................................ 80
Filename....................................................................................................................... 80
Correlation.....................................................................................................................80
Convert..........................................................................................................................81

State
If a fading list file is loaded, this parameter activates the path.
Each change of the state of a path causes a restart of the fader and therefore a restart
of all dynamic lists.
Remote command: 
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATe on page 239

Profile
Sets the used profile. Per default, all fading paths use Rayleigh profile.
"Static Path" Fading profile for all paths.
"Pure Doppler" Fading profile for paths 1 to 4.
"Rayleigh" Fading profile for all paths.
Remote command: 
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF on page 239

Filename
You can load predefined or user-defined application-specific fading list files.
The fading list files are files in a Rohde & Schwarz proprietary file format and with the
predefined file extension *.fad_udyn.

Such files can originate, for example, from drive test measurements. Convert the mea-
surement results in the required file format before loading the file in the file simulator.
Remote command: 
[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog? on page 238
[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog:USER? on page 238
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELect
on page 238
[:SOURce<hw>]:FSIMulator:CDYNamic:DELete on page 239

Correlation
In MIMO configurations, access dialogs to configure the correlation settings:
"Vector" For the "Pure Doppler" paths, opens the "Relative Tap Gain Vector"

dialog where you can configure the phase shift of the selected path.
For description, see Chapter 5.3.3, "Relative gain vector matrix set-
tings", on page 106.

"Matrix" For the "Rayleigh" paths, opens the "Correlation Matrix" dialog.
Available is only the "Matrix Mode > Individual", see Chapter 5.3.2,
"Correlation matrix table", on page 104.
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Convert
If enabled, files with filename like *customer*.fad_udyn are converted into the
Rohde & Schwarz proprietary file format when the fading simulator is enabled. Conver-
ted files are saved on the hard drive.
As long as the file content remains unchanged, converting the file once, after it is loa-
ded for the first time, is sufficient. Each time you start the fading simulation with
enabled custom fading, the R&S SMW loads the file automatically from the hard drive.
If *customer*.fad_udyn files are used but there is no converted file available and
you try to enable fading simulation, an error message appears.
If you use predefined *.fad_udyn files or user-defined application-specific fading list
files created from drive test measurements for examples, the convert function has no
effect. Set "Convert > 0ff" in this case.
See:
● "Human-readable customized dynamic fading files for SISO configurations"

on page 78.
● "Creating and converting human-readable customized dynamic fading files"

on page 78.
Remote command: 
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:CONVert:STATe
on page 240

3.10  High-speed train

In the "High Speed Train" configuration, the fading simulator simulates propagation
conditions in conformity with the test case "High-speed train conditions", as defined in
3GPP TS 25.141, annex D.4A and 3GPP TS 36.141, annex B.3. Here, the behavior of
a receiver in high-speed train conditions is tested, i.e. the simulated scenario repre-
sents a fast moving receiver that drives past an antenna. The fading simulator gener-
ates the signal as a seq uence of complete cycles of approach towards to the BS
antenna and departure from it.

Figure 3-7: High-speed train propagation

Three high-speed scenarios are defined:
● Scenario 1: Open space
● Scenario 2: Tunnel with leaky cable
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● Scenario 3: Tunnel for multi-antennas

3.10.1  Scenario 1 and scenario 3

For each of the scenarios 1 and 3, one path without a fading profile is simulated (Pure
Doppler). The path has constant level, no delay and variable Doppler shift.

The Doppler shift for these scenarios is calculated as follows:

Where fA(t) is the actual Doppler shift and fD is the maximum Doppler frequency.

The cosine of angle is given by:

Where:
● DS/2 is the distance in meters between the train and the BS at the beginning of the

simulation
● Dmin is the minimum distance in meters between the BS and the railway track
● v is the velocity of the train in m/s
● t is time in seconds

For scenario 1 and for BS with receiver diversity, the Doppler shift variation is the same
between the antennas.

3.10.2  Scenario 2

Scenario 2 is not defined for EUTRA/LTE test cases.

For scenario 2, one Rician fading propagation channel with Rician factor K=10 dB and
with one tap is simulated. The Rician factor K is defined as the ratio between the domi-
nant signal power and the variant of the other weaker signals (see "K (Rician factor)"
on page 86).

3.10.3  High-speed train scenario parameters

The Table 3-7 gives an overview of the parameters of the HST test scenarios accord-
ing to the test case "High-speed train conditions".
Table 3-7: Parameters for high-speed train conditions

Parameter  Value  

 Scenario 1 Scenario 2 Scenario 3

DS 1000 m Infinity 300 m
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Parameter  Value  

Dmin 50 m - 2 m

K - 10 dB -

v 350 km/h 300 km/h 300 km/h

fD 1340 Hz 1150 Hz 1150 Hz

The Figure 3-8 and Figure 3-9 show the trajectory of the Doppler shift for scenario 1
and 3 for the test parameters specified in the test case. For these two scenarios, the
Doppler shift trajectories for any user-defined parameters are also displayed in the
"3GPP HST" dialog.

Figure 3-8: Doppler shift trajectory for scenario 1

Figure 3-9: Doppler shift trajectory for scenario 3

Doppler shift calculation

The HST scenarios are defined for the UE and for the BS tests. In the fading simulator,
the same standards are used for both test cases. Consider however, the following dif-
ference in the calculation of the Doppler shift:
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● In HST UE tests, the resulting Doppler shift is based only on the used DL fre-
quency.

● In HST BS tests, the DL signal itself already contains a Doppler shift. The UE syn-
chronizes on this shifted DL frequency. The simulated UL signal contains a Doppler
shift, too.
The resulting Doppler shift is then based on both, the UL and the DL frequency.

To enable the fading simulator to consider the DL Doppler shift, use the following two
parameters:
● Consider DL RF
● Virtual DL RF

General recommendations on performing HST BS tests

The following is a list of the general steps required to enable the fading simulator to
generate the signal required for the HST BS tests

1. Set the "RF Frequency" of the instrument to the FUL, as defined in the specification.

2. Enable a high-speed train scenario with extension "(DL+UL)" in its name.

3. If not enabled, activate the parameter "Fading > (HST) Path Table > Consider DL
RF > On".

4. Set the value of the parameter "Fading > (HST) Path Table > Virtual DL RF" to the
FDL, as defined in the specification.

Example: Configuring the fading simulator to generate an HST BS test signal
according to 3GPP TS 36.104
For frequency band 1 tests, the specification defines: FDL = 2.14 GHz and FUL = 1.95
GHz. The resulting Doppler shift is FD = 1140 Hz.
● In the status bar, select "Frequency = FUL = 1.95 GHz"
● Select "Fading A > Fading Settings > Standards" and navigate to the required high-

speed train scenario "3GPP > High Speed Train > HST 3 Tunnel Multi Antenna (DL
+UL)"

● If not enabled, activate the parameter "Fading > Path Table > Consider DL RF >
On".

● Select "Fading > Path Table > Virtual DL RF = FDL = 2.14 GHz"
● Select "Fading > Fading Settings > State > On"
● Use the command [:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler? to

query the resulting Doppler shift.
Compare the example below and the Doppler shift trajectory specified in the 3GPP
TS36.104.

High-speed train scenario settings

To access these settings:

1. Select "Fading > Fading Settings > Standards".
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2. Navigate to the required high-speed train scenario, e.g. "3GPP > High Speed Train
> HST 3 Tunnel Multi Antenna (DL+UL)"

The "3GPP HST" dialog displays the default values of the high-speed train scenar-
ios and allows you to adjust them for further tests.

Settings:

State..............................................................................................................................85
Profile............................................................................................................................ 85
Speed............................................................................................................................86
D (min).......................................................................................................................... 86
D (S)..............................................................................................................................86
K (Rician factor)............................................................................................................ 86
Consider DL RF............................................................................................................ 86
Start Offset.................................................................................................................... 87
Virtual DL RF.................................................................................................................87

State
Activates/deactivates simulation of high-speed train propagation according to the
selected scenario.
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:STATe on page 192

Profile
Determines the fading profile for the selected scenario. The fading profile determines
which transmission path is simulated.
Although both scenarios 1 and 3 are specified as pure Doppler paths without a fading
profile and scenario 2 as a Rician fading, in this fading simulator you can change the
fading profile.
"Static Path" A static transmission path with no attenuation (loss) or delay is simu-

lated.

High-speed train
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"Pure Doppler" A transmission path is simulated in which there is an individual direct
connection from the transmitter to the moving receiver (discrete com-
ponent).
The simulated path has a constant delay and attenuation (no loss).
The Doppler frequency shift is determined only by the parameters
Speed, D (min) and D (S).
Tip: Use the SCPI command [:SOURce<hw>]:FSIMulator:
HSTRain:FDOPpler? to query the Doppler frequency shift.

"Rayleigh" A radio hop is simulated in which many highly scattered subwaves
arrive at a moving receiver.

"Rice" One Rician fading propagation channel with K (Rician factor) and with
one tap is simulated.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:PROFile on page 190

Speed
Sets the velocity parameter, i.e. the speed of the moving receiver.
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:SPEed on page 189

D (min)
For "Profile > Static Path or Pure Doppler", sets the parameter Dmin to define the dis-
tance between the BS and the railway track.
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum on page 189

D (S)
For "Profile > Static Path or Pure Doppler", sets the parameter DS and define the initial
distance DS/2 between the train and the BS at the beginning of the simulation.

Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt on page 189

K (Rician factor)
For scenario 2, sets the Rician factor K that is defined as the ratio between the domi-
nant signal power and the variant of the other weaker signals.
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor on page 190

Consider DL RF
Enables the selection of virtual downlink frequency (DL RF).
By default, this parameter is enabled for the HST (DL+UL) standards. For detailed
description, see "Doppler shift calculation" on page 83.
Note: While performing HST BS tests and "Consider DL RF > Off", the DL Doppler
shift is not considered by the calculation of the UL Doppler shift.

High-speed train
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Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe
on page 191

Start Offset
Set a value greater than zero to shift the HST profile in time.
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:SOFFset on page 191

Virtual DL RF
Sets the virtual downlink frequency. For HST BS tests, enter the FDL defined in the
specification. The value is used by the calculation of the UL Doppler shift.
For detailed description, see "Doppler shift calculation" on page 83
Remote command: 
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency on page 191

3.11  Custom fading profile

The custom fading profile requires R&S SMW-K72.

The custom fading profile allows you to modify the classical Jakes and Flat fading pro-
files. These modified profiles are required by the IEEE 802.11p channel models.

A frequency offset foffset can be applied to shift the spectrum of the original profile. Two
cut-off frequencies, fl (lower) and fu (upper), can be configured to set the lower and
upper cut-off frequencies of the resulting spectrum, see Figure 3-10.

Figure 3-10: Resulting asymmetric Doppler spectrum

In the fading simulator, all these required profile parameters are configurable, see
"Custom fading profile settings" on page 88.

Custom fading profile
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Custom fading profile settings

To access these settings:

1. Select "Fading > Fading Settings > Path Table"

2. Select "Profile > Custom"

3. Select "Custom Profile > Custom Data"

Settings:

Doppler Shape.............................................................................................................. 88
Bandwidth..................................................................................................................... 89
Frequency Offset...........................................................................................................89
Lower/Upper Cutoff Frequency..................................................................................... 89

Doppler Shape
Sets the Doppler shape ("Flat" or "Rayleigh") of the virtual profile.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DSHape on page 223

Custom fading profile
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Bandwidth
Sets the bandwidth of the original Doppler profile from which the resulting profile is cre-
ated, see Figure 3-10.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 223

Frequency Offset
Sets the frequency offset foffset used to shift the original profile, see Figure 3-10.

Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 223

Lower/Upper Cutoff Frequency
Sets the lower and upper cut-off frequencies, fl and fu, that depend on the original pro-
file bandwidth Bandwidth.
The following applies:
● fu  ≤  foffset  +  Bandwidth/2
● fl  ≥  foffset  -  Bandwidth/2
● fu  -  fl  ≥  1 Hz
● 50 Hz ≤ Bandwidth ≥ 40 kHz
Where the highest possible absolute cut-off frequency is 4 kHz.
Remote command: 
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DATA on page 223

Custom fading profile



Signal routing settingsFading Simulation

90User Manual 1175.6826.02 ─ 29

4  Signal routing settings
To route the signal in standard (non-MIMO) configuration

1. Select "System Configuration > Mode > Standard".

2. Select "Fading > Signal Routing (non-MIMO)".

To route the signal in MIMO configuration

Option: R&S SMW-B14/-B15/-K74 and optionally R&S SMW-K75/-K76

► Follow the instructions in Chapter 5.2, "How to enable LxMxN MIMO test configura-
tions", on page 95.

To generate SISO signal with 400 MHz or 800 MHz fading bandwidth

Option: R&S SMW-B15/-K822/-K823

► Select SISO configuration by following the instructions in:
● "To enable MIMO configuration with 400 MHz fading bandwidth" on page 97.
● "To enable MIMO configuration with 800 MHz fading bandwidth" on page 98.

This section describes the settings related to the fading bandwidth and simulation.

For comprehensive description of all settings in the "System Configuration" dialog and
information on how to define the I/Q stream-mapping, connect external instruments,
etc.:
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See section "Signal routing and system configuration" in the R&S SMW user manual.

BB Bandwidth................................................................................................................91
CA Bandwidth............................................................................................................... 91
Signal Routing...............................................................................................................91

BB Bandwidth
Requires R&S SMW-B15/-K822/-K823.
Sets the baseband signal bandwidth that the fading simulator supports.
The value range and the maximum available bandwidth depend on the installed
options and the selected MIMO configuration.
For example:
● In MIMO configurations with fewer than 8 channels, the max. baseband bandwidth

is 400 MHz.
● In MIMO configurations with fewer than 4 channels, the max. baseband bandwidth

is 800 MHz.
For more information, see data sheet.
Remote command: 
:SCONfiguration:BBBW on page 240

CA Bandwidth
Option: R&S SMW-B15/-K822/-K823
Indicates the resulting channel aggregation (CA) bandwidth, calculated based on the
MIMO configuration and the "BB Bandwidth".
The "CA Bandwidth" represents the signal bandwidth at the stream mapper.
For more information, see data sheet.
Remote command: 
:SCONfiguration:CABW? on page 241

Signal Routing
In "System Configuration > Mode > Standard", defines the signal routing for the fading
signal at the output of the fading simulator.
Note: Signal routing for MIMO setups is performed with the settigns in the "System
Configuration" dialog, see Chapter 5.2, "How to enable LxMxN MIMO test configura-
tions", on page 95.
In remote control, however, all available signal routing settings are configured with the
command [:SOURce<hw>]:FSIMulator:ROUTe.
In "System Configuration > Mode > Standard", the input signal of the fading simulator
is defined by the setting "Baseband > Signal Routing". An instrument equipped with
two fading simulators and two baseband blocks, the input signal of each of the fading
simulator can be:
● the signal from a single baseband block,
● the summation signal from both baseband blocks or
● each a signal from one of the two baseband blocks.
The following is a list of the routing settings for an instrument equipped with two base-
band blocks, two signal paths and two options fading simulator (R&S SMW-B14).
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"A to A/ B to B" Dual-channel fading. The fading signal from fader A is output on
baseband path A and the fading signal from fader B is output on
baseband path B.
The R&S SMW can be operated like two instruments; two independ-
ently configured signals are routed to the instrument's output.
This configuration is also suitable for transmit or receive diversity
tests:
● Use the signal of one of the baseband generators to simulate the

receiving conditions of a receiver with two antennas, like a high-
quality car radio or UMTS base station.

● Correlate the paths of the two fading simulators, i.e. the two fad-
ing channels. You can simulate the conditions of receiver with two
antennas which receive statistically correlated signals. Such con-
dition appears, e.g., in a car with two antennas when the two
received signals exhibit a degree of correlation due to a similar
environment, like an underpass or hills.

"A to A/B to A" Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are both output on baseband path A.
This configuration is suitable for the simulation of:
● mobile radio network handover in the handheld device
● testing of filtering out the own signal if there is simultaneous pres-

ence of a strong signal from another standard.
To simulate the required conditions, configure each of the baseband
signals according to the desired standard and route them to the fad-
ing simulator. After fading, the two signals with widely divergent signal
strengths are output on a common output path.

"A to B / B to B"
Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are both output on baseband path B.

"A to A and B / B to A and B"
Dual-channel fading. The fading signal from fader A and the fading
signal from fader B are output on baseband path A and baseband
path B.
The possible applications are analogous to the "A to A / B to A" rout-
ing. With this routing however, the signal at the output of the fading
simulator is split up and routed to both paths. The processing of these
two paths after the fading can be differently. To simulate a further
degradation of the receiving conditions, for instance, use the provided
function to superimpose the signal of one of the paths by noise or
destroy it.

"A to A and B / B (open)"
The fading signal from fader A is output on baseband path A and
baseband path B. The signal from fader B is not output, the signal
flow of baseband B is interrupted.
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"A (open)/ B to A and B"
The fading signal from fader B is output on baseband path A and
baseband path B. The signal from fader A is not output, the signal
flow of baseband A is interrupted.

Remote command: 
[:SOURce<hw>]:FSIMulator:ROUTe on page 156
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5  Multiple input multiple output (MIMO)
If the instrument is equipped with the required options, the R&S SMW supports versa-
tile MIMO configurations.

Section Chapter 2.1, "Required options", on page 18 provides an overview; for detailed
information, refer to the R&S SMW data sheet.

Multiple input multiple output (MIMO) refers to a multi-channel method where two or
more simultaneous channel inputs and channel outputs are being used for boosting
data rates. The benefits of an MIMO system became visible only if the data signal is
tested in fading conditions. The MIMO fading option considers this special form of mul-
tipath propagation in channel simulation.

Depending on the number of the transmitting and receiving antennas used in a MIMO
system, different MxN MIMO test configurations are specified. The term MxN is a rep-
resentation of a MIMO system, where M is the number of the transmitting Tx antennas
and N the number of the receiving Rx antennas. Throughout this description, we also
use the term LxMxN as a short form of the used system configuration. In this case, L
represents the number of entities, M the number of basebands (Tx antennas) and
N the  number of streams (Rx antennas).

Normally, the simulation of a system with two or more transmitting and/or receiving
antennas requires two or more signal generators and/or fading simulator. The MIMO
fading option (R&S SMW-K74) in combination with up to four Fading simulator options
(R&S SMW-B14) enables you to simulate MIMO receiver tests scenarios with up to 8
Tx or up to 8 Rx antennas with one single instrument. (See also Chapter 5.1, "Multiple
entity MxN MIMO test configurations", on page 95).

Configurations with more than two entities and the higher-order MIMO configurations
require the additional options multiple entities (R&S SMW-K76) and higher order MIMO
(R&S SMW-K75).

Abstract representation of the signal routing

2x2 MIMO system Preview diagram Block diagram

Illustration of the principle Detailed representation of the
signal processing

Each F<Tx><Rx> block repre-
sents one MIMO channel

"High level" representation

The Fading simulator is displayed as one single block; the number of
the input basebands (M) and the output streams (N) indicate the MxN
MIMO configuration.
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The representation of a multi-entity MIMO configuration is even more abstract (see
also Chapter 5.1, "Multiple entity MxN MIMO test configurations", on page 95).

5.1  Multiple entity MxN MIMO test configurations

Equipped with the MIMO fading option (R&S SMW-K74), the instrument enables the
simulation of versatile MIMO tests scenarios with one single instrument.

The supported MIMO scenarios depend on:
● The installed options, in particular on the number of options fading simulator

(R&S SMW-B14/B15), i.e. on the number of the available [Fader] boards
● On the availability of the options multiple entities (R&S SMW-K76) and higher order

MIMO (R&S SMW-K75).

For more information, see data sheet.

5.2  How to enable LxMxN MIMO test configurations

Option: R&S SMW-B14/-B15/-K74 and optionaly R&S SMW-K75/-K76

Select and configure a MIMO scenario before you define the further fading settings or
the signal routing through the instrument.

To enable a MIMO scenario

1. Select "Fading > MIMO > System Configuration"

2. In the "System Configuration > Fading/Baseband Configuration" dialog, enable
"Mode > Advanced"

3. Define the MIMO scenario, e.g. to configure a 1x4x4 MIMO select:

a) "Entities (Users, Cells) = 1"
b) "Basebands (Rx Antennas) = 4"
c) "Streams (Tx Antennas) = 4"
d) "BB Source Config > Coupled Sources"

The preview diagram displays a detailed view of the signal routing for the current
selected configuration, together with short description of the possible application of
this configuration.

How to enable LxMxN MIMO test configurations
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4. Select "Fading/Baseband Configuration > Apply" to trigger the instrument to use
the selected configuration and close the dialog.

The block diagram displays the configured signal routing.

5. To enable a multiple-entities configuration, select "System Configuration > Fading/
Baseband Configuration" and enable for example:

a) "Mode > Advanced"
b) "Entities (Users, Cells) = 4", "Basebands (Rx Antennas) = 2", "Streams (Tx

Antennas) = 2"
c) "BB Source Config > Coupled Sources per Entity"
d) "Apply".

How to enable LxMxN MIMO test configurations
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Refer to Chapter 5.3, "Fading settings in MIMO configuration", on page 98 for
description on the provided MIMO fading settings.

To route the signal in MIMO mode

In MIMO mode, the signal routing is performed upon the selected MIMO configuration.

► Configure the instrument for a MIMO scenario.
See "To enable a MIMO scenario" on page 95.

The signal routing is fixed and depends on the selected MIMO configuration.

To enable MIMO configuration with 400 MHz fading bandwidth

Option: R&S SMW-B15/-K74/-K822

1. Select "Fading > MIMO > System Configuration"

2. In the "System Configuration > Fading/Baseband Configuration" dialog, enable
"Mode > Advanced"

3. Enable a MIMO scenario with up to 8 channels, e.g. 2x2x2 MIMO.

4. Select "BB Bandwidth = 400 MHz".

The parameter "CA Bandwidth" indicates the aggregated channel bandwidth at the
stream mapper.

How to enable LxMxN MIMO test configurations
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5. Select "Apply".

6. Change the MIMO configuration, e.g. select 2x2x4 MIMO.

The "BB Bandwidth" is set automatically to the maximum bandwidth for the
selected MIMO configuration. The resulting "CA Bandwidth" is updated, too.

To enable MIMO configuration with 800 MHz fading bandwidth

Option: R&S SMW-B15/-K74/-K822/-K823

1. Follow the instructions listed in "To enable MIMO configuration with 400 MHz fad-
ing bandwidth" on page 97.

2. Enable a MIMO scenario with up to 4 channels, e.g. 1x2x2 MIMO.

3. Select "BB Bandwidth = 800 MHz".

4. Select "Apply".

5.3  Fading settings in MIMO configuration

The MIMO fading settings are available if a MIMO scenario is configured.

1. Configure the instrument for a MIMO scenario. See "To enable a MIMO scenario"
on page 95.

2. You can access the dialog for configuring the MIMO settings of all MIMO channel
via each of the "Fading" blocks.
Select "Fading > Fading Settings".

Fading settings in MIMO configuration
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Figure 5-1: General settings in System Configuration > 2x2x2 (multi entity mode, L=2)

In "System Configurations" with multiple entities (L > 1), the dialog consists of more
than one side tabs; one tab per entity. The tab name indicates the fader state the
settings are related to.

3. Select "Path Table".

Figure 5-2: Path table settings in single entity mode (L=1): Understanding the displayed informa-
tion

Fading settings in MIMO configuration
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1a/1b = Path group number (displayed in the first row) and path number (second row in the table
header); the example shows 4 groups with different number of active paths (the first group is
marked with a blue border)

2 = Fading profile, assigned per fading path
3/3a = Common group delay of a path group ("Basic Delay" is always 0 for group 1); adjustable for the

other groups (light gray background)
4 = Resulting delay per path, calculated as the sum of the common group delay and the path-spe-

cific delay.
5 = Adjustable parameter for paths with Rice fading
6 = Pure display parameters are on a dark background
7 = Access to a "Vector" or a "MIMO Matrix" for configuration of the correlation between the chan-

nels

4. In the path table, navigate to the row "Coefficient".
For the corresponding path, select "Matrix" or "Vector".

The "Fading: Correlation Matrix" dialog comprises the parameters necessary to
adjust the correlation between the channels. You can define the correlation in one
of the following ways:
● In "Matrix Mode > Individual"

Figure 5-3: Correlation matrix in an individual matrix mode

In this mode, you can adjust the matrix coefficients directly in the coefficient
matrix.

● In "Matrix Mode > Kronecker"

Fading settings in MIMO configuration
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Figure 5-4: Correlation matrix in the kronecker mode

The definition of the correlation matrix settings is based on the kronecker
assumption, i.e defined are the Rx and Tx antenna correlation coefficients. The
instrument calculates automatically the resulting correlation matrix and displays
it.
See Chapter 5.3.4, "Kronecker mode correlation coefficients", on page 108.

● In "Matrix Mode > AoA/AoD"

Figure 5-5: Correlation matrix in TGn format (AoA/AoD mode)

See Chapter 5.3.5, "TGn/TGac channel models settings", on page 110.
● In "Matrix Mode > SCME/WINNER"

Fading settings in MIMO configuration
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See:
– Chapter 5.3.6, "SCME/WINNER model settings", on page 112
– Chapter 5.3.8, "MIMO OTA testing related settings", on page 130

● For static paths and paths with "Pure Doppler" fading profile, the corresponding
settings are grouped in the "Relative Tap Gain Vector" dialog.

Figure 5-6: Relative tap gain vector

This dialog provides additional parameters to simulate a gain weighting and
phase shift between the signals with constant fading transmitted among the dif-
ferent Tx antennas.
See Chapter 5.3.3, "Relative gain vector matrix settings", on page 106.

Fading settings in MIMO configuration
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5.3.1  Current path (Tap) settings

Prev
Displays the previous tap relative to the current tap. If tap 1 is the current tap, this but-
ton is disabled.
Remote command: 
n.a.

Copy To Prev
Copies the matrix values of the current tap to the next lower tap. If tap 1 is the current
tap, this button is disabled.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious on page 200

Current Path (Tap) #
Selects the tap to be displayed.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP on page 200

Copy To Next
Copies the matrix values of the current tap to the next higher tap. If the current tap is
the last tap, this button is disabled.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT on page 199

Copy To All
Copies the matrix values of the current tap all taps.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 199

Next
Displays the next tap relative to the current tap. If the current tap is the last tap, this
button is disabled.
Remote command: 
n.a.

Matrix Mode
Selects the input mode for the Rx and Tx correlation values.
"Individual" Allows entering the correlation values individually.
"Kronecker" Opens additional input fields for entering the Rx correlation and Tx

correlation values, see Chapter 5.3.4, "Kronecker mode correlation
coefficients", on page 108.
The matrix values are calculated automatically.

Fading settings in MIMO configuration
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"AoA / AoD" Opens additional input fields for defining the Rx and TX correlation
parameters based on the Spatial Channel Model (SCM), see Chap-
ter 5.3.5, "TGn/TGac channel models settings", on page 110.
The matrix values are calculated automatically.

"SCME / WIN-
NER"

Opens additional input fields for defining the parameters of the Spa-
tial Channel Model Extended (SCME) model, see Chapter 5.3.6,
"SCME/WINNER model settings", on page 112.
The matrix values are calculated automatically.

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE on page 203

Polarization, Antenna Modeling
Accesses the corresponding tab in the "Antenna Model" dialog, see Chapter 5.3.6,
"SCME/WINNER model settings", on page 112.

Data Format
Selects the matrix representation format. The data format can be changed at every
time. The matrix table is updated immediately.
"Magnitude-Phase"

Displays the matrix values as value pairs of magnitude and phase.
"Real-Imag" Displays the matrix values as complex numbers.
Remote command: 
n.a.

5.3.2  Correlation matrix table

The correlation matrix table displays the values for the transmitter/receiver correlation.
The correlation matrix is valid for the selected fading path. To adjust the values, edit
the matrix elements directly, use the correlation coefficients of the Kronecker Mode,
define the TGn/TGac parameters of the AoA /AoD mode or use the SCME/WINNER
mode.

To access the settings of the correlation matrix in table form:

1. Enable a MIMO configuration

2. Select the "Fading > Path Table > Matrix" and navigate to "Fading: Correlation
Matrix > Matrix".

Fading settings in MIMO configuration
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Defining the matrix values individually

In individual matrix mode, you have to define the matrix values manually. Irrespectively
of the selected data format, you have to enter valid correlation values.

Impossible calculation and conflict settings
The individual direct definition of the matrix elements may lead to impossible calcula-
tion due to inappropriate values and/or settings conflict.
You have to change the corresponding values.

The Figure 5-7 uses a 2x2 MIMO matrix to depict the basic configuration principle.

Figure 5-7: Simplified representation of a 2x2 MIMO matrix

To define the matrix, set the only the value pairs in the diagonal and upper triangle (a
total of 10 value pairs in this example, see Figure 5-7). The instrument exploits the
complex conjugate symmetry across the diagonal and determines automatically the
remaining value pairs in the lower triangle.

By default, the values in the matrix diagonal are set to 1. Use values different than 1 to
simulate antennas with different power level (steering).

Fading settings in MIMO configuration
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Settings:

Real/Magnitude........................................................................................................... 106
Phase/Imag................................................................................................................. 106
Conflict........................................................................................................................ 106
Accept......................................................................................................................... 106

Real/Magnitude
Enters the value for the real/ratio part of the correlation.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
MAGNitude on page 204

Phase/Imag
Enters the value for the phase/imaginary part of the correlation.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
PHASe on page 203

Conflict
Indicates a matrix conflict.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict? on page 203

Accept
Accepts the values for the phase/imaginary and the real/ration part of the correlation.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept on page 202

5.3.3  Relative gain vector matrix settings

The "Fading: Relative Tap Gain Vector" dialog is available for static paths and paths
with "Pure Doppler Fading Profile". This dialog provides additional parameters to simu-
late a gain weighting or phase shift between the signals with constant fading transmit-
ted over the different Tx antennas.

Access:

1. Enable a MIMO configuration and select "Fading > Path Table > Profile > Static or
Pure Doppler".

2. Select "Path Table > Coefficient > Vector".

Fading settings in MIMO configuration
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Use this function to simulate beamforming signal.

Example: 
This example illustrates the phase shift between the signals with a start phase of 45
degrees, power level of 2 dB, and the gain and phase settings as follow:
● "AA Gain > 0", "AA Phase > 0"
● "AB Gain > -1", "AB Phase > 10"
● "BA Gain > -2", "BA Phase > 20"
● "BB Gain > -3", "BB Phase > 350"
Resulting simulation:

Settings:

Set to Unity..................................................................................................................107
Gain.............................................................................................................................108
Phase.......................................................................................................................... 108

Set to Unity
Presets the vector matrix to an unitary matrix.

Fading settings in MIMO configuration
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet on page 204

Gain
(disabled if customized dynamic fading R&S SMW-K820 is used)
Defines the relative gain of the selected path.
A gain value of 0 dB means no loss, and e.g. -3 dB is loss in this path.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN on page 204

Phase
Defines the phase shift of the selected path.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASe
on page 205

5.3.4  Kronecker mode correlation coefficients

► To access the settings of the correlation matrix in Kronecker mode, enable a MIMO
configuration, select the "Fading > Path Table > Matrix" and select "Fading: Corre-
lation Matrix > Matrix Mode > Kronecker".

Figure 5-8: Correlation matrix in Kronecker mode

Calculating of the matrix values based on the Kronecker assumption

In Kronecker mode, it is sufficient that you specify one Tx and one Rx correlation per
MIMO channel. The instrument automatically computes the full correlation matrix
according to the formula:
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where ρ(l)
Rx and ρ(l)

Tx are the Rx and Tx correlations.

The evaluation of the Kronecker product ⊗ leads to:

Which and how many coefficients are available, depends on the selected MIMO config-
uration, e.g. any of the 2x2, 4x2, and 3x2 MIMO configurations, requires only one Rx
correlation coefficient AB, whereas there are six Rx correlation coefficients in case of
2x4 MIMO configuration.

Settings:

Tx Correlation Coefficients, Magnitude/Real...............................................................109
Tx Correlation Coefficients, Phase/Imag.....................................................................109
Rx Correlation Coefficients, Magnitude/Real...............................................................110
Rx Correlation Coefficients, Phase/Imag.....................................................................110

Tx Correlation Coefficients, Magnitude/Real
Enters the value for the real/ratio part of the transmitter correlation (ρ(l)

Tx).

The available Tx correlation coefficients depends on the selected MIMO mode.
Remote command: 
For "Data Format > Magnitude-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:MAGNitude on page 202
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:REAL on page 202

Tx Correlation Coefficients, Phase/Imag
Enters the value for the phase/imaginary part of the transmitter correlation (ρ(l)

Tx).

The available Tx correlation coefficients depends on the selected MIMO mode.
Remote command: 
For "Data Format > Ratio-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:PHASe on page 201
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For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:IMAGinary on page 201

Rx Correlation Coefficients, Magnitude/Real
Enters the value for the real/ratio part of the receiver correlation (ρ(l)

Rx).

The available Rx correlation coefficients depends on the selected MIMO mode.
Remote command: 
For "Data Format > Magnitude-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:MAGNitude on page 202
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:REAL on page 202

Rx Correlation Coefficients, Phase/Imag
Enters the value for the phase/imaginary part of receiver correlation (ρ(l)

Rx).

The available Rx correlation coefficients depends on the selected MIMO mode.
Remote command: 
For "Data Format > Ratio-Phase"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:PHASe on page 201
For "Data Format > Real-Imag"
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:IMAGinary on page 201

5.3.5  TGn/TGac channel models settings

TGn and TGac channel models are specified for the evaluation of IEEE 802.11n and
IEEE 802.11ac systems respectively.

These channel models are based on the so called rays, which are defined at the BS
and MS side by their AoA (Angle of Arrival) and the AoD (Angle of Departure). The
rays are distributed according to the selected statistic function and angle spread (AS).

In this implementation, one fading path consists by default of one ray but you can
define up to six rays per path. The AoA (Angle of Arrival) / AoD (Angle of Departure)
parameters, i.e. AoA/AoD angles, angle spreads (AS) and distribution of the rays, as
well as the distances between the antennas at the Tx and the Rx side, are configura-
ble.

To access the dialog with TGn/TGac settings

1. Enable a MIMO configuration, select the "Fading > Path Table > Matrix".

2. Select "Fading: Correlation Matrix > Matrix Mode > AoA/AoD".
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Settings:

RX/TX Antenna Distance.............................................................................................111
Ray State.....................................................................................................................111
Relative Gain /dB.........................................................................................................111
Angle of Arrival (AoA)..................................................................................................112
AoA Spread................................................................................................................. 112
Angle of Departure (AoD)............................................................................................112
AoD Spread.................................................................................................................112
Distribution...................................................................................................................112

RX/TX Antenna Distance
Determines the distance between the Tx and Rx antennas as function of the wave
length lambda and is calculated as follow:
Physical Antenna Distance = "RX/TX Antenna Distance" * λ, where
the wave length λ = c / "Frequency" and c is the speed of light.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX on page 206
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX on page 206

Ray State
Enables/disables the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe
on page 208

Relative Gain /dB
Sets the relative gain (in dB) of the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN on page 207
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Angle of Arrival (AoA)
Sets the AoA (Angle of Arrival) of the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe
on page 207

AoA Spread
Sets the AoA (Angle of Arrival) spread (AS) of the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead
on page 207

Angle of Departure (AoD)
Sets the AoD (Angle of Departure) of the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:
ANGLe on page 207

AoD Spread
Sets the AoD (Angle of Departure) spread (AS) of the selected ray.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:
SPRead on page 207

Distribution
Select one of the proposed statistical functions to determine the distribution of the
selected ray.
Tip: Use this parameter to simulate ray scattering due to obstacles with different sur-
face (see also Chapter 6.7, "TGn settings", on page 205).
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution on page 206

5.3.6  SCME/WINNER model settings

Option: R&S SMW-K72/-K73

The SCME and WINNER II channel models are developed by WINNER [1]. The origi-
nal model is the SCM (Spatial Channel Model) and the SCME (SCM Extension) is its
first extension. The WINNER II is the final published model.

The SCME and WINNER II channel models offer Cluster Delay Line (CDL) models for
reduced complexity simulations. These CDL models can be simulated in the SCME/
WIINER matrix mode. A channel correlation matrix is calculated from the CDL parame-
ters and the channel is stochastically simulated.

This section describes the settings of the SCME/WINNER model. For information on
the antenna modeling and polarization, see:
● Chapter 5.3.8, "MIMO OTA testing related settings", on page 130.
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● See also Chapter A.16, "SCM and SCME channel models for MIMO OTA",
on page 308.

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Matrix"

3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME /
WINNER"

With the provided settings, you can define up to 20 clusters, each of which com-
prising of up to 3 subclusters.
A cluster is defined with its AoA (Angle of Arrival) / AoD (Angle of Departure)
parameters. These are the AoA/AoD angles, angle spreads (AS) and a relative
gain. If a subcluster is enabled, it is also attenuated. The three subclusters powers
are fixed ratios of the total cluster power (see Subcluster > Relative Gain /dB)
Different Power Azimuth Spectrum (PAS) distributions can be used to describe the
distribution of the selected cluster. However, usually the clusters simulated in one
path have the same distribution.

Settings:

MS Speed....................................................................................................................114
MS DoT (Direction of Travel).......................................................................................114
Cluster State................................................................................................................114
Relative Gain /dB.........................................................................................................114
Subcluster > State.......................................................................................................114
Subcluster > Relative Gain /dB................................................................................... 114
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Angle of Departure (AoD)............................................................................................115
AoD Spread.................................................................................................................115
Angle of Arrival (AoA)..................................................................................................115
AoA Spread................................................................................................................. 115
Distribution...................................................................................................................115

MS Speed
Sets the speed of the mobile station.
This value determines the value of the parameter "Speed" (see Path Table > Speed).
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed on page 211

MS DoT (Direction of Travel)
Sets the direction of travel of the mobile station.
If LOS (line-of-sight) is simulated, then this parameter sets the value of the parameter
Frequency Ratio for the Rice fading profile.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT on page 211

Cluster State
Enables/disables the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe
on page 211

Relative Gain /dB
Sets the relative gain (in dB) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN on page 211

Subcluster > State
If the corresponding cluster is enabled, you can enable up to 3 subclusters.
A cluster is composed of 20 spatially separated subpaths with equal powers. The sub-
paths are occasionally split to subsets or subclusters (also known as mid-paths) having
different resolvable delays. In the SCME and WINNER II models, one cluster can be
split into 3 subclusters. Each subcluster consists of 10, 6 and 4 subpaths. Hence, the
subcluster power is 10/20, 6/20 and 4/20 relative power to the total cluster power.
See also "Relative Gain /dB" on page 114.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:
SUBCluster<di>:STATe on page 213

Subcluster > Relative Gain /dB
Displays the resulting relative attenuation, applied on an enabled subcluster. The value
is determined based on the select "Relative Gain" of the cluster and is calculated as
follows:
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RelativeGainSub-Cluster = RelativeGainCluster + GainFactor

The used gain factors are values in dB and are listed in Table 5-1.
The values are part of the SCME Urban Micro-Cell (SCME UMi) and SCME Urban
Macro-Cell (SCME UMa) models according to TR 37.977.
Table 5-1: Overview: Gain factors and default relative gain values per subcluster

Sub-Cluster number Gain Factor, W Gain Factor, dB

1 10/20 -3.01

2 6/20 -5.229

3 4/20 -6.99

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:
SUBCluster<di>:GAIN? on page 213

Angle of Departure (AoD)
Sets the AoD (Angle of Departure) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe
on page 212

AoD Spread
Sets the AoD (Angle of Departure) spread (AS) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead
on page 212

Angle of Arrival (AoA)
Sets the AoA (Angle of Arrival) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe
on page 212

AoA Spread
Sets the AoA (Angle of Arrival) spread (AS) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead
on page 212

Distribution
To set the distribution of the selected cluster, select one of the power azimuth spectrum
(PAS) distributions. All clusters of the same tap must have the same distribution.
Tip: Use this parameter to simulate rays scattered due to obstacles with different sur-
face (see also Chapter 6.7, "TGn settings", on page 205).
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution
on page 212

5.3.7  SCM fading profile

Option: R&S SMW-K73

Spatial channel model (SCM)

The spatial channel model (SCM) is a 2D geometry-based channel model specified in
the 3GPP TR 25.996.

In the SCM fading profile, the channel coefficients are not calculated from a MIMO cor-
relation matrix but given by an equation. This equation depends on geometrical param-
eters, like the angle of arrival and departure, and angular spread and their statistical
behavior. The illustration on Figure 5-9 outlines the main SCM parameters. For
detailed description of the SCM model, see TR 25.996.

Figure 5-9: SCM angular parameters (simplified representation)

BS = Base station antenna array
MS = Mobile station antenna array
N = North: absolute reference direction used to define the antenna orientation (array broadside)
DoT = Direction of travel of the mobile station
LOS = Line-of-sight
AoD = Angle of departure
AoA = Angle of arrival
Cluster = Group of 20 spatially separated subpaths with equal powers; one cluster can be split into three

subclusters, where the subclusters consist of 10, 6 and 4 subpaths.

3D geometry-based channel model

The 3D geometry-based channel model is specified in the 3GPP TR 36.873.

The model is an extension to the 2D spatial channel model (SCM). The following addi-
tional parameters are provided:
● Zenith of Departure/Arrival
● Zenith angular spread for Departure/Arrival
● DoT (direction of travel)
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● Antenna array configurations comprising row and column number larger or equal to
one (see Chapter 5.3.7.4, "Antenna modeling settings", on page 122)

● Additional antenna pattern files for 3D, based on the predefined antenna patterns
files for the 2D model (see "Antenna Pattern" on page 125)

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > SCM Data".

The provided parameters are similar to the parameters in SCME/WINNER matrix
mode, like the angle, channel polarization and antenna modeling settings provided
for MIMO-OTA testing. You can configure one SCM cluster per fading path but the
channel and antenna parameters are common for all paths.
For background information on the antenna modeling and channel polarization,
see:
● "Antenna Modeling" on page 132
● "Channel polarization" on page 133

● SCM cluster settings............................................................................................. 118
● 3D channel model................................................................................................. 120
● Channel polarization settings................................................................................121
● Antenna modeling settings....................................................................................122
● LOS component settings.......................................................................................126
● Subpath start phases............................................................................................ 128
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5.3.7.1  SCM cluster settings

MS Speed....................................................................................................................118
MS DoT (Direction of Travel).......................................................................................118
σSF............................................................................................................................... 118
Relative Gain /dB.........................................................................................................118
Subcluster > State.......................................................................................................118
Subcluster > Relative Gain /dB................................................................................... 119
Angle of Departure (AoD)............................................................................................119
AoD Spread.................................................................................................................119
Angle of Arrival (AoA)..................................................................................................119
AoA Spread................................................................................................................. 119
Distribution...................................................................................................................119

MS Speed
Sets the speed of the mobile station.
This value determines the value of the parameter "Speed" (see "Path Table" > Speed).
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:SPEed on page 227

MS DoT (Direction of Travel)
Sets the direction of travel of the mobile station, see Figure 5-9.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:DOT on page 228

σSF

Sets the lognormal shadow fading standard deviation, applied as a common parameter
to the paths.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:SIGMa on page 228

Relative Gain /dB
Sets the relative gain (in dB) of the selected cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN on page 230

Subcluster > State
Enables up to 3 subclusters.
A cluster is composed of 20 spatially separated subpaths with equal powers. The sub-
paths are occasionally split to subsets or subclusters (also known as mid-paths) having
different resolvable delays. In the SCM model, one cluster can be split into 3 subclus-
ters, where the subclusters consist of 10, 6 and 4 subpaths. Hence, the subcluster
power is 10/20, 6/20 and 4/20 relative power to the total cluster power.
See also "Subcluster > Relative Gain /dB" on page 119.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATe
on page 230
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Subcluster > Relative Gain /dB
Displays the resulting relative attenuation, applied on an enabled subcluster. The value
is determined based on the select "Relative Gain" of the cluster and is calculated as
follows:
RelativeGainSub-Cluster = RelativeGainCluster + GainFactor

The used gain factors are values in dB and are listed in "Subcluster > Relative
Gain /dB" on page 119.
Table 5-2: Overview: Gain factors and default relative gain values per subcluster

Sub-Cluster
number

Gain factor, W Subpath number Gain factor, dB

1 10/20 1, 2, 3, 4, 5, 6, 7, 8, 19, 20 -3.01

2 6/20 9, 10, 11, 12, 17, 18 -5.229

3 4/20 13, 14, 15, 16 -6.99

Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN
on page 230

Angle of Departure (AoD)
Sets the AoD (angle of departure) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe on page 229

AoD Spread
Sets the AoD (angle of departure) spread (AS) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead on page 229

Angle of Arrival (AoA)
Sets the AoA (angle of arrival) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe on page 229

AoA Spread
Sets the AoA (angle of arrival) spread (AS) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead on page 229

Distribution
Displays the distribution of the cluster.
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5.3.7.2  3D channel model

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > 3D > On".

Most of the settings are the same as for the 2D SCM model.
In the following, listed are only the dedicated 3D model setting: the zenith dimen-
sion and its parameters.

Settings

3D................................................................................................................................120
MS DoT > φv/Θv.......................................................................................................... 121
Zenith of Departure..................................................................................................... 121
ZoD Spread.................................................................................................................121
Zenith of Arrival (ZoA)................................................................................................. 121
ZoA Spread................................................................................................................. 121

3D
Enables the 3D geometry-based channel model.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:D3Mode:STATe on page 227
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MS DoT > φv/Θv

Sets the direction of travel of the mobile station as travel azimuth angle (φv) and eleva-
tion angle (Θv).

Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:PHI on page 228
[:SOURce<hw>]:FSIMulator:SCM:THETa on page 228

Zenith of Departure
Sets the zenith of departure (ZoD) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:ANGLe
on page 229

ZoD Spread
Sets the ZoD (zenith of departure) spread of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:SPRead
on page 229

Zenith of Arrival (ZoA)
Sets the ZoA (zenith of arrival) of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:ANGLe
on page 229

ZoA Spread
Sets the ZoA (zenith of arrival) spread of the cluster.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:SPRead
on page 229

5.3.7.3  Channel polarization settings

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > SCM Data"

4. Select "Polarization".

5. Select "Channel Poliarization > On".

6. Set the XPR (cross polarization power ratios) values.
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Settings:

Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.

Channel Polarization State..........................................................................................122
Vertical/Horizontal Cross Polarization Power Ratio.................................................... 122

Channel Polarization State
Enables/disables simulation of channel polarization.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:POLarization:STATe on page 231

Vertical/Horizontal Cross Polarization Power Ratio
Sets the cross polarization power ratio (XPR) in dB.
XPRv = P/Pvvhv and XPRh = P/Phhvh, where XPRv = XPRh = XPR.

Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORizontal
on page 231
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical
on page 231

5.3.7.4  Antenna modeling settings

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".
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3. Select "SCM Profile > SCM Data"

4. Select "Antenna Modeling".

5. Configure the base station (BS) antenna settings, for example:

● "Tx Antenn Array Structure > Calculation Mode > Spacing", if the spacing (i.e.
the physical distance) between the antenna elements is a known value.

● "Horizontal Spacing = 0.5*λ"
For mobile devices, however, the measured characteristics are the antenna
radiation pattern, gain and relative phase.
To use the relative phase instead of the antenna spacing, provide the relative
phase information in the antenna pattern file. When this file is loaded, the rela-
tive phase information is extracted from it and used in the calculations.
See also Figure 5-14.

a) To load custom antenna pattern for the transmit or the receive antenna:

● "Select Antenna Pattern > User Defined".
● For each antenna element, navigate to the antenna pattern file and load it.

The selected 2D antenna pattern file describes the BS and MS antenna gains of
each array element.

A figure displays the structure of the current antenna array. The number of columns
and rows in the array are set automatically, depending on the selected MIMO con-
figuration.

Settings:

Antenna Structure....................................................................................................... 124
Number of Rows (M)/Columns (N)..............................................................................124
Calculation Mode........................................................................................................ 124
Horizontal Spacing...................................................................................................... 125
Vertical Spacing.......................................................................................................... 125
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Antenna array..............................................................................................................125
Antenna Pattern.......................................................................................................... 125
User Defined Antenna Patterns per Row, Column......................................................126

Antenna Structure
If 3D > "On", sets the antenna array structure.
See "Antenna array" on page 132.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:STRucture on page 232[:
SOURce]:FSIMulator:SCM:ANTenna:RX:STRucture on page 232

Number of Rows (M)/Columns (N)
Sets the number of rows (M) and the number of columns (N) in the antenna array, see
"Antenna Modeling" on page 132.
The number of Tx and Rx antennas is set automatically according to the selected
LxMxN MIMO configuration ("System Configuration > LxMxN"). Supported are configu-
rations with L = 1, 2 or 4 even number of Tx and Rx antennas.
See section "Signal Routing and System Configuration" in the R&S SMW user manual.
Remote command: 
[:SOURce]:FSIMulator:SCM:ANTenna:RX:COLumns[:SIZE] on page 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ROWS[:SIZE]? on page 233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumns[:SIZE] on page 233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS[:SIZE]? on page 233

Calculation Mode
Selects how the phase information is calculated.
See Figure 5-14.
"Spacing" The phase information is calculated from the spacing between the

antenna elements.
The spacing (i.e. the physical distance) between the antenna ele-
ments is set with the parameter Horizontal Spacing .

"Relative Phase"
If the loaded antenna pattern file contains the required information,
the relative phase is extracted from the antenna pattern file.
See:
● "Antenna element spacing or relative phase" on page 132
● Chapter B, "Antenna pattern file format", on page 348.

"Analog Beamforming"
In this mode, the composite antenna pattern of an antenna array
comprising gain and phase can be used to simulate analog beam-
forming. The co-polarized antenna elements of the array are com-
bined to a single RF port.

Remote command: 
[:SOURce]:FSIMulator:SCM:ANTenna:RX:CALC:MODE on page 232
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE on page 232
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Horizontal Spacing
For "Calculation Mode > Spacing", sets the distance (dh) between the antennas in the
antenna array normalized by the wavelength λ.
It is calculated as follows:
dh = "Horizontal Spacing" * λ

Where:
● λ is the wavelength calculated as λ = c/"Frequency"
● c is the speed of light
● "Frequency" is the center frequency.
See also "Antenna element spacing or relative phase" on page 132.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal
on page 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:HORizontal
on page 233

Vertical Spacing
If 3D > "On", "Calculation Mode > Spacing" and "Number of Rows ≥ 2", sets the dis-
tance (dv) between the antennas in the antenna array normalized by the wavelength λ.

It is calculated as follows:
dv = "Vertical Spacing" * λ

Where:
● λ is the wavelength calculated as λ = c/"Frequency"
● c is the speed of light
● "Frequency" is the center frequency.
See also "Antenna element spacing or relative phase" on page 132.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:VERTical
on page 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:VERTical on page 233

Antenna array
Graphical representation of the current antenna array.
Each dot indicates a single antenna element.
The spacing between the antenna elements is indicated, if "Calculation Mode > Spac-
ing" is used.

Antenna Pattern
Antenna patterns are files that describe the 2D or 3D antenna radiation pattern.
The following predefined antenna patterns are available:
● "Isotropic"
● "Dipole"
● "3 Sectors" and "6 Sectors"

These two sector antenna patterns are required for the BS testing, as specified in
the TR 25.996.
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● "Dual Polarization Isotropic"
You can also load custom antenna pattern, see "User Defined Antenna Patterns per
Row, Column" on page 126.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATTern on page 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:PATTern on page 233

User Defined Antenna Patterns per Row, Column
Indicates the custom antenna pattern file per antenna element.
To change the used file for an antenna element:
● Select a predefined or "User File"
● Navigate to the antenna pattern file and load it.
Antenna pattern files are XML files with file predefined file syntax and extension
*.ant_pat.

They describe the antenna pattern as an array with typical resolutions of 1 degree to 5
degrees for the azimuth. These files contain the gain values for a given azimuth. For
an isotropic antenna radiating energy equally in all directions, the array elements are
all 0 dB.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe
on page 234
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ANTenna<di>:PFILe on page 234

5.3.7.5  LOS component settings

Access:

1. Enable a MIMO configuration.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > SCM Data"
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4. Select "LOS Component".

The LOS modeling is based on the ricean K factor. It is defined as the ratio of
power in the LOS component to the total power in the diffused non line-of-sight
(NLOS) component.

Settings:

Use LOS Component.................................................................................................. 127
LOS Angle of Departure (AoD)................................................................................... 127
LOS Angle of Arrival (AoA)......................................................................................... 127
LOS Zenith of Departure............................................................................................. 128
LOS Zenith of Arrival...................................................................................................128
K Factor.......................................................................................................................128
3D Distance.................................................................................................................128
Use Random Phases.................................................................................................. 128
LOS Start Phases....................................................................................................... 128

Use LOS Component
Adds a line-of-sight (LOS) component to the cluster.
The LOS component is supported only in the first fading path.
To activate the LOS component:
● Set "Path Table > Fading Path#1 > State > On" and set "Profile > SCM".
● Set "SCM Data > LOS Component Settings > Use LOS Component > On".
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:STATe on page 234

LOS Angle of Departure (AoD)
Sets the AoD (angle of departure) of the LOS component.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[:ANGLe] on page 234

LOS Angle of Arrival (AoA)
Sets the AoA (angle of arrival) of the LOS component.
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Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[:ANGLe] on page 234

LOS Zenith of Departure
If 3D > "On", sets the ZoD (zenith of departure) of the LOS component.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture:ZENith:ANGLe
on page 234

LOS Zenith of Arrival
If 3D > "On", sets the ZoA (zenith of arrival) of the LOS component.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival:ZENith:ANGLe on page 234

K Factor
Sets the ricean K factor.
The K factor is defined as the ratio of power in the LOS component to the total power
in the diffused non line-of-sight (NLOS) component.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor on page 235

3D Distance
If 3D > "On", sets the distance between the base station (BS) and the user terminal
(UT).
The value is used to calculate the phase shift of the LOS component.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:DISTance on page 235

Use Random Phases
If enabled, random subpath start phases are selected.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:STATe on page 235

LOS Start Phases
Sets the start phase in degree of the LOS signal per MIMO channel.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VV on page 236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HH on page 236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VH on page 236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HV on page 236

5.3.7.6  Subpath start phases

Access:

1. Enable a MIMO configuration.
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See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Path# > Profile > SCM".

3. Select "SCM Profile > SCM Data"

4. Select "Subpath Start Phases".

Settings:

Use Random Phases.................................................................................................. 129
Subpath # > VV/HH/VH/HV Phase..............................................................................129

Use Random Phases
If enabled, random start phases are selected.
Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATe on page 231

Subpath # > VV/HH/VH/HV Phase
Sets the phase per subpath.
A total number of 20 subpaths are supported.
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Remote command: 
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HH
on page 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HV
on page 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VH
on page 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VV
on page 236

5.3.8  MIMO OTA testing related settings

The MIMO OTA testing is a term describing radiated testing of mobile devices. The sig-
nal is transmitted over-the-air (OTA) to a mobile device placed in an anechoic cham-
ber. The mobile devices are tests in a real-word like conditions.

This section introduces the main concept of the two-stage method. You find the com-
plete description of this method in the TR 37.977 specification.

About the MIMO OTA two stage method

According to TR 37.977, the method consists of two stages:
● Acquiring the complex antenna radiation pattern of the DUT

Figure 5-10: MIMO OTA testing: stage 1 [TR 37.977]

1 = Base station (BS) emulator
2 = Test chamber
3 = Reference antenna
4 = MIMO DUT (mobile device)
5 = Anechoic material
6 = Measurement result: antenna radiation pattern

The measurement is performed in an over-the-air (OTA) test setup. The DUT is
placed in an anechoic chamber.
The antenna radiation pattern is measured of each antenna element.

● Convolving the antenna pattern with the channel model
The measured antenna pattern is loaded into the MIMO channel emulator. The
DUT performance is measured with throughput tests.
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Figure 5-11: MIMO OTA testing: stage 2 (conducted setup)

1 = BS emulator
2 = Channel emulator
3 = DUT with standard antenna ports (as for conducted conformance tests)
4 = Connection between the BS and the channel emulator ([DIG I/Q] interface)
5 = Cable connection between the BS emulator and the DUT
6 = Antenna radiation pattern, as measured in stage 1
7 = Measurement result

The measurements in this second stage can be performed in a conducted or in a
radiated (OTA) setup.
The radiated tests assure that the self-interference effects between the antenna
elements of the DUT are also considered.

Figure 5-12: MIMO OTA testing: stage 2 (radiated setup)

1 = BS emulator
2 = Channel emulator
3 = MIMO DUT
4 = Anechoic chamber
5 = Connection between the BS and the channel emulator ([DIG I/Q] interface)
v, h = Probe antennas with vertical (v) and horizontal (h) polarization, co-located in the anechoic cham-

ber
H = Radiated channel matrix of the chamber
6 = Radiated connection to the DUT
7 = Antenna radiation pattern (as measured in stage 1) and the inverted channel matrix H -1 of the

chamber
8 = Measurement result

The test setup consists of a BS emulator, a channel emulator, a DUT placed in an
anechoic or a reverberation chamber and a reference antenna. In the examples on Fig-
ure 5-10, Figure 5-11 and Figure 5-12, the R&S®CMW acts as BS emulator and the
R&S SMW as a channel simulator. Approved RF cables are used for all connections.
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In the two-stage method, the R&S SMW takes over the convolving of the antenna pat-
tern with standard compliant channel model (SCME UMi and UMa). If the channel
matrix H of the chamber is known, the R&S SMW can apply the inverse channel matrix
H-1. The signal received at the DUT antennas is thus the same as in the cable-conduc-
ted method.

Antenna Modeling

The antenna modeling includes the definition of the:
● Antenna array structure

(see "Antenna array" on page 132)
● Antenna polarization

(see "Antenna polarization" on page 133)
● Antenna radiation pattern

(see Chapter B, "Antenna pattern file format", on page 348)

Antenna array

The antenna model is based on a 2D planar antenna array structure. The antenna
elements are placed in the vertical and horizontal direction in an array composed of N
columns and M rows (see Figure 5-13). The antenna elements are uniformly spaced.

The horizontal and vertical spacings between the antenna columns are dh*λ and dv*λ.
The spacing between the antenna pairs of cross-polarized antennas is denoted as
cross polarized antenna spacing dxp*λ.

In the current firmware version, the antenna elements are placed on a single row and
vertical spacing is not supported.

Figure 5-13: 2D planar antenna array structure where each column is a cross-polarized 45° antenna
with dxp= 0*λ

The user interface illustrates the selected antenna array similarly.

Antenna element spacing or relative phase

If the spacing between the antenna elements is unknown, the antenna relative phase
can be used instead (see Figure 5-14). Which information is used is defined with the
parameter Calculation Mode.

If Calculation Mode > "Relative Phase", the following applies:
● If all selected antenna pattern files contain the relative phase information, it is

extracted from there.
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(see Chapter B, "Antenna pattern file format", on page 348)
● If one of the selected antenna pattern files contain relative phase information, this

information is used. The relative phase values in all other selected antenna pattern
files are assumed to be zero.

● If none of the selected antenna pattern files contain relative phase information, the
following settings apply: "Spacing = 0.5*λ".

Antenna polarization

The polarization of an antenna describes the orientation of the electric wave radiated
by the antenna.

According to TR 25.996, using antenna polarization requires that the antenna complex
response for both vertical and horizontal components is known.

Provide the antenna polarization information in one of the following ways:
● Described in the antenna pattern file and extracted from there

To use this way:
– Create and load an antenna pattern file containing both the horizontal and ver-

tical polarization antenna radiation patterns
(see Chapter B, "Antenna pattern file format", on page 348)

– Activate channel polarization Channel Polarization State > "On"
– Select Antenna Polarization Mode > "Separate AP".

● Selected with the parameter "Antenna Polarization Slant Angle"
To use this way:
– Load an antenna pattern file containing only one antenna pattern.
– Activate channel polarization Channel Polarization State > "On"
– Select Antenna Polarization Mode > "Single AP with Slant Angle".
– Set the parameter "Antenna Polarization Slant Angle".

Available polarization angles are:
● Horizontal polarization
● Vertical polarization
● Cross-polarization 90°
● Cross-polarization 45°

Channel polarization

The channel correlation polarization matrix is computed from the antenna element
polarization angles and the XPR (cross polarization power ratio of a propagation chan-
nel) values.

See:
● "Antenna polarization" on page 133
● "Vertical/Horizontal Cross Polarization Power Ratio" on page 137.
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Channel correlation matrix

The total channel correlation matrix R is the result of the element-wise product of the
polarization correlation matrix RP and the spatial correlation matrix RS:

R = RP*RS.

In the following, we assume that:
● The elements of the channel polarization matrix are uncorrelated
● The transmitter and the receiver ends are uncorrelated

The polarization and spatial correlation matrices, RP and RS are calculated as follows:
● Spatial correlation matrix RS

The spatial correlation matrix depends on the spatial characteristics of the channel:
– Antenna radiation patterns at the transmitter and the receiver ends
– Antenna spacing
– Power azimuth spectrum PAS of the clusters
The correlation between antenna array elements n and m is calculated according
to the Schumacher model [2].

Figure 5-14: Schumacher model for calculation the correlation between antenna array elements
[2]

ρn,m = Correlation between antenna array elements
m, n = Antenna array elements
d = Antenna spacing between the two antenna elements
λ = Wavelength of the signal
PAS (Ø) = Power azimuth spectrum of the impinging signal
Gn (Ø), Gm(Ø) = Antenna radiation patterns, characterized by a power gain, for antenna elements n and

m

Note: The magnitude e-j2πd/λ(sinØ) is also the relative phase resulting form the spac-
ing d and the angle Ø. For a known relative phase φ, the magnitude is calculated
as ejφ.
If the transmitter and the receiver ends are uncorrelated, then the total spatial
channel correlation matrix is the Kroneker product of the two correlation matrices.
RS=RRx⊗RTx

● Polarization correlation matrix RP

Three matrices describe the polarization of the system: channel polarization S, the
transmitter and the receiver antenna array polarizations PTx and PRx.

Related settings

See:
● Chapter 5.3.8.2, "Antenna model settings", on page 138

Fading settings in MIMO configuration



Multiple input multiple output (MIMO)Fading Simulation

135User Manual 1175.6826.02 ─ 29

● Chapter 5.3.8.1, "Channel polarization settings", on page 135
● Chapter 5.3.9, "Inverse channel matrix", on page 144

See also:
● Chapter B, "Antenna pattern file format", on page 348
● Chapter 5.3.6, "SCME/WINNER model settings", on page 112
● Chapter A.16, "SCM and SCME channel models for MIMO OTA", on page 308

5.3.8.1  Channel polarization settings

Access:

1. Enable a MIMO configuration, e.g. a 2x2 MIMO scenario.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Matrix"

3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME /
WINNER"

4. Select "Fading: Correlation Matrix > Polarization".

5. Select "Channel Polarization > On".
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6. Set the XPR (cross polarization power ratios) values.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings
in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all
entities.

7. Set the parameter "Antenna Polarization Mode", depending on the information in
the used antenna pattern files.
For example, if your files contain both vertical and horizontal gain information,
select "Antenna Polarization Mode > Separate AP".

8. Load the antenna pattern files.
See "User Defined Antenna Patterns per Row, Column" on page 143.

The calculated channel polarization matrix is displayed.
See also:
● Chapter B, "Antenna pattern file format", on page 348
● "Channel correlation matrix" on page 134

Settings:

Channel Polarization State..........................................................................................136
Antenna Polarization Mode......................................................................................... 136
Vertical/Horizontal Cross Polarization Power Ratio.................................................... 137
S..................................................................................................................................137

Channel Polarization State
Enables/disables simulation of channel polarization.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe] on page 213

Antenna Polarization Mode
Sets way the software extracts or calculates the antenna polarization patterns.
"Single AP with Slant Angle"

The antenna pattern file contains one antenna radiation pattern.
The antenna polarization is calculated from the provided antenna pat-
tern and the polarization angle, as selected with the parameter
Antenna Polarization Slant Angle.
See also "Antenna polarization" on page 133.
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"Separate AP" Option: R&S SMW-K73
The antenna pattern file has to describe two antenna radiation pat-
terns, one for each polarization (see Chapter B, "Antenna pattern file
format", on page 348).
The correlation between any two channels for the same path is calcu-
lated as follows [3]:

Figure 5-15: Calculation of the correlation between channels [3]

Ppm, Pqn = Powers transferred through the subchannels (Txp - Rxm) and (Txq - Rxn);
in this implementation, Ppm = Pqn = 1

γmn
Tx, γpq

Rx = Correlation coefficient between antenna elements in the transmitter and
receiver array; values per polarization

Tx, Rx = Transmitter and receiver array
v, h = Vertical and horizontal polarization
n, m / p, q = Antenna elements in the transmitter/receiver array

Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:PATTern:MODE on page 214

Vertical/Horizontal Cross Polarization Power Ratio
Sets the cross polarization power ratio (XPR) in dB.
XPRv = P/Pvvhv and XPRh = P/Phhvh, where XPRv = XPRh = XPR.

The resulting channel polarization matrix S is displayed.
Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal
on page 214
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical
on page 214

S
Displays the resulting channel polarization matrix S calculated as:

Where:
● Svv = Shh = 1
● Svh and Shv are commonly designated as Sxy and are calculated from the equation

E{Sxy2} = Pxy
where:
– E is the expectation, i.e. the mean power per polarization component
– Pxy values are derived from the selected Vertical/Horizontal Cross Polarization

Power Ratio XPR.
● It is assumed that the elements of the channel polarization matrix are uncorrelated,

i.e.:
E{SijSlk*} = 0 for i != j, k != l
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5.3.8.2  Antenna model settings

Access:

1. Enable a MIMO configuration, e.g. a 2x2 MIMO scenario.
See "To enable a MIMO scenario" on page 95.

2. Select "Fading > Path Table > Matrix"

3. In the required "Tap", select "Fading: Correlation Matrix > Matrix Mode > SCME /
WINNER"

4. Select "Fading: Correlation Matrix > Antenna Modeling".

5. Configure the base station (BS) antenna settings, for example:

● "Antenna Polarization Slant Angle > Cross 45°"
● "Calculation Mode > Spacing", if the spacing (i.e. the physical distance)

between the antenna elements is a known value.
● "Horizontal Spacing = 4*λ"
● "Antenna Pattern > 3Sector"

A figure displays the structure of the current antenna array. The number of columns
and rows in the array are set automatically, depending on the selected MIMO con-
figuration.
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6. To configure the mobile station (MS) antenna settings, select "Rx Antenna Array
Structure".
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings
in the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all
entities.

Sometimes, it is difficult to determine the antenna spacing of the mobile device;
instead the relative phase is measured.
To use the relative phase instead of the antenna spacing, provide the relative
phase information in the antenna pattern file. When this file is loaded, the relative
phase information is extracted from it and used in the calculations.
See also Figure 5-14.

7. To load custom antenna pattern for the transmit or the receive antenna:

● "Select Antenna Pattern > User File".
● For each antenna element, navigate to the antenna pattern file and load it.

The selected 2D antenna pattern file describes the BS and MS antenna gains of
each array element.

Depending on its format, the antenna pattern file contains the following information:
● Antenna gain information only
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● Antenna gain and phase information
● Horizontal and vertical gain information
● Horizontal and vertical gain and phase information.
See also:
● Chapter B, "Antenna pattern file format", on page 348
● "Antenna Modeling" on page 132.
● "Channel correlation matrix" on page 134

Settings:

Antenna Polarization Slant Angle................................................................................140
Number of Rows (M)/Columns (N)..............................................................................141
Calculation Mode........................................................................................................ 141
Horizontal Spacing...................................................................................................... 142
Cross-Polarized Antenna Spacing.............................................................................. 142
Antenna Array............................................................................................................. 142
Antenna Pattern.......................................................................................................... 143
User Defined Antenna Patterns per Row, Column......................................................143

Antenna Polarization Slant Angle
The information on the antenna polarization at the Tx and Rx ends is required to calcu-
late the channel polarization.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
If channel polarization is activated (Channel Polarization State > "On"), specify the
antenna polarization in one of the following ways:
● Described in the antenna pattern file and extracted from there.

One antenna radiation pattern for each polarization if necessary.
(The parameter "Antenna Polarization Slant Angle" is not necessary and not availa-
ble.)

● Selected with the parameter "Antenna Polarization Slant Angle"
For information on the prerequisites and how to use these two ways, see "Antenna
polarization" on page 133.
The following polarizations are available:
● Horizontal polarization
● Vertical polarization
● Cross-polarization 90°
● Cross-polarization 45°
A graph displays the structure of the current antenna array.
See also:
● Chapter B, "Antenna pattern file format", on page 348.
● Chapter A.16, "SCM and SCME channel models for MIMO OTA", on page 308
Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe
on page 214
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe
on page 214
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Number of Rows (M)/Columns (N)
Sets the number of rows (M) and the number of columns (N) in the antenna array, see
"Antenna Modeling" on page 132.
Note: In this firmware version, only one-dimensional arrays are supported.
The antenna elements are places in one row and only the horizontal spacing is consid-
ered.
The number of Tx and Rx antennas is set automatically according to the selected MxN
MIMO configuration ("System Configuration > LxMxN").
See section "Signal Routing and System Configuration" in the R&S SMW user manual.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.

Example: 
In an 1x4x2 MIMO configuration, there are 4 Tx and 2 Rx antennas.
The "Tx Antenna Array" consists of 4 antennas:
● if "Antenna Polarization Slant Angle > Horizontal/Vertical", these 4 antennas are

placed in a row (4x1 array)
● if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there are exact

2 columns and 1 row.
The "Rx Antenna Array" contains exact 2 antennas, that can be distributed in one the
following ways:
● if "Antenna Polarization Slant Angle > Horizontal/Vertical", in 2 columns and 1 row

(2x1array)
● if "Antenna Polarization Slant Angle > Cross-Polarization 45°/90°", there is exact 1

column and 1 row
In both arrays, a spacing dxp can also exist between the cross polarized antenna ele-
ments.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE on page 214
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE on page 215

Calculation Mode
Selects how the correlation between the antenna elements is calculated: based on the
spacing between the antenna elements or on the relative phase.
See Figure 5-14.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
"Spacing" The spacing (i.e. the physical distance) between the antenna ele-

ments is set with the parameter Horizontal Spacing or Cross-Polar-
ized Antenna Spacing.
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"Relative Phase"
Option: R&S SMW-K73
If the loaded antenna pattern file contains the required information,
the relative phase is extracted from the antenna pattern file.
See:
● "Antenna element spacing or relative phase" on page 132
● Chapter B, "Antenna pattern file format", on page 348.

Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE on page 215
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:CALC:MODE on page 215

Horizontal Spacing
For "Calculation Mode > Spacing", sets the distance (dh) between the antennas in the
antenna array normalized by the wavelength λ.
It is calculated as follows:
dh = "Horizontal Spacing" * λ

Where the wavelength is λ = c/"Frequency" and c is the speed of light.
See also "Antenna element spacing or relative phase" on page 132.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal
on page 215
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal
on page 215

Cross-Polarized Antenna Spacing
For "Calculation Mode > Spacing", set the distance (dxp) between the two antenna ele-
ments of a cross-polarized antenna pair normalized by the wavelength λ .
It is calculated as follows:
dxp= "Cross Polarized Antenna Spacing" * λ.

Where the wavelength is λ = c/"Frequency" and c is the speed of light.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs
on page 215
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs on page 215

Antenna Array
Graphical representation of the current antenna array.
Each dot indicates a single antenna element. Small lines indicate the used polarization,
if "Antenna Polarization Mode > Single AP with Slant Angle" is used.
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The spacing between the antenna elements is indicated, if "Calculation Mode > Spac-
ing" is used.

Antenna Pattern
Antenna patterns are files that describe the 2D antenna radiation pattern.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
The following predefined antenna patterns are available:
● "Isotropic"
● "Dipole"
● "3 Sectors" and "6 Sectors"

These two sector antenna patterns are required for the BS testing, as specified in
the TR 25.996.

● "Dipole +45°/-45°"
The predefined files do not contain polarization and relative phase information. They
are suitable, in the following cases:
● Calculation Mode > "Spacing" or "Relative Phase"

(See "Antenna element spacing or relative phase" on page 132 for information on
file handling in the second case.)

● Antenna Polarization Mode > "Single AP with Slant Angle"
● Standard / Test Case > "3GPP/LTE MIMO" > "SCME UMa/Umi"
You can also load custom antenna pattern, see "User Defined Antenna Patterns per
Row, Column" on page 143.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern on page 216
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern on page 216

User Defined Antenna Patterns per Row, Column
Indicates the custom antenna pattern file per antenna element.
Note: In multi-entity configurations, like, for example, 2x4x4 or 4x2x2, the settings in
the dialogs "Channel Polarization" and "Rx Antenna Array Structure" apply to all enti-
ties.
To change the used file for an antenna element:
● Select a predefined or "User File"
● Navigate to the antenna pattern file and load it.
Antenna pattern files are XML files with file predefined file syntax and extension
*.ant_pat.

They describe the antenna pattern as an array with typical resolutions of 1 degree to 5
degrees for the azimuth. These files contain the gain values for a given azimuth. For
an isotropic antenna radiating energy equally in all directions, the array elements are
all 0 dB.
Antenna pattern files can also contain the following information:
● Separate antenna patterns per antenna polarization
● Relative phase description, also per antenna polarization.
Note: Always use antenna pattern files that are suitable for the current setting.
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The following features require a fully described antenna pattern file
● Calculation Mode > "Relative Phase"
● Antenna Polarization Mode > "Separate AP"
● Use Inverse Channel Matrix > "On".
For description of the file format, see Chapter B, "Antenna pattern file format",
on page 348.
Remote command: 
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog? on page 216
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?
on page 216
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILe
on page 217
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ANTenna<di>:PFILe on page 217

5.3.9  Inverse channel matrix

Option: R&S SMW-B14 and R&S SMW-K73

Some test cases, like for example the MIMO OTA tests, specify actions to be taken to
counteract the channel response of the channel between the test equipment and the
DUT.

The process includes measuring the channel response matrix and applying the inver-
ted version of this channel matrix to the generated signal. In the MIMO OTA tests using
radiated tests for instance, signal generated in this way is received by the DUT as if a
conducted test is used.

The inverse channel matrix is specified for the following test situations but can apply
inverse channel matrix in any 2x2 MIMO scenario:
● MIMO OTA radiated testing

See
● Applying SCM fading porfiles

See Chapter 5.3.7, "SCM fading profile", on page 116.

Access:

1. Enable a 2x2 MIMO configuration.

2. Select "Fading > Inverse Channel Matrix"
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How to counteract the channel matrix of an anechoic chamber

To counteract the anechoic chamber channel matrix of the setup on Figure 5-12 for
example, apply the inverse channel matrix of the radiated channel. The radiated chan-
nel is the channel between the antenna probes and the DUT antennas inside the
chamber.

Perform the following general steps:

1. Establish a radiated (over-the-air) MIMO connection to the DUT.

2. Measure the transmission matrix in the anechoic chamber.

3. Calculate the inverse matrix (H-1). Enter the inverse matrix values.

4. In the R&S SMW, enable a 2x2 MIMO configuration.

5. Select "Fading > Inverse Channel Matrix"

6. Select "Use Inverse Channel Matrix > On".

7. Enter the calculated inverse matrix values.

The complex elements of the inverse channel matrix are applied on the transmitted
signal to compensate for chamber effects.

Settings

Use Inverse Channel Matrix........................................................................................145
Complex Matrix Elements (Real/Imag)....................................................................... 146

Use Inverse Channel Matrix
Applies a 2x2 inverse channel matrix on the signal to compensate for chamber effects.
Enter the four inverse matrix values, see Complex Matrix Elements (Real/Imag).
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Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe
on page 217

Complex Matrix Elements (Real/Imag)
Sets the 4 complex elements (h00, h01, h10, h11) of the inverse channel matrix.

Ain, Bin = Faded channel signals
Aout, Bout = Output signal of the channel emulator

The supported matrix size is 2x2.
Remote command: 
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:
COLumn<ch>:REAL on page 217
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:
COLumn<ch>:IMAGin on page 217

5.4  Bypassing a deactivated fading simulator

To access this setting, proceed as follows:

1. Enable "Fading > Signal Routing (MIMO) > System Configuration > Mode >
Advanced".

2. Select "Fading > Off".

3. Select "Fading > Bypass if Fading Off > On".

The fading simulator is disabled and the input basebands bypass it.
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Impact of the parameter on the calculation of the output streams

The parameter determines the way the output streams are calculated, if the fading sim-
ulator is disabled:
● Disabled parameter "Bypass if Fading Off" (default state)

The fading simulator itself is disabled, but each output stream is still the linear com-
bination of the input baseband signals and depend on the current MIMO configura-
tion.

Example: 
In a 4x2 MIMO system, for instance, the two output streams A and B are calculated
from all the four input basebands. This instrument state is indicated by the sum sym-
bols  at each output streams.
Table 5-3: Representation of the instrument state Bypass if Fading Off > Off

In the "System Configuration" preview diagram In the block diagram

● Enabled parameter "Bypass if Fading Off"
Bypasses the "Fading" block, i.e. the fading simulator is disabled and the base-
bands bypass unchanged the fading block.
Depending on the MIMO configuration, the block diagram visualizes this behavior
different (see Table 5-4). The absence of the sum symbols confirms the selection,
too.
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Example: 
● In a 4x2 MIMO system, for instance, the two output streams A and B are identical

to the two input baseband signals A and B.
The basebands C and D are not processed.

● Vice versa, in a 3x4 MIMO system, the three output streams A, B and C are identi-
cal to the three basebands.
The stream D is a zero stream that starts after the "Fading" block.

Table 5-4: Bypass if Fading Off > On: Representation in the block diagram

MxN MIMO configuration,
where M>N

MxN MIMO configuration,
where M<N

"Bypass if Fading Off > ON" during troubleshooting
While performing troubleshooting, enable this parameter to exclude the impact of the
fading in the signal processing.

SCPI command:

[:SOURce]:FSIMulator:BYPass:STATe on page 151

Bypassing a deactivated fading simulator
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6  Remote-control commands
This subsystem contains the commands necessary to configure the fading simulator in
a remote environment. We assume that the R&S SMW has already been set up for
remote operation in a network as described in the R&S SMW documentation. A knowl-
edge about the remote control operation and the SCPI command syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW user manual.

Required Options

All SCPI commands described in this section, require at least the R&S SMW-B14
option. For better overview, this option is not listed at each command. Also required
options, however, are listed.

The dynamic fading configurations (Birth Death, Moving Propagation, 2 Channel Inter-
ferer and High-Speed Train) are available with option R&S SMW-K71.

See also Chapter 2.1, "Required options", on page 18.

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

ENTity<ch> 1 to 8 Entity in a multiple entity configuration

ENTity3|4|5|6|7|8 require option R&S SMW-K76

SOURce<hw> [1]|2 to 8 Available faders

SOURce3|4|5|6|7|8 require option R&S SMW-K76

Only SOURce1 possible, if the keyword ENTity is used

GROup<st> [1]|2 to 4 Available fading path groups

PATH<ch> [1]|2 to 5 Available fading paths

TAP<ch> [1] to 10 Available MIMO taps

RAY<st> [1] to 6 Available TGn clusters/rays

CLUSter<ch> [1] to 20 Available SCME/WIMMER clusters

Using SCPI command aliases for advanced mode with multiple entities
You can address multiple entities configurations by using the SCPI commands starting
with the keyword SOURce or the alias commands starting with the keyword ENTity.
Note that the meaning of the keyword SOURce<hw> changes in the second case.
For details, see section "SCPI Command Aliases for Advanced Mode with Multiple
Entities" in the R&S SMW user manual.
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Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument preset or reset is
recommended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

The following commands specific to the fading simulator are described here:

● General settings....................................................................................................150
● Delay modes......................................................................................................... 172
● Birth death.............................................................................................................183
● High-speed train....................................................................................................187
● Moving propagation...............................................................................................192
● MIMO settings.......................................................................................................197
● TGn settings..........................................................................................................205
● SCME/WINNER and antenna model settings.......................................................208
● Two channel interferer...........................................................................................218
● Custom fading profile............................................................................................ 222
● SCM fading profile.................................................................................................224
● Customized dynamic fading..................................................................................236
● Fading bandwidth..................................................................................................240

6.1  General settings

[:SOURce]:FSIMulator:BYPass:STATe............................................................................. 151
[:SOURce<hw>]:FSIMulator:CONFiguration......................................................................151
[:SOURce<hw>]:FSIMulator:SISO:COPY......................................................................... 152
[:SOURce<hw>]:FSIMulator:COPY:DESTination............................................................... 152
[:SOURce<hw>]:FSIMulator:COPY:EXECute....................................................................152
[:SOURce<hw>]:FSIMulator:COPY:SOURce.....................................................................152
[:SOURce<hw>]:FSIMulator:FREQuency..........................................................................153
[:SOURce<hw>]:FSIMulator:CLOCk:RATE?..................................................................... 153
[:SOURce<hw>]:FSIMulator:GLOBal:SEED......................................................................154
[:SOURce<hw>]:FSIMulator:HOPPing:MODE................................................................... 154
[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges.............................................................. 154
[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples?................................................................ 155
[:SOURce<hw>]:FSIMulator:ILOSs:MODE........................................................................155
[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS].......................................................................155
[:SOURce<hw>]:FSIMulator:KCONstant...........................................................................156
[:SOURce<hw>]:FSIMulator:PRESet................................................................................156
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[:SOURce<hw>]:FSIMulator:RESTart:MODE.....................................................................156
[:SOURce<hw>]:FSIMulator:ROUTe.................................................................................156
[:SOURce]:FSIMulator:SYNChronize:STATe..................................................................... 159
[:SOURce<hw>]:FSIMulator:SDEStination........................................................................160
[:SOURce<hw>]:FSIMulator:FREQuency:DETect?............................................................ 160
[:SOURce<hw>]:FSIMulator:SPEed:UNIT.........................................................................161
[:SOURce<hw>]:FSIMulator:STANdard............................................................................ 161
[:SOURce<hw>]:FSIMulator:STANdard:REFerence........................................................... 168
[:SOURce<hw>]:FSIMulator[:STATe]................................................................................ 169
[:SOURce]:FSIMulator:CATalog?..................................................................................... 169
[:SOURce<hw>]:FSIMulator:LOAD.................................................................................. 170
[:SOURce]:FSIMulator:DELETE.......................................................................................170
[:SOURce<hw>]:FSIMulator:STORe................................................................................ 170
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD................................................... 170
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant............................................ 170
[:SOURce<hw>]:FSIMulator:COUPle:SPEed.................................................................... 171
[:SOURce<hw>]:FSIMulator:CSPeed............................................................................... 171

[:SOURce]:FSIMulator:BYPass:STATe <BypState>

Enables/disables bypassing of the fading simulator if the simulator is deactivated.

Parameters:
<BypState> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:FSIMulator:CONFiguration <Configuration>

Selects the fading configuration.

To activate the selected fading configuration, use the command for switching the state.

Parameters:
<Configuration> STANdard | BIRThdeath | MDELay | TCInterferer | HSTRain |

CDYNamic
Defines the configuration: Standard delay, birth death propaga-
tion, moving propagation, two channel interferer, high-speed
train and customized dynamic fading propagation.
*RST: STANdard

Example: SOURce1:FSIMulator:CONFiguration MDELay
SOURce1:FSIMulator:MDELay:STATe ON
Selects and activates the moving propagation configuration

Options: BIRThdeath|MDELay|TCInterferer|HSTRain require R&S SMW-
K71
CDYNamic requires R&S SMW-K820

Manual operation: See "Configuration" on page 31

General settings
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[:SOURce<hw>]:FSIMulator:SISO:COPY <CopyToDest>

In "System Configurations" with multiple entities (L > 2), copies the settings of the cur-
rent fading simulator to all or to the selected entities.

Parameters:
<CopyToDest> FADB | FADA | FADC | FADD | FADF | FADE | FADG | FADH |

ALL
*RST: ALL

Example: SOURce1:FSIMulator:SISO:COPY ALL
Options: R&S SMW-K76

Manual operation: See "Copy To / Entity" on page 30

[:SOURce<hw>]:FSIMulator:COPY:DESTination <Destination>

Selects a group whose settings will be overwritten.

Parameters:
<Destination> integer

Range: 1  to  4 (Standard Delay)/ 8 (Fine Delay)
*RST: 2

Example: See [:SOURce<hw>]:FSIMulator:COPY:SOURce
on page 152

Manual operation: See "To" on page 48

[:SOURce<hw>]:FSIMulator:COPY:EXECute

Copies the settings of a fading path group to the selected one.

Example: See [:SOURce<hw>]:FSIMulator:COPY:SOURce
on page 152

Usage: Event

Manual operation: See "Copy" on page 48

[:SOURce<hw>]:FSIMulator:COPY:SOURce <Source>

Sets the group whose settings are to be copied.

Parameters:
<Source> integer

Range: 1  to  8
*RST: 1

General settings
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Example: FSIM:DEL:STAT ON
FSIM:COPY:DEST 4
FSIM:COPY:SOUR 1
FSIM:COPY:EXEC
// copies the settings from group 1 to group 4

Manual operation: See "Copy Path Group" on page 47

[:SOURce<hw>]:FSIMulator:FREQuency <Frequency>

● If [:SOURce<hw>]:FSIMulator:SDEStination RF is selected, queries the
estimated RF frequency.

● If [:SOURce<hw>]:FSIMulator:SDEStination BB is selected, sets the fre-
quency used for the calculation of the Doppler shift.

Parameters:
<Frequency> float

Range: 1E5  to  100E9
Increment: 0.01
*RST: 1E9
Default unit: Hz

Example: SOURce1:FSIMulator:SDEStination RF
SOURce1:FSIMulator:FREQuency?

SOURce1:FSIMulator:SDEStination BB
SOURce1:FSIMulator:FREQuency 2143200000

Manual operation: See "Dedicated Frequency" on page 37
See "Virtual RF" on page 37

[:SOURce<hw>]:FSIMulator:CLOCk:RATE?

Queries the clock rate the fading simulator is using for the signal processing.

Return values: 
<ClocRate> CR200 | CR100 | CR050 | CR025 | CR250 | CR125 | CR062 |

CR500 | CR1G
CR200 = 200 MHz, CR100 = 100 MHz, CR050 = 50 MHz,
CR025 = 25 MHz
CR250 = 250 MHz, CR125 = 125 MHz, CR062 = 62.5 MHz,
CR500 = 500 MHz, CR1G = 1GHz
The value depends on the selected "System Configuration" and
influences the bandwidth of the generated signal.
*RST: depends on the installed options*
*) CR200M (R&S SMW-B10)/CR250M (R&S SMW-B9)

Usage: Query only

Options: CR250|CR125|CR062|CR500|CR1G require R&S SMW-B9/B15

Manual operation: See "Fading Clock Rate" on page 34
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[:SOURce<hw>]:FSIMulator:GLOBal:SEED <Seed>

This command enters the fading start seed. This value is global for the instrument.

Parameters:
<Seed> integer

Range: 0  to  9
*RST: 0

Example: FSIM:GLOB:SEED 2
Sets the start seed to 2

Manual operation: See "Start Seed" on page 44

[:SOURce<hw>]:FSIMulator:HOPPing:MODE <Mode>

This is a password-protected function. Unlock the protection level 1 to access it.

Activates frequency hopping and determines how fading is resumed after a frequency
hop.

Note: Activate list mode and load the frequency table befor activating frequency hop-
ping.

Parameters:
<Mode> OFF | IBANd | OOBand

OFF
Frequency hopping is deactivated.
IBANd
Activates an in-band frequency hopping.
OOBand
Activates an out of band frequency hopping.
*RST: OFF

Example: FSIM:HOPP:MODE OFF
Manual operation: See "Freq. Hopping" on page 38

[:SOURce<hw>]:FSIMulator:IGNore:RFCHanges <RfChanges>

This is a password-protected function. Unlock the protection level 1 to access it.

Sets if frequency changes < 5% are ignored. This enables faster frequency hopping.

Parameters:
<RfChanges> 1 | ON | 0 | OFF

*RST: 0

Example: FSIM:IGN:RFCH ON
Ignores frequency changes < 5% for the fading.

Manual operation: See "Ignore RF Changes < 5PCT" on page 37

General settings
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[:SOURce<hw>]:FSIMulator:ILOSs:CSAMples?

This command queries the share of samples which were clipped due to the insertion
loss setting.

Return values: 
<CSamples> string

Example: FSIM:ILOS:CSAM?
Queries the share of samples which were clipped.
Response: 11
11% of the samples were clipped.

Usage: Query only

Manual operation: See "Clipped Samples" on page 43

[:SOURce<hw>]:FSIMulator:ILOSs:MODE <Mode>

This command sets the insertion loss of the fading simulator.

Parameters:
<Mode> NORMal | LACP | USER

NORMal
The minimum insertion loss for a path of the fading simulator is
set to a fixed value of 18 dB.
*RST: NORMal

Example: FSIM:ILOS:MODE USER
Chooses the user-defined setting for the insertion loss.
FSIM:ILOS 4 dB
sets the minimum insertion loss to 4 dB.

Manual operation: See "Insertion Loss Mode" on page 42

[:SOURce<hw>]:FSIMulator:ILOSs[:LOSS] <Loss>

This command sets the user-defined insertion loss of the fading simulator when "User"
is selected.

In the "Normal" and "Low ACP" modes, the current setting of the value can be queried.

Parameters:
<Loss> float

Range: -3  to  30
Increment: 0.1
*RST: 0
Default unit: dB

Example: FSIM:ILOS:MODE USER
Chooses the user-defined setting for the insertion loss.
FSIM:ILOS 4 dB
sets the minimum insertion loss to 4 dB.

General settings
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Manual operation: See "Insertion Loss" on page 43

[:SOURce<hw>]:FSIMulator:KCONstant <KConstant>

Selects whether to keep the speed or the resulting Doppler shift constant in case of fre-
quency changes.

Parameters:
<KConstant> SPEed | DSHift

*RST: SPEed

Example: FSIM:KCON SPE
Keeps the speed constant in case of frequency changes.

Manual operation: See "Keep Constant" on page 47

[:SOURce<hw>]:FSIMulator:PRESet

Sets the default settings (*RST values) for fading simulation.

Example: SOURce1:FSIMulator:PRESet
Usage: Event

Manual operation: See "Set to Default" on page 30

[:SOURce<hw>]:FSIMulator:RESTart:MODE <Mode>

Selects how a restart of fading simulation is triggered.

Parameters:
<Mode> AUTO | BBTRigger | AAUT

BBTRigger
Restarts the fading process synchronously with received base-
band trigger signal.
AAUT
Not supported in the current version.
*RST: AUTO

Manual operation: See " Mode" on page 38

[:SOURce<hw>]:FSIMulator:ROUTe <Route>

Selects on which baseband path the faded signal is output. The input signal of the
fader is selected with command SOURce:BB:ROUTe.

For one-path instruments this command is query only. It returns value FAA (Fader A
always outputs the signal on baseband A).

Note: All MIMO configurations are enabled only in :SCONfiguration:MODE
ADVanced.

General settings
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:SCONfiguration:
MODE

:SCONfiguration:FADing
<FadConfig>

[:SOURce<hw>]:FSIMulator:ROUTe

STANdard FAAFBNone
FAAFBB
FAAFBA
FABFBB
FAABFBN
FANFBAB
FAABFBAB

FAMAXAB
FAAFBB
FAAFBA
FABFBB
FAMAXAB
FBMAXAB
FAABFBAB

ADVanced MIMO1X2
MIMO1X3
MIMO1X4
MIMO2X2
MIMO2X3
MIMO2X4
MIMO3X1
MIMO3X2
MIMO3X3
MIMO3X4
MIMO4X1
MIMO4X2
MIMO4X3
MIMO4X4
MIMO1X8
MIMO8X1
MIMO2X8
MIMO8X2
MIMO2X1
MIMO4X8
MIMO8X4

FA1A2BFB1A2BM12
FA1A2BFB1A2BM13
FA1A2BFB1A2BM14
FA1A2BFB1A2B|FA1A2BFB1A2BM22
FA1A2BFB1A2BM23
FA1A2BFB1A2BM24
FA1A2BFB1A2BM31
FA1A2BFB1A2BM32
FA1A2BFB1A2BM33
FA1A2BFB1A2BM34
FA1A2BFB1A2BM41
FA1A2BFB1A2BM42
FA1A2BFB1A2BM43
FA1A2BFB1A2BM44
FA1A2BFB1A2BM18
FA1A2BFB1A2BM81
FA1A2BFB1A2BM28
FA1A2BFB1A2BM82
FA1A2BFB1A2BM21
FA1A2BFB1A2BM48
FA1A2BFB1A2BM84

 MIMO2X1X2
MIMO2X2X1
MIMO2X2X2
MIMO2X1X3
MIMO2X1X4
MIMO2X2X3
MIMO2X3X1
MIMO2X3X2
MIMO2X4X1

FA1A2BFB1A2BM212
FA1A2BFB1A2BM221
FA1A2BFB1A2BM222
FA1A2BFB1A2BM213
FA1A2BFB1A2BM214
FA1A2BFB1A2BM223
FA1A2BFB1A2BM231
FA1A2BFB1A2BM232
FA1A2BFB1A2BM241
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:SCONfiguration:
MODE

:SCONfiguration:FADing
<FadConfig>

[:SOURce<hw>]:FSIMulator:ROUTe

 MIMO3X1X2
MIMO3X2X1
MIMO3X2X2
MIMO4X1X2
MIMO4X2X1
MIMO4X2X2

FA1A2BFB1A2BM312
FA1A2BFB1A2BM321
FA1A2BFB1A2BM322
FA1A2BFB1A2BM412
FA1A2BFB1A2BM421
FA1A2BFB1A2BM422

 SISO3X1X1
SISO4X1X1
SISO5X1X1
SISO6X1X1
SISO7X1X1
SISO8X1X1

FAAFBB311
FAAFBB411
FAAFBB511
FAAFBB611
FAAFBB711
FAAFBB811

 MIMO2X2X4
MIMO2X4X2
MIMO2X4X4
MIMO2X3X3
MIMO2X3X4
MIMO2X4X3

FA1A2BFB1A2BM224
FA1A2BFB1A2BM242
FA1A2BFB1A2BM244
FA1A2BFB1A2BM233
FA1A2BFB1A2BM234
FA1A2BFB1A2BM243

 MIMO8X8 FA1A2BFB1A2BM88

Parameters:
<Route> FAA | FAMAXAB | FAAFBA | FAAFBB | FABFBB | FBMAXAB |

FAABFBAB | FA1A2BFB1A2B | FA1A2BFB1A2BM22 |
FA1A2BFB1A2BM24 | FA1A2BFB1A2BM42 |
FA1A2BFB1A2BM23 | FA1A2BFB1A2BM32 |
FA1A2BFB1A2BM12 | FA1A2BFB1A2BM33 |
FA1A2BFB1A2BM34 | FA1A2BFB1A2BM43 |
FA1A2BFB1A2BM44 | FA1A2BFB1A2BM18 |
FA1A2BFB1A2BM81 | FA1A2BFB1A2BM28 |
FA1A2BFB1A2BM82 | FA1A2BFB1A2BM21 |
FA1A2BFB1A2BM212 | FA1A2BFB1A2BM221 |
FA1A2BFB1A2BM222 | FA1A2BFB1A2BM13 |
FA1A2BFB1A2BM31 | FA1A2BFB1A2BM14 |
FA1A2BFB1A2BM41 | FAMAXA | FA1A2BFB1A2BM224 |
FA1A2BFB1A2BM242 | FA1A2BFB1A2BM48 |
FA1A2BFB1A2BM84 | FA1A2BFB1A2BM88 |
FA1A2BFB1A2BM312 | FA1A2BFB1A2BM321 |
FA1A2BFB1A2BM322 | FA1A2BFB1A2BM412 |
FA1A2BFB1A2BM421 | FA1A2BFB1A2BM422 | FAAFBB311 |
FAAFBB411 | FAAFBB511 | FAAFBB611 | FAAFBB711 |
FAAFBB811 | FA1A2BFB1A2BM213 | FA1A2BFB1A2BM214 |
FA1A2BFB1A2BM223 | FA1A2BFB1A2BM231 |
FA1A2BFB1A2BM232 | FA1A2BFB1A2BM241 |
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FA1A2BFB1A2BM244 | FA1A2BFB1A2BM233 |
FA1A2BFB1A2BM234 | FA1A2BFB1A2BM243
FAA
The faded modulation signal of fader A is placed on baseband
path A.
FAAFBB
The faded modulation signal of fader A is placed on baseband
path A and the faded modulation signal of fader B is placed on
baseband path B.
FAAFBA
The faded modulation signal of fader A and B is placed on base-
band path A.
FABFBB
The faded modulation signal of fader A and B is placed on base-
band path B.
FAABFBAB
The faded modulation signal of fader A and B is placed on base-
band paths A and B.
FAMAXA
The faded modulation signal of fader A is placed on baseband
path A.
FBMAXB
The faded modulation signal of fader B is placed on baseband
path B.
FAMAXAB
The faded modulation signal of fader A is placed on baseband
paths A and B.
FBMAXAB
The faded modulation signal of fader B is placed on baseband
paths A and B.
FA1A2BFB1A2B|FA1A2BFB1A2BM22| ... |FAAFBB811
Sets a MIMO mode

Example: SOURce1:FSIMulator:MIMO:CAPability?
// "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."
SOURce1:FSIMulator:ROUTe FA1A2BFB1A2BM24
// selects a 1x2X4 MIMO configuration 

Options: See data sheet.

Manual operation: See "Signal Routing" on page 91

[:SOURce]:FSIMulator:SYNChronize:STATe <State>

Couples the fading simulators so that if both blocks are active, a subsequent restart
event in any of them causes a simultaneous restart of the other.

Restart event can be caused by a start/stop alternation or a parameter change that
results in a signal recalculation and therefore a process restart.

General settings
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:FSIMulator:STATe 1
SOURce2:FSIMulator:STATe 1
SOURce:FSIMulator:SYNChronize:STATe 1
SOURce1:FSIMulator:STATe 0
SOURce2:FSIMulator:STATe 1
// the fading simulators restart simultaneously

Manual operation: See " Synchronization" on page 39

[:SOURce<hw>]:FSIMulator:SDEStination <SDestination>

Defines the frequency to that the signal of the whole Fader block is dedicated.

Parameters:
<SDestination> RF | BB

RF
The Doppler shift is calculated based on the actual RF fre-
quency, that is dynamically estimated.
To query the estimated dedicated frequency, use the command
[:SOURce<hw>]:FSIMulator:FREQuency.
To query the output connector, use the command [:
SOURce<hw>]:FSIMulator:FREQuency:DETect?
on page 160.
BB
Set the fader frequency manually by means of the command [:
SOURce<hw>]:FSIMulator:FREQuency.
*RST: RF

Example: See [:SOURce<hw>]:FSIMulator:FREQuency on page 153

Manual operation: See "Signal Dedicated To" on page 34

[:SOURce<hw>]:FSIMulator:FREQuency:DETect?

Queries the output interface the steam used to estimate the dedicated frequency is
mapped to.

Return values: 
<DetectPrimary> RFA | BBMM1 | RFB | BBMM2 | IQOUT1 | IQOUT2 | FAD1 |

FAD2 | FAD4 | FAD3 | DEF

Example: :SOURce1:FSIMulator:FREQ:DETect?

Usage: Query only

Manual operation: See "Dedicated Connector" on page 37
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[:SOURce<hw>]:FSIMulator:SPEed:UNIT <Unit>

This command chooses the default unit for the parameter speed as displayed in the
dialog.

Note: The remote control command changes only the units displayed in the graphical
user interface. While configuring the speed via remote control, the speed units must be
specified.

Parameters:
<Unit> MPS | KMH | MPH | NMPH

*RST: KMH

Example: FSIM:SPE:UNIT MPS
Sets meters per second as the default unit for the speed param-
eter as displayed in the graphical user interface.

Manual operation: See "Speed Unit" on page 47

[:SOURce<hw>]:FSIMulator:STANdard <Standard>

Selects a predefined fading simulator setting which complies with the test specifica-
tions found in the common mobile radio standards.

For a detailed summary of all the default settings, see Chapter A, "Predefined fading
settings", on page 242.

Standard/test case <Predefined_Standard> Description

- USER USER parameter cannot be
set. A query returns this value
if a user-defined Fading set-
ting was loaded or if one of
the associated settings was
changed after the selection of
a standard

CDMA

See Chapter A.1, "CDMA stand-
ards", on page 242

CDMA0 | CDMA3 | CDMA8 |
CDMA30 | C1DMA30 | CDMA100

CDMA 5 (0 km/h), CDMA6
(3km/h), CDMA1 (8 km/h),
CDMA2 (30 km/h), CDMA3
(30 km/h, 1 path), CDMA4
(100km/h)

GSM

See Chapter A.2, "GSM stand-
ards", on page 245

GTU1P5 | G6TU1P5 | GTU3P6 |
G6TU3P6 | GTU3 | G6TU3 | GTU6 |
G6TU6 | GTU50 | G6TU50 |
G6TU100 | G6TU60

GSM Typical Urban
1.5/3/3.6/6/50/60/100 km/h, 6
and 12 path

 GHT100 | G6HT100 | GHT120 |
G6HT120 | GHT200 | G6HT200

GSM Hilly Terrain 100/120
km/h, 6 and 12 path

 GRA130 | GRA250 | GRA300 |
GRA500

GSM Rural Area
130/250/300/500 km/h, 6 path

 GET50 | GET60 | GET100 GSM Equal Test 50/60/100
km/h, 6 path

 GTI5 GSM typical case for small
cells, 5km/h, 2 path
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Standard/test case <Predefined_Standard> Description

NADC

See Chapter A.3, "NADC stand-
ards", on page 250

NADC8 | NADC50 | NADC100 NADC 8/50/100 km/h, 2 path

DCS1800/PCS1900

See Chapter A.4, "PCN stand-
ards", on page 251

P6TU1 | PTU1 | P6TU50 | PTU50 Typical Urban 1.5/50 km/h, 6
and 12 path

 P6HT100 | PHT100 Hilly Terrain 100 km/h, 6 and
12 path

 PRA130 Rural Area 130 km/h, 6 path

 PET50 | PET100 Equal Test 50/100 km/h, 6
path

TETRA

See Chapter A.5, "TETRA stand-
ards", on page 256

TTU | T6TU TETRA Typical Urban
50km/h, 2 path and 6 path

 TBU TETRA 2 path

 THT | T6HT TETRA Hilly Terrain 200
km/h, 2 path and 6 path

 T4ET TETRA Equal Test 200 km/h,
4 path

 TDR TETRA Direct Mode Rural
Propagation Model 1 path

 TDU TETRA Mode Urban Propa-
gation Model 1 path

3GPP FDD

See Chapter A.6, "3GPP stand-
ards", on page 260

G3C1 | G3C2 | G3C3 | G3C4 3GPP FDD Test Case x (BS)

 G3UEC1 | G3UEC2 | G3UEC3 |
G3UEC4 | G3UEC5 | G3UEC6

3GPP FDD UE Test Case x
(UE)

 G3UEC7SE 3GPP FDD UE Sector (UE)

 G3UEC7BE 3GPP FDD Beam (UE)

 G3UEC8CQ 3GPP FDD CQI (UE)

 G3UEPA3 | G3UEPB3 3GPP FDD Pedestrian A 4
path / B 6 path (UE)

 G3UEVA3 | G3UEVA30 |
G3UEVA120

3GPP FDD Vehicular A 6 path
(UE)

 G3MBSFN3 3GPP MBSFN

 G3TU3 | G3TU50 | G3TU120 3GPP FDD Typical Urban 20
path

 G3HT120 3GPP FDD Hilly Terrain 20
path

 G3RA120 | G3RA250 3GPP FDD Rural Area 10
path
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Standard/test case <Predefined_Standard> Description

 BD1 3GPP Birth Death 2 path

Moving Propagation MD1 3GPP Moving Propagation
"Ref. + Moving Channel",
2path

See Chapter A.15, "3GPP/LTE
moving propagation", on page 306

MPLTEETU200 3GPP Moving Propagation
scenario 1 "ETU200Hz",
according to the test case
3GPP TS36.141, annex B4.

 MPLTEPDOPP 3GPP Moving Propagation
scenario 2 "AWGN", accord-
ing to the test case
3GPP TS36.141, annex B4.

3GPP High-Speed Train scenar-
ios

G3HST1OS | G3HST1OSDU 3GPP HST1 "Open space",
according to the test case
3GPP TS25.141, annex D.4A
and 3GPP TS36.141, annex
B.3

See Chapter A.14, "3GPP/LTE
high speed train", on page 305

G3HST2TLC | G3HST2TLCDU 3GPP HST2 "Tunnel with
leaky cable", according to the
test case 3GPP TS25.141,
annex D.4A

 G3HST3TMA | G3HST3TMADU 3GPP HST3 "Tunnel for multi-
antennas", according to the
test case 3GPP TS25.141,
annex D.4A and
3GPP TS36.141, annex B.3

SCME/Geo SCME UMi 3kmh/
30kmh

SCME/Geo SCME UMa 3kmh/
30kmh

See Chapter A.16, "SCM and
SCME channel models for MIMO
OTA", on page 308

G3SCMEUMA3 | G3SCMEUMA30 |
G3SCMEUMI3 | G3SCMEUMI30

GEOSCMEUMA3|GEOSCMEUMA30|
GEOSCMEUMI3|GEOSCMEUMI30

SCME/Geo SCME Urban
Micro/Macro-Cell Channel, 3
km/h and 30 km/h

WLAN

See Chapter A.7, "WLAN stand-
ards", on page 271

HL2A | HL2B | HL2C | HL2D | HL2E WLAN HyperLan 18 path

DAB

See Chapter A.8, "DAB stand-
ards", on page 276

DABRA04 | DABRA06 DAB Rural Area 4 and 6 path

 DABTU12 | DABTU06 DAB Typical Urban 12 and 6
path

 DABSFN DAB Single Frequency Net-
work (in the VHF range) 7
path

WiMAX

See Chapter A.9, "WIMAX stand-
ards", on page 278

WMITUOIPA | WMITUOIPB | WMI-
TUVA60 | WMITUVA120

Wimax ITU OIP-A, ITU OIP-B,

ITU V-A-60, ITU V-A-120
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Standard/test case <Predefined_Standard> Description

 WMSUI1A360P90 |
WMSUI1A360P75 |
WMSUI1A030P90 |
WMSUI1A030P75

SUI 1 (omi ant. 90/75%),

SUI 1 (30 ant. 90/75%)

 WMSUI2A360P90 |
WMSUI2A360P75 |
WMSUI2A030P90 |
WMSUI2A030P75

SUI 2 (omi ant. 90/75%),

SUI 2 (30 ant. 90/75%)

 WMSUI3A360P90 |
WMSUI3A360P75 |
WMSUI3A030P90 |
WMSUI3A030P75

SUI 3 (omi ant. 90/75%),

SUI 3 (30 ant. 90/75%)

 WMSUI4A360P90 |
WMSUI4A360P75 |
WMSUI4A030P90 |
WMSUI4A030P75

SUI 4 (omi ant. 90/75%),

SUI 4 (30 ant. 90/75%)

 WMSUI5A360P90 |
WMSUI5A360P75 |
WMSUI5A360P50 |
WMSUI5A030P90 |
WMSUI5A030P75 |
WMSUI5A030P50

SUI 5 (omi ant. 90/75/50%),

SUI 5 (30 ant. 90/75/50%)

 WMSUI6A360P90 |
WMSUI6A360P75 |
WMSUI6A360P50 |
WMSUI6A030P90 |
WMSUI6A030P75 |
WMSUI6A030P50 |

SUI 6 (omi ant. 90/75/50%),

SUI 6 (30 ant. 90/75/50%)

WiMAX-MIMO

See Chapter A.12, "WIMAX-
MIMO standards", on page 296

WMITUPB3L | WMITUPB3M | WMI-
TUPB3H | WMITUVA60L | WMI-
TUVA60M | WMITUVA60H

ITU PB Low/Medium/High,

ITU VA Low/Medium/High

LTE

See Chapter A.10, "LTE stand-
ards", on page 291

LTEEPA1 | LTEEPA5

LTEEVA5 | LTEEVA70

LTEETU1 | LTEETU5 | LTEETU30 |
LTEETU70 | LTEETU200 |
LTEETU300 | LTEETU600

LTEMBSFN5

LTE EPA 1/5Hz,

LTE EVA 5/70Hz,

LTE ETU 1/5/30/70/200/300/6
00Hz

LTE MBSFN 5Hz

LTE HST

See Chapter A.10.7, "HST 1 500
A/B, HST 3 500 A/B",
on page 294

HST1LTE500A | HST3LTE500A |
HST1LTE500B | HST3LTE500B

LTE HST 1 500 A/B

LTE HST 3 500 A/B
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Standard/test case <Predefined_Standard> Description

LTE-MIMO

See Chapter A.11, "LTE-MIMO
standards", on page 294

LMEPA1L | LMEPA1M | LMEPA1H |
LMEPA5L | LMEPA5M | LMEPA5H

LMEVA5L | LMEVA5M | LMEVA5H |
LMEVA70L | LMEVA70M |
LMEVA70H

LMETU1L | LMETU1M | LMETU1H |
LMETU5L | LMETU5M | LMETU5H |
LMETU30L | LMETU30M |
LMETU30H | LMETU70L |
LMETU70M | LMETU70H |
LMETU200L | LMETU200M |
LMETU200H | LMETU300L |
LMETU300M | LMETU300H |
LMETU600L | LMETU600M |
LMETU600H

LTE EPA 1/5Hz Low/Medium/
High,

LTE EVA 5/70Hz Low/
Medium/High,

LTE ETU 1/30/70/300/600Hz
Low/Medium/High

1xEVDO

See Chapter A.13, "1xevdo stand-
ards", on page 301

EVDO1CH1 | EVDO1CH1BC5 |
EVDO1CH2 | EVDO1CH2BC5 |
EVDO1CH3 | EVDO1CH3BC5 |
EVDO1CH4 | EVDO1CH4BC5 |
EVDO1CH5 | EVDO1CH5BC5

1xEVDO Chan. 1/2/3/4/5

WATTERSON

See Chapter A.17, "Watterson
standards", on page 311

WATTI1 | WATTI3 | WATTI2 Watterson I1, I2, I3

802.11n-SISO

See Chapter A.18, "802.11n-SISO
standards", on page 313

WLANNSMODA | WLANNSMODB |
WLANNSMODC | WLANNSMODD |
WLANNSMODE | WLANNSMODF

802.11n SISO Model
A/B/C/D/E/F

802.11n-MIMO

See Chapter A.19, "802.11n-
MIMO standards", on page 314

WLANNMODA | WLANNMODB |
WLANNMODC | WLANNMODD |
WLANNMODE | WLANNMODF

802.11n MIMO Model
A/B/C/D/E/F

802.11ac-SISO

See Chapter A.21, "802.11ac-
SISO standards", on page 334

WLANACSMODA|WLANACSMODB|
WLANACSMODC|WLANACSMODD|
WLANACSMODE|WLANACSMODF

802.11ac SISO Model
A/B/C/D/E/F

802.11ac-MIMO

See Chapter A.20, "802.11ac-
MIMO standards", on page 324

WLANACMODA | WLANACMODB |
WLANACMODC | WLANACMODD |
WLANACMODE | WLANACMODF

802.11ac MIMO Model
A/B/C/D/E/F

802.11p

See Chapter A.22, "802.11p chan-
nel models", on page 335

WLANPRURALLOS | WLANPURBA-
NAPPLOS | WLANPURBANCRON-
LOS | WLANPHIGHWAYNLOS |
WLANPHIGHWAYLOS

802.11p Channel models:
Rural LOS, Urban Approach-
ing LOS, Urban Crossing
NLOS, Highway LOS, High-
way NLOS
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Standard/test case <Predefined_Standard> Description

5G NR

See Chapter A.23, "5G NR stand-
ards", on page 337.

TDLA30D5L | TDLA30D5M |
TDLA30D5MA | TDLA30D5H |
TDLA30D10L | TDLA30D10M |
TDLA30D10MA | TDLA30D10H |
TDLB100D400L | TDLB100D400M |
TDLB100D400MA | TDLB100D400H |
TDLC300D100L | TDLC300D100M |
TDLC300D100MA | TDLC300D100H
| TDLA30D75L | TDLA30D75M |
TDLA30D75MA | TDLA30D75H |
TDLA30D300L | TDLA30D300M |
TDLA30D300MA | TDLA30D300H |
TDLA30D35L | TDLA30D35M |
TDLA30D35MA | TDLA30D35H |
TDLC60D300L | TDLC60D300M |
TDLC60D300MA | TDLC60D300H

TDLA30D10S | TDLA30D35S |
TDLA30D75S | TDLA30D300S |
TDLB100D400S | TDLC60D300S |
TDLC300D100 | STDLC300D400S |
TDLC300D600S | TDLC300D600L |
TDLC300D600M | TDLC300D600H |
TDLC300D1200S | TDLC300D1200L
| TDLC300D1200M |
TDLC300D1200H

FR1CDLAUMA | FR1CDLCUMA |
FR1CDLCUMA4 | FR1CDLAUMI |
FR1CDLCUMI | FR1CDLCUMI2 |
FR2CDLAINO | FR2CDLCUMI |
FR1CDLBUMA | FR1CDLBUMI

NTNTDLA100D200L|
NTNTDLA100D200M|
NTNTDLA100D200H|
NTNTDLC5D200L|
NTNTDLC5D200M|
NTNTDLC5D200H

5G New Radio models

TDLA30-5/10 Hz,
TDLB100-400 Hz,
TDLC300-100 Hz,
TDLA30-75/300 Hz,
TDLA30-35/10 Hz,
TDLC60-300/10 Hz Low/
Medium/Medium A/High

TDLA30-5/10/35/75/300 Hz,
TDLB100-400 Hz,
TDLC60-300 Hz,
TDLC300-100 Hz SISO,
TDLC300-400 Hz SISO,
TDLC300-600 Hz SISO,
TDLC300-600 Hz Low/
Medium/High, TDLC300-1200
Hz SISO, TDLC300-1200 Hz
Low/Medium/High

FR1 and FR2 CDL models

FR1 NTN TDL models:

5G NR High-Speed Train scenar-
ios

See Chapter A.25, "5G NR high
speed train", on page 344.

HST1NR35015|HST1NR35030|
HST3NR35015|HST3NR35030

HST1NR50015|HST1NR50030|
HST3NR50015|HST3NR50030

HST1/HST3 350 km/h 15/30
kHz

HST1/HST3 500 km/h 15/30
kHz

5G NR Moving propagation

See Chapter A.26, "5G NR mov-
ing propagation", on page 345.

MPX15|MPX30

MPY15|MPY30|MPY120

MPZ15|MPZ30

|MPNTNX15|MPNTNX30|

MP X 15/30kHz SCS

MP Y 15/30/120kHz SCS

MP Z 15/30kHz SCS

5G NR MIMO OTA

See Chapter A.24, "5G NR MIMO
OTA channel models",
on page 342

FR1CDLAUMA|FR1CDLBUMA|
FR1CDLCUMA

FR1CDLCUMA4

FR1CDLAUMI|FR1CDLBU-
MIFR1CDLCUMI

FR1CDLCUMI2

FR2CDLAINO|FR2CDLCUMI

FR1 CDL-A/-B/-C UMa 2x2

FR1 CDL-C UMa 4x4

FR1 CDL-A/-B/-C UMi 4x4

FR1 CDL-C UMi 2x2

FR2 CDL-A InO, FR2 CDL-C
UMi
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Parameters:
<Standard> USER | CDMA8 | CDMA30 | C1DMA30 | CDMA100 | CDMA0 |

CDMA3 | G6TU3 | GTU3 | G6TU50 | GTU50 | G6HT100 |
GHT100 | GRA250 | GET50 | GET100 | HL2A | HL2B | HL2C |
HL2D | HL2E | NADC8 | NADC50 | NADC100 | P6TU1 | PTU1 |
P6TU50 | PTU50 | P6HT100 | PHT100 | PRA130 | PET50 |
PET100 | TTU | TBU | THT | T4ET | G3C1 | G3C2 | G3C3 |
G3C4 | G3UEC4 | G3UEC5 | G3UEC6 | G3UEC7SE |
G3UEC7BE | G3UEC8CQ | G3UEPA3 | G3UEPB3 |
G3UEVA30 | G3UEVA120 | G3TU3 | G3TU50 | G3TU120 |
G3HT120 | G3RA120 | G3RA250 | BD1 | MP1 | DABRA04 |
DABRA06 | DABTU12 | DABTU06 | DABSFN |
WMSUI1A360P90 | WMSUI1A360P75 | WMSUI1A030P90 |
WMSUI1A030P75 | WMSUI2A360P90 | WMSUI2A360P75 |
WMSUI2A030P90 | WMSUI2A030P75 | WMSUI3A360P90 |
WMSUI3A360P75 | WMSUI3A030P90 | WMSUI3A030P75 |
WMSUI4A360P90 | WMSUI4A360P75 | WMSUI4A030P90 |
WMSUI4A030P75 | WMSUI5A360P90 | WMSUI5A360P75 |
WMSUI5A360P50 | WMSUI5A030P90 | WMSUI5A030P75 |
WMSUI5A030P50 | WMSUI6A360P90 | WMSUI6A360P75 |
WMSUI6A360P50 | WMSUI6A030P90 | WMSUI6A030P75 |
WMSUI6A030P50 | WMITUOIPA | WMITUOIPB | WMITUVA60 |
TDU | TDR | WMITUVA120 | GET60 | G6HT120 | G6HT200 |
GRA130 | GRA300 | GRA500 | G6TU1P5 | G6TU3P6 | G6TU6 |
G6TU60 | G6TU100 | GHT120 | GHT200 | GTU1P5 | GTU3P6 |
GTU6 | GTU60 | GTU100 | LMEPA5L | LMEPA5M | LMEPA5H |
LMEVA5L | LMEVA5M | LMEVA5H | LMEVA70L | LMEVA70M |
LMEVA70H | LMETU70L | LMETU70M | LMETU70H |
LMETU300L | LMETU300M | LMETU300H | WMITUPB3L |
WMITUPB3M | WMITUPB3H | WMITUVA60L | WMITUVA60M |
WMITUVA60H | EVDO1CH1 | EVDO1CH1BC5 | EVDO1CH2 |
EVDO1CH2BC5 | EVDO1CH3 | EVDO1CH3BC5 | EVDO1CH4 |
EVDO1CH4BC5 | EVDO1CH5 | EVDO1CH5BC5 | G3HST1OS |
G3HST2TLC | G3HST3TMA | MPLTEETU200 | MPLTEPDOPP |
T6TU | T6HT | LTEEPA5 | LTEEVA5 | LTEEVA70 | LTEETU70 |
LTEETU300 | G3UEC1 | G3UEC2 | G3UEC3 | G3UEVA3 |
G3MBSFN3 | WATTI1 | WATTI3 | WATTI2 | GTI5 |
G3HST1OSDU | G3HST2TLCDU | G3HST3TMADU |
LTEMBSFN5 | LTECQI5 | LTEETU30 | LMETU30L |
LMETU30M | LMETU30H | WLANNMODA | WLANNMODB |
WLANNMODC | WLANNMODD | WLANNMODE |
WLANNMODF | WLANACMODA | WLANACMODB |
WLANACMODC | WLANACMODD | WLANACMODE |
WLANACMODF | WLANNSMODA | WLANNSMODB |
WLANNSMODC | WLANNSMODD | WLANNSMODE |
WLANNSMODF | WLANACSMODA | WLANACSMODB |
WLANACSMODC | WLANACSMODD | WLANACSMODE |
WLANACSMODF | G3SCMEUMA3 | G3SCMEUMA30 |
G3SCMEUMI3 | G3SCMEUMI30 | WLANPRURALLOS |
WLANPURBANAPPLOS | WLANPURBANCRONLOS |
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WLANPHIGHWAYNLOS | WLANPHIGHWAYLOS | LTEEPA1 |
LTEETU1 | LTEETU600 | LMEPA1L | LMEPA1M | LMEPA1H |
LMETU1L | LMETU1M | LMETU1H | LMETU600L |
LMETU600M | LMETU600H | GEOSCMEUMA3 |
GEOSCMEUMA30 | GEOSCMEUMI3 | GEOSCMEUMI30 |
TDLA30D5L | TDLA30D5M | TDLA30D5H | TDLA30D10L |
TDLA30D10M | TDLA30D10H | TDLB100D400L |
TDLB100D400M | TDLB100D400H | TDLC300D100L |
TDLC300D100M | TDLC300D100H | TDLA30D75L |
TDLA30D75M | TDLA30D75H | TDLA30D300L |
TDLA30D300M | TDLA30D300H | TDLA30D5MA |
TDLA30D10MA | TDLB100D400MA | TDLC300D100MA |
TDLA30D75MA | TDLA30D300MA | TDLA30D5S |
TDLA30D10S | TDLB100D400S | TDLC300D100S |
TDLA30D75S | TDLA30D300S | TDLA30D35S |
TDLC60D300S | TDLA30D35L | TDLA30D35M |
TDLA30D35MA | TDLA30D35H | TDLC60D300L |
TDLC60D300M | TDLC60D300MA | TDLC60D300H |
HST1NR35015 | HST1NR35030 | HST3NR35015 |
HST3NR35030 | MPY15 | MPY30 | FR1CDLAUMA |
FR1CDLCUMA | FR1CDLAUMI | FR1CDLCUMI |
FR2CDLAINO | FR2CDLCUMI | FR1CDLBUMA |
FR1CDLBUMI | HST1NR50015 | HST1NR50030 |
HST3NR50015 | HST3NR50030 | HST1LTE500A |
HST3LTE500A | HST1LTE500B | HST3LTE500B | LTEETU5 |
LTEETU200 | LMETU5L | LMETU5M | LMETU5H |
LMETU200L | LMETU200M | LMETU200H | TDLC300D600L |
TDLC300D600M | TDLC300D600H | TDLC300D1200L |
TDLC300D1200M | TDLC300D1200H | TDLC300D400S |
TDLC300D600S | TDLC300D1200S | MPX15 | MPX30 |
MPZ15 | MPZ30 | FR1CDLCUMI2 | FR1CDLCUMA4 | MPY120 |
MPNTNX15 | MPNTNX30 | NTNTDLA100D200L |
NTNTDLA100D200M | NTNTDLA100D200H |
NTNTDLC5D200L | NTNTDLC5D200M | NTNTDLC5D200H
*RST: USER

Example: FSIM:STAN THT
Manual operation: See "Standard / Test Case" on page 31

Option: see the corresponding section in Chapter A, "Predefined fading settings",
on page 242.

[:SOURce<hw>]:FSIMulator:STANdard:REFerence <Reference>

Queries the reference in the standard for the selected test case.

Parameters:
<Reference> string
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Example: FSIM:STAN WC1BUP2
// Selects settings in acc. with 3GPP FDD Test Case 1 (2 fading paths)
FSIM:STAN:REF?
// "3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2"

Manual operation: See "Standard / Test Case" on page 31

[:SOURce<hw>]:FSIMulator[:STATe] <State>

Activates fading simulation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: Option: R&S SMW-B14
FSIM ON
// Activates fading simulation

Example: Option: R&S SMW-B15
SCONfiguration:MODE ADV
SCONfiguration:APPLy
FSIM ON
// Activates fading simulation

Manual operation: See "State" on page 30
See "State Path" on page 48

[:SOURce]:FSIMulator:CATalog?

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.fad.

Return values: 
<FileNames> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: SOURce1:FSIMulator:STORe "/var/user/delay_3gpp"
*RST
SOURce1:FSIMulator:CATalog?
// Birth_3gpp, delay_3gpp, fad_test
SOURce1:FSIMulator:LOAD "/var/user/fad_test"
SOURce1:FSIMulator:STATe 1
SOURce1:FSIMulator:DELETE "Birth_3gpp"

Usage: Query only

Manual operation: See "Save/Recall" on page 31

General settings
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[:SOURce<hw>]:FSIMulator:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.fad.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See [:SOURce]:FSIMulator:CATalog? on page 169.

Usage: Setting only

Manual operation: See "Save/Recall" on page 31

[:SOURce]:FSIMulator:DELETE <Filename>

Deletes the specified file containing a fading setting from the default directory. The
default directory is set with the command MMEM:CDIRectory. A path can also be
specified. Only files with the file ending *.fad are deleted.

Note: This command is only valid with DELETE in the long form as DEL is used as
short form of header keyword DELay.

Setting parameters: 
<Filename> string

Example: See [:SOURce]:FSIMulator:CATalog? on page 169

Usage: Setting only

Manual operation: See "Save/Recall" on page 31

[:SOURce<hw>]:FSIMulator:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.fad) is assigned
automatically.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Example: See [:SOURce]:FSIMulator:CATalog? on page 169.

Usage: Setting only

Manual operation: See "Save/Recall" on page 31

[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:CSTD <Cstd>
[:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:LCONstant <LConstant>
(available in "System Configuration > Mode > Standard")

Couples the lognormal fading setting.

General settings



Remote-control commandsFading Simulation

171User Manual 1175.6826.02 ─ 29

Parameters:
<LConstant> 1 | ON | 0 | OFF

*RST: 0

Example: SCONfiguration:MODE STANdard

SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile PDOP
SOURce1:FSIMulator:DEL:GROup1:PATH1:SPEed 1111.111
SOURce1:FSIMulator:STATe 1
SOURce1:FSIMulator:COUPle:SPEed 1
SOURce1:FSIMulator:CSPeed 1

SOURce2:FSIMulator:CONFiguration STAN
SOURce2:FSIMulator:STATe 1
SOURce2:FSIMulator:DEL:GROup1:PATH1:SPEed?
// 1111.111

SOURce1:FSIMulator:COUPle:LOGNormal:LCONstant 1
SOURce1:FSIMulator:COUPle:LOGNormal:CSTD 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:STATe 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:LCONstant 150
SOURce2:FSIMulator:DEL:GROup1:PATH1:LOGNormal:LCONstant?
// 150
SOURce1:FSIMulator:DEL:GROup1:PATH1:LOGNormal:CSTD 2
SOURce2:FSIMulator:DEL:GROup1:PATH1:LOGNormal:CSTD?
// 2

Manual operation: See "Local Constant Coupled" on page 44

[:SOURce<hw>]:FSIMulator:COUPle:SPEed <Speed>

(available in "System Configuration > Mode > Standard")

Couples the setting for the speed for the paths of both faders.

Parameters:
<Speed> 1 | ON | 0 | OFF

*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:
LCONstant on page 170

Manual operation: See "Speed Setting Coupled" on page 44

[:SOURce<hw>]:FSIMulator:CSPeed <CSpeed>

Determines whether the same speed is set for all of the activated fading paths.

Parameters:
<CSpeed> 1 | ON | 0 | OFF

*RST: 1
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Example: See [:SOURce<hw>]:FSIMulator:COUPle:LOGNormal:
LCONstant on page 170

Manual operation: See "Common Speed For All Paths" on page 47

6.2  Delay modes

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay.....................172
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay........................... 172
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDELay.....................173
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay........................... 173
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDELay?...................173
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?......................... 173
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:COEFficient..174
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:PHASe........ 175
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:STATe..........175
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase...........................175
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler.................. 176
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:RESulting]....... 176
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler:ACTual?.....177
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:ACTual?........... 177
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FRATio...................... 178
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio............................ 178
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift.............................. 178
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead.........................179
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:CSTD............ 179
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:LCONstant.....179
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:STATe............180
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS........................ 180
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS.............................. 180
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio............................ 180
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile.................... 181
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile...........................181
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEed.......................182
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed.............................182
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe....................... 182
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe..............................182
[:SOURce<hw>]:FSIMulator:DELay|DEL:STATe................................................................ 182

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:ADELay
<ADelay>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:ADELay
<ADelay>

Sets the path-specific delay ("Additional Delay") of the selected path.
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Parameters:
<ADelay> float

Range: depends on the installed options*
Increment: depends on the installed options*
*RST: 0
*) See Chapter 2.4, "Characteristics of R&S SMW-B14 and
R&S SMW-B15", on page 25.

Example: SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup2:PATH2:STATe 1
SOURce1:FSIMulator:DEL:GROup2:PATH2:ADElay 10E-6
// sets a delay of 10 us for path 2 of the fading group 2

Manual operation: See "Additional Delay" on page 51

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:BDELay
<BDelay>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
<BDelay>

Sets the basic group delay.

Parameters:
<BDelay> float

Range: depends on the installed options*
Increment: depends on the installed options*
*RST: 0
*) See Chapter 2.4, "Characteristics of R&S SMW-B14 and
R&S SMW-B15", on page 25.

Example: SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup2:PATH2:STATe 1
SOURce1:FSIMulator:DEL:GROup2:PATH2:BDElay 1E-3
// sets a delay of 1 ms for path 2 of the fading group 2

Options: R&S SMW-B14

Manual operation: See "Basic Delay" on page 51

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:RDELay?
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:RDELay?
Queries the resulting delay of the paths for the selected fading configuration. The
Resulting Delay is the sum of the Basic Delay (SOURce:FSIM:...:BDELay) and the
Additional Delay (SOURce:FSIM:...:ADELay).
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Return values: 
<RDelay> float

Sum of the values set with the commands [:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:BDELay
and [:SOURce<hw>]:FSIMulator:DELay|DEL:
GROup<st>:PATH<ch>:ADELay.
Range: depends on the installed options*
Increment: 10E-9
*RST: 0
*) See Chapter 2.4, "Characteristics of R&S SMW-B14 and
R&S SMW-B15", on page 25.

Example: SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup2:PATH1:STATe 1
SOURce1:FSIMulator:DEL:GROup2:PATH2:BDElay 2E-4
// sets a delay of 200 us for the fading group 2
SOURce1:FSIMulator:DEL:GROup2:PATH2:ADElay 1E-5
// sets an additonal delay
SOURce1:FSIMulator:DEL:GROup2:PATH2:RDELay?
// 0.00021

Usage: Query only

Manual operation: See "Resulting Delay" on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
COEFficient <Coefficient>

Determines the magnitude of the complex correlation coefficient. The higher the
entered percentage, the greater the correlation of the statistical fading processes for
the two paths. Highly correlated ambient conditions for the signal are simulated in this
manner.

Sets the correlation coefficient of the correlated path of the second fader also to the
entered value.

Parameters:
<Coefficient> float

Range: 0  to  100
Increment: 0.1
*RST: 100
Default unit: PCT

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A
to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:COEF 95
specifies a correlation coefficient of 95% for the two paths.

Manual operation: See "Correlation Coefficient" on page 55
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[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
PHASe <Phase>

Determines the phase of the complex correlation coefficient.

Sets the phase of the correlation coefficient of the correlated path of the second fader
also to the entered value.

Parameters:
<Phase> float

Range: 0  to  359.9
Increment: 0.05
*RST: 0
Default unit: DEG

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO2:PATH:CORR:STAT ON
switches on the correlation of fading path 1 of group 2 of fader A
to fading path 1 of group 2 of fader B.
FSIM:DEL:GRO2:PATH:CORR:PHAS 5
specifies a phase of the correlation coefficient equal to 5 DEG
for the two paths.

Manual operation: See "Correlation Coefficient Phase" on page 55

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CORRelation:
STATe <State>

Enables correlation of the paths of the first fader. The suffix in SOURce defines the
fader on which path settings the correlation is based.

When correlation is activated, the settings of the correlation parameters, the profile, the
speed and the lognormal parameters are the same for both paths.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:FSIMulator:DELay:STATe ON
SOURce1:FSIMulator:DELay:GROup2:PATH1:
CORRelation:STATe ON
Enables correlation of fading path 1 of group 2 of fader A to fad-
ing path 1 of group 2 of fader B.

Manual operation: See "Correlation Path" on page 54

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CPHase
<CPhase>

Sets the start phase rotation.
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Parameters:
<CPhase> float

Range: 0  to  359.9
Increment: 0.1
*RST: 0
Default unit: DEG

Example: FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO1:PATH1:PROF RICE
selects the Rice fading profile for fading path 1 of group 1.
FSIM:DEL:GRO1:PATH:CPH 5DEG
sets a start phase rotation of 5 DEG for fading path 1 of group 2.
The path is multiplied by this phase.

Manual operation: See "Const. Phase" on page 52
See "Start Phase" on page 52

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler
<FDoppler>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler[:
RESulting] <FDoppler>

Queries the resulting Doppler frequency for the fading configuration.

The Doppler frequency is determined by the selected speed ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed).

For the Pure Doppler and Rice Fading profiles, the actual Doppler shift is a function of
the selected ratio of the Doppler shift to the Doppler frequency ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio). Use the command [:
SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual? to query the actual Doppler shift.

Delay modes



Remote-control commandsFading Simulation

177User Manual 1175.6826.02 ─ 29

Parameters:
<FDoppler> float

Range: 0  to  max*
Increment: 0.01
*RST: 0
Default unit: Hz
*) Option:
R&S SMW-B14 max = 4000
R&S SMW-B15 max deppends on the System Configuration
LxMxN and profile as follows:
Lx1x1 with L = 1 to 8: max = 4000
1x2x2/2x2x2/2x2x1/2x1x2/3x2x2/4x2x2/1x2x4/1x4x2: max =
4000
1x2x8/1x8x2/1x4x4/2x4x4/2x2x4: max = 2000
1x8x4/1x4x8/2x4x4: max = 600
1x8x8 (subset 1 or 2): max = 300 (R&S SMW-K821)
1x8x8 (all absets): max = 150 (R&S SMW-B15/K75)
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:
PATH<ch>:PROFile BELLindoor|BELVehicle: max = 50

Example: SOURce1:FSIMulator:CONFiguration STAN
SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile RICE
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio 1
SOURce1:FSIMulator:DEL:GROup1:PATH1:FDOPpler:RESulting?
// Response:  2.77968967451476
// set a frequency ratio for the first fading path of group 1. 
// I.e. set an angle of incidence of about 45° with respect to 
// a receiver that is going away from the transmitter
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio -0.71
SOURce1:FSIMulator:DEL:GROup1:PATH1:FDOPpler:RESulting?
// Response:  2.77968967451476
SOURce1:FSIMulator:DELay:GROup1:PATH1:FDOPpler:ACTual?
// Response:  -1.97

Manual operation: See "Resulting Doppler Shift" on page 53

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FDOPpler:
ACTual?

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FDOPpler:
ACTual?

Queries the actual Doppler shift.

For the Pure Doppler and Rice Fading profiles, the actual Doppler shift is a function of
the selected ratio of the Doppler shift to the Doppler frequency ([:SOURce<hw>]:
FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio).
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Return values: 
<ActDoppler> float

Range: -4000.0  to  4000
Increment: 0.01
*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:DELay|DEL:
GROup<st>:PATH<ch>:FDOPpler[:RESulting]
on page 176

Usage: Query only

Manual operation: See "Actual Doppler Shift" on page 54

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:FRATio
<FRatio>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FRATio <FRatio>
For Rice, pure Doppler and Gauss Doppler fading, sets the ratio of the actual Doppler
frequency to the set Doppler frequency. The Frequency Ratio serves as a measure of
the angle of incidence between the transmitter and receiver.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:DELay|DEL:
GROup<st>:PATH<ch>:FDOPpler[:RESulting]
on page 176

Manual operation: See "Frequency Ratio" on page 53

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSHift <FShift>

Sets the frequency shift for the Gauss Watterson fading.

Parameters:
<FShift> float

Range: -10  to  10
Increment: 0.0001
*RST: 0

Example: FSIM:DEL:GRO:PATH2:PROF WATT
FSIM:DEL:GRO:PATH2:FS?

Manual operation: See "Frequency Shift" on page 52
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[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:FSPRead
<FSpread>

Sets the frequency spread for the Gauss Watterson fading.

Parameters:
<FSpread> float

Range: 1E-4  to  30
Increment: 1E-4
*RST: 0.1

Example: FSIM:DEL:GRO:PATH2:PROF WATT
FSIM:DEL:GRO:PATH2:FSPR?

Manual operation: See "Frequency Spread" on page 51

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
CSTD <Cstd>

Sets the standard deviation for lognormal fading.

Parameters:
<Cstd> integer

Range: 0  to  12
*RST: 0
Default unit: dB

Example: FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:CSTD 2
sets a standard deviation of 2 dB for fading path 2 of group 1.

Manual operation: See "Standard Deviation " on page 56

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
LCONstant <LConstant>

Sets the Local Constant for lognormal fading.

Parameters:
<LConstant> float

Range: 0  to  200
Increment: 0.1
*RST: 100
Default unit: m
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Example: FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
selects lognormal fading for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:LOGN:LCON 100
sets a Local Constant of 100 m for the second fading path of
group 1.

Manual operation: See "Local Constant" on page 55

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOGNormal:
STATe <State>

Enables/ disables a lognormal fading.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:LOGN:STAT ON
activates lognormal fading for fading path 2 of group 1.

Manual operation: See "Lognormal State" on page 55

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:LOSS <Loss>
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:LOSS <Loss>
Sets the loss of the paths.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 10|0
Default unit: dB

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:LOSS 2 dB
sets a loss of 2 dB for fading path 2 of group 1.

Manual operation: See "Path Loss" on page 50

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PRATio <PRatio>

Sets the power ratio of the discrete and distributed components for Rice fading
(:SOURce:FSIMulator:DELay:GROup:PATH2:PROFile RICE).
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Parameters:
<PRatio> float

Range: -30  to  30
Increment: 0.01
*RST: 0
Default unit: dB

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:PROF RICE
sets the Rice fading profile for fading path 2 of group 1.
FSIM:DEL:GRO:PATH2:PRAT -15
sets a power ratio of –15 dB. The distributed (Rayleigh) compo-
nent prevails. The total power of the two components remains
constant.

Manual operation: See "Power Ratio" on page 51

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:PROFile
<Profile>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:PROFile <Profile>
Selects the fading profile for the paths.

Parameters:
<Profile> SPATh | RAYLeigh | PDOPpler | RICE | CPHase | OGAUs |

TGAUs | DGAUs | WDOPpler | WRICe | GDOPpler | GFD8 |
GFD1 | WATTerson | CUSTom | SCM | BELLindoor | BELVehicle
SPAT
static transmission path
PDOPpler | RAYLeigh | RICE | CUSTom | SCM
pure Doppler | Rayleigh | Rice | Custom | SCM
CPHase
constant phase
OGAUs | TGAUs | DGAUs | GDOPpler | GFD8 | GFD1
GAUS1 | GAUS2 | GAUSDAB | Gauss Doppler | Gauss (0.08 fd)
| Gauss (0.01 fd)

WATTerson
Gauss (Watterson)
WDOPpler | WRICe
WiMAX Doppler | WiMAX Rice
BELLindoor|BELVehicle
Bell Shape tgn Indoor, Bell Shape tgn Moving Vehicle
*RST: RAYLeigh

Options: OGAUs|TGAUs|DGAUs|GDOPpler|GFD8|GFD1|WATTerson|
WDOPpler|WRICe require R&S SMW-K72
SCM require R&S SMW-K73
CUSTom require R&S SMW-K820
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Manual operation: See "Profile" on page 49

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:SPEed
<Speed>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:SPEed <Speed>
Sets the speed v of the moving receiver.

Parameters:
<Speed> float

Range: 0  to  dynamic
Increment: 0.001
*RST: 0.83333

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:SPE 2MPS
sets a speed of 2 m/s for the moving receiver for fading path 2 of
group 1.

Manual operation: See "Speed" on page 52

[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:STATe
<State>

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:STATe <State>
Activates the selected path.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration.
FSIM:DEL:GRO:PATH2:STAT ON
Activates fading path 2 in group 1.

Manual operation: See "State Path" on page 48

[:SOURce<hw>]:FSIMulator:DELay|DEL:STATe <State>

Activates the fading configurations.

Note: Changing the configuration will cause an interruption in the fading process, fol-
lowed by a restart after about one second.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: FSIM:DEL:STAT ON
Activates the "Standard Delay" fading configuration for fader A
and switches on fading for path A.
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6.3  Birth death

Option: R&S SMW-K71

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID...................................................... 183
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum.................................................183
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum?..............................................183
[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl.................................................184
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS................................................ 184
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile.............................................184
[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions...........................................................185
[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset............................................................ 185
[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed............................................................... 185
[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio.............................................................. 186
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler?.........................................186
[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?............................. 187
[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe................................................................187

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:GRID <Grid>

Sets the delay grid for both paths with birth death propagation fading.

Parameters:
<Grid> float

Range: 1E-9  to  dynamic
Increment: 1E-9
*RST: 1E-6

Example: FSIM:BIRT:DEL:GRID 0.00001
Sets a delay grid of 10 us.

Manual operation: See "Delay Grid" on page 60

[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MINimum <Minimum>
[:SOURce<hw>]:FSIMulator:BIRThdeath:DELay:MAXimum?
Queries the minimum/maximum delay for both paths with birth death propagation fad-
ing.

Return values: 
<Maximum> float

Range: 0  to  max
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Example: FSIM:BIRT:DEL:MIN 0.000012
Sets a minimum delay of 12 us.
FSIM:BIRT:DEL:GRID 0.000002
sets a delay grid of 2 us.
FSIM:BIRT:POS 9
sets 9 possible hop positions.
FSIM:BIRT:DEL:MAX?
queries the maximum delay.
Response: 0.000028
the maximum delay is 28 us. The delay range lies between +12
and +28 us. There are 9 hop positions on a 2 us grid available.

Usage: Query only

Manual operation: See "Maximum Delay" on page 61

[:SOURce<hw>]:FSIMulator:BIRThdeath:HOPPing:DWELl <Dwell>

Sets the time until the next change in the delay of a path (birth death event).

Parameters:
<Dwell> float

Range: 1E-3  to  429.49672950
Increment: 100E-9
*RST: 191E-3

Example: FSIM:BIRT:HOPP:DWEL 210 ms
Sets a dwell time of 210 ms until the next change in the delay of
a fading path.

Manual operation: See "Hopping Dwell" on page 61

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:LOSS <Loss>

Sets the loss of the paths with birth death propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0
Default unit: dB

Example: FSIM:BIRT:PATH2:LOSS 4 dB
Sets a loss of 4 dB for the second fading path.

Manual operation: See "Path Loss" on page 60

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:PROFile <Profile>

This command queries the fading profile. In birth death propagation, the pure Doppler
profile is used.
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Parameters:
<Profile> PDOPpler

*RST: PDOPpler

Example: FSIM:BIRT:PATH2:PROF?
Queries the profile of the second fading path.

Manual operation: See "Profile" on page 60

[:SOURce<hw>]:FSIMulator:BIRThdeath:POSitions <Positions>

Sets the number of possible hop positions in the delay range.

0 us < (...:BIRT:POS – 1) x ...:DEL:GRID + ...:DEL:MIN < 40 us

Parameters:
<Positions> integer

Range: 3  to  50
*RST: 11

Example: FSIM:BIRT:POS 11
Sets 11 possible delay positions.

Manual operation: See "Positions" on page 60

[:SOURce<hw>]:FSIMulator:BIRThdeath:SOFFset <Soffset>

Sets the time until the start of the next birth death event. With dual-channel fading, this
allows the user to intentionally displace the birth death events of the two faders with
respect to one another.

Parameters:
<Soffset> float

Range: 0  to  429
Increment: 100E-9
*RST: 0

Example: FSIM:BIRT:SOFF 21E-6
Sets a start offset of 21 us.

Manual operation: See "Start Offset" on page 61

[:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed <Speed>

Sets the speed of the moving receiver for birth death propagation.

The default speed unit is m/s. Units different than the default one must be specified.
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Parameters:
<Speed> float

Range: 0  to  dynamic
Increment: 0.001
*RST: 0
Default unit: m/s

Example: SOURce1:FSIMulator:BIRThdeath:SPEed 100 KMH
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler?
// 92.6574343641427
SOURce1:FSIMulator:BIRThdeath:FRATio 1
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler:ACTual?
// 92.66
SOURce1:FSIMulator:BIRThdeath:FRATio 0.5
SOURce1:FSIMulator:BIRThdeath:PATH1:FDOPpler:ACTual?
// 46.33

Manual operation: See "Speed" on page 62

[:SOURce<hw>]:FSIMulator:BIRThdeath:FRATio <FRatio>

Sets the ratio of the actual Doppler frequency to the set Doppler frequency with birth
death propagation fading.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 1

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 185

Manual operation: See "Frequency Ratio" on page 62

[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler?

Queries the resulting Doppler frequency with birth death propagation.

Return values: 
<FDoppler> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 185

Usage: Query only

Manual operation: See "Resulting Doppler Shift" on page 62
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[:SOURce<hw>]:FSIMulator:BIRThdeath:PATH<ch>:FDOPpler:ACTual?

Queries the actuial Doppler frequency.

Return values: 
<ActDoppler> float

Range: -1600  to  1600
Increment: 0.01
*RST: 0

Example: See [:SOURce<hw>]:FSIMulator:BIRThdeath:SPEed
on page 185

Usage: Query only

Manual operation: See "Actual Doppler Shift" on page 63

[:SOURce<hw>]:FSIMulator:BIRThdeath:STATe <State>

This command selects the birth death propagation fading configuration and switches
the fading simulation on and off.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOUR2:FSIM:BIRT:STAT ON
Selects birth death propagation for fader B and switches on fad-
ing in path B.

Manual operation: See "Configuration" on page 31

6.4  High-speed train

Option: R&S SMW-K71.

Example: Enabling and configuring a high-speed train propagation
The following is an example of how to configure the settings without using a predefined
standard.

SOURce1:FSIMulator:CONFiguration HSTRain
SOURce1:FSIMulator:HSTRain:PROFile PDOPpler
SOURce1:FSIMulator:HSTRain:SPEed 100kmh
SOURce1:FSIMulator:HSTRain:FDOPpler?
// Response in Hz: "92.657"
SOURce1:FSIMulator:HSTRain:DISTance:MINimum 20m
SOURce1:FSIMulator:HSTRain:DISTance:STARt 2000m
SOURce1:FSIMulator:HSTRain:PATH:STATe ON 
SOURce1:FSIMulator:HSTRain:STATe ON
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Example: Querying doppler shifts for high-speed train profiles
The following is an example of how to configure the settings without using a predefined
standard.

SOURce1:FSIMulator:CONFiguration HSTRain
// Set static path profile.
SOURce1:FSIMulator:HSTRain:PROFile SPATh
SOURce1:FSIMulator:HSTRain:SPEed 4300kmh
SOURce1:FSIMulator:HSTRain:SPEed?
// Response in m/s: "1199.17"
SOURce1:FSIMulator:HSTRain:FDOPpler?
// Response in Hz: "4000"

// Set pure Doppler profile.
SOURce1:FSIMulator:HSTRain:PROFile PDOPpler
SOURce1:FSIMulator:HSTRain:SPEed 205058kmh
SOURce1:FSIMulator:HSTRain:SPEed?
// Response in m/s: "56960.567"
SOURce1:FSIMulator:HSTRain:FDOPpler?
// Response in Hz: "190000"
Pure Doppler profile offers Doppler shifts of up to 190 kHz.

Example: Configuring a high-speed train scenario for BS tests
The following is an example of how to configure fading simulator to generate an HST
BS test signal according to 3GPP TS36.104.
For frequency Band 1 tests, the specification defines:
FDL = 2.14 GHz, FUL = 1.95 GHz and FD = 1140 Hz

SOURce1:FSIMulator:PRESet
SOURce1:FSIMulator:STANdard G3HST1OSDU
SOURce1:FREQuency:CW 1.95E9
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe ON
SOURce1:FSIMulator:HSTRain:DOWNlink:FREQuency 2.14E9
SOURce1:FSIMulator:HSTRain:SOFFSet 0
SOURce1:FSIMulator:HSTRain:PATH:STATe ON 
SOURce1:FSIMulator:HSTRain:STATe ON
SOURce1:FSIMulator:HSTRain:FDOPpler?
// Response in Hz: 1136.893

Commands

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum................................................ 189
[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt.....................................................189
[:SOURce<hw>]:FSIMulator:HSTRain:SPEed................................................................... 189
[:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler?.............................................................190
[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe...........................................................190
[:SOURce<hw>]:FSIMulator:HSTRain:PROFile.................................................................190
[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor.................................................................190
[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe................................. 191
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[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency............................................191
[:SOURce<hw>]:FSIMulator:HSTRain:SOFFset................................................................ 191
[:SOURce<hw>]:FSIMulator:HSTRain:STATe....................................................................192

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:MINimum <Minimum>

Sets the parameter Dmin, i.e. the distance between the BS and the railway track.

Parameters:
<Minimum> float

Range: 1  to  100
Increment: 0.1
*RST: 2

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187

Manual operation: See "D (min)" on page 86

[:SOURce<hw>]:FSIMulator:HSTRain:DISTance:STARt <Start>

Sets the parameter DS, i.e. the initial distance DS/2 between the train and the BS at the
beginning of the simulation.

Parameters:
<Start> integer

Range: 20  to  2000
*RST: 300

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187

Manual operation: See "D (S)" on page 86

[:SOURce<hw>]:FSIMulator:HSTRain:SPEed <Speed>

Sets the velocity parameter , i.e. the speed of the moving receiver in m/s.

Parameters:
<Speed> float

Range: 0.001  to  depends on settings
Increment: 0.001
*RST: 83.333

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187.

Example: See Example"Querying doppler shifts for high-speed train pro-
files" on page 188.

Manual operation: See "Speed" on page 86
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[:SOURce<hw>]:FSIMulator:HSTRain:FDOPpler?

Queries the maximum Doppler Shift for the selected configuration.

Return values: 
<FDoppler> float

Range: 0  to  depends on settings
Increment: 0.01
*RST: 0

Example: See Example"Querying doppler shifts for high-speed train pro-
files" on page 188.

Usage: Query only

[:SOURce<hw>]:FSIMulator:HSTRain:PATH:STATe <State>

Activates/deactivates the selected path for the High Speed Train fading configurations.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187

Manual operation: See "State Path" on page 48

[:SOURce<hw>]:FSIMulator:HSTRain:PROFile <Profile>

Determines the fading profile for the selected scenario. The fading profile determines
which transmission path is simulated.

Parameters:
<Profile> SPATh | PDOPpler | RAYLeigh

*RST: PDOPpler

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187

Manual operation: See "Profile" on page 85

[:SOURce<hw>]:FSIMulator:HSTRain:KFACtor <KFactor>

Sets the Rician factor K for high speed train scenario 2.

Parameters:
<KFactor> float

Range: -30  to  30
Increment: 0.01
*RST: 10
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Example: SOURce1:FSIMulator:PRESet
SOURce1:FSIMulator:STANdard G3HST2TLC
SOURce1:FSIMulator:HSTRain:KFACtor 10

Manual operation: See "K (Rician factor)" on page 86

[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency:STATe
<HstDlFreqState>

Enables the definition of virtual downlink frequency.

Parameters:
<HstDlFreqState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring a high-speed train scenario for BS
tests" on page 188

Manual operation: See "Consider DL RF" on page 86

[:SOURce<hw>]:FSIMulator:HSTRain:DOWNlink:FREQuency <HstDlFreq>

Sets the virtual downlink frequency, necessary to calculate the UL Doppler shift.

Parameters:
<HstDlFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 1E9

Example: See Example"Configuring a high-speed train scenario for BS
tests" on page 188

Manual operation: See "Virtual DL RF" on page 87

[:SOURce<hw>]:FSIMulator:HSTRain:SOFFset <StartOffset>

Shifts the high speed train profile in time.

The maximum possible shift is calculated as max = 2*DS/v ,where:
● DS is the distance in meters between the train and the BS at the beginning of the

simulation
● v is the velocity of the train in m/s

Parameters:
<StartOffset> float

Range: 0  to  429.49672950
Increment: 100E-9
*RST: 0

Example: See Example"Configuring a high-speed train scenario for BS
tests" on page 188.
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Manual operation: See "Start Offset" on page 87

[:SOURce<hw>]:FSIMulator:HSTRain:STATe <State>

Activates/deactivates simulation of High Speed Train propagation according to the
selected scenario 1 or 3.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Enabling and configuring a high-speed train prop-
agation" on page 187

Manual operation: See "Configuration" on page 31
See "State" on page 85

6.5  Moving propagation

Option: R&S SMW-K71.

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod..............................................192
[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation..................................193
[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE......................................................193
[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase.....................194
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN............................................. 194
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation.........................................194
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS.........................................................195
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe........................................................ 195
[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod.................................................... 195
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay...................................................196
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS....................................................196
[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe................................................... 196
[:SOURce<hw>]:FSIMulator:MDELay:STATe.....................................................................197

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:VPERiod <VPeriod>

Sets the speed of the delay variation of the moving fading paths for moving propaga-
tion with all moving channels. A complete cycle comprises one pass through this "Var-
iation Period".

Parameters:
<VPeriod> float

Range: 5  to  200
Increment: 0.1
*RST: 25
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Example: FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
FSIM:MDEL:ALL:MOV:VPER 50 s
sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 71

[:SOURce<hw>]:FSIMulator:MDELay:ALL:MOVing:DELay:VARiation <Variation>

This command enters the range for the delay of the moving fading paths for moving
propagation with all moving channels. The delay of the moving path slowly varies
sinusoidally within this range.

Parameters:
<Variation> float

Range: 0.3E-6  to  10E-6
Increment: 10E-9
*RST: 5E-6

Example: FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.
FSIM:MDEL:STAT ON
activates the moving propagation for fader A.
FSIM:MDEL:ALL:MOV:DEL:VAR 1E-5
sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Delay Variation (Peak-Peak)" on page 71

[:SOURce<hw>]:FSIMulator:MDELay:CHANnel:MODE <Mode>

Determines whether only one or several moving channels are simulated.

Parameters:
<Mode> ONE | ALL

*RST: ONE

Example: FSIM:CONF MDEL
Selects a moving propagation configuration.
FSIM:MDEL:CHAN:MODE ALL
enables all moving channels.

Manual operation: See "Moving Channels" on page 34
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[:SOURce<hw>]:FSIMulator:MDELay:DEL30:GROup<st>:PATH<ch>:CPHase
<CPhase>

These commands determine the phase for constant phase fading for the "Standard
Delay", and "Moving Propagation All Moving Channels" fading configurations.

Parameters:
<CPhase> float

Range: 0  to  359.9
Increment: 0.1
*RST: 0

Example: FSIM:DEL:STAT ON
Activates the Standard Delay fading configuration.
FSIM:DEL:GRO2:PATH:PROF CPH
selects the Constant Phase fading profile for fading path 1 of
group 2.
FSIM:DEL:GRO2:PATH:CPH 5DEG
sets a phase of 5 DEG for fading path 1 of group 2. The path is
multiplied by this phase.

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:MEAN <Mean>

Sets the mean delay of the moving fading path for moving propagation.

Parameters:
<Mean> float

Range: 0  to  40E-6
Increment: 10E-9
*RST: 3.5E-6

Example: FSIM:MDEL:STAT ON
Sets moving propagation.
FSIM:MDEL:MOV:DEL:VAR 1E-5
sets the range 10 us (+/- 5 us) for the variation of the delay of
the moving fading path.
FSIM:MDEL:MOV:DEL:MEAN 9E-6
sets the mean delay of the moving path to 9 us.
FSIM:MDEL:MOV:VPER 105
sets a period of 105 s for the sinusoidal variation of the delay of
the moving path. The delay of the moving path now varies once
sinusoidal in 105 s between 4 us and 14 us.

Manual operation: See "Delay" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:DELay:VARiation <Variation>

Enters the range for the delay of the moving fading path for moving propagation. The
delay of the moving path slowly varies sinusoidal within this range.

Moving propagation
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Parameters:
<Variation> float

Range: 0.3E-6  to  dynamic
Increment: 10E-9
*RST: 5E-6

Example: FSIM:MDEL:MOV:DEL:VAR 1E-5
Sets the range 10 us for the delay of the moving fading path.

Manual operation: See "Variation (Peak-Peak)" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:LOSS <Loss>

Sets the insertion loss of the moving path for moving propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0

Example: FSIM:MDEL:MOV:LOSS 12 dB
Sets the loss for the moving fading path.

Manual operation: See "Path Loss" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:STATe <State>

This command activates the moving fading path for moving propagation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: FSIM:MDEL:STAT ON
Sets moving propagation.
FSIM:MDEL:MOV:STAT ON
activates the moving path for moving propagation.

Manual operation: See "State" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:MOVing:VPERiod <VPeriod>

This command sets the speed of the delay variation of the moving fading path for mov-
ing propagation. A complete cycle comprises one pass through this "Variation Period".

Parameters:
<VPeriod> float

Range: 10  to  500
Increment: 0.1
*RST: 157
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Example: FSIM:MDEL:MOV:VPER 100 s
Sets the period for the delay variation to 100 s.

Manual operation: See "Variation Period" on page 70

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:DELay <Delay>

This command enters the delay of the reference path for moving propagation.

Parameters:
<Delay> float

Range: 0  to  40E-6
Increment: 10E-9
*RST: 0

Example: FSIM:MDEL:REF:DEL 1E-5
Sets the range to 10 us for the delay of the reference path.

Manual operation: See "Delay" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:LOSS <Loss>

Sets the loss of the reference path for moving propagation.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.001
*RST: 0

Example: FSIM:MDEL:REF:LOSS 12 dB
Sets the insertion loss for the reference path.

Manual operation: See "Path Loss" on page 69

[:SOURce<hw>]:FSIMulator:MDELay:REFerence:STATe <State>

This command activates the reference path for moving propagation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: FSIM:MDEL:STAT ON
Sets moving propagation.
FSIM:MDEL:REF:STAT ON
activates the reference path for moving propagation.

Manual operation: See "State" on page 69

Moving propagation



Remote-control commandsFading Simulation

197User Manual 1175.6826.02 ─ 29

[:SOURce<hw>]:FSIMulator:MDELay:STATe <State>

This command activates the moving propagation fading configuration. The paths and
the fading simulator must be switched on separately
(SOURce:FSIMulator:MDELay:MOVing|REFerence:STATe ON and
SOURce:FSIMulator ON).

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: FSIM:MDEL:STAT ON
Sets moving propagation for fader A.

Manual operation: See "Configuration" on page 31

6.6  MIMO settings

The MIMO configurations require additional options:
● For up to 2x2 MIMO configurations, 2x option R&S SMW-B14/B15 and R&S SMW-

K74
● The LxMxN MIMO configurations with M > 2 or N > 2 require 4xR&S SMW-

B14/B15 and R&S SMW-K74
● Higher-order MIMO configurations require R&S SMW-K75
● Multi entity LxMxN configurations with L > 2 require also R&S SMW-K76

The options above apply to all commands in this section. If further options are required,
there are listed in the corresponding command.

Example: Enabling an 1x8x8 MIMO configuration with two R&S SMW
In the following, we assume that the two R&S SMW are connected and configured as
required.
The example uses R&S SGS as RF extensions and the internal baseband signal of the
first R&S SMW as trigger source for both instruments. If you use common external trig-
ger source, consider to adapt the proposed configuration.

*RST
// Select 8x8 MIMO and set MIMO subset.
SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO8X8 
SCONfiguration:MIMO:SUBSet SET1

SCONfiguration:APPLy
// The instrument generates streams A to D.
// Configure connectors for synchronous baseband triggering.
// Alternatively, use an external common trigger source.
SOURce1:INPut:USER6:DIRection OUTP
OUTPut1:USER6:SIGNal MTR
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// Configure the fading simulator.
// Enable synchronization of the fading process to the baseband trigger.
SOURce1:FSIMulator:RESTart:MODE BBTR
SOURce1:FSIMulator:STATe 1

// Configure the baseband signal incl. trigger settings. 
// Synchronize baseband triggering for an external common trigger source.
// Adapt configuratiom.
SOURce1:BB:EUTRa:TRIGger:SEQuence ARET
SOURce1:BB:EUTRa:TRIGger:SOURce EGT1
SOURce1:BB:EUTRa:STATe 1

// Set frequency and level of the RF signal.
SOURce1:FREQuency:CW 1950000000
SOURce2:FREQuency:CW 1950000000
SOURce1:POWer:POWer -50
SOURce2:POWer:POWer -50
// Connect and configure the RF extensions, for example, R&S SGS.
SOURce1:IQ:OUTPut:ANALog:STATe 1
SOURce2:IQ:OUTPut:ANALog:STATe 1

// Activate the IQ and RF outputs.
SOURce2:IQ:STATe 1
SOURce1:IQ:STATe 1
OUTPut2:STATe 1
OUTPut1:STATe 1

// Save the configuration.
*SAV 1
MMEMory:STORe:STATe 1,"/var/user/8x8_MIMO_Subset1.savrcl.txt"

// Transfer to file to the second instrument
// Load the configuration and change the subset.
SCONfiguration:MIMO:SUBSet SET2

// Trigger the baseband signal generation and hence the fading process.
OUTPut1:USER6:TRIGger:IMMediate

Commands

[:SOURce<hw>]:FSIMulator:MIMO:CAPability?.................................................................199
[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT...............................................................199
[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL..................................................................199
[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious.........................................................200
[:SOURce<hw>]:FSIMulator:MIMO:MDLoad..................................................................... 200
[:SOURce<hw>]:FSIMulator:MIMO:MDSTore....................................................................200
[:SOURce<hw>]:FSIMulator:MIMO:TAP........................................................................... 200
[:SOURce<hw>]:FSIMulator:MIMO:SUBSet......................................................................200
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:

COLumn<st>:IMAGinary.......................................................................................201
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:

COLumn<st>:IMAGinary.......................................................................................201
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
COLumn<st>:PHASe........................................................................................... 201

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:
COLumn<st>:PHASe........................................................................................... 201

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
COLumn<st>:MAGNitude..................................................................................... 202

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:
COLumn<st>:MAGNitude..................................................................................... 202

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:ROW<di>:
COLumn<st>:REAL............................................................................................. 202

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:ROW<di>:
COLumn<st>:REAL............................................................................................. 202

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept............................................202
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict?........................................ 203
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE............................................. 203
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:PHASe......... 203
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:MAGNitude... 204
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet..........................................204
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN....................................... 204
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASe.....................................205

[:SOURce<hw>]:FSIMulator:MIMO:CAPability?

Queries the supported MIMO configurations.

Return values: 
<MimoCapability> string

Example: :SOURce1:FSIMulator:MIMO:CAPability?
Response: "M2X2,M2X4,M4X2,M2X3,M3X2,M1X2,..."

Usage: Query only

[:SOURce<hw>]:FSIMulator:MIMO:COPY:NEXT

Copies the matrix values of the current tap to the subsequent tap. If the current tap is
the last tap, the command is discarded.

See also [:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL on page 199.

Usage: Event

Manual operation: See "Copy To Next" on page 103

[:SOURce<hw>]:FSIMulator:MIMO:COPY:ALL

Applies the matrix values of the current tap to all taps.

Usage: Event

Manual operation: See "Copy To All" on page 103
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[:SOURce<hw>]:FSIMulator:MIMO:COPY:PREVious

This command copies the matrix values of the current tap to the next lower tap.

Example: FSIM:MIMO:COPY:PREV
Copies the settings of the current tap to the next lower tap.

Usage: Event

Manual operation: See "Copy To Prev" on page 103

[:SOURce<hw>]:FSIMulator:MIMO:MDLoad <MDLoad>

Loads file with saved MIMO settings.

Setting parameters: 
<MDLoad> string

Example: FSIM:MIMO:MDL 'MIMO_Settings'
Loads the settings file.

Usage: Setting only

[:SOURce<hw>]:FSIMulator:MIMO:MDSTore <MDStore>

Saves the MIMO settings in a file.

Setting parameters: 
<MDStore> string

Example: FSIM:MIMO:MDST 'MIMO_Settings'
Saves the MIMO settings in a file.

Usage: Setting only

[:SOURce<hw>]:FSIMulator:MIMO:TAP <Tap>

Sets the current tap.

Parameters:
<Tap> TAP1 | TAP2 | TAP3 | TAP4 | TAP5 | TAP6 | TAP7 | TAP8 |

TAP9 | TAP10 | TAP11 | TAP12 | TAP13 | TAP14 | TAP15 |
TAP16 | TAP17 | TAP18 | TAP19 | TAP20
*RST: TAP1

Example: SORce1:FSIMulator:MIMO:TAP TAP15
Manual operation: See "Current Path (Tap) #" on page 103

[:SOURce<hw>]:FSIMulator:MIMO:SUBSet <Subset>

In 8x8 or 4x4 MIMO configuration with higher fading bandwidth, sets the subset of
MIMO channels that is calculated by the particular R&S SMW.
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Parameters:
<Subset> SET2 | SET1 | ALL

*RST: SET1 (R&S SMW-B10)/ALL(R&S SMW-B9)

Example: See Example"Enabling an 1x8x8 MIMO configuration with two
R&S SMW" on page 197.

Options: ALL requires R&S SMW-B9
SET2|SET1 requires R&S SMW-K821/K822.

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:IMAGinary <Imaginary>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:IMAGinary <Imaginary>

Sets the value for the imaginary part of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase
value is set to 0 when changing the data format.

Parameters:
<Imaginary> float

Range: -1  to  1
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:IMAGinary 0.5
Sets the imaginary part of the Tx correlation AB to 0.5.

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 109

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:PHASe <Phase>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:PHASe <Phase>

Sets the value for the phase of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase
value is set to 0 when changing the data format.

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:PHASe 30
Sets the phase of the Tx correlation AB to 30 degrees.

Manual operation: See "Tx Correlation Coefficients, Phase/Imag" on page 109

MIMO settings



Remote-control commandsFading Simulation

202User Manual 1175.6826.02 ─ 29

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:MAGNitude <Magnitude>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:MAGNitude <Magnitude>

Sets the ratio of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase
value is set to 0 when changing the data format.

Parameters:
<Magnitude> float

Range: 0  to  1
Increment: 1E-4
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:MAGNitude 0.5
Sets the ratio of the Tx correlation AB to 0.5.

Manual operation: See "Tx Correlation Coefficients, Magnitude/Real" on page 109

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:RX:
ROW<di>:COLumn<st>:REAL <Real>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:KRONecker:CORRelation:TX:
ROW<di>:COLumn<st>:REAL <Real>

Sets the value for the real part of the receiver/transmitter correlation.

Note: If the values for the real part and the imaginary part are both set to 0, the phase
value is set to 0 when changing the data format.

Parameters:
<Real> float

Range: -1  to  1
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:KRONecker:
CORRelation:TX:ROW1:COLumn2:REAL 0.5
Sets the value for the real part of the Tx correlation AB to 0.5.

Manual operation: See "Tx Correlation Coefficients, Magnitude/Real" on page 109

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ACCept

Accepts the values for the phase/imaginary and the real/ration part of the correlation.

Example: FSIM:MIMO:TAP2:MATR:ACC
Usage: Event

Options: R&S SMW-K71/-K74

Manual operation: See "Accept" on page 106
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:CONFlict?

Queries whether there is a matrix conflict or not.

Return values: 
<Conflict> 1 | ON | 0 | OFF

Example: FSIM:MIMO:TAP2:MATR:CONF?
Queries whether there is a matrix conflict or not

Usage: Query only

Options: R&S SMW-K71/-K74

Manual operation: See "Conflict" on page 106

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:MODE <Mode>

Sets the input mode for the Rx and Tx correlation values (matrix mode).

Parameters:
<Mode> INDividual | KRONecker | AOAaod | SCWI

*RST: INDividual

Example: FSIM:MIMO:TAP2:MATR:MODE IND
Selects the matrix mode individual.

Options: R&S SMW-K71/-K74

Manual operation: See "Matrix Mode" on page 103

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
PHASe <Phase>

Sets the value for the phase/imaginary part of the correlation.

Suffix: 
<di>

.
1 to 4

<st> 1 to 4

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: FSIM:MIMO:TAP2:MATR:ROW1:COL1:PHAS 90
Sets the correlation value to the specified value.

Options: R&S SMW-K71/-K74

Manual operation: See "Phase/Imag" on page 106
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:MATRix:ROW<di>:COLumn<st>:
MAGNitude <Magnitude>

Determines the value for the real/magnitude part of the correlation.

Suffix: 
<di>

.
1 to 4

<st> 1 to 4

Parameters:
<Magnitude> float

Range: 0  to  1
Increment: 0.0001
*RST: 1

Example: FSIM:MIMO:TAP2:MATR:ROW1:COL1:MAGN 0.5
Sets the correlation value to the specified value.

Options: R&S SMW-K71/-K74

Manual operation: See "Real/Magnitude" on page 106

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor:PRESet

The command presets the vector matrix to an unitary matrix.

Example: FSIM:MIMO:TAP2:GVEC:PRES
Resets the gain vector matrix.

Usage: Event

Manual operation: See "Set to Unity" on page 107

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:GAIN <Gain>

Sets the relative gain in the selected path.

Suffix: 
<st>

.
1 to 8

Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.01
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:GVECtor1:GAIN -3
Decreases the level in path AA by 3 dB.

Manual operation: See "Gain" on page 108
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[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:GVECtor<st>:PHASe <Phase>

Sets the phase shift of the selected path.

Suffix: 
<st>

.
1 to 8

Parameters:
<Phase> float

Range: 0  to  360
Increment: 0.02
*RST: 0

Example: SOURce1:FSIMulator:MIMO:TAP2:GVECtor1:PHASe 45
Shifts the phase in path AA by 45 degree.

Options: R&S SMW-K820

Manual operation: See "Phase" on page 108

6.7  TGn settings

Option: R&S SMW-K74.

Example: Simulating one path TGn fading with two rays with different distribu-
tions
In the following example we assume that a MIMO fading configuration is enabled, e.g
2x2 MIMO. One MIMO path is activated, the default path settings are used.

// ******************************************************************
// Enable the corresponding matrix mode and set the relevant SCM settings
// ******************************************************************

SOURce:FSIMulator:MIMO:TAP:MATRix:MODE AOAaod
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX 0.5
SOURce:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX 0.5

// ******************************************************************
// Set ray#1 to simulate signal scattered by 
// obstacles causing static fading distribution, e.g. a building
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:GAIN 0
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:ARRival:ANGLe 72
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:ARRival:SPRead 5
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:DEParture:ANGLe 15
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:DEParture:SPRead 3
SOURce:FSIMulator:MIMO:TAP:TGN:DISTribution EQUal
SOURce:FSIMulator:MIMO:TAP:TGN:RAY1:STATe ON

// ******************************************************************
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// Set ray#2 to simulate signal scattered by 
// obstacles causing Gaussian fading distribution, e.g. a tree 
// ******************************************************************
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:GAIN -10
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:ARRival:ANGLe 23
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:ARRival:SPRead 7
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:DEParture:ANGLe 25
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:DEParture:SPRead 5
SOURce:FSIMulator:MIMO:TAP:TGN:DISTribution GAUSs
SOURce:FSIMulator:MIMO:TAP:TGN:RAY2:STATe ON

// ******************************************************************
// Query the resulting matrix correlation coefficients with the 
// SOURce:FSIMulator:MIMO:TAP:MATRix:... commands
// ******************************************************************

Commands

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX........................................ 206
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX........................................ 206
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution..........................................206
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe.......................207
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLe................... 207
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead..................... 207
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead..................207
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN...................................... 207
[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe.....................................208

[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:RX <DistanceRx>
[:SOURce<hw>]:FSIMulator:MIMO:TGN:ANTenna:DISTance:TX <DistanceTx>
Sets the RX/TX antenna distance in the SCM fading model.

Parameters:
<DistanceTx> float

Range: 0.1  to  2
Increment: 0.1
*RST: 0.5

Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "RX/TX Antenna Distance" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:DISTribution <Distribution>

Selects one of the proposed statistical functions to determine the distribution of the
selected cluster.

Parameters:
<Distribution> LAPLace | GAUSs | EQUal

*RST: EQUal
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Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "Distribution" on page 112

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:ANGLe
<ArrAngle>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:ANGLe
<DepAngle>

Sets the AoA (Angle of Arrival) / AoD (Angle of Departure) of the selected ray.

Parameters:
<DepAngle> float

Range: 0  to  359.999
Increment: 0.001
*RST: 0

Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "Angle of Departure (AoD)" on page 112

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:ARRival:SPRead
<ArrSpread>

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:DEParture:SPRead
<DepSpread>

Sets the AoD (Angle of Departure) / AoA (Angle of Arrival) spread (AS) of the selected
ray.

Parameters:
<DepSpread> float

Range: 0.1  to  75
Increment: 0.001
*RST: 0.1

Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "AoD Spread" on page 112

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:GAIN <Gain>

Sets the relative gain (in dB) of the selected ray.

Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0
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Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "Relative Gain /dB" on page 111

[:SOURce<hw>]:FSIMulator:MIMO:TAP<ch>:TGN:RAY<st>:STATe <RayState>

Enables/disables the selected ray.

Parameters:
<RayState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Simulating one path TGn fading with two rays with
different distributions" on page 205.

Manual operation: See "Ray State" on page 111

6.8  SCME/WINNER and antenna model settings

Option: R&S SMW-K72/-K73.

Example: Configuring the settings in SCME/WINNER mode
The following is a simple example of how to configure the settings.
You can also load the configuration of predefined SCME models automatically, see:
● Chapter A.16, "SCM and SCME channel models for MIMO OTA", on page 308
● [:SOURce<hw>]:FSIMulator:STANdard on page 161

// Enable 2x2 MIMO configuration
SCONfiguration:MODE ADVanced
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy

// select SCME/WINNER matrix mode
// configure the spacial channel model
SOURce1:FSIMulator:MIMO:TAP TAP1
SOURce1:FSIMulator:MIMO:TAP1:MATRix:MODE SCWI
SOURce1:FSIMulator:MIMO:SCWI:TAP1:SPEed 30kmh
SOURce1:FSIMulator:DEL:GROup1:PATH1:SPEed?
// Response:  8.333
SOURce1:FSIMulator:MIMO:SCWI:TAP1:DOT 120
SOURce1:FSIMulator:DEL:GROup1:PATH1:FRATio?
// Response: -0.5
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:SUBCluster1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:GAIN 0
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:TAP1:SUBCluster1:GAIN?
// Response: -3.01029995663981
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SOURce1:FSIMulator:DEL:GROup1:PATH1:LOSS?
// Response: 3.01
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:ARRival:ANGLe 0.7
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DEParture:ANGLe 6.6
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DEParture:SPRead 5
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:ARRival:SPRead 35
SOURce1:FSIMulator:MIMO:SCWI:CLUSter1:DISTribution LAPL

SOURce1:FSIMulator:STATe 1

Example: Configuring MIMO-OTA settings
The following is a simple example of how to configure and enable an antenna model.

SOURce:FSIMulator:STANdard G3SCMEUMI30
SOURce:FSIMulator:MIMO:TAP1:MATRix:MODE SCWI

// configure the Tx antenna array (BS)
SOURce:FSIMulator:MIMO:ANTenna:TX:PATTern SEC3
SOURce:FSIMulator:MIMO:ANTenna:TX:CALC:MODE SPAC
SOURce:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORIzontal 0.5
SOURce:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE?
// ANT02
SOURce:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE?
// ANT02
SOURce:FSIMulator:MIMO:ANTenna:TX:PATTern SEC3

// configure the Rx antenna array (MS)
SOURce:FSIMulator:MIMO:ANTenna:RX:PATTern ISO
SOURce:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE?
// ANT02
SOURce1:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE?
// ANT02
SOURce:FSIMulator:MIMO:ANTenna:RX:CALC:MODE REL
// query predefined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog?
// 3Sector,6Sector,Dipole,Isotropic
// query existing user defined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? "/var/user"
//  ant1_phases_pol,ant2_phases_pol
SOURce:FSIMulator:MIMO:ANTenna:RX:PATTern USER
SOURce:FSIMulator:MIMO:ANTenna:RX:ANTenna1:PFILe "/var/user/ant1_phases_pol"
SOURce:FSIMulator:MIMO:ANTenna:RX:ANTenna2:PFILe "/var/user/ant2_phases_pol"

// apply inverse channel matrix
SOURce:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe 1
SOURce:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW1:COLumn2:REAL 0.3
SOURce:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW2:COLumn1:IMAGin -0.82

// enable channel polarization
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SOURce:FSIMulator:MIMO:ANTenna:MODeling:STATe 1
SOURce:FSIMulator:MIMO:ANTenna:PATTern:MODE SEP
SOURce:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical 9
SOURce:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal 9
// SOURce:FSIMulator:MIMO:ANTenna:PATTern:MODE SING
// SOURce:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe POLCROSS45
// SOURce:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs 0

Commands

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed................................................. 211
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT.................................................... 211
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe............................. 211
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN............................................211
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe............................ 212
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe.........................212
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead...........................212
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead........................212
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution..................................212
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:STATe..... 213
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:GAIN?.... 213
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe].........................................213
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:PATTern:MODE.............................................214
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal........................... 214
[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical...............................214
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe........................................214
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe................................ 214
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE.................................................214
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE....................................................214
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE......................................... 215
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE............................................ 215
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE...................................................215
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:CALC:MODE...........................................215
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs............................................215
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs.................................... 215
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal...................................... 215
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal...............................215
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog?................................................ 216
[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?...................................... 216
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern..........................................................216
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern.................................................. 216
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ANTenna<di>:PFILe.........................................217
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILe................................. 217
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe................................. 217
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:COLumn<ch>:

REAL..................................................................................................................217
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:COLumn<ch>:

IMAGin............................................................................................................... 217
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[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:SPEed <Speed>

Sets the speed of the mobile station.

Parameters:
<Speed> float

Range: 0  to  27778
Increment: 0.001
*RST: 0.83333

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "MS Speed" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:TAP<st>:DOT <DotAngle>

Sets the direction of travel of the mobile station.

Parameters:
<DotAngle> float

Range: 0  to  359.9
Increment: 0.1
*RST: 90

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "MS DoT (Direction of Travel)" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:STATe <State>

Enables/disables the selected cluster.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "Cluster State" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:GAIN <Gain>

Sets the relative gain (in dB) of the selected cluster.

Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0
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Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "Relative Gain /dB" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:ANGLe <Angle>
[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:ANGLe

<Angle>
Sets the AoA (angle of arrival) / AoD (angle of departure) of the selected cluster.

Parameters:
<Angle> float

Range: 0  to  359.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "Angle of Departure (AoD)" on page 115

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:ARRival:SPRead
<Spread>

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DEParture:SPRead
<Spread>

Sets the AoA (angle of arrival) / AoD (angle of departure) spread (AS) of the selected
cluster.

Parameters:
<Spread> float

Range: 1  to  75
Increment: 0.001
*RST: 1

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "AoD Spread" on page 115

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:DISTribution <Distribution>

Sets one of the Power Azimuth Spectrum (PAS) distributions.

Parameters:
<Distribution> LAPLace | GAUSs | EQUal

*RST: EQUal

Example: See Example"Configuring the settings in SCME/WINNER mode"
on page 208

Manual operation: See "Distribution" on page 115
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[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:
STATe <State>

If the corresponding cluster is enabled, enables the sub-clusters.

Suffix: 
<di>

.
1 to 3
sub-cluster number

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1

Manual operation: See "Subcluster > State" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:SCWI:CLUSter<ch>:TAP<st>:SUBCluster<di>:
GAIN?

Queries the resulting relative gain of an enabled sub-cluster.

Suffix: 
<di>

.
1 to 3
sub-cluster number

Return values: 
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:STATe 1
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:GAIN 0
SOURce1:FSIMulator:MIMO:SCWI:CLUSter2:TAP1:SUBCluster2:GAIN?
// Response: -5.299

Usage: Query only

Manual operation: See "Subcluster > Relative Gain /dB" on page 114

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:MODeling[:STATe] <AntennaState>

Enables/disables simulation of channel polarization.

Parameters:
<AntennaState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "Channel Polarization State" on page 136
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[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:PATTern:MODE <AntModPatMode>

Sets way the software extracts or calculates the antenna polarization patterns.

Parameters:
<AntModPatMode> SEParate | SINGle

*RST: SINGle

Example: See Example"Configuring MIMO-OTA settings" on page 209

Options: SEParate requires option R&S SMW-K73

Manual operation: See "Antenna Polarization Mode" on page 136

[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:HORizontal
<AntPolPowRatHor>

[:SOURce]:FSIMulator:MIMO:ANTenna:POLarization:PRATio:VERTical
<AntPolPowRatVer>

Sets the cross polarization power ratio (XPR) in dB.

Parameters:
<AntPolPowRatVer> float

Range: 0  to  20
Increment: 0.001
*RST: 9

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "Vertical/Horizontal Cross Polarization Power Ratio"
on page 137

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:POLarization:ANGLe <AntRxPolAngle>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:POLarization:ANGLe

<AntTxPolAngle>
Set the antenna element polarization slant angle.

Parameters:
<AntTxPolAngle> POLCROSS45 | POLCROSS90 | POLCO0 | POLCO90

POLCROSS45 | POLCROSS90
cross-poliarization 45°/90°
POLCO0 | POLCO90
co-poliarization 0°/90° (vertical/horizontal poliarization)
*RST: POLCO0

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "Antenna Polarization Slant Angle" on page 140

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:COLumn:SIZE <AntModRxColSize>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ROWS:SIZE <AntModRxRowSize>
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[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:COLumn:SIZE
<AntModTxColSize>

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ROWS:SIZE <AntModTxRowSize>
Sets the number of rows and the number of columns in the antenna array.

Parameters:
<AntModTxRowSize> ANT01 | ANT02 | ANT03 | ANT04 | ANT08

*RST: ANT01

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "Number of Rows (M)/Columns (N)" on page 141

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:CALC:MODE <AntModCalcRxMod>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:CALC:MODE

<AntModCalcRxMod>
Set how the distance between the antenna elements is defined: based on the physical
distance or on the relative phase.

Parameters:
<AntModCalcRxMod> SPACing | RELativphase

SPACing
To set the distance, use the corresponding command, for exam-
ple [:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:
ESPacing:HORizontal.
RELativphase
Load an antenna pattern file that contains the relative phase
description.
See Chapter B, "Antenna pattern file format", on page 348
*RST: SPACing

Example: See Example"Configuring MIMO-OTA settings" on page 209

Options: RELativphase requires option R&S SMW-K73

Manual operation: See "Calculation Mode" on page 141

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:CROSs <Cross>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:CROSs <Cross>
[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ESPacing:HORizontal

<AntRxEspacHori>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ESPacing:HORizontal

<AntTxEspacHori>
Sets the polarized distance between the antennas in the antenna array.

Parameters:
<AntTxEspacHori> float

Range: 0  to  10
Increment: 0.01
*RST: 0.5

SCME/WINNER and antenna model settings



Remote-control commandsFading Simulation

216User Manual 1175.6826.02 ─ 29

<Cross> float
Range: 0  to  10
Increment: 0.01
*RST: 0

Example: See Example"Configuring MIMO-OTA settings" on page 209.

Manual operation: See "Horizontal Spacing" on page 142

[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog?

Queries the available predefined antenna pattern files (*.ant_pat).

To query the user-defined antenna pattern files, use the command [:SOURce]:
FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER?.

Return values: 
<Catalog> string

Files names without file extension.

Example: See Example"Configuring MIMO-OTA settings" on page 209

Usage: Query only

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 143

[:SOURce]:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? [<CatDir>]

Queries the user-defined antenna pattern files (*.ant_pat) in the specified directory.

Query parameters: 
<CatDir> string

File path

Return values: 
<Catalog> string

Files names without file extension.

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 143

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:PATTern <AntRxPattDesc>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:PATTern <AntTxPattDesc>
Sets the antenna pattern mode.

Parameters:
<AntTxPattDesc> ISOtropic | USER | SEC3 | SEC6 | DIPole | DPISotripic

*RST: ISOtropic

Example: See Example"Configuring MIMO-OTA settings" on page 209
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Manual operation: See "Antenna Pattern" on page 143

[:SOURce]:FSIMulator:MIMO:ANTenna:RX:ANTenna<di>:PFILe <RxPattern>
[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:TX:ANTenna<di>:PFILe <TxPattern>
Selects the antenna pattern file (*.ant_pat) per antenna.

Querry the existing files with the command [:SOURce]:FSIMulator:MIMO:
ANTenna:PATTern:CATalog:USER?.

Suffix: 
<di>

.
1 to 8
Value range depends on the selected system configuration, i.e.
the number of Tx and Rx antennas in the antenna array

Parameters:
<TxPattern> string

Complete file path, incl. the filename; the file extension can be
omitted

Example: See Example"Configuring MIMO-OTA settings" on page 209

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 143

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe
<AntModInvMatrix>

Applies the inverse channel matrix to compensate for chamber effects.

To set the matrix values, use the commands [:SOURce<hw>]:FSIMulator:MIMO:
ANTenna:INVerse:MATRix:ROW<st>:COLumn<ch>:REAL and [:SOURce<hw>]:
FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:COLumn<ch>:IMAGin
.

Parameters:
<AntModInvMatrix> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring MIMO-OTA settings" on page 209

Options: R&S SMW-B14 and R&S SMW-K73

Manual operation: See "Use Inverse Channel Matrix" on page 145

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:
COLumn<ch>:REAL <AntModInvMatRea>

[:SOURce<hw>]:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW<st>:
COLumn<ch>:IMAGin <AntModInvMatIma>

Sets the complex elements of the inverse channel matrix.
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Suffix: 
<st>

.
1 | 2
Number of row and columns
Current matrix size is 2x2

Parameters:
<AntModInvMatIma> float

Range: -1  to  1
Increment: 0.01
*RST: 0

Example: See Example"Configuring MIMO-OTA settings" on page 209

Options: R&S SMW-B14 and R&S SMW-K73

Manual operation: See "Complex Matrix Elements (Real/Imag)" on page 146

6.9  Two channel interferer

Option: R&S SMW-K71.

Example: Enabling a two channel interferer fading configuration
The following is a simple example of how to configure and enable a two channel inter-
ferer fading configuration.

SOURce1:FSIMulator:CONFiguration TCI

SOURce1:FSIMulator:TCInterferer:REFerence:PROFile PDOP
SOURce1:FSIMulator:TCInterferer:REFerence:LOSS 1
SOURce1:FSIMulator:TCInterferer:REFerence:SPEed 2
SOURce1:FSIMulator:TCInterferer:REFerence:FRATio 0.5
SOURce1:FSIMulator:TCInterferer:REFerence:DELay:MINimum 0.00003
SOURce1:FSIMulator:TCInterferer:PERiod 160

SOURce1:FSIMulator:TCInterferer:MOVing:PROFile SPAT
SOURce1:FSIMulator:TCInterferer:REFerence:LOSS 0
SOURce1:FSIMulator:TCInterferer:MOVing:DELay:MINimum 0.00003
SOURce1:FSIMulator:TCInterferer:MOVing:DELay:MAXimum 0.00011
SOURce1:FSIMulator:TCInterferer:MOVing:MMODe SLID

SOURce1:FSIMulator:TCInterferer:REFerence:STATe 1
SOURce1:FSIMulator:TCInterferer:MOVing:STATe 1
SOURce1:FSIMulator:TCINterferer:STATe 0
SOURce1:FSIMulator:STATE 1

SOURce1:FSIMulator:TCINterferer:REFerence:FDOPpler?
// 3.33564095198152
SOURce1:FSIMulator:TCINterferer:REFerence:FDOPpler:ACTual?
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Commands

[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe]............................................................. 219
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MAXimum................. 219
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:MMODe.............................. 219
[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod............................................................. 220
[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed.............................................................. 220
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MINimum.................. 220
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?.......................... 221
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler:ACTual?...............221
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio................................221
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS..................................222
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:PROFile.............................. 222
[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe................................. 222

[:SOURce<hw>]:FSIMulator:TCINterferer[:STATe] <State>

Activates the 2 channel interferer fading configuration.

The paths and the fading simulator must be switched on separately, see [:
SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe and [:
SOURce<hw>]:FSIMulator[:STATe].

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "Configuration" on page 31
See "State" on page 74

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MAXimum
<Maximum>

Sets the maximum delay for the moving path.

Parameters:
<Maximum> float

Range: dynamic  to  0.001
Increment: 20E-9
*RST: 110E-6

Example: see Example"Enabling a two channel interferer fading configura-
tion" on page 218

Manual operation: See "Delay Max (Moving Path)" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:MMODe <MMode>

Selects the type of moving applied to the moving path.

Two channel interferer
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Parameters:
<MMode> SLIDing | HOPPing

*RST: HOPPing

Example: see Example"Enabling a two channel interferer fading configura-
tion" on page 218

Manual operation: See "Moving Mode (Moving Path)" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:PERiod <Period>

Sets either the dwell time or the period for a complete cycle of the moving path.

Parameters:
<Period> float

Range: 0.1  to  10
Increment: 0.01
*RST: 2.9 s (for hopping mode) / 160 s (for sliding mode)

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "Period/Dwell" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:SPEed <Speed>

Sets the speed v of the moving receiver for 2 channel interferer fading.

Parameters:
<Speed> float

Range: 0  to  27778 (dynamic)
Increment: 0.001
*RST: 0.83333

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "Speed" on page 75

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:DELay:MINimum
<Minimum>

Sets the minimum delay for the reference path and the moving path.

Parameters:
<Minimum> float

Range: 0  to  dynamic
Increment: 20E-9
*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218
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Manual operation: See "Delay Min" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler?

Queries the Doppler frequency of the reference and moving path with 2 channel inter-
ferer fading.

Return values: 
<FDoppler> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Usage: Query only

Manual operation: See "Profile" on page 75
See "Res. Doppler Shift" on page 75

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FDOPpler:ACTual?

Queries the actual Doppler shift.

Return values: 
<ActDoppler> float

Range: -1600  to  1600
Increment: 0.01
*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218.

Usage: Query only

Manual operation: See "Act. Doppler Shift" on page 76

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:FRATio <FRatio>

Sets the ratio of the actual Doppler frequency to the set Doppler frequency for the ref-
erence and moving path with 2 channel interferer fading.

Parameters:
<FRatio> float

Range: -1  to  1
Increment: 0.0001
*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "Freq. Ratio" on page 75
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[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:LOSS <Loss>

Seta the loss of the reference and moving path with 2 channel interferer fading.

Parameters:
<Loss> float

Range: 0  to  50
Increment: 0.1
*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "Path Loss" on page 75

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:PROFile <Profile>

Sets the fading profile to be used for the reference and moving path with 2 channel
interferer fading.

Parameters:
<Profile> SPATh | PDOPpler | RAYLeigh

*RST: SPATh

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

[:SOURce<hw>]:FSIMulator:TCINterferer:REFerence|MOVing:STATe <State>

Activate the reference and moving path of the 2 channel interferer fading configuration.

The 2 channel interferer fading configuration and the fading simulator must be
switched on separately, see [:SOURce<hw>]:FSIMulator:TCINterferer[:
STATe] on page 219 and .[:SOURce<hw>]:FSIMulator[:STATe]
Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Enabling a two channel interferer fading configu-
ration" on page 218

Manual operation: See "State" on page 74

6.10  Custom fading profile

Option: R&S SMW-K72.
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Example: Enabling, configuring and disabling a custom fading profile
The following is a simple example of how to configure, enable and disable a custom
profile.

SOURce1:FSIMulator:DELay:GROup1:PATH2:PROFile CUSTom
SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DATA 200,100,100,200

SOURce1:FSIMulator:DEL:GROup1:PATH2:CUSTom:DSHape FLAT

SOURce1:FSIMulator:DEL:GROup1:PATH2:PROFile RAYL

Commands

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DSHape.............223
[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DATA................. 223

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:
DSHape <DopplerShape>

Sets the doppler shape of the virtual profile.

Parameters:
<DopplerShape> FLAT | RAYLeigh

*RST: RAYLeigh

Example: See Example"Enabling, configuring and disabling a custom fad-
ing profile" on page 223

Manual operation: See "Doppler Shape" on page 88

[:SOURce<hw>]:FSIMulator:DELay|DEL:GROup<st>:PATH<ch>:CUSTom:DATA
<Bandwidth>, <OffsetFreq>, <LowerCutFreq>, <UpperCutFreq>

Sets the parameters of the custom fading profile.

Parameters:
<Bandwidth> float

Range: 50  to  40000
Increment: 1
*RST: 200
Default unit: Hz

<OffsetFreq> float
Range: -23950  to  23950
Increment: 1
*RST: 0
Default unit: Hz

<LowerCutFreq> float
Range: -4000  to  3950
Increment: 1
*RST: 0
Default unit: Hz

Custom fading profile
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<UpperCutFreq> float
Range: -3950  to  4000
Increment: 1
*RST: 100
Default unit: Hz

Example: See Example"Enabling, configuring and disabling a custom fad-
ing profile" on page 223

Manual operation: See "Bandwidth" on page 89
See "Frequency Offset" on page 89
See "Lower/Upper Cutoff Frequency" on page 89

6.11  SCM fading profile

Option: R&S SMW-K73.

Example: Configuring the SCM fading profile settings
The following is a simple example of how to configure the settings.

// Enable 2x2 MIMO configuration
SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy 

// select SCM fading profile
SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile SCM
SOURce1:FSIMulator:MIMO:TAP1 TAP1
SOURce1:FSIMulator:SCM:SPEed 8.333
SOURce1:FSIMulator:SCM:DOT 120
SOURce1:FSIMulator:SCM:SIGMa 8

SOURce1:FSIMulator:SCM:TAP1:DEParture:ANGLe 6.6
SOURce1:FSIMulator:SCM:TAP1:DEParture:SPRead 5
SOURce1:FSIMulator:SCM:TAP1:ARRival:ANGLe 25
SOURce1:FSIMulator:SCM:TAP1:ARRival:SPRead 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster1:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster2:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster3:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster1:GAIN?
// -3.01029995663981
 

// SOURce1:FSIMulator:SCM:TAP1:SUBPath1:STATe 0
// SOURce1:FSIMulator:SCM:TAP1:SUBPath1:PHASe:VV 135
SOURce1:FSIMulator:SCM:TAP1:SUBPath1:STATe 1

SOURce1:FSIMulator:SCM:LOS:STATe 1
SOURce1:FSIMulator:SCM:LOS:DEParture:ANGLe 5

SCM fading profile



Remote-control commandsFading Simulation

225User Manual 1175.6826.02 ─ 29

SOURce1:FSIMulator:SCM:LOS:ARRival:ANGLe 30
SOURce1:FSIMulator:SCM:LOS:KFACtor -15
SOURce1:FSIMulator:SCM:LOS:RANDom:PHASe:STATe 1

// configure the Tx antenna array (BS)
SOURce1:FSIMulator:SCM:ANTenna:TX:COLumns:SIZE?
// R02

SOURce1:FSIMulator:SCM:ANTenna:TX:ROWS:SIZE?
// R01

SOURce1:FSIMulator:SCM:ANTenna:TX:CALC:MODE SPAC
SOURce1:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal 0.5
SOURce1:FSIMulator:SCM:ANTenna:TX:PATTern SEC3
// configure the Rx antenna array (MS)
SOURce1:FSIMulator:SCM:ANTenna:RX:CALC:MODE REL
SOURce1:FSIMulator:SCM:ANTenna:RX:PATTern ISO

// apply inverse channel matrix
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:STATe 1
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW1:COLumn2:REAL 0.3
SOURce1:FSIMulator:MIMO:ANTenna:INVerse:MATRix:ROW2:COLumn1:IMAGin -0.82

// enable channel polarization
SOURce1:FSIMulator:SCM:POLarization:STATe 1
SOURce1:FSIMulator:SCM:POLarization:PRATio:VERTival 9
SOURce1:FSIMulator:SCM:POLarization:PRATio:HORizontal 9

SOURce1:FSIMulator:STATe 1

Example: Configuring the 3D geometry-based channel model
Option: R&S SMW-K73.
The following is a simple example on how to configure the settings.

SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy 

SOURce1:FSIMulator:DEL:GROup1:PATH1:PROFile SCM
SOURce1:FSIMulator:MIMO:TAP1 TAP1
SOURce1:FSIMulator:SCM:D3Mode:STATe 1
SOURce1:FSIMulator:SCM:TAP1:SUBCluster1:STATe 1
SOURce1:FSIMulator:SCM:PHI 45
SOURce1:FSIMulator:SCM:THETa 45
SOURce1:FSIMulator:SCM:TAP1:DEParture:ANGLe 10
SOURce1:FSIMulator:SCM:TAP1:DEParture:SPRead 1
SOURce1:FSIMulator:SCM:TAP1:ARRival:ANGLe 25
SOURce1:FSIMulator:SCM:TAP1:ARRival:SPRead 2
SOURce1:FSIMulator:SCM:TAP1:DEParture:ZENith:ANGLe 20
SOURce1:FSIMulator:SCM:TAP1:DEParture:ZENith:SPRead 2
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SOURce1:FSIMulator:SCM:TAP1:ARRival:ZENith:ANGLe 10
SOURce1:FSIMulator:SCM:TAP1:ARRival:ZENith:SPRead 1
SOURce1:FSIMulator:SCM:LOS:STATe 1
SOURce1:FSIMulator:SCM:LOS:DEParture:ZENith:ANGLe 10
SOURce1:FSIMulator:SCM:LOS:ARRival:ZENith:ANGLe 10
SOURce1:FSIMulator:SCM:LOS:DISTance 10

SOURce1:FSIMulator:SCM:ANTenna:TX:STRucture CROSS
SOURce1:FSIMulator:SCM:ANTenna:TX:COLumns:SIZE R01
SOURce1:FSIMulator:SCM:ANTenna:TX:CALC:MODE SPAC
SOURce1:FSIMulator:SCM:ANTenna:TX:PATTern ISO

SOURce1:FSIMulator:SCM:ANTenna:RX:STRucture LIN
SOURce1:FSIMulator:SCM:ANTenna:RX:COLumns:SIZE R01
SOURce1:FSIMulator:SCM:ANTenna:RX:CALC:MODE SPAC
SOURce1:FSIMulator:SCM:ANTenna:RX:ESPacing:VERTical 5

Commands

[:SOURce<hw>]:FSIMulator:SCM:D3Mode:STATe.............................................................227
[:SOURce<hw>]:FSIMulator:SCM:SPEed......................................................................... 227
[:SOURce<hw>]:FSIMulator:SCM:DOT............................................................................ 228
[:SOURce<hw>]:FSIMulator:SCM:SIGMa......................................................................... 228
[:SOURce<hw>]:FSIMulator:SCM:PHI..............................................................................228
[:SOURce<hw>]:FSIMulator:SCM:THETa......................................................................... 228
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:ANGLe....................................229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:ANGLe................................ 229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe...............................................229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe........................................... 229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:SPRead.................................. 229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:SPRead...............................229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead............................................. 229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead..........................................229
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN..............................................................230
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATe.................................... 230
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN......................................230
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATe.............................................. 231
[:SOURce<hw>]:FSIMulator:SCM:POLarization:STATe...................................................... 231
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORizontal................................... 231
[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical...................................... 231
[:SOURce]:FSIMulator:SCM:ANTenna:RX:STRucture........................................................232
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:STRucture................................................ 232
[:SOURce]:FSIMulator:SCM:ANTenna:RX:CALC:MODE.................................................... 232
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE.............................................232
[:SOURce]:FSIMulator:SCM:ANTenna:RX:COLumns[:SIZE]...............................................233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ROWS[:SIZE]?..................................................233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumns[:SIZE]....................................... 233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS[:SIZE]?.......................................... 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:VERTical...........................................233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:VERTical................................... 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:HORizontal........................................233
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[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal................................ 233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:PATTern........................................................... 233
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATTern....................................................233
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ANTenna<di>:PFILe.......................................... 234
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe...................................234
[:SOURce<hw>]:FSIMulator:SCM:LOS:STATe.................................................................. 234
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival:ZENith:ANGLe..........................................234
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture:ZENith:ANGLe...................................... 234
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[:ANGLe]...................................................234
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[:ANGLe]............................................... 234
[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor............................................................... 235
[:SOURce<hw>]:FSIMulator:SCM:LOS:DISTance..............................................................235
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:STATe........................................ 235
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HH.............................................236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HV............................................. 236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VH............................................. 236
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VV............................................. 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HH................................. 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HV................................. 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VH................................. 236
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VV................................. 236

[:SOURce<hw>]:FSIMulator:SCM:D3Mode:STATe <ThreeDMode>

Enables the 3D geometry-based channel model.

Parameters:
<ThreeDMode> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the 3D geometry-based channel
model" on page 225.

Manual operation: See "3D" on page 120

[:SOURce<hw>]:FSIMulator:SCM:SPEed <Speed>

Sets the speed of the mobile station.

Parameters:
<Speed> float

Range: 0  to  27778
Increment: 0.001
*RST: 0.83333

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "MS Speed" on page 118
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[:SOURce<hw>]:FSIMulator:SCM:DOT <DirOfTravel>

Sets the direction of travel of the mobile station.

Parameters:
<DirOfTravel> float

Range: 0  to  359.9
Increment: 0.1
*RST: 90

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "MS DoT (Direction of Travel)" on page 118

[:SOURce<hw>]:FSIMulator:SCM:SIGMa <Sigma>

Sets the lognormal shadow fading standard deviation, applied as a common parameter
to the paths.

Parameters:
<Sigma> float

Range: 0  to  20
Increment: 0.01
*RST: 8

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "σSF" on page 118

[:SOURce<hw>]:FSIMulator:SCM:PHI <ScmPhi>

Sets the travel azimuth angle.

Parameters:
<ScmPhi> float

Range: 0  to  359.9
Increment: 0.1
*RST: 90

Example: See Example"Configuring the 3D geometry-based channel
model" on page 225.

Manual operation: See "MS DoT > φv/Θv" on page 121

[:SOURce<hw>]:FSIMulator:SCM:THETa <ScmTheta>

Sets the elevation angle.
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Parameters:
<ScmTheta> float

Range: 0  to  179.9
Increment: 0.1
*RST: 90

Example: See Example"Configuring the 3D geometry-based channel
model" on page 225.

Manual operation: See "MS DoT > φv/Θv" on page 121

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:ANGLe <ArrZenith>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:ANGLe

<ZenithDeparture>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ANGLe <Angle>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ANGLe <Angle>
Sets the AoA (angle of arrival) / AoD (angle of departure) of the cluster.

Parameters:
<Angle> float

Range: 0  to  359.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Angle of Departure (AoD)" on page 119

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:ZENith:SPRead <ArrZenSpr>

Sets the ZoA (zenith of arrival) spread of the cluster.

Parameters:
<ArrZenSpr> float

Range: 0  to  75
Increment: 0.001
*RST: 1

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "ZoA Spread" on page 121

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:ZENith:SPRead
<DepZenSpread>

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:ARRival:SPRead <Spread>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:DEParture:SPRead <Spread>
Sets the AoA (angle of arrival) / AoD (angle of departure) spread (AS) of the cluster.

SCM fading profile



Remote-control commandsFading Simulation

230User Manual 1175.6826.02 ─ 29

Parameters:
<Spread> float

Range: 1  to  75
Increment: 0.001
*RST: 1

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "AoD Spread" on page 119

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:GAIN <Gain>

Sets the relative gain (in dB) of the cluster.

Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Relative Gain /dB" on page 118

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:STATe <State>

Enables the sub-clusters.

Suffix: 
<di>

.
1 to 3
sub-cluster number

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Subcluster > State" on page 118

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBCluster<di>:GAIN <Gain>

Queries the resulting relative gain of an enabled sub-cluster.

Suffix: 
<di>

.
1 to 3
sub-cluster number
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Parameters:
<Gain> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Subcluster > Relative Gain /dB" on page 119

[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath:STATe <State>

If enabled, random start phases are selected.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Use Random Phases" on page 129

[:SOURce<hw>]:FSIMulator:SCM:POLarization:STATe <State>

Enables/disables simulation of channel polarization.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Channel Polarization State" on page 122

[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:HORizontal
<RatioHorizontal>

[:SOURce<hw>]:FSIMulator:SCM:POLarization:PRATio:VERTical <RatioVertical>
Sets the cross polarization power ratio (XPR) in dB.

Parameters:
<RatioVertical> float

Range: 0  to  20
Increment: 0.001
*RST: 9

Example: See Example"Configuring the SCM fading profile settings"
on page 224.
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Manual operation: See "Vertical/Horizontal Cross Polarization Power Ratio"
on page 122

[:SOURce]:FSIMulator:SCM:ANTenna:RX:STRucture <AntennaRxStruct>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:STRucture <AntennaStruct>
Sets the antenna array structure.

Parameters:
<AntennaStruct> LIN | CROSS

*RST: LIN

Example: See Example"Configuring the 3D geometry-based channel
model" on page 225.

Manual operation: See "Antenna Structure" on page 124

[:SOURce]:FSIMulator:SCM:ANTenna:RX:CALC:MODE <Mode>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:CALC:MODE <Mode>
Set how the phase information is calculated

Parameters:
<Mode> SPACing | RELativphase | BFORming

SPACing
The phase information is calculated from the spacing between
the antenna elements.
To set the distance, use the corresponding command, for exam-
ple [:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:
ESPacing:HORizontal.
RELativphase
Load an antenna pattern file that contains the relative phase
description.
See Chapter B, "Antenna pattern file format", on page 348
BFORming
Composite antenna pattern of an antenna array comprising gain
and phase is used to simulate analog beamforming.
To set the distance, use the corresponding command, for exam-
ple [:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:
ESPacing:HORizontal.
*RST: SPACing

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Options: R&S SMW-K73

Manual operation: See "Calculation Mode" on page 124
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[:SOURce]:FSIMulator:SCM:ANTenna:RX:COLumns[:SIZE] <NumRxCol>
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ROWS[:SIZE]?
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:COLumns[:SIZE] <NumTxCol>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ROWS[:SIZE]?
Queries the number of rows and the number of columns in the antenna array.

Return values: 
<NumTxRows> R01 | R02 | R03 | R04 | R08

*RST: R02

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Usage: Query only

Manual operation: See "Number of Rows (M)/Columns (N)" on page 124

[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:VERTical <AntenRxSpacVert>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:VERTical

<AntTxSpacVertic>
[:SOURce]:FSIMulator:SCM:ANTenna:RX:ESPacing:HORizontal <SpacingHoriz>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ESPacing:HORizontal <Horizontal>
Sets the distance between the antennas in the antenna array.

Parameters:
<Horizontal> float

Range: 0  to  10
Increment: 0.01
*RST: 0.5

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Horizontal Spacing" on page 125

[:SOURce]:FSIMulator:SCM:ANTenna:RX:PATTern <TypeOfPattern>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:PATTern <Pattern>
Sets the antenna pattern mode.

Parameters:
<Pattern> ISOtropic | USER | SEC3 | SEC6 | DIPole | DPISotripic

*RST: ISOtropic

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Antenna Pattern" on page 125
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[:SOURce]:FSIMulator:SCM:ANTenna:RX:ANTenna<di>:PFILe <Filename>
[:SOURce<hw>]:FSIMulator:SCM:ANTenna:TX:ANTenna<di>:PFILe <Filename>
Selects the antenna pattern file (*.ant_pat) per antenna.

Querry the existing files with the command [:SOURce]:FSIMulator:MIMO:
ANTenna:PATTern:CATalog:USER?.

Suffix: 
<di>

.
1 to 8
Value range depends on the selected system configuration, i.e.
the number of Tx and Rx antennas in the antenna array

Parameters:
<Filename> string

Complete file path, incl. the filename; the file extension can be
omitted

Example: // query existing user defined antenna pattern files (*.ant_pat)
SOURce:FSIMulator:MIMO:ANTenna:PATTern:CATalog:USER? "/var/user"
//  ant1,ant2
SOURce:FSIMulator:SCM:ANTenna:TX:PATTern USER
SOURce:FSIMulator:SCM:ANTenna:TX:ANTenna1:PFILe "/var/user/ant1"
SOURce:FSIMulator:SCM:ANTenna:TX:ANTenna2:PFILe "/var/user/ant2"

Manual operation: See "User Defined Antenna Patterns per Row, Column"
on page 126

[:SOURce<hw>]:FSIMulator:SCM:LOS:STATe <State>

Adds a line-of-sight (LOS) component to the cluster.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Use LOS Component" on page 127

[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival:ZENith:ANGLe <LosZenithOfArr>
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture:ZENith:ANGLe

<LosZenithDepar>
[:SOURce<hw>]:FSIMulator:SCM:LOS:ARRival[:ANGLe] <Angle>
[:SOURce<hw>]:FSIMulator:SCM:LOS:DEParture[:ANGLe] <Angle>
Sets the AoD and AoA of the LOS component.
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Parameters:
<Angle> float

Range: 0  to  359.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "LOS Angle of Departure (AoD)" on page 127

[:SOURce<hw>]:FSIMulator:SCM:LOS:KFACtor <Factor>

Sets the ricean K factor.

Parameters:
<Factor> float

Range: -50  to  0
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "K Factor" on page 128

[:SOURce<hw>]:FSIMulator:SCM:LOS:DISTance <Los3dDistance>

Sets the distance between the base station (BS) and the user terminal (UT).

Parameters:
<Los3dDistance> float

Range: 0  to  1000
Increment: 0.01
*RST: 0

Example: See Example"Configuring the 3D geometry-based channel
model" on page 225.

Manual operation: See "3D Distance" on page 128

[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:STATe <State>

If enabled, random subpath start phases are selected.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Use Random Phases" on page 128
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[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HH <PhaseHH>
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:HV <PhaseHV>
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VH <PhaseVH>
[:SOURce<hw>]:FSIMulator:SCM:LOS:RANDom:PHASe:VV <PhaseVV>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HH <PhaseHH>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:HV <PhaseHV>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VH <PhaseVH>
[:SOURce<hw>]:FSIMulator:SCM:TAP<st>:SUBPath<di>:PHASe:VV <PhaseVV>
Sets the start phase in degree of the LOS signal / the subpath per MIMO channel.

Suffix: 
<di>

.
1 to 20
Subpath number

Parameters:
<PhaseVV> float

Range: 0  to  359.999
Increment: 0.001
*RST: 0

Example: See Example"Configuring the SCM fading profile settings"
on page 224.

Manual operation: See "Subpath # > VV/HH/VH/HV Phase" on page 129

6.12  Customized dynamic fading

Option: R&S SMW-K820.

Example: Configuring the customized dynamic fading settings

SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2X2
SCONfiguration:APPLy 

SOURce1:FSIMulator:CONFiguration CDYN
SOURce1:FSIMulator:CDYNamic:PATH1:PROF PDOPpler
SOURce1:FSIMulator:CDYNamic:PATH5:PROF?
// RAYLeigh
SOURce1:FSIMulator:CDYNamic:CATalog?
// Urban_PureDoppler,Urban_Rayleigh_1,Urban_Rayleigh_2

SOURce1:FSIMulator:CDYNamic:PATH1:DATA:DSELect "Urban_PureDoppler.fad_udyn"
SOURce1:FSIMulator:CDYNamic:PATH5:DATA:DSELect "Urban_Rayleigh_1"

MMEMory:CDIRectory "/var/user/cdf"
SOURce1:FSIMulator:CDYNamic:CATalog:USER?
// dynList_sys1_ch1_PG1_path1, my_cdf
SOURce1:FSIMulator:CDYNamic:DELete "/var/user/cdf/my_cdf"
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SOURce1:FSIMulator:CDYNamic:PATH3:DATA:DSELect "/var/user/cdf/dynList_sys1_ch1_PG1_path1"

SOURce1:FSIMulator:MIMO:TAP1 TAP5
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ROW1:COLumn1:MAGNitude 0.5
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ROW1:COLumn1:PHASe 0
SOURce1:FSIMulator:MIMO:TAP5:MATRix:ACCept

SOURce1:FSIMulator:CDYNamic:PATH1:CONVert:STATe 0
SOURce1:FSIMulator:CDYNamic:PATH5:CONVert:STATe 0
SOURce1:FSIMulator:CDYNamic:PATH3:CONVert:STATe 0

SOURce1:FSIMulator:CDYNamic:PATH1:STATe 1

SOURce1:FSIMulator:STATe 1

Example: Using human-readable customized dynamic fading files
Option: R&S SMW-K820.
We assume you have created a file with the required contend and renamed is as
described in Chapter 3.9, "Customized dynamic fading", on page 77.
The file Urban_customer.fad_udyn is transfered to the R&S SMW.
SCONfiguration:MODE STD

SOURce1:FSIMulator:CONFiguration CDYN
SOURce1:FSIMulator:CDYNamic:PATH1:PROF PDOPpler
SOURce1:FSIMulator:CDYNamic:CATalog:USER?
// MyUrban_PureDoppler,Urban_customer

SOURce1:FSIMulator:CDYNamic:PATH1:DATA:DSELect "Urban_cusotmer.fad_udyn"

SOURce1:FSIMulator:CDYNamic:PATH1:CONVert:STATe 1
SOURce1:FSIMulator:CDYNamic:PATH1:STATe 1
SOURce1:FSIMulator:STATe 1

Commands

[:SOURce<hw>]:FSIMulator:CDYNamic:STATe................................................................. 237
[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog?............................................................ 238
[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog:USER?...................................................238
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELect.................................... 238
[:SOURce<hw>]:FSIMulator:CDYNamic:DELete............................................................... 239
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF................................................. 239
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATe.................................................239
[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:CONVert:STATe...................................240

[:SOURce<hw>]:FSIMulator:CDYNamic:STATe <State>

Activates the customized dynamic fading configuration.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Manual operation: See "Configuration" on page 31

[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog?

Queries the predefined files with customized dynamic fading settings. Listed are files
with the file extension *.fad_udyn.

Return values: 
<FileNames> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Usage: Query only

Manual operation: See "Filename" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:CATalog:USER?

Queries the files with user-defined customized dynamic fading settings in the default
directory. Listed are files with the file extension *.fad_udyn.

Return values: 
<FileNames> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Usage: Query only

Manual operation: See "Filename" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:DATA:DSELect <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.fad_udyn.

Suffix: 
<ch>

.
1 to 12
Fading path

Parameters:
<Filename> "<filename>"

Filename or absolute file path; file extension can be omitted.
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Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Manual operation: See "Filename" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:DELete <Filename>

Deletes the specified file. Deleted are user-defined files with file extension
*.fad_udyn.

Setting parameters: 
<Filename> "<filename>"

Complete file path and file name; file extension can be omitted.

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Usage: Setting only

Manual operation: See "Filename" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:PROF <Prof>

Sets the fading profile.

Suffix: 
<ch>

.
1 to 12
Fading path

Parameters:
<Prof> PDOPpler | RAYLeigh | SPATh

PDOPpler
Pure Doppler profile available in the first four paths
(PATH1|2|3|4)
RAYLeigh
Rayleigh profile available for all paths
SPATh
Static path profile available for all paths
*RST: PDOPpler

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Manual operation: See "Profile" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:STATe <State>

Activates the selected path, if a customized dynamic file is selected.

Suffix: 
<ch>

.
1 to 12
Fading path
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring the customized dynamic fading set-
tings" on page 236

Manual operation: See "State" on page 80

[:SOURce<hw>]:FSIMulator:CDYNamic:PATH<ch>:CONVert:STATe
<CdynConvertFile>

Enable to convert files with filename like *customer*.fad_udyn into the
Rohde & Schwarz proprietary file format when the fading simulator is enabled.

Parameters:
<CdynConvertFile> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Using human-readable customized dynamic fad-
ing files" on page 237.

Manual operation: See "Convert" on page 81

6.13  Fading bandwidth

Option: R&S SMW-B15/-K822/-K823

Example: Enbaling signal with 400 MHz fading bandwidth
The following is a simple example on how to configure the settings.

SCONfiguration:MODE ADV
SCONfiguration:FADing MIMO2x2x2
SCONfiguration:BBBW BB400
SCONfiguration:CABW?
// BB800
SCONfiguration:APPLy
SCONfiguration:FADing MIMO2x2x4
SCONfiguration:BBBW?
// BB200
SCONfiguration:CABW?
// BB800

Commands

:SCONfiguration:BBBW <Bandwidth>

Sets the bandwidth of the baseband signal at the inputs of the fading simulator.

The available values depend on the selected MIMO configuration.
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For example:
● In MIMO configurations with fewer than 8 channels, the max. baseband bandwidth

is 400 MHz.
● In MIMO configurations with fewer than 4 channels, the max. baseband bandwidth

is 800 MHz.

See user manual R&S®SMW-B14/-K71/-K72/-K73/-K74/-K75/-K820/-K821/-K822/-
K823 Fading Simulation.

Parameters:
<Bandwidth> BB040 | BB050 | BB080 | BB100 | BB160 | BB200 | BB800 |

BB400 | BB500 | BB1G | BB2G | BB120 | BBOUTDEF | BB240
BB040|BB050 ...
Bandwidth in MHz, e.g. 40 MHz.
BB1G|BB2G
1 GHz, 2 GHz bandwidth.
Available in SISO configurations.
BBOUTDEF
Bandwidth determined by the signal at the HS DIG I/Q.

Example: See Example"Enbaling signal with 400 MHz fading bandwidth"
on page 240.

Options: R&S SMW-K822
BB800 requires R&S SMW-K823

Manual operation: See "BB Bandwidth" on page 91

:SCONfiguration:CABW?

Queries the resulting channel aggregation bandwidth, i.e. the signal bandwidth at the
outputs of the stream mapper.

The value is calculated automatically and depends on the selected configuration, the
installed options and the selected baseband bandwidth (:SCONfiguration:BBBW).

See user manual R&S®SMW-B14/-K71/-K72/-K73/-K74/-K75/-K820/-K821/-K822/-
K823 Fading Simulation.

Return values: 
<Bandwidth> BB800 | BB200

*RST: depends on options

Example: See Example"Enbaling signal with 400 MHz fading bandwidth"
on page 240.

Usage: Query only

Options: R&S SMW-K822/K823

Manual operation: See "CA Bandwidth" on page 91
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Annex
A  Predefined fading settings

The predefined fading settings correspond to the test scenarios defined in the common
mobile radio standards. The following tables provide a listing of the predefined stand-
ards along with the underlying test scenarios and the enabled settings.

As listed in Chapter 2.4, "Characteristics of R&S SMW-B14 and R&S SMW-B15",
on page 25, there is a difference in the system clocks and the delay resolutions
depending on which of the options is installed. These differences also affect the used
fading paths and the preset values in some of the predefined fading profiles.

● CDMA standards...................................................................................................242
● GSM standards..................................................................................................... 245
● NADC standards................................................................................................... 250
● PCN standards......................................................................................................251
● TETRA standards..................................................................................................256
● 3GPP standards....................................................................................................260
● WLAN standards...................................................................................................271
● DAB standards......................................................................................................276
● WIMAX standards................................................................................................. 278
● LTE standards.......................................................................................................291
● LTE-MIMO standards............................................................................................294
● WIMAX-MIMO standards...................................................................................... 296
● 1xevdo standards..................................................................................................301
● 3GPP/LTE high speed train...................................................................................305
● 3GPP/LTE moving propagation.............................................................................306
● SCM and SCME channel models for MIMO OTA................................................. 308
● Watterson standards............................................................................................. 311
● 802.11n-SISO standards.......................................................................................313
● 802.11n-MIMO standards......................................................................................314
● 802.11ac-MIMO standards....................................................................................324
● 802.11ac-SISO standards.....................................................................................334
● 802.11p channel models....................................................................................... 335
● 5G NR standards.................................................................................................. 337
● 5G NR MIMO OTA channel models......................................................................342
● 5G NR high speed train.........................................................................................344
● 5G NR moving propagation...................................................................................345

A.1  CDMA standards

Option: R&S SMW-B14/B15

CDMA standards



Predefined fading settingsFading Simulation

243User Manual 1175.6826.02 ─ 29

A.1.1  CDMA 1 (8km/h - 2 path)

Table A-1: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 8 8

also with 15km/h in band class 5

A.1.2  CDMA 2 (30km/h - 2 path)

Table A-2: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 30 30

also with 14km/h in band classes 1,4,6,8

also with 58km/h in band class 5

A.1.3  CDMA 3 (30km/h - 1 path)

Table A-3: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0
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 Path 1

Delay [ns]: 0

LogNormal off

Correlated with: off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 30

also with 58km/h in band class 5

A.1.4  CDMA 4 (100km/h - 3 path)

Table A-4: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Correlated with: off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 100 100 100

also with 192km/h in band class 5

A.1.5  CDMA 5 (0km/h - 2 path)

Table A-5: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Correlated with: off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.1.6  CDMA 6 (3km/h - 1 path)

Table A-6: C.S0011-A_MS_Minimum_Performance_Spec.pdf

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Correlated with: off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 3

A.2  GSM standards

Option: R&S SMW-B14/B15

A.2.1  GSM TU3 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3
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A.2.2  GSM TU50 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.2.3  GSM HT100 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1,5 4,5 7,5 8 17,7

Delay [ns]: 0 100 300 500 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.2.4  GSM RA250 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 6,88 0 0 0 0 0

Freq Ratio: 0,7 0 0 0 0 0

Speed [km/h]: 250 250 250 250 250 250
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There has been a change in the specifications TS8916B, Baseline Change from 5.1.0
to 5.2.0. The power ratio for path 1 with Rice fading is now no longer referred only to
Rayleigh of path 1. Instead, it is referred to the total power of all of the paths.
The preset value used in the instrument of 6.88 fulfills this requirement. It does not
conform to the value given in the specification since the instrument always determines
the power ratio for one path. By taking into account the power of the other paths in cal-
culating this value, however, the required power ratio for all six paths is achieved.

A.2.5  GSM ET50 (EQ50) (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.2.6  GSM ET60 (EQ60) (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 60 60 60 60 60 60

GSM standards
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A.2.7  GSM ET100 (EQ100) (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.2.8  GSM TU3 (12 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3 3

GSM standards



Predefined fading settingsFading Simulation

249User Manual 1175.6826.02 ─ 29

A.2.9  GSM TU50 (12 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.2.10  GSM HT100 (12 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10 8 6 4 0 0

Delay [ns]: 0 100 300 500 700 1000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 8 9 10 12 14

GSM standards
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Delay [ns]: 1300 15000 15200 15700 17200 20000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.2.11  GSM TI5

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 400

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 5 5

A.3  NADC standards

Option: R&S SMW-B14/B15

Path 2 should be placed in its own group (delay max. 40 000 ns).

A.3.1  NADC 8 (2 path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off

NADC standards
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 Path 1 Path 2

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 8 8

A.3.2  NADC 50 (2 path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.3.3  NADC 100 (2 path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 41200

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 100 100

A.4  PCN standards

Option: R&S SMW-B14/B15

PCN standards
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A.4.1  PCN TU1.5 (6 path)

Same as GSM Tux

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 1,5 1,5 1,5 1,5 1,5 1,5

A.4.2  PCN TU50 (6 path)

Same as GSM TU50

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.4.3  PCN HT100 (6 path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1,5 4,5 7,5 8 17,7

Delay [ns]: 0 100 300 500 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

PCN standards
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 100 100 100 100 100 100

A.4.4  PCN RA130 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 6,47 0 0 0 0 0

Freq Ratio: 0,7 0 0 0 0 0

Speed [km/h]: 130 130 130 130 130 130

A.4.5  PCN ET50 (EQ50) (6 path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.4.6  PCN ET60 (EQ60) (6 path)

Same as GSM

PCN standards
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60

A.4.7  PCN ET100 (EQ100) (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0 0 0 0

Delay [ns]: 0 3200 6400 9600 12800 16000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

A.4.8  PCN TU1.5 (12 path)

Same as GSM Tux

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

1,5 1,5 1,5 1,5 1,5 1,5

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

1,5 1,5 1,5 1,5 1,5 1,5

A.4.9  PCN TU50 (12 path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

PCN standards
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio [dB]: 0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed [km/h]: 50 50 50 50 50 50

A.4.10  PCN HT100 (12 path)

Same as GSM

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10 8 6 4 0 0

Delay [ns]: 0 100 300 500 700 1000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 4 8 9 10 12 14

Delay [ns]: 1300 15000 15200 15700 17200 20000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100

A.5  TETRA standards

Option: R&S SMW-B14/B15

TETRA standards
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A.5.1  TETRA TU50 (2 path)

EN300 392-2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 22,3

Delay [ns]: 0 5000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.5.2  TETRA TU50 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3.00 0 2.0 6.0 8.0 10.0

Delay [ns]: 0 0 0 0 0 0

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.5.3  TETRA BU50 (2 path)

EN300 392-2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 3

Delay [ns]: 0 5000

LogNormal off off
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 Path 1 Path 2

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.5.4  TETRA HT200 (2 path)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 8,6

Delay [ns]: 0 15000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 200 200

A.5.5  TETRA HT200 (6 path)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 2 4 7 6 12

Delay [ns]: 0 200 400 600 15000 17200

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

200.02 200.02 200.02 200.02 200.02 200.02

A.5.6  TETRA ET200 (4 path)

EN300 392-2, Equalizer Test

TETRA standards
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Note:Path 3 and 4 should be placed in their own group (delay max. 40 000 ns)

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 10,2 16

Delay [ns]: 0 11600 73200 99300

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 200 200 200 200

A.5.7  TETRA DU 50 (1Path)

ETSI EN 300 396-2 V1.2.1

 Path 1

Profile [Type] Rice

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0,7

Speed [km/h]: 50

A.5.8  TETRA DR 50 (1Path)

ETSI EN 300 396-2 V1.2.1

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off
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 Path 1

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 50

A.6  3GPP standards

Option: R&S SMW-K71

VAx are typical fading profiles, with x representing the speed, such as VA3 represents
3 km/h.
These standards define a certain combination of channels with a specific doppler fre-
quency. Basically, the maximum possible doppler frequency of a path is determined by
the RF output frequency and the speed of the moving mobile receiver. However, if you
change the RF frequency in a VAx standard, the doppler frequency remains the same,
thus resulting in individual speed settings.
Refer also to Chapter A.6.12, "3GPP mobile VA3, 3GPP mobile VA30, 3GPP mobile
VA120", on page 265 for VAx fading profiles.

A.6.1  3GPP case 1 (UE/BS)

Table A-7: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex
D.2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 3 3

3GPP standards
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A.6.2  3GPP case 2 (UE/BS)

Table A-8: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0 (2003-09), annex
D.2

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 0

Delay [ns]: 0 976 20000

LogNormal off Off off

Corr with off Off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 3 3 3

A.6.3  3GPP case 3 (UE/BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0
(2003-09), annex D.2

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 6 9

Delay [ns]: 0 260 521 781

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 120 120 120 120

A.6.4  3GPP case 4 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 976

LogNormal off off
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 Path 1 Path 2

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 3 3

A.6.5  3GPP case 5 (UE)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 50 50

A.6.6  3GPP case 6 (UE) and case 4 (BS)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2 and 3GPP TS 25.141 V6.3.0
(2003-09), annex D.2

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 6 9

Delay [ns]: 0 260 521 781

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 250 250 250 250
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A.6.7  3GPP mobile case 7 (UE-Sector)

Table A-9: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4.3 6.6 2 7 7.5

Delay [ns]: 0 260 1040 4690 7290 14580

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

50 50 50 50 50 50

A.6.8  3GPP mobile case 7 (UE-Beam)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2

 Path 4 Path 5 Path 6

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0.3 0.9

Delay [ns]: 4690 7290 14580

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 50 50 50

A.6.9  3GPP mobile case 8 (UE, CQI)

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, Table B.1C;

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 10

Delay [ns]: 0 976

LogNormal off off
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 Path 1 Path 2

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 30 30

A.6.10  3GPP mobile PA3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian A (HSDPA)

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 9.7 19.2 22.8

Delay [ns]: 0 110 190 410

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 3 3 3 3

A.6.11  3GPP mobile PB3

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU Pedestrian B (HSDPA)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0.9 4.9 8 7.8 23.9

Delay [ns]: 0 200 800 1200 2300 3700

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

3 3 3 3 3 3

3GPP standards
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A.6.12  3GPP mobile VA3, 3GPP mobile VA30, 3GPP mobile VA120

Table A-10: 3GPP TS 25.101 V6.2.0 (2003-09), annex B2.2, ITU vehicular A (HSDPA)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1) 3 | 30 | 120 1)

1) Speed of the respective standard VAx: VA3 = 3 km/h, VA30 = 30 km/h and VA120 =
120 km/h.

A.6.13  3GPP MBSFN propagation channel profile (18 path)

Table A-11: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1.5 1.4 3.6 0.6 7.0

Delay [ns]: 0 30 150 310 370 1090

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3

Table A-12: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0 (Cont.)

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10.0 11.5 11.4 13.6 10.6 17.0

Delay [ns]: 12490 12520 12640 12800 12860 13580
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 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3

Table A-13: 3GPP 3GPP TS 36.521-1 respectivelly TS36.101 V9.8.0 (Cont.)

 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 20.0 21.5 21.4 23.6 20.6 27.0

Delay [ns]: 27490 27520 27640 27800 27860 28580

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Frequency
[Hz]: *

3 3 3 3 3 3

A.6.14  3GPP birth death

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.4

 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0 to 10us 0 to 10us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Dwell: 191ms

(Mean)-Offset: 5 us

3GPP standards
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A.6.15  3GPP TUx

Table A-14: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 18

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 7.6 10.1 10.2 5.7 16.3

Delay [ns]: 217 512 514 0 1230

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

Table A-15: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 10.2 11.5 13.4 21.5 21.6

Delay [ns]: 517 674 882 1820 1840

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

Table A-16: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 11 Path 12 Path 13 Path 14 Path 15

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 16.9 17.1 17.4 22.1 22.6

Delay [ns]: 1287 1311 1349 1880 1940

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3
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Table A-17: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 16 Path 19 Path 5 Path 17 Path 20

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 19 19 19.8 23.5 24.3

Delay [ns]: 1533 1540 1620 2050 2140

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 3 3 3 3 3

A.6.16  3GPP HTx

Table A-18: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9 Path 10

Profile
[Type]

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Loss
[dB]:

8.9 10.2 11.5 3.6 17.6 11.8 12.7 13 25.8 26.2

Delay
[ns]:

356 441 528 0 15000 546 609 625 16880 16980

Log-
Normal

off off off off off off off off off off

Corr
with

off off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100 100 100 100 100

Table A-19: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path
11

Path
12

Path
13

Path
14

Path
15

Path
16

Path
17

Path
18

Path
19

Path
20

Profile
[Type]

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Ray-
leigh

Loss
[dB]:

16.2 17.3 17.7 29 29.9 22.7 24.1 25.8 30 30.7
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 Path
11

Path
12

Path
13

Path
14

Path
15

Path
16

Path
17

Path
18

Path
19

Path
20

Delay
[ns]:

842 916 941 17620 17830 16172 16492 16876 17850 18020

Log-
Normal

off off off off off off off off off off

Corr
with

off off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0 0

Speed
[km/h]:

100 100 100 100 100 100 100 100 100 100

A.6.17  3GPP RAx

Table A-20: 3GPP TS 25.943 V5.1.0 (2002-06)

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Pure Dop Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 5.2 6.4 8.4 9.3 10

Delay [ns]: 0 42 101 129 149

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Freq Ratio: 0.7 0 0 0 0

Speed [km/h]: 250 250 250 250 250

Table A-21: 3GPP TS 25.943 V5.1.0 (2002-06) (Cont.)

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 13.1 15.3 18.5 20.4 22.4

Delay [ns]: 245 312 410 469 528

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0
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 Path 6 Path 7 Path 8 Path 9 Path 10

Freq Ratio: 0 0 0 0 0

Speed [km/h]: 250 250 250 250 250

A.6.18  3GPP birth death

3GPP TS 25.101 V6.2.0 (2003-09), annex B2.4

 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0…10us 0…10us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Dwell: 191ms

(Mean)-Offset: 5 us

A.6.19  Reference + moving channel

See Chapter A.15.1, "Reference + moving channel", on page 307.

A.6.20  HST1 open space, HST1 open space (DL+UL)

See Chapter A.14.1, "HST1 open space, HST1 open space (DL+UL)", on page 305.

A.6.21  HST2 tunnel leaky cable

See Chapter A.14.2, "HST2 tunnel leaky cable, HST2 tunnel leaky cable (DL+UL)",
on page 305.

A.6.22  HST3 tunnel multi antennas, HST3 tunnel multi antennas (DL+UL)

See Chapter A.14.3, "HST3 tunnel multi antennas, HST3 tunnel multi antennas (DL
+UL)", on page 306.
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A.7  WLAN standards

Option: R&S SMW-B14/B15

A.7.1  WLAN / hyperlan/2 model a

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

2,6 0,9 1,7 0 3,5 4,3 7,8 6,1 6,9

Delay
[ns]:

30 10 20 0 40 50 90 70 80

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 12 Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

5,2 4,7 7,3 9,9 12,5 13,7 18 22,4 26,7

Delay
[ns]:

60 110 140 170 200 240 290 340 390

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8
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Corresp. to a typical office environment for NLOS conditions and an average rms delay
spread of 50ns

A.7.2  WLAN / hyperlan/2 model b

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3,9 3 0 2,6 3,5 1,3 2,6 5,6 3,4

Delay
[ns]:

30 10 50 0 20 80 110 230 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 14 Path 12 Path 15 Path 11 Path 13 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3,9 7,7 9,9 12,1 14,3 15,4 18,4 20,7 24,6

Delay
[ns]:

140 280 330 380 430 490 560 640 730

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresp. to a typical large open space and office environments for NLOS conditions
and an average rms delay spread of 100ns
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A.7.3  WLAN / hyperlan/2 model c

 Path 4 Path 2 Path 5 Path 1 Path 3 Path 6 Path 7 Path 10 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3,3 3,6 3,9 4,2 0 0,9 1,7 2,6 1,5

Delay
[ns]:

0 10 20 30 50 80 110 140 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 8 Path 14 Path 12 Path 13 Path 11 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

3 4,4 5,9 5,3 7,9 9,4 13,2 16,3 21,2

Delay
[ns]:

230 280 330 400 490 600 730 880 1050

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8
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A.7.4  WLAN / hyperlan/2 model d

 Path 4 Path 2 Path 5 Path 1 Path 3 Path 6 Path 7 Path 10 Path 9

Profile
[Type]

Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

0 10 10,3 10,6 6,4 7,2 8,1 9 7,9

Delay
[ns]:

0 10 20 30 50 80 110 140 180

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

10 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 8 Path 14 Path 12 Path 13 Path 11 Path 15 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

9,4 10,8 12,3 11,7 14,3 15,8 19,6 22,7 27,6

Delay
[ns]:

230 280 330 400 490 600 730 880 1050

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresponds to a typical office environment for "LOS" conditions. A 10db spike at 0
delay has been added resulting in an average rms delay spread of 140ns
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A.7.5  WLAN / hyperlan/2 model e

 Path 5 Path 2 Path 3 Path 4 Path 1 Path 6 Path 7 Path 8 Path 9

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

4,9 5,1 5,2 0,8 1,3 1,9 0,3 1,2 2,1

Delay
[ns]:

0 10 20 40 70 100 140 190 240

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

 Path 10 Path 11 Path 15 Path 13 Path 14 Path 12 Path 16 Path 17 Path 18

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss
[dB]:

0 1,9 2,8 5,4 7,3 10,6 13,4 17,4 20,9

Delay
[ns]:

320 430 560 710 880 1070 1280 1510 1760

LogNor-
mal

off off off off off off off off off

Corr
with

off off off off off off off off off

Power
Ratio
[dB]:

0 0 0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0 0 0

Speed
[km/h]:

10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8 10,8

Corresponds to a typical large open space environment for NLOS conditions and an
average rms delay spread of 250ns
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A.8  DAB standards

Option: R&S SMW-K72

A.8.1  DAB RA (4Tabs)

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Rice Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 2 10 20

Delay [ns]: 0 200 400 600

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]:  0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: 120 120 120 120

Tap 2: S(d) = 0,1 +/- 0,02

A.8.2  DAB RA (6 tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rice Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 4 8 12 16 20

Delay [ns]: 0 100 200 300 400 500

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

120 120 120 120 120 120
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A.8.3  DAB TU (12 tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Gaus1 Gaus1

Loss [dB]: 4 3 0 2,6 3 5

Delay [ns]: 0 100 300 500 800 1100

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Profile
[Type]

Gaus1 Gaus1 Gaus2 Gaus2 Gaus2 Gaus2

Loss [dB]: 7 5 6,5 8,6 11 10

Delay [ns]: 1300 1700 2300 3100 3200 5000

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

Tap 6: S(d) = 1,0 +/- 0,1

A.8.4  DAB TU (6 tabs)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Gaus1 Gaus2 Gaus2

Loss [dB]: 3 0 2 6 8 10

Delay [ns]: 0 200 500 1600 2300 5000

LogNormal off off off off off off

Corr with off off off off off off
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

25 25 25 25 25 25

Tap 3: S(d) = 1,0 +/- 0,1

A.8.5  DAB SFN (VHF)

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6 Path 7

Profile
[Type]

Rayleigh GausDAB GausDAB GausDAB GausDAB GausDAB GausDAB

Loss [dB]: 0 13 18 22 26 31 32

Delay [ns]: 0 100000 220000 290000 385000 480000 600000

LogNor-
mal

off off off off off off off

Corr with off off off off off off off

Power
Ratio [dB]:

0 0 0 0 0 0 0

Freq
Ratio:

0 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60 60

Needs both Fading Boards combined, i.e. Signal Routing "A->A(max paths) || B-
>B(unfaded)" or "A->A(unfaded) || B->B(max paths)".
Do not use Group 5.

A.9  WIMAX standards

● WiMAX SUI x
Option: R&S SMW-K72

● WiMAX ITU
Option: R&S SMW-B14/B15

WIMAX standards



Predefined fading settingsFading Simulation

279User Manual 1175.6826.02 ─ 29

A.9.1  SUI 1 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 15 20

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 6,0206 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K-fact. = 4 ->> 10lg4 = 6,02

A.9.2  SUI 1 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 15 20

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 13,0103 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

A.9.3  SUI 1 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 21 32

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 12,0412 0 0
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 Path 1 Path 2 Path 3

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

A.9.4  SUI 1 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 21 32

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 18,57332 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K-fact. = 72

A.9.5  SUI 2 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 12 15

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 10,41393 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

A.9.6  SUI 2 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 18 27
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 Path 1 Path 2 Path 3

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 9,0309 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=8

A.9.7  SUI 2 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 18 27

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 15,56303 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=36

A.9.8  SUI 3 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06
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A.9.9  SUI 3 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 8,45098 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=7

A.9.10  SUI 3 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 4,771213 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=3

A.9.11  SUI 3 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 400 900

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 12,78754 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=19

A.9.12  SUI 4 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 4 8

Delay [ns]: 0 1500 4000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.13  SUI 4 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 4 8

Delay [ns]: 0 1500 4000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=1
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A.9.14  SUI 4 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 20

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=1

A.9.15  SUI 4 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 20

Delay [ns]: 0 400 1100

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 6,9897 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=5

A.9.16  SUI 5 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.17  SUI 5 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.18  SUI 5 (omni ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 5 10

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=2
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A.9.19  SUI 5 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=0 (no Rice-component)

A.9.20  SUI 5 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=2

A.9.21  SUI 5 (30° ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 11 22

Delay [ns]: 0 4000 10000

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 8,45098 0 0

Freq Ratio: 0,2 0,15 0,25

Speed [km/h]: 0.03 0.02 0.03

K=7

A.9.22  SUI 6 (omni ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)

A.9.23  SUI 6 (omni ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)
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A.9.24  SUI 6 (omni ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 10 14

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=1

A.9.25  SUI 6 (30° ant., 90%)

 Path 1 Path 2 Path 3

Profile [Type] WMDopp WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=0 (no Rice-component)

A.9.26  SUI 6 (30° ant., 75%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off
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 Path 1 Path 2 Path 3

Power Ratio [dB]: 3,0103 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=2

A.9.27  SUI 6 (30° ant., 50%)

 Path 1 Path 2 Path 3

Profile [Type] WMRice WMDopp WMDopp

Loss [dB]: 0 16 26

Delay [ns]: 0 14000 20000

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 6,9897 0 0

Freq Ratio: 0,4 0,3 0,5

Speed [km/h]: 0.05 0.04 0.06

K=5

A.9.28  ITU OIP-A

 Path 1
(Path 4)

Path 2 Path 3 Path 4
(Path 1)

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 9,7 19,2 22,8

Delay [ns]: 0 110 190 410

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

Freq Ratio: 0 0 0 0

Speed [km/h]: - - - -
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A.9.29  ITU OIP-B

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0,9 4,9 8 7,8 23,9

Delay [ns]: 0 200 800 1200 2300 3700

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

- - - - - -

A.9.30  ITU V-A 60

 Path 1
(Path 4)

Path 2 Path 3 Path 4
(Path 1)

Path 5
(Path 7)

Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60

A.9.31  ITU V-A 120

 Path 1
(Path 4)

Path 2 Path 3 Path 4
(Path 1)

Path 5
(Path 7)

Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 10000
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 Path 1
(Path 4)

Path 2 Path 3 Path 4
(Path 1)

Path 5
(Path 7)

Path 6

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Freq Ratio: 0 0 0 0 0 0

Speed
[km/h]:

120 120 120 120 120 120

A.10  LTE standards

Option: R&S SMW-B14/B15

A.10.1  CQI 5Hz

CQI Tests according to 3GPP 36.521.1 Version 9.1.0, B2.4

 Path 1 Path 2

Profile [Type] Const. Phase Pure Doppler

Loss [dB]: 0 0

Delay [ns]: 0 450

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [Hz]: 0 5 Hz

A.10.2  EPA (Extended pedestrian A)

Table A-22: 3GPP TR36.803

 Path 4 Path 2 Path 3 Path 1 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh  

Loss [dB]: 0 1 2 3  

Delay [ns]: 0 30 70 90  

LogNormal off off off off  

Corr with off off off off  
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 Path 4 Path 2 Path 3 Path 1 Path 5

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh   

Loss [dB]: 17.2 20.8 8   

Delay [ns]: 190 410 110   

LogNormal off off off   

Corr with off off off   

Power Ratio
[dB]:

0 0 0   

Frequency
[Hz]: *

     

*) Frequency [Hz] = 1 Hz or 5 Hz

A.10.3  EVA (Extended vehicular A)

Table A-23: 3GPP TR36.803

 Path 4 Path 2 Path 3 Path 1 Path 11

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1.5 1.4 3.6 0.6

Delay [ns]: 0 30 150 310 370

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 12 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh  

Loss [dB]: 9.1 7 12 16.9  

Delay [ns]: 710 1090 1730 2510  

LogNormal off off off off  

Corr with off off off off  
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 Path 4 Path 2 Path 3 Path 1 Path 11

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

*) Frequency [Hz] = 5 Hz or 70 Hz

A.10.4  ETU (Extended typical urban)

Table A-24: 3GPP TR36.803

 Path 5 Path 2 Path 3 Path 4 Path 1

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 1 1 1 0 0

Delay [ns]: 0 50 120 200 230

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 9 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 5 7  

Delay [ns]: 500 1600 2300 5000  

LogNormal off off off off  

Corr with off off off off  

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

*) Frequency [Hz] = 1 Hz, 5 Hz, 30 Hz, 70 Hz, 200 Hz, 300 Hz or 600 Hz

A.10.5  MBSFN propagation channel profile (5 hz)

See Chapter A.6.13, "3GPP MBSFN propagation channel profile (18 path)",
on page 265.

* All fading paths use "Frequency = 5 Hz" and "Speed = 5.4 km/h".
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A.10.6  HST 1 open space

See Chapter A.14.1, "HST1 open space, HST1 open space (DL+UL)", on page 305.

A.10.7  HST 1 500 A/B, HST 3 500 A/B

According to 3GPP TS 36.141, Release 16.

The following applies to all HST scenarios:
● "Signal Dedicated to = Baseband Output"
● "Consider DL RF = Yes"

Fading scenario HST1-LTE500a HST1-LTE500b HST3-LTE500a HST3-LTE500b

Virtual RF [MHz] 2010 1880 2010 1880

Profile Pure Doppler Pure Doppler Pure Doppler Pure Doppler

Speed [km/h]: 500 500 500 500

Dmin [m] 50 50 2 2

Ds [m] 1000 1000 300 300

Virtual DL RF [MHz] 2010 1880 2010 1880

A.10.8  HST 3 tunnel multi antennas

See Chapter A.14.3, "HST3 tunnel multi antennas, HST3 tunnel multi antennas (DL
+UL)", on page 306.

A.10.9  ETU 200Hz moving

See Chapter A.15.2, "ETU 200Hz moving (UL timing adjustment, scenario 1)",
on page 307.

A.10.10  Pure doppler moving

See Chapter A.15.3, "Pure doppler moving (UL timing adjustment, scenario 2)",
on page 308.

A.11  LTE-MIMO standards

Option: R&S SMW-K74
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A.11.1  EPA (Extended pedestrian A)

See Chapter A.10.2, "EPA (Extended pedestrian A)", on page 291.

A.11.2  EVA (Extended vehicular A)

 Path 1 Path 2 Path 3 Path 11 Path 12

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1.5 1.4 3.6 0.6

Delay [ns]: 0 30 150 310 370

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Frequency
[Hz]: *

     

 Path 6 Path 7 Path 8 Path 13 Path 10

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 9.1 7 12 16.9  

Delay [ns]: 710 1090 1730 2510  

LogNormal off off off off  

Corr with off off off off  

Power Ratio
[dB]:

0 0 0 0  

Frequency
[Hz]: *

     

A.11.3  ETU (Extended typical urban)

See Chapter A.10.4, "ETU (Extended typical urban)", on page 293.

A.11.4  MIMO parameter

Table A-25: R-High

real imaginary real imaginary real imaginary real imaginary

1 0 -0.4193 0.24 0.5297 0.7013 -0.3904 -0.1669

-0.4193 -0.24 1 0 -0.0538 -0.4212 0.5297 0.7013
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real imaginary real imaginary real imaginary real imaginary

0.5297 -0.7013 -0.0538 0.4212 1 0 -0.4193 0.24

-0.3904 0.1669 0.5297 -0.7013 -0.4193 -0.24 1 0

Table A-26: R-Medium

real imaginary real imaginary real imaginary real imaginary

1 0 0 0 0.7264 0 0 0

0 0 1 0 0 0 -0.7264 0

0.7264 0 0 0 1 0 0 0

0 0 -0.7264 0 0 0 1 0

Table A-27: R-Low

real imaginary real imaginary real imaginary real imaginary

1 0 0 0 0 0 0 0

0 0 1 0 0 0 0 0

0 0 0 0 1 0 0 0

0 0 0 0 0 0 1 0

The MIMO correlation matrices for the high, medium and low antenna correlation for
the 1x2, 2x2 and 4x2 MIMO configurations are calculated according to 3GPP
TS36.101, annex B2.3.2.

A.11.5  HST3 tunnel multi antennas

See Chapter A.14.3, "HST3 tunnel multi antennas, HST3 tunnel multi antennas (DL
+UL)", on page 306.

A.12  WIMAX-MIMO standards

Option: R&S SMW-K74

A.12.1  ITU pedestrian b 3

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0,9 4,9 8 7,8 23,9

Delay [ns]: 0 200 800 1200 2300 3700
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 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Speed
[km/h]:

3 3 3 3 3 3

Table A-28: MIMO Parameter - High Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 -0,1468 0,4156 0,0303 0,7064 -0,298 -0,0911

 -0,1468 -0,4156 1 0 0,28913 -0,1163 0,0303 0,7064

 0,0303 -0,7064 0,28913 0,11629 1 0 -0,1468 0,4156

 -0,298 0,09111 0,0303 -0,7064 -0,1468 -0,4156 1 0

TAP 2 1 0 -0,4467 0,4227 -0,4007 -0,6073 0,4357 0,10191

 -0,4467 -0,4227 1 0 -0,0777 0,44066 -0,4007 -0,6073

 -0,4007 0,6073 -0,0777 -0,4407 1 0 -0,4467 0,4227

 0,4357 -0,1019 -0,4007 0,6073 -0,4467 -0,4227 1 0

TAP 3 1 0 -0,2906 0,4347 -0,6664 0,262 0,07976 -0,3658

 -0,2906 -0,4347 1 0 0,30755 0,21355 -0,6664 0,262

 -0,6664 -0,262 0,30755 -0,2135 1 0 -0,2906 0,4347

 0,07976 0,36582 -0,6664 -0,262 -0,2906 -0,4347 1 0

TAP 4 1 0 -0,4273 0,4259 -0,6522 0,2088 0,18976 -0,367

 -0,4273 -0,4259 1 0 0,36761 0,18855 -0,6522 0,2088

 -0,6522 -0,2088 0,36761 -0,1886 1 0 -0,4273 0,4259

 0,18976 0,36699 -0,6522 -0,2088 -0,4273 -0,4259 1 0

TAP 5 1 0 -0,7026 -0,3395 -0,5378 -0,4866 0,21266 0,52447

 -0,7026 0,3395 1 0 0,54306 0,1593 -0,5378 -0,4866

 -0,5378 0,4866 0,54306 -0,1593 1 0 -0,7026 -0,3395

 0,21266 -0,5245 -0,5378 0,4866 -0,7026 0,3395 1 0

TAP 6 1 0 -0,45 0,4222 -0,4564 -0,5655 0,44413 0,06178

 -0,45 -0,4222 1 0 -0,0334 0,44717 -0,4564 -0,5655

 -0,4564 0,5655 -0,0334 -0,4472 1 0 -0,45 0,4222

 0,44413 -0,0618 -0,4564 0,5655 -0,45 -0,4222 1 0
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Table A-29: MIMO Parameter - Medium Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1-
TAP 6

1 0 0 0 0,7264 0 0 0

 0 0 1 0 0 0 -0,7264 0

 0,7264 0 0 0 1 0 0 0

 0 0 -0,7264 0 0 0 1 0

Table A-30: MIMO Parameter - Low Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 0 0 0,02201 0,51313 0 0

 0 0 1 0 0 0 -0,022 -0,5131

 0,02201 -0,5131 0 0 1 0 0 0

 0 0 -0,022 0,51313 0 0 1 0

TAP 2 1 0 0 0 -0,2911 -0,4411 0 0

 0 0 1 0 0 0 0,29107 0,44114

 -0,2911 0,44114 0 0 1 0 0 0

 0 0 0,29107 -0,4411 0 0 1 0

TAP 3 1 0 0 0 -0,4841 0,19032 0 0

 0 0 1 0 0 0 0,48407 -0,1903

 -0,4841 -0,1903 0 0 1 0 0 0

 0 0 0,48407 0,19032 0 0 1 0

TAP 4 1 0 0 0 -0,4738 0,15167 0 0

 0 0 1 0 0 0 0,47376 -0,1517

 -0,4738 -0,1517 0 0 1 0 0 0

 0 0 0,47376 0,15167 0 0 1 0

TAP 5 1 0 0 0 -0,3907 -0,3535 0 0

 0 0 1 0 0 0 0,39066 0,35347

 -0,3907 0,35347 0 0 1 0 0 0

 0 0 0,39066 -0,3535 0 0 1 0

TAP 6 1 0 0 0 -0,3315 -0,4108 0 0

 0 0 1 0 0 0 0,33153 0,41078

 -0,3315 0,41078 0 0 1 0 0 0

 0 0 0,33153 -0,4108 0 0 1 0
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A.12.2  ITU vehicular A-60

 Path 1 Path 2 Path 3 Path 4
(Path 7)

Path 5
(Path 8)

Path 6

Profile
[Type]

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 1 9 10 15 20

Delay [ns]: 0 310 710 1090 1730 2510

LogNormal off off off off off off

Corr with off off off off off off

Power Ratio
[dB]:

0 0 0 0 0 0

Speed
[km/h]:

60 60 60 60 60 60

Table A-31: MIMO Parameter - High Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 -0,2366 0,4312 0,6883 0,1211 -0,2151 0,26814

 -0,2366 -0,4312 1 0 -0,1106 -0,3254 0,6883 0,1211

 0,6883 -0,1211 -0,1106 0,32545 1 0 -0,2366 0,4312

 -0,2151 -0,2681 0,6883 -0,1211 -0,2366 -0,4312 1 0

TAP 2 1 0 0,1388 0,2343 -0,3508 -0,5926 0,09016 -0,1644

 0,1388 -0,2343 1 0 -0,1875 -6E-05 -0,3508 -0,5926

 -0,3508 0,5926 -0,1875 6E-05 1 0 0,1388 0,2343

 0,09016 0,16445 -0,3508 0,5926 0,1388 -0,2343 1 0

TAP 3 1 0 -0,6443 0,365 0,3884 -0,5604 -0,0457 0,50283

 -0,6443 -0,365 1 0 -0,4548 0,2193 0,3884 -0,5604

 0,3884 0,5604 -0,4548 -0,2193 1 0 -0,6443 0,365

 -0,0457 -0,5028 0,3884 0,5604 -0,6443 -0,365 1 0

TAP 4 1 0 -0,362 0,4331 0,1899 0,6795 -0,363 -0,1637

 -0,362 -0,4331 1 0 0,22555 -0,3282 0,1899 0,6795

 0,1899 -0,6795 0,22555 0,32822 1 0 -0,362 0,4331

 -0,363 0,16373 0,1899 -0,6795 -0,362 -0,4331 1 0

TAP 5 1 0 -0,7074 0,3372 -0,3933 -0,565 0,46874 0,26706

 -0,7074 -0,3372 1 0 0,0877 0,5323 -0,3933 -0,565

 -0,3933 0,565 0,0877 -0,5323 1 0 -0,7074 0,3372

WIMAX-MIMO standards



Predefined fading settingsFading Simulation

300User Manual 1175.6826.02 ─ 29

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

 0,46874 -0,2671 -0,3933 0,565 -0,7074 -0,3372 1 0

TAP 6 1 0 -0,4405 0,4238 -0,4383 -0,58 0,43888 0,06974

 -0,4405 -0,4238 1 0 -0,0527 0,44124 -0,4383 -0,58

 -0,4383 0,58 -0,0527 -0,4412 1 0 -0,4405 0,4238

 0,43888 -0,0697 -0,4383 0,58 -0,4405 -0,4238 1 0

Table A-32: MIMO Parameter - Medium Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1-
TAP 6

1 0 0 0 0,7264 0 0 0

 0 0 1 0 0 0 -0,7264 0

 0,7264 0 0 0 1 0 0 0

 0 0 -0,7264 0 0 0 1 0

Table A-33: MIMO Parameter - Low Correlation

 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

TAP 1 1 0 0 0 0,49998 0,08797 0 0

 0 0 1 0 0 0 -0,5 -0,088

 0,49998 -0,088 0 0 1 0 0 0

 0 0 -0,5 0,08797 0 0 1 0

TAP 2 1 0 0 0 -0,2548 -0,4305 0 0

 0 0 1 0 0 0 0,25482 0,43046

 -0,2548 0,43046 0 0 1 0 0 0

 0 0 0,25482 -0,4305 0 0 1 0

TAP 3 1 0 0 0 0,28213 -0,4071 0 0

 0 0 1 0 0 0 -0,2821 0,40707

 0,28213 0,40707 0 0 1 0 0 0

 0 0 -0,2821 -0,4071 0 0 1 0

TAP 4 1 0 0 0 0,13794 0,49359 0 0

 0 0 1 0 0 0 -0,1379 -0,4936

 0,13794 -0,4936 0 0 1 0 0 0

 0 0 -0,1379 0,49359 0 0 1 0

TAP 5 1 0 0 0 -0,3907 -0,3535 0 0
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 real imagi-
nary

real imagi-
nary

real imagi-
nary

real imagi-
nary

 0 0 1 0 0 0 0,39066 0,35347

 -0,3907 0,35347 0 0 1 0 0 0

 0 0 0,39066 -0,3535 0 0 1 0

TAP 6 1 0 0 0 -0,3184 -0,4213 0 0

 0 0 1 0 0 0 0,31838 0,42131

 -0,3184 0,42131 0 0 1 0 0 0

 0 0 0,31838 -0,4213 0 0 1 0

A.13  1xevdo standards

Option: R&S SMW-B14/B15

According to 3GPP2 C.S0032-A v2.0

A.13.1  1xevdo chan. 1

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 8 8

A.13.2  1xevdo chan. 1 (Bd. 5, 11)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off
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 Path 1 Path 2

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 15 15

A.13.3  1xevdo chan. 2

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 3

A.13.4  1xevdo chan. 2 (Bd. 5, 11)

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 6

A.13.5  1xevdo chan. 3

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0
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 Path 1

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 30

A.13.6  1xevdo chan. 3 (Bd. 5, 11)

 Path 1

Profile [Type] Rayleigh

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 0

Speed [km/h]: 58

A.13.7  1xevdo chan. 4

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 100 100 100

1xevdo standards
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A.13.8  1xevdo chan. 4 (Bd. 5, 11)

 Path 1 Path 2 Path 3

Profile [Type] Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 0 3

Delay [ns]: 0 2000 14500

LogNormal off off off

Corr with off off off

Power Ratio [dB]: 0 0 0

Freq Ratio: 0 0 0

Speed [km/h]: 192 192 192

A.13.9  1xevdo chan. 5

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.13.10  1xevdo chan. 5 (Bd. 5, 11)

 Path 1 Path 2

Profile [Type] Rayleigh Rayleigh

Loss [dB]: 0 0

Delay [ns]: 0 2000

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0
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 Path 1 Path 2

Freq Ratio: 0 0

Speed [km/h]: 0 0

A.14  3GPP/LTE high speed train

Option: R&S SMW-K74 and R&S SMW-K71

A.14.1  HST1 open space, HST1 open space (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3
"High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: -

Freq Ratio:  

Speed [km/h]: 350km/h

Dmin 50m

Ds 1000m

A.14.2  HST2 tunnel leaky cable, HST2 tunnel leaky cable (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

3GPP/LTE high speed train
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 Path 1

Profile [Type] Rice

Loss [dB]: 10

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Freq Ratio: 1

Speed [km/h]: 300km/h

A.14.3  HST3 tunnel multi antennas, HST3 tunnel multi antennas (DL+UL)

3GPP TS25.141, annex D.4A "High Speed Train" and 3GPP TS36.141, annex B.3A
"High Speed Train"

The HST DL+UL standards consider the downlink and the uplink. That is, if a doppler
shift occurs in the downlink, the mobile receiver synchronizes to that shifted frequency.
The uplink to the base station then results in a doppler shift enlarged by a factor based
on the sum of the DL and UL frequency.

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: -

Freq Ratio:  

Speed [km/h]: 300km/h

Dmin 2m

Ds 300m

A.15  3GPP/LTE moving propagation

Option: R&S SMW-K71

3GPP/LTE moving propagation
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A.15.1  Reference + moving channel

Table A-34: 3GPP TS 25.101, annex B2.3

 Path 1 Path 2

Profile [Type] Static Static

Loss [dB]: 0 0

Delay [ns]: 0 1 to 6us

LogNormal off off

Corr with off off

Power Ratio [dB]: 0 0

Freq Ratio: 1 1

Speed [km/h]: 0 0

Period: 157,0796s = 2*PI/0.04

(Mean)-Delay: 3.5μs

A.15.2  ETU 200Hz moving (UL timing adjustment, scenario 1)

Table A-35: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 1 1 1 0 0

Delay [ns]: 0 50 120 200 230

LogNormal off off off off off

Corr with off off off off off

Power Ratio
[dB]:

0 0 0 0 0

Doppler [Hz]:      

Speed [km/h]: 120 120 120 120 120

 Path 6 Path 7 Path 8 Path 9

Profile [Type] Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 0 3 5 7

Delay [ns]: 500 1600 2300 5000

LogNormal off off off off

Corr with off off off off

Power Ratio [dB]: 0 0 0 0

3GPP/LTE moving propagation
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 Path 6 Path 7 Path 8 Path 9

Doppler [Hz]:     

Speed [km/h]: 120 120 120 120

Period: 157,0796s = 2*PI/0.04

Amplitude: 5us = 10us/2

A.15.3  Pure doppler moving (UL timing adjustment, scenario 2)

Table A-36: 3GPP TS36.141, annex B.4 "Moving Propagation Conditions"

 Path 1

Profile [Type] Pure Doppler

Loss [dB]: 0

Delay [ns]: 0

LogNormal off

Corr with off

Power Ratio [dB]: 0

Doppler [Hz]:  

Speed [km/h]: 350

Period: 48,33s = 2*PI/0.13

Amplitude: 5μs = 10μs/2

A.16  SCM and SCME channel models for MIMO OTA

Option: R&S SMW-K72

The SCM/SCME models define 6 clusters characterized by the delay, the AoA/AoD,
AS and PAS shape.

These channel models are defined for 2x2 MIMO configuration and cannot be loaded
in other MIMO configurations.

SCME models

The following antenna polarization and antenna pattern settings apply for all SCME
models.

Antenna settings Polarization Distance (da) Antenna pattern

Tx Cross 45° 0 Dipole

Rx Horizontal 0.5λ Isotropic

SCM and SCME channel models for MIMO OTA
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Geo SCME models

The following antenna polarization and antenna pattern settings apply for all Geo
SCME:
● "Polarization = On"
● "LOS component = Off"
● "σSF = 8 dB"
● "Use random start phases = On"

Antenna settings Distance (da) Antenna pattern

Tx 0 Dipole +45°/-45°

Rx 0.5λ Vertical dipole

A.16.1  SCME/Geo SCME urban micro-cell channel (UMi) 3 km/h and 30
km/h

Tap Path 4 Path 2 Path 3 Path 1 Path 16 Path 6

Cluster  1   2  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 5.2 7 4.3 6.5 8.3

Delay [ns]: 0 5 10 285 290 295

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  0.7   -13.2  

AoD [°]:  6.6   14.1  

Tap Path 7 Path 8 Path 13 Path 10 Path 11 Path 12

Cluster  3   4  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 5.7 7.9 9.7 7.3 9.5 11.3

Delay [ns]: 205 210 215 660 665 670

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  146.1   -30.5  

AoD [°]:  50.8   38.4  

SCM and SCME channel models for MIMO OTA
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Tap Path 9 Path 18 Path 15 Path 5 Path 17 Path 14

Cluster  5   6  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 9 11.2 13 11.4 13.6 15.4

Delay [ns]: 800 810 820 920 930 940

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  -11.4   -1.1  

AoD [°]:  6.7   40.3  

Delay spread [ns]: 294

Cluster AS AoD / AS AoA [°]: 5 /35

Cluster PAS shape: Laplacian

Total AS AoD / AS AoA [°]: 18.2 /67.8

Mobile speed [km/h] / direction of travel [°]: 3, 30 /120

XPR1) [dB]: 9

1) XPR = cross polarization power ratio in the selected propagation channel

A.16.2  SCME/Geo SCME urban macro-cell channel (UMa) 3 km/h and 30
km/h

Tap Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Cluster  1   2  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 3 5.2 7 5.2 7.4 9.2

Delay [ns]: 0 5 10 360 365 370

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  66   46  

AoD [°]:  82   81  

Tap Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Cluster  3   4  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

SCM and SCME channel models for MIMO OTA
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Tap Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

Loss [dB]: 4.7 6.9 8.7 8.2 10.4 12.2

Delay [ns]: 255 260 265 1040 1045 1050

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  143   33  

AoD [°]:  80   99  

Tap Path 13 Path 14 Path 15 Path 16 Path 17 Path 18

Cluster  5   6  

Profile
[type]:

Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh Rayleigh

Loss [dB]: 12.1 14.3 16.1 15.5 17.7 19.5

Delay [ns]: 2730 2735 2740 4600 4605 4610

Fine delay
required:

0 0 0 0 0 0

AoA [°]:  -91   -19  

AoD [°]:  102   107  

Delay spread [ns]: 839.5

Cluster AS AoD / AS AoA [°]: 2 / 35

Cluster PAS shape: Laplacian

Total AS AoD / AS AoA [°]: 7.8 / 62.6

Mobile speed [km/h] / direction of travel [°]: 3, 30 / 120

XPR1) [dB]: 9

1) XPR = cross polarization power ratio in the selected propagation channel

A.17  Watterson standards

Option: R&S SMW-K72

Watterson standards
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A.17.1  Watterson I1

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watterson

Loss [dB]: 4.1 4.3 1.2 7.2 13.5

Delay [ns]: 40000 40000 40000 290000 1139000

LogNormal off off off off off

Corr with off off off off off

Freq. Spread: 0.0073 0.0318 0.0272 0.144 0.34

Freq Shift
[Hz]:

0.0022 0.017 0.0094 0.0089 -0.167

Speed [km/h]:      

Tap 2: S(d) = 0,1 +/- 0,02

A.17.2  Watterson I2

 Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

Profile
[Type]

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Wat-
terson

Gauss-Watter-
son

Gauss-Watter-
son

Loss [dB]: 4.1 5.5 1.7 5.9 17.6 12.6

Delay [ns]: 40000 40000 40000 290000 590000 1126000

LogNormal off off off off off off

Corr with off off off off off off

Freq.
Spread:

0.0064 0.0084 0.0153 0.18 0.334 0.336

Freq Shift
[Hz]:

-0.0008 0.0127 0.0071 0.0159 0.108 0.118

Speed
[km/h]:

      

Tap 3: S(d) = 0,1 +/- 0,02

Watterson standards
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A.17.3  Watterson I3

 Path 1 Path 2 Path 3 Path 4 Path 5

Profile [Type] Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watter-
son

Gauss-Watterson

Loss [dB]: 3.8 5.7 1.6 10.8 10.6

Delay [ns]: 445000 445000 445000 750000 750000

LogNormal off off off off off

Corr with off off off off off

Freq. Spread: 0.034 0.032 0.0658 0.0104 0.013

Freq Shift
[Hz]:

0.0764 0.0134 0.0989 0.121 0.141

Speed [km/h]:      

 Path 6 Path 7 Path 8 Path 9

Profile [Type] Gauss-Watterson Gauss-Watterson Gauss-Watterson Gauss-Watterson

Loss [dB]: 7.7 12.9 10.4 8.5

Delay [ns]: 750000 1088000 1088000 1088000

LogNormal off off off off

Corr with off off off off

Freq. Spread: 0.0229 0.0149 0.0206 0.0335

Freq Shift [Hz]: 0.131 0.121 0.151 0.014

Speed [km/h]:     

Tap 6: S(d) = 1,0 +/- 0,1

A.18  802.11n-SISO standards

Option: R&S SMW-B14/B15

These fading profiles are implemented as the IEEE 802.11n-MIMO models, expect
that:
● Correlation Path = Off
● Coefficient, % = 100
● Phase, deg = 0

See Chapter A.19, "802.11n-MIMO standards", on page 314.

802.11n-SISO standards
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A.19  802.11n-MIMO standards

Option: R&S SMW-K71

According to IEEE 802.11-03/940r4

Rx Antenna Distance = 1

Tx Antenna Distance = 0.5

Distribution = Laplace

Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell
Shape tgn Moving Vehicle

Speed = 1.2 km/h, exception Model F, Path 3 where Speed = 40 km/h

A.19.1  Model a

Tap: Path 1

Cluster  

Profil [Typ] Bell Shape tgn Indoor

Loss [dB] 0

Delay [ns] 0

AoA 45

AS (A) 40

AoD 45

AS (D) 40

Speed [km/h] 1.2

A.19.2  Model b

Tap: Path 4 Path 2 Path 3  Path 1  

Cluster   1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 5.4 10.8 3.2 16.2 6.3

Delay [ns]: 0 10 20 20 30 30

AoA: 4.3 4.3 4.3 118.4 4.3 118.4

AS (A): 14.4 14.4 14.4 25.2 14.4 25.2

AoD: 225.1 225.1 225.1 106.5 225.1 106.5
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Tap: Path 4 Path 2 Path 3  Path 1  

AS (D): 14.4 14.4 14.4 25.4 14.4 25.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 5  Path 6 Path 7 Path 8 Path 9

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

21.7 9.4 12.5 15.6 18.7 21.8

Delay [ns]: 40 40 50 60 70 80

AoA: 4.3 118.4 118.4 118.4 118.4 118.4

AS (A): 14.4 25.2 25.2 25.2 25.2 25.2

AoD: 225.1 106.5 106.5 106.5 106.5 106.5

AS (D): 14.4 25.4 25.4 25.4 25.4 25.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.19.3  Model c

Tap: Path 4 Path 2 Path 3 Path 1 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 2.1 4.3 6.5 8.6 10.8

Delay [ns]: 0 10 20 30 40 50

AoA: 290.3 290.3 290.3 290.3 290.3 290.3

AS (A): 24.6 24.6 24.6 24.6 24.6 24.6

AoD: 13.5 13.5 13.5 13.5 13.5 13.5

AS (D): 24.7 24.7 24.7 24.7 24.7 24.7

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 10 Path 10 Path 8 Path 8 Path 9 Path 9

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

13 5 15.2 7.2 17.3 9.3

Delay [ns]: 60 60 70 70 80 80

AoA: 290.3 332.3 290.3 332.3 290.3 332.3

AS (A): 24.6 22.4 24.6 22.4 24.6 22.4

AoD: 13.5 56.4 13.5 56.4 13.5 56.4

AS (D): 24.7 22.5 24.7 22.5 24.7 22.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 7 Path 7 Path 11 Path 12 Path 13 Path 14

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

19.5 11.5 13.7 15.8 18 20.2

Delay [ns]: 90 90 110 140 170 200

AoA: 290.3 332.3 332.3 332.3 332.3 332.3

AS (A): 24.6 22.4 22.4 22.4 22.4 22.4

AoD: 13.5 56.4 56.4 56.4 56.4 56.4

AS (D): 24.7 22.5 22.5 22.5 22.5 22.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.19.4  Model d

Tap: Path 4 Path 2 Path 3 Path 1 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

0 0.9 1.7 2.6 3.5 4.3
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Tap: Path 4 Path 2 Path 3 Path 1 Path 5 Path 6

Delay [ns]: 0 10 20 30 40 50

AoA: 158.9 158.9 158.9 158.9 158.9 158.9

AS (A): 27.7 27.7 27.7 27.7 27.7 27.7

AoD: 332.1 332.1 332.1 332.1 332.1 332.1

AS (D): 27.4 27.4 27.4 27.4 27.4 27.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 10 Path 8 Path 9 Path 7 Path 11  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.2 6.1 6.9 7.8 9 6.6

Delay [ns]: 60 70 80 90 110 110

AoA: 158.9 158.9 158.9 158.9 158.9 320.2

AS (A): 27.7 27.7 27.7 27.7 27.7 31.4

AoD: 332.1 332.1 332.1 332.1 332.1 49.3

AS (D): 27.4 27.4 27.4 27.4 27.4 32.1

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 12  Path 13  Path 14  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

11.1 9.5 13.7 12.1 16.3 14.7

Delay [ns]: 140 140 170 170 200 200

AoA: 158.9 320.2 158.9 320.2 158.9 320.2

AS (A): 27.7 31.4 27.7 31.4 27.7 31.4

AoD: 332.1 49.3 332.1 49.3 332.1 49.3

AS (D): 27.4 32.1 27.4 32.1 27.4 32.1
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Tap: Path 12  Path 13  Path 14  

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 16   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

19.3 17.4 18.8 23.2 21.9 23.2

Delay [ns]: 240 240 240 290 290 290

AoA: 158.9 320.2 276.1 158.9 320.2 276.1

AS (A): 27.7 31.4 37.4 27.7 31.4 37.4

AoD: 332.1 49.3 275.9 332.1 49.3 275.9

AS (D): 27.4 32.1 36.8 27.4 32.1 36.8

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 17  Path 18

Cluster 2 3  

Profil [Typ] Bell Shape tgn Indoor Bell Shape tgn Indoor Bell Shape tgn
Indoor

(Relative) Loss
[dB]:

25.5 25.2 26.7

Delay [ns]: 340 340 390

AoA: 320.2 276.1 276.1

AS (A): 31.4 37.4 37.4

AoD: 49.3 275.9 275.9

AS (D): 32.1 36.8 36.8

Speed [km/h] 1.2 1.2 1.2

Distribution Laplace Laplace Laplace
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A.19.5  Model e

Tap: Path 4 Path 2 Path 5 Path 1 Path 3  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Moving
Vehicle

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

2.6 3 3.5 3.9 4.5 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 163.7 163.7 163.7 163.7 163.7 251.8

AS (A): 35.8 35.8 35.8 35.8 35.8 41.6

AoD: 105.6 105.6 105.6 105.6 105.6 293.1

AS (D): 36.1 36.1 36.1 36.1 36.1 42.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 10  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.6 3.2 6.9 4.5 8.2 5.8

Delay [ns]: 80 80 110 110 140 140

AoA: 163.7 251.8 163.7 251.8 163.7 251.8

AS (A): 35.8 41.6 35.8 41.6 35.8 41.6

AoD: 105.6 293.1 105.6 293.1 105.6 293.1

AS (D): 36.1 42.5 36.1 42.5 36.1 42.5

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 8   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

9.8 7.1 7.9 11.7 9.9 9.6
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Tap: Path 9   Path 8   

Delay [ns]: 180 180 180 230 230 230

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 14   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

13.9 10.3 14.2 16.1 14.3 13.8

Delay [ns]: 280 280 280 330 330 330

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 11   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

18.3 14.7 18.6 20.5 18.7 18.1

Delay [ns]: 380 380 380 430 430 430

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38
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Tap: Path 15   Path 11   

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 13    Path 16  Path 17 Path 18

Cluster 1 2 3 4 2 4 4 4

Profil [Typ] Bell
Shape tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

(Relative)
Loss [dB]:

22.9 19.9 22.8 20.6 22.4 20.5 20.7 24.6

Delay [ns]: 490 490 490 490 560 560 640 730

AoA: 163.7 251.8 80 182 251.8 182 182 182

AS (A): 35.8 41.6 37.4 40.3 41.6 40.3 40.3 40.3

AoD: 105.6 293.1 61.9 275.7 293.1 275.7 275.7 275.7

AS (D): 36.1 42.5 38 38.7 42.5 38.7 38.7 38.7

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

A.19.6  Model f

Tap: Path 4 Path 2 Path 5 Path 1 Path 3  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

3.3 3.6 3.9 4.2 4.6 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 315.1 315.1 315.1 315.1 315.1 180.4

AS (A): 48 48 48 48 48 55

AoD: 56.2 56.2 56.2 56.2 56.2 183.7

AS (D): 41.6 41.6 41.6 41.6 41.6 55.2

Speed
[km/h]

1.2 1.2 40 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 6  Path 7  Path 10  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

5.3 2.8 6.2 3.5 7.1 4.4

Delay [ns]: 80 80 110 110 140 140

AoA: 315.1 180.4 315.1 180.4 315.1 180.4

AS (A): 48 55 48 55 48 55

AoD: 56.2 183.7 56.2 183.7 56.2 183.7

AS (D): 41.6 55.2 41.6 55.2 41.6 55.2

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 8   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative)
Loss [dB]:

8.2 5.3 5.7 9.5 7.4 6.7

Delay [ns]: 180 180 180 230 230 230

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 11   Path 13   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape tgn
Indoor

(Relative)
Loss [dB]:

11 7 10.4 12.5 10.3 9.6

Delay [ns]: 280 280 280 330 330 330

AoA: 315.1 180.4 74.7 315.1 180.4 74.7
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Tap: Path 11   Path 13   

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 12    Path 14    

Cluster 1 2 3 4 1 2 3 4

Profil [Typ] Bell
Shape
tgn
Indoor

Bell
Shape tgn
Indoor

Bell
Shape
tgn Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

Bell
Shape
tgn
Indoor

(Relative)
Loss [dB]:

14.3 10.4 14.1 8.8 16.7 13.8 12.7 13.3

Delay [ns]: 400 400 400 400 490 490 490 490

AoA: 315.1 180.4 74.7 251.5 315.1 180.4 74.7 251.5

AS (A): 48 55 42 28.6 48 55 42 28.6

AoD: 56.2 183.7 153 112.5 56.2 183.7 153 112.5

AS (D): 41.6 55.2 47.4 27.2 41.6 55.2 47.4 27.2

Speed
[km/h]

1.2 1.2 1.2 1.2 1.2 1.2 1.2 1.2

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15     

Cluster 1 2 3 4 5

Profil [Typ] Bell Shape tgn
Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

Bell Shape
tgn Indoor

(Relative) Loss [dB]: 19.9 15.7 18.5 18.7 12.9

Delay [ns]: 600 600 600 600 600

AoA: 315.1 180.4 74.7 251.5 68.5

AS (A): 48 55 42 28.6 30.7

AoD: 56.2 183.7 153 112.5 291

AS (D): 41.6 55.2 47.4 27.2 33

Speed [km/h] 1.2 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace Laplace

802.11n-MIMO standards



Predefined fading settingsFading Simulation

324User Manual 1175.6826.02 ─ 29

Tap: Path 16  Path 17 Path 18

Cluster 2 5 6 6

Profil [Typ] Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

Bell Shape tgn
Indoor

(Relative) Loss [dB]: 19.9 14.2 16.3 21.2

Delay [ns]: 730 730 880 1050

AoA: 180.4 68.5 246.2 246.2

AS (A): 55 30.7 38.2 38.2

AoD: 183.7 291 62.3 62.3

AS (D): 55.2 33 38 38

Speed [km/h] 1.2 1.2 1.2 1.2

Distribution Laplace Laplace Laplace Laplace

A.20  802.11ac-MIMO standards

Option: R&S SMW-K71

The 802.11ac-MIMO channel models are conform for channel bandwidth ≤ 40 MHz.

According to IEEE 802.11-03/940r4

Rx Antenna Distance = 1

Tx Antenna Distance = 0.5

Distribution = Laplace

Profile = Bell Shape tgn Indoor, exception Model F, Path 3 where the Profile = Bell
Shape tgn Moving Vehicle

Speed = 0.089 km/h, exception Model F, Path 3 where Speed = 40 km/h

A.20.1  Model A (≤ 40 MHz)

Tap: Path 1

Cluster  

Profil [Typ] Bell Shape tgn Indorr

Loss [dB] 0

Delay [ns] 0

AoA 45
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Tap: Path 1

AS (A) 40

AoD 45

AS (D) 40

Speed [km/h] 0.089

A.20.2  Model B (≤ 40 MHz)

Tap: Path 4 Path 2 Path 3  Path 1  

Cluster   1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

0 5.4 10.8 3.2 16.2 6.3

Delay [ns]: 0 10 20 20 30 30

AoA: 4.3 4.3 4.3 118.4 4.3 118.4

AS (A): 14.4 14.4 14.4 25.2 14.4 25.2

AoD: 225.1 225.1 225.1 106.5 225.1 106.5

AS (D): 14.4 14.4 14.4 25.4 14.4 25.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 5  Path 6 Path 7 Path 8 Path 9

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

21.7 9.4 12.5 15.6 18.7 21.8

Delay [ns]: 40 40 50 60 70 80

AoA: 4.3 118.4 118.4 118.4 118.4 118.4

AS (A): 14.4 25.2 25.2 25.2 25.2 25.2

AoD: 225.1 106.5 106.5 106.5 106.5 106.5

AS (D): 14.4 25.4 25.4 25.4 25.4 25.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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A.20.3  Model C (≤ 40 MHz)

Tap: Path 4 Path 2 Path 3 Path 1 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

0 2.1 4.3 6.5 8.6 10.8

Delay [ns]: 0 10 20 30 40 50

AoA: 290.3 290.3 290.3 290.3 290.3 290.3

AS (A): 24.6 24.6 24.6 24.6 24.6 24.6

AoD: 13.5 13.5 13.5 13.5 13.5 13.5

AS (D): 24.7 24.7 24.7 24.7 24.7 24.7

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 10 Path 10 Path 8 Path 8 Path 9 Path 9

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

13 5 15.2 7.2 17.3 9.3

Delay [ns]: 60 60 70 70 80 80

AoA: 290.3 332.3 290.3 332.3 290.3 332.3

AS (A): 24.6 22.4 24.6 22.4 24.6 22.4

AoD: 13.5 56.4 13.5 56.4 13.5 56.4

AS (D): 24.7 22.5 24.7 22.5 24.7 22.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 7 Path 7 Path 11 Path 12 Path 13 Path 14

Cluster 1 2     

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

19.5 11.5 13.7 15.8 18 20.2

Delay [ns]: 90 90 110 140 170 200
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Tap: Path 7 Path 7 Path 11 Path 12 Path 13 Path 14

AoA: 290.3 332.3 332.3 332.3 332.3 332.3

AS (A): 24.6 22.4 22.4 22.4 22.4 22.4

AoD: 13.5 56.4 56.4 56.4 56.4 56.4

AS (D): 24.7 22.5 22.5 22.5 22.5 22.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

A.20.4  Model D (≤ 40 MHz)

Tap: Path 4 Path 2 Path 3 Path 1 Path 5 Path 6

Cluster       

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

0 0.9 1.7 2.6 3.5 4.3

Delay [ns]: 0 10 20 30 40 50

AoA: 158.9 158.9 158.9 158.9 158.9 158.9

AS (A): 27.7 27.7 27.7 27.7 27.7 27.7

AoD: 332.1 332.1 332.1 332.1 332.1 332.1

AS (D): 27.4 27.4 27.4 27.4 27.4 27.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 10 Path 8 Path 9 Path 7 Path 11  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.2 6.1 6.9 7.8 9 6.6

Delay [ns]: 60 70 80 90 110 110

AoA: 158.9 158.9 158.9 158.9 158.9 320.2

AS (A): 27.7 27.7 27.7 27.7 27.7 31.4

AoD: 332.1 332.1 332.1 332.1 332.1 49.3

AS (D): 27.4 27.4 27.4 27.4 27.4 32.1
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Tap: Path 10 Path 8 Path 9 Path 7 Path 11  

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 12  Path 13  Path 14  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

11.1 9.5 13.7 12.1 16.3 14.7

Delay [ns]: 140 140 170 170 200 200

AoA: 158.9 320.2 158.9 320.2 158.9 320.2

AS (A): 27.7 31.4 27.7 31.4 27.7 31.4

AoD: 332.1 49.3 332.1 49.3 332.1 49.3

AS (D): 27.4 32.1 27.4 32.1 27.4 32.1

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 16   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

19.3 17.4 18.8 23.2 21.9 23.2

Delay [ns]: 240 240 240 290 290 290

AoA: 158.9 320.2 276.1 158.9 320.2 276.1

AS (A): 27.7 31.4 37.4 27.7 31.4 37.4

AoD: 332.1 49.3 275.9 332.1 49.3 275.9

AS (D): 27.4 32.1 36.8 27.4 32.1 36.8

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace
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Tap: Path 17  Path 18

Cluster 2 3  

Profil [Typ] Bell Shape tgn Indorr Bell Shape tgn Indorr Bell Shape tgn
Indorr

(Relative) Loss
[dB]:

25.5 25.2 26.7

Delay [ns]: 340 340 390

AoA: 320.2 276.1 276.1

AS (A): 31.4 37.4 37.4

AoD: 49.3 275.9 275.9

AS (D): 32.1 36.8 36.8

Speed [km/h] 0.089 0.089 0.089

Distribution Laplace Laplace Laplace

A.20.5  Model E (≤ 40 MHz)

Tap: Path 4 Path 2 Path 5 Path 1 Path 3  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

2.6 3 3.5 3.9 4.5 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 163.7 163.7 163.7 163.7 163.7 251.8

AS (A): 35.8 35.8 35.8 35.8 35.8 41.6

AoD: 105.6 105.6 105.6 105.6 105.6 293.1

AS (D): 36.1 36.1 36.1 36.1 36.1 42.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 10  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.6 3.2 6.9 4.5 8.2 5.8
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Tap: Path 6  Path 7  Path 10  

Delay [ns]: 80 80 110 110 140 140

AoA: 163.7 251.8 163.7 251.8 163.7 251.8

AS (A): 35.8 41.6 35.8 41.6 35.8 41.6

AoD: 105.6 293.1 105.6 293.1 105.6 293.1

AS (D): 36.1 42.5 36.1 42.5 36.1 42.5

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 8   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

9.8 7.1 7.9 11.7 9.9 9.6

Delay [ns]: 180 180 180 230 230 230

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 14   Path 12   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

13.9 10.3 14.2 16.1 14.3 13.8

Delay [ns]: 280 280 280 330 330 330

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38
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Tap: Path 14   Path 12   

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15   Path 11   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

18.3 14.7 18.6 20.5 18.7 18.1

Delay [ns]: 380 380 380 430 430 430

AoA: 163.7 251.8 80 163.7 251.8 80

AS (A): 35.8 41.6 37.4 35.8 41.6 37.4

AoD: 105.6 293.1 61.9 105.6 293.1 61.9

AS (D): 36.1 42.5 38 36.1 42.5 38

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 13    Path 16  Path 17 Path 18

Cluster 1 2 3 4 2 4 4 4

Profil [Typ] Bell
Shape tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn
Indorr

(Relative)
Loss [dB]:

22.9 19.9 22.8 20.6 22.4 20.5 20.7 24.6

Delay [ns]: 490 490 490 490 560 560 640 730

AoA: 163.7 251.8 80 182 251.8 182 182 182

AS (A): 35.8 41.6 37.4 40.3 41.6 40.3 40.3 40.3

AoD: 105.6 293.1 61.9 275.7 293.1 275.7 275.7 275.7

AS (D): 36.1 42.5 38 38.7 42.5 38.7 38.7 38.7

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace
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A.20.6  Model F (≤ 40 MHz)

Tap: Path 4 Path 2 Path 5 Path 1 Path 3  

Cluster     1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Moving
Vehicle

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

3.3 3.6 3.9 4.2 4.6 1.8

Delay [ns]: 0 10 20 30 50 50

AoA: 315.1 315.1 315.1 315.1 315.1 180.4

AS (A): 48 48 48 48 48 55

AoD: 56.2 56.2 56.2 56.2 56.2 183.7

AS (D): 41.6 41.6 41.6 41.6 41.6 55.2

Speed
[km/h]

0.089 0.089 40 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 6  Path 7  Path 10  

Cluster 1 2 1 2 1 2

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

5.3 2.8 6.2 3.5 7.1 4.4

Delay [ns]: 80 80 110 110 140 140

AoA: 315.1 180.4 315.1 180.4 315.1 180.4

AS (A): 48 55 48 55 48 55

AoD: 56.2 183.7 56.2 183.7 56.2 183.7

AS (D): 41.6 55.2 41.6 55.2 41.6 55.2

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 9   Path 8   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative)
Loss [dB]:

8.2 5.3 5.7 9.5 7.4 6.7
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Tap: Path 9   Path 8   

Delay [ns]: 180 180 180 230 230 230

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 11   Path 13   

Cluster 1 2 3 1 2 3

Profil [Typ] Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape tgn
Indorr

(Relative)
Loss [dB]:

11 7 10.4 12.5 10.3 9.6

Delay [ns]: 280 280 280 330 330 330

AoA: 315.1 180.4 74.7 315.1 180.4 74.7

AS (A): 48 55 42 48 55 42

AoD: 56.2 183.7 153 56.2 183.7 153

AS (D): 41.6 55.2 47.4 41.6 55.2 47.4

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 12    Path 14    

Cluster 1 2 3 4 1 2 3 4

Profil [Typ] Bell
Shape
tgn Indorr

Bell
Shape tgn
Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

Bell
Shape
tgn
Indorr

(Relative)
Loss [dB]:

14.3 10.4 14.1 8.8 16.7 13.8 12.7 13.3

Delay [ns]: 400 400 400 400 490 490 490 490

AoA: 315.1 180.4 74.7 251.5 315.1 180.4 74.7 251.5

AS (A): 48 55 42 28.6 48 55 42 28.6

AoD: 56.2 183.7 153 112.5 56.2 183.7 153 112.5

AS (D): 41.6 55.2 47.4 27.2 41.6 55.2 47.4 27.2
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Tap: Path 12    Path 14    

Speed
[km/h]

0.089 0.089 0.089 0.089 0.089 0.089 0.089 0.089

Distribu-
tion

Laplace Laplace Laplace Laplace Laplace Laplace Laplace Laplace

Tap: Path 15     

Cluster 1 2 3 4 5

Profil [Typ] Bell Shape tgn
Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

Bell Shape
tgn Indorr

(Relative) Loss [dB]: 19.9 15.7 18.5 18.7 12.9

Delay [ns]: 600 600 600 600 600

AoA: 315.1 180.4 74.7 251.5 68.5

AS (A): 48 55 42 28.6 30.7

AoD: 56.2 183.7 153 112.5 291

AS (D): 41.6 55.2 47.4 27.2 33

Speed [km/h] 0.089 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace Laplace

Tap: Path 16  Path 17 Path 18

Cluster 2 5 6 6

Profil [Typ] Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

Bell Shape tgn
Indorr

(Relative) Loss [dB]: 19.9 14.2 16.3 21.2

Delay [ns]: 730 730 880 1050

AoA: 180.4 68.5 246.2 246.2

AS (A): 55 30.7 38.2 38.2

AoD: 183.7 291 62.3 62.3

AS (D): 55.2 33 38 38

Speed [km/h] 0.089 0.089 0.089 0.089

Distribution Laplace Laplace Laplace Laplace

A.21  802.11ac-SISO standards

Option: R&S SMW-B14/B15
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These fading profiles are implemented as the IEEE 802.11ac-MIMO models, expect
that:
● Correlation Path = Off
● Coefficient, % = 100
● Phase, deg = 0

See Chapter A.20, "802.11ac-MIMO standards", on page 324.

A.22  802.11p channel models

Option: R&S SMW-B14/B15

According to C2C-CC TF Antennae & Wireless Performance – Whitepaper Vs 1.0

● Fading Profile = Custom
● Doppler Shape = Rayleigh
● Bandwidth = 2*abs(fd)
● Frequency Offset = 0 Hz
● for fd > 0:

– Lower Cutoff Frequency = 0
– Upper Cutoff Frequency = fd
for fd < 0:
– Lower CutOff Frequency = -fd
– Upper CutOff Frequency = 0

A.22.1  Rural LOS

This channel model is intended primarily as a reference result. It applies in very open
environments where other vehicles, buildings and large fences are absent.

 Path 1 Path 2 Path 3

Profile [Type] Static Custom Custom

(Relative) Loss
[dB]:

0 14 17

Delay [ns]: 0 83 183

fD [Hz] 0 492 -295

A.22.2  Urban approaching LOS

Two vehicles approaching each other in an urban setting with buildings nearby.

802.11p channel models
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 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 8 10 15

Delay [ns]: 0 117 183 333

fD [Hz] 0 236 -157 492

A.22.3  Urban crossing NLOS

Two vehicles approaching an Urban blind intersection with other traffic present. Build-
ings/fences present on all corners.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 3 5 10

Delay [ns]: 0 267 400 533

fD [Hz] 0 295 -98 591

A.22.4  Highway LOS

Two cars following each other on Multi-lane inter-region roadways such as German
autobahns and USA Interstates. Signs, overpasses, hill-sides and other traffic present.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 10 15 20

Delay [ns]: 0 100 167 500

fD [Hz] 0 689 -492 886

A.22.5  Highway NLOS

As for Highway LOS but with occluding trucks present between the vehicles.

 Path 1 Path 2 Path 3 Path 4

Profile [Type] Static Custom Custom Custom

(Relative)
Loss [dB]:

0 2 5 7

802.11p channel models
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 Path 1 Path 2 Path 3 Path 4

Delay [ns]: 0 200 433 700

fD [Hz] 0 689 -492 886

A.23  5G NR standards

Option: R&S SMW-B14/B15; MIMO profiles require R&S SMW-K74.

According to 3GPP TS 38.101-4 and TS 38.141-1.

The following settings apply to all paths:
● Path state = On; "Path x (off)" explicitly states inactive paths
● Profile type = Rayleigh
● LogNormal = Off
● Corr with = Off
● Power ratio = 0 dB
● Speed = 0 km/h

Channel models naming convention

The names of the channel models follow the syntax:

FR<1|2> TDL<A|B|C><delay spread, ms>-<Doppler, Hz> <Low/Med/Med
A/High/SISO>, where:
● FR designates the frequency band (FR1 below 6GHz, FR2 above 6GHz)
● Low/Med/Med A/High indicates the MIMO correlation matrix
● SISO designates the non-MIMO case; SISO and MIMO profiles are identical but in

the SISO case correlation matrix is not relevant.

● FR1 TDLA30-5/10 SISO/Low/Med/Med A/High....................................................337
● FR1 TDLB100-400 SISO/Low/Med/Med A/High...................................................338
● FR1 TDLC300-100 SISO/Low/Med/High.............................................................. 339
● FR1 TDLC300-400 SISO...................................................................................... 339
● FR1 TDLC300-600 SISO/Low/Med/High.............................................................. 339
● FR1 TDLC300-1200 SISO/Low/Med/High............................................................ 340
● FR1 NTN TDLA100-200 Low/Med/High................................................................340
● FR1 NTN TDLC5-200 Low/Med/High................................................................... 341
● FR2 TDLA30-35/75/300 SISO/Low/Med/Med A/High...........................................341
● FR2 TDLC60-300 SISO/Low/Med/Med A/High.....................................................341
● MIMO parameter...................................................................................................342

A.23.1  FR1 TDLA30-5/10 SISO/Low/Med/Med A/High

This profile has Doppler frequencies of 5 Hz or 10 Hz (fC = 1 GHz) for all paths.
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Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 0 5.1 9.6 15.5 5.1

"Resulting Delay (ns)" 10 15 25 0 20

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 (off) Path 10 (off)

"Path Loss (dB)" 8.2 13.1 11.5 0 0

"Resulting Delay (ns)" 50 65 75 0 0

Fine delay required 1 1 1 0 0

 Path 11 Path 12 Path 13 Path 14 (off) Path 15 (off)

"Path Loss (dB)" 11 16.2 16.6 0 0

"Resulting Delay (ns)" 105 135 150 0 0

Fine delay required 1 1 1 0 0

 Path 16 Path 17 (off) Path 18 (off) Path 19 (off) Path 20 (off)

"Path Loss (dB)" 26.2 - - - -

"Resulting Delay (ns)" 290 - - - -

Fine delay required 1 - - - -

A.23.2  FR1 TDLB100-400 SISO/Low/Med/Med A/High

Not supported in 4x4, 2x8 and 8x2 MIMO configurations. This profile has a Doppler fre-
quency of 400 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 2.2 0.6 0.3 0 0.6

"Resulting Delay (ns)" 10 30 35 0 20

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 1.2 5.9 0.8 2.2 7.1

"Resulting Delay (ns)" 45 55 170 120 480

Fine delay required 1 1 1 0 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 6.3 7.5 - - -

"Resulting Delay (ns)" 245 330 - - -

Fine delay required 1 1 - - -

5G NR standards
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A.23.3  FR1 TDLC300-100 SISO/Low/Med/High

These profiles have a Doppler frequency of 100 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 0 7.7 2.5 6.9 9.9

"Resulting Delay (ns)" 65 70 190 0 200

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 2.4 6.6 13 8 7.1

"Resulting Delay (ns)" 195 325 1045 240 520

Fine delay required 1 1 1 1 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 14.2 16 - - -

"Resulting Delay (ns)" 1510 2595 - - -

Fine delay required 1 1 - - -

A.23.4  FR1 TDLC300-400 SISO

These profiles have a Doppler frequency of 400 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 0 7.7 2.5 6.9 9.9

"Resulting Delay (ns)" 65 70 190 0 200

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 2.4 6.6 13 8 7.1

"Resulting Delay (ns)" 195 325 1045 240 520

Fine delay required 1 1 1 1 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 14.2 16 - - -

"Resulting Delay (ns)" 1510 2595 - - -

Fine delay required 1 1 - - -

A.23.5  FR1 TDLC300-600 SISO/Low/Med/High

These profiles have a Doppler frequency of 600 Hz (fC = 1 GHz) for all paths.
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Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 0 7.7 2.5 6.9 9.9

"Resulting Delay (ns)" 65 70 190 0 200

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 2.4 6.6 13 8 7.1

"Resulting Delay (ns)" 195 325 1045 240 520

Fine delay required 1 1 1 1 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 14.2 16 - - -

"Resulting Delay (ns)" 1510 2595 - - -

Fine delay required 1 1 - - -

A.23.6  FR1 TDLC300-1200 SISO/Low/Med/High

These profiles have a Doppler frequency of 1200 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 0 7.7 2.5 6.9 9.9

"Resulting Delay (ns)" 65 70 190 0 200

Fine delay required 1 1 1 0 0

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 2.4 6.6 13 8 7.1

"Resulting Delay (ns)" 195 325 1045 240 520

Fine delay required 1 1 1 1 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 14.2 16 - - -

"Resulting Delay (ns)" 1510 2595 - - -

Fine delay required 1 1 - - -

A.23.7  FR1 NTN TDLA100-200 Low/Med/High

These profiles have a Doppler frequency of 200 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 (off) Path 5 (off)

"Path Loss (dB)" 0 4.7 6.5 - -
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"Resulting Delay (ns)" 0 110 285 - -

Fine delay required 0 1 1 - -

A.23.8  FR1 NTN TDLC5-200 Low/Med/High

These profiles have a Doppler frequency of 200 Hz (fC = 1 GHz) for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 (off) Path 5 (off)

"Path Loss (dB)" 0.6 8.9 21.5 - -

"Resulting Delay (ns)" 0 0 60 - -

Fine delay required 0 0 1 - -

A.23.9  FR2 TDLA30-35/75/300 SISO/Low/Med/Med A/High

The fading profile uses the same path settings as the settings defined for the FR1
TDLA30-5/10 Hz profiles. For the FR2 profiles merely the Doppler frequency changes
to 35 Hz, 75 Hz and 300 Hz.

See Chapter A.23.1, "FR1 TDLA30-5/10 SISO/Low/Med/Med A/High", on page 337.

A.23.10  FR2 TDLC60-300 SISO/Low/Med/Med A/High

These profiles have a Doppler frequency of 300 Hz for all paths.

Parameter Path 1 Path 2 Path 3 Path 4 Path 5

"Path Loss (dB)" 7.8 0.3 0 8.9 14.5

"Resulting Delay (ns)" 0 15 40 50 55

Fine delay required 0 1 0 1 1

 Path 6 Path 7 Path 8 Path 9 Path 10

"Path Loss (dB)" 8.5 10.2 121.1 13.9 15.2

"Resulting Delay (ns)" 75 80 130 210 300

Fine delay required 1 1 1 1 0

 Path 11 Path 12 Path 13 (off) Path 14 (off) Path 15 (off)

"Path Loss (dB)" 16.9 19.4 - - -

"Resulting Delay (ns)" 360 520 - - -

Fine delay required 0 9 - - -
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A.23.11  MIMO parameter

The MIMO correlation matrices for the high, medium and low antenna correlation are
configured according to TS 38.101-4, section B.2.3.

A.24  5G NR MIMO OTA channel models

Option: R&S SMW-B14/B15; MIMO profiles require R&S SMW-K72/-K73/-K74.

According to 3GPP TR 38.827.

The CDL channel models are defined for FR1 and FR2 MIMO-OTA testing. The follow-
ing applies for fading standards:
● The fading profile for all models and all paths is SCM.
● All channel models are 3D channel models with enabled channel polarization
● 5G NR MIMO OTA standards are available for the specified LxMxN system config-

uration (see Chapter 5, "Multiple input multiple output (MIMO)", on page 94).
● A set of predefined 3D antenna patterns is available and used for each predefined

scenario. The file selection of the antenna pattern also considers the fader dedica-
ted frequency for FR1 models.

● UE velocity v is defined as follows:
– for FR1, v = 30km/h
– for FR2, v = 3 km/h (InO) and v = 12 km/h (UMi).

● Subpath start phases are preset for each predefined scenario.
● The DoT value for CDL-B is selected according to R4-1915060.
● SCM model parameters and the per cluster parameters are set automatically.

Channel models naming convention

The names of the channel models follow the syntax:

FR<1|2> CDL<A|B|C> <Umi|Uma|InO>, where:
● FR designates the frequency band (FR1 below 7.125 GHz, FR2 above 24.250

6GHz)
● UMi = Urban micro-cell
● UMa = Urban macro-cell
● InO = Indoor office

A.24.1  FR1 CDL-A/-B/-C UMa 2x2

● "System Configuration = 1x2x2"
● Velocity [km/h] = 30 km/h

5G NR MIMO OTA channel models
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 CDL-A CDL-B CDL-C

DoT [phi,theta] 182.17°, 90° 90°, 90° 65°, 90°

A.24.2  FR1 CDL-A/-B/-C UMi 4x4

● "System Configuration = 1x4x4"
● Velocity [km/h] = 30 km/h

 CDL-A CDL-B CDL-C

DoT [phi,theta] 135°, 90° 90°, 90° 127.05°, 90°

A.24.3  FR1 CDL-C UMa 4x4

● "System Configuration = 1x4x4"
● Velocity [km/h] = 30 km/h

 CDL-A CDL-B CDL-C

DoT [phi,theta] 182.17°, 90° 90°, 90° 65°, 90°

A.24.4  FR1 CDL-C UMi 2x2

● "System Configuration = 1x2x2"
● Velocity [km/h] = 30 km/h

 CDL-A CDL-B CDL-C

DoT [phi,theta] 135°, 90° 90°, 90° 127.05°, 90°

A.24.5  FR2 CDL-A InO

● "System Configuration = 1x2x2"
● Velocity [km/h] = 12 km/h
● DoT [phi,theta] = 74.11°, 90°

A.24.6  FR2 CDL-C UMi

● "System Configuration = 1x2x2"
● Velocity [km/h] = 3 km/h
● DoT [phi,theta] = 112.51°, 90°

5G NR MIMO OTA channel models
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A.25  5G NR high speed train

Option: R&S SMW-K74 and R&S SMW-K71

The following applies to all HST scenarios:
● "Signal Dedicated to = Baseband Output"
● "Consider DL RF = Yes"

A.25.1  HST1 NR350 15 khz/30 khz SCS

3GPP TS 38.104, TS 38.141-1 and TS 38.141-2

Fading scenario HST1 NR350 15 kHz SCS HST1 NR350 30 kHz SCS

Virtual RF [MHz] 1950 3600

Profile Pure Doppler Pure Doppler

Speed [km/h]: 350 350

Dmin [m] 150 150

Ds [m] 700 1000

Virtual DL RF [MHz] 1950 3600

A.25.2  HST1 NR500 15 khz/30 khz SCS

3GPP TS 38.104, TS 38.141-1 and TS 38.141-2

Fading scenario HST1 NR500 15 kHz SCS HST1 NR500 30 kHz SCS

Virtual RF [MHz] 1750 3600

Profile Pure Doppler Pure Doppler

Speed [km/h]: 500 500

Dmin [m] 150 150

Ds [m] 700 700

Virtual DL RF [MHz] 1850 3600

A.25.3  HST3 NR350 15 khz/30 khz SCS

3GPP TS 38.104, TS 38.141-1 and TS 38.141-2

Fading scenario HST1 NR350 15 kHz SCS HST1 NR350 30 kHz SCS

Virtual RF [MHz] 1950 3600

Profile Pure Doppler Pure Doppler

5G NR high speed train
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Fading scenario HST1 NR350 15 kHz SCS HST1 NR350 30 kHz SCS

Speed [km/h]: 350 350

Dmin [m] 2 2

Ds [m] 300 300

Virtual DL RF [MHz] 2140 3600

A.25.4  HST3 NR500 15 khz/30 khz SCS

3GPP TS 38.104, TS 38.141-1 and TS 38.141-2

Fading scenario HST1 NR500 15 kHz SCS HST1 NR500 30 kHz SCS

Virtual RF [MHz] 1750 3600

Profile Pure Doppler Pure Doppler

Speed [km/h]: 500 500

Dmin [m] 2 2

Ds [m] 300 300

Virtual DL RF [MHz] 1850 3600

A.26  5G NR moving propagation

Option: R&S SMW-K71

● MP X 15kHz/30kHz SCS.......................................................................................345
● MP Y 15kHz/30kHz/120kHz SCS......................................................................... 346
● MP Z 15kHz/30kHz SCS.......................................................................................346
● MP NTN X 15kHz/30kHz SCS.............................................................................. 347

A.26.1  MP X 15kHz/30kHz SCS

3GPP TS 38.141-1 and TS 38.141-2
Table A-37: MP X 15kHz/30kHz SCS channel model: common parameters for all paths

 MP X 15kHz SCS MP X 30kHz SCS

Delay variation (peak-peak) (µs) 10 5

Variation period (s) 157.1 78.5

Profile Static Static

Fine delay (ns) 0 0

Lognormal Off Off

5G NR moving propagation
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 MP X 15kHz SCS MP X 30kHz SCS

Corr with Off Off

Doppler shift (Hz) (keep constant) 400 400

Speed (km/h) (fC = 1 GHz) 431.701 431.701

Table A-38: MP X 15kHz/30kHz SCS channel model: path losses and delays

Parameter Path 1 Path 2 Path 3 Path 4 Path 5 Path 6

"Path Loss (dB)" 0 7.7 2.5 6.9 9.9 2.4

"Resulting Delay (ns)" 65 70 190 0 200 195

 Path 7 Path 8 Path 9 Path 10 Path 11 Path 12

"Path Loss (dB)" 6.6 13 8 7.1 14.2 16

"Resulting Delay (ns)" 325 1045 240 520 1510 2595

A.26.2  MP Y 15kHz/30kHz/120kHz SCS

3GPP TS 38.104 and TS 38.141-2
Table A-39: MP Y 15kHz/30kHz/120kHz SCS channel model: common parameters for path 1

 MP Y 15kHz SCS MP Y 30kHz SCS MP Y 120kHz SCS

Delay variation (peak-peak) (µs) 10 5 1.25

Variation period (s) 48.3 24.2 6

Profile Static Static Static

Loss (dB) 0 0 0

Delay (ns) 0 0 0

Fine delay (ns) 0 0 0

Lognormal Off Off Off

Corr with Off Off Off

Doppler shift (Hz) (fC = 1 GHz) 324.30 324.30 324.30

Speed (km/h) (keep constant) 350 350 350

A.26.3  MP Z 15kHz/30kHz SCS

3GPP TS 38.141-1 and TS 38.141-2
Table A-40: MP Z 15kHz/30kHz SCS channel model: common parameters for path 1

 MP Z 15kHz SCS MP Z 30kHz SCS

Delay variation (peak-peak) (µs) 10 5

Variation period (s) 34.9 17.4

5G NR moving propagation
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 MP Z 15kHz SCS MP Z 30kHz SCS

Profile Static Static

Loss (dB) 0 0

Delay (ns) 0 0

Fine delay (ns) 0 0

Lognormal Off Off

Corr with Off Off

Doppler shift (Hz) (fC = 1 GHz) 463.28 463.28

Speed (km/h) (keep constant) 500 500

A.26.4  MP NTN X 15kHz/30kHz SCS

3GPP TS 38.181
Table A-41: MP NTN X 15kHz/30kHz SCS channel model: common parameters for all paths

 MP NTN X 15kHz SCS MP NTN X 30kHz SCS

Delay variation (peak-peak) (µs) 10 5

Variation period (s) 157.1 78.5

Profile Rayleigh Rayleigh

Fine delay (ns) 0 0

Lognormal Off Off

Corr with Off Off

Doppler shift (Hz) (keep constant) 200 200

Speed (km/h) (fC = 1 GHz) 215.849 215.849

Table A-42: MP NTN X 15kHz/30kHz SCS channel model: path losses and delays

Parameter Path 1 Path 2 Path 3 Path 4 (off) Path 5 (off) Path 6 (off)

"Path Loss (dB)" 0 4.7 6.5 - - -

"Resulting Delay (ns)" 0 110 285 - - -

5G NR moving propagation



Antenna pattern file formatFading Simulation

348User Manual 1175.6826.02 ─ 29

B  Antenna pattern file format
Antenna pattern files are XML files in the Rohde & Schwarz proprietary antenna pat-
tern file format. These files use the predefined file extension *.ant_pat. They
describe the antenna power response matrix as an array with resolutions of 1 degree
to 5 degrees for both the elevation and the azimuth angels. In their minimum format,
antenna pattern files contain only the loss values for a given azimuth angle. For an iso-
tropic antenna for instance, that radiates the energy equally in all directions, the array
elements are all 0 dB.

Antenna pattern files can also include the relative phase and antenna polarization
information.

Parsing of antenna pattern files containing relative phase and polarization information
requires option R&S SMW-K73.

The antenna pattern file format uses a generic file structure for both 2D and 3D
antenna models (see Figure B-1). It can be seen as a table with the following parts:
● Header row comprising the azimuth angles (<az_values>)
● First column defining the zenith angles (<zenith>)
● A data part describing the antenna power response (<power>).

The table can have different number of columns (1 to n), depending on the azimuth
resolution (<az_res>). The number of rows depends on the zenith resolution
(<elev_res>).

The <is3D> element defines if the pattern is a 2D or a 3D antenna model; if <is3D =
"1"> a three-dimensional antenna pattern description is required.

Depending on the antenna type, there are three possibilities to describe the antenna
power response:
● Single polarized antenna

Antenna power only (<hasPolInfo> and <hasPhaseInfo> are not specified)
See 1) on Figure B-1

● Dual-polarized antenna
Vertical and horizontal power descriptions (<hasPolInfo="1"
hasPhaseInfo="0">)
See 2) on Figure B-1

● Dual-polarized antenna
Vertical and horizontal relative phase descriptions, additional to the vertical and
horizontal power descriptions (<hasPolInfo="1" hasPhaseInfo="1">)
See 2) on Figure B-1

For details on the file syntax, see Table B-1.
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Figure B-1: File format structure

1 = 3D antenna model, if is3D="1" and 2D - if is3D="0"
1 to n = Number of columns, depending on <az_res>
1 to m = Number of rows, depending on <elev_res>
2 = Combination of <hasPolInfo> and <hasPhaseInfo> and the meaning for the <data> part
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Example: Antenna with three sectors (3Sectors.ant_pat) as specified in TR
25.996 (extract)
According to TR 25.996, the 3 sector antenna pattern is used for each sector. The fol-
lowing equation describes the antenna pattern:
A (Θ) = -min [12(Θ/Θ3dB)2, Am]

Where:
● - 180°≤ Θ< 180° is the angle between the direction of interest and the boresight of

the antenna
● Θ3dB is the 3 dB beamwidth in degrees
● Am is the maximum attenuation

For the 3 sector scenario Θ = 70 deg and Am = 40 dB.

Note: The antenna pattern files define the antenna power and not the antenna gain.
<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr count="1">  
 </antenna_descr>
    <az_res> 1.00000000e+000 </az_res>
    <elev_res> 1.00000000e+000 </elev_res>
 <data>
  <!-- list of the azimuth values <az_values> --> 
     -179.5,-178.5,-177.5,...   -89.5,   -88.5,   -87.5,   -86.5,...178.5,179.5
  <!-- <power_values> --> 
     -89.5,   40,    40,    40,...3.92e+01,3.84e+01,3.75e+01,3.66e+01,...   40,40
  </data>
</antenna_pattern>
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Example: Antenna pattern with polarization and relative phase information
(extract)
This example contains comments for better understanding. Comments are indicated
with <!-- and -->.
<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr>
    <antenna hasPhaseInfo="1" hasPolInfo="1"/>
 </antenna_descr>
 <az_res> 1.00000 </az_res>
 <elev_res> 1.00000 </elev_res>
 <data>
  <!-- list of the azimuth values <az_values> --> 
      -180.0,-179.0... 0... 179.0,179.0
  <!-- vertical polarization <vertical_power_values> --> 
          0,9.722102564,9.150142134... 12.79746154... 10.0064906,9.722102564
  <!-- horizontal polarization <horizontal_power_values> --> 
          0,25.53114835,25.53776203... 25.3327381... 25.48485262,25.53114835
  <!-- vertical relative phase <vertical_phase_values> --> 
          0,3.203435487,3.271611926... 3.767874967... 3.139292698,3.203435487
  <!-- horizontal relative phase <horizontal_phase_values> --> 
          0,0.624420629,0.632933957... 0.56246144... 0.615821973,0.624420629

Example: Antenna pattern for 3D channel model (extract)
This example contains comments for better understanding. Comments are indicated
with <!-- and -->.
<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
 <antenna_descr>
  <antenna    hasPhaseInfo="0" hasPolInfo="1" is3D="1"/>
 </antenna_descr>
 <az_res> 1.00000 </az_res>
 <elev_res> 2.00000 </elev_res>
 <data>

<-- list of the azimuth values <az_values> --> 
      -180.0,-179.0... 0... 179.0,179.0
  <!-- vertical polarization <vertical_power_values> --> 
           0.0, 5.33e+01, 5.33e+01, 5.33e+01, ... 5.33e+01
  <!-- horizontal polarization <horizontal_power_values> --> 
          2.0, 5.32e+01, 5.32e+01, 5.32e+01, ... 5.32e+01

File syntax

The Table B-1 describes the used tags and parameters.
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Table B-1: Format of *.ant_pat file

Tag name Parameter Description

<antenna_pat-
tern>

 Defines antenna pattern file

<antenna_descr>  Contains the descriptions of the antennas

 <count> Number of antenna patterns; value = 1 always

<antenna>  Descriptions of the individual antenna

 <hasPolInfo> Indicates if the file contains the vertical and horizontal power information or not.
● "0": single polarized antenna, power information only

(Antenna polarization is set with the parameter Antenna Polarization Slant Angle)
● "1": dual polarized antenna, vertical and horizontal power information included

The vertical and horizontal power descriptions are mandatory

 <hasPhaseInfo> Indicates if the file contains relative phase description or not.
● "0": no relative phase information
● "1": relative phase information included

The relative phase description is mandatory
If also <hasPolInfo="1">, both the vertical and the horizontal relative phase descrip-
tions are mandatory

 <is3D> Indicates if the file describes a 3D antenna model or not.
● "0": 2D model
● "1": 3D model

<az_res>  Azimuth resolution of the antenna pattern description (<data> tag)

Value in degrees integer divider of 360

Value range: - 180° to 179°

<elev_res>  Elevation resolution of the <data> tag

Value in degrees integer divider of 180

<data>  Antenna pattern description as an array with:
● [1 + 360/<az_res>] columns

– 2D antenna model:
The first column indicates the elevation angle used to create the 2D pattern out of
the 3D pattern.
It is usually 0°.

– 3D antenna model
The first column indicates the zenith.
It is value in the range 0 to 180°

● 2 to 5 rows, depending on the <hasPolInfo> and the <hasPhaseInfo> tags

The first row lists the azimuth angles <az_values>*).

The second row describes antenna power response in terms of loss values in dB; the power
values are positive values, calculated as:

20*log10(LinearGain)

If <hasPolInfo="1">, the descriptions of the vertical and horizontal power response of
the antenna is mandatory.

Required are two rows, for the vertical and the horizontal information; always in this order.

If <hasPhaseInfo="1">, the relative phase description is mandatory.

Required are one or, if <hasPolInfo="1">, two rows - for the vertical and the horizontal
information; always in this order.

Allowed are values in the range 0 rad to 2pi rad.
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*) If the azimuth angles (<az_values>) are given with lower resolution that the resolu-
tion specified with the <az_res> element, an interpolation is applied.

How to create an antenna pattern file from the measured values

The radiated antenna pattern of the DUT is the measurement result of the stage 1 in
the two stage MIMO OTA test method (see "About the MIMO OTA two stage method"
on page 130). The following is an overview of the general steps required to convert the
measured antenna pattern values into the Rohde & Schwarz 2D antenna pattern for-
mat.

General steps

1. Convert the azimuth value to the values range of -180° to 180°.

2. Convert the magnitude values expressed in dBm into loss values expressed in dB.
Calculate the required power values as 20*log10(LinearGain)

3. Interpolate the values to achieve an azimuth resolution of 1°.

4. Create the 2D antenna pattern file.

The example on Figure B-2 illustrates the required steps.

Figure B-2: Converting custom data into the Rohde & Schwarz 2D antenna pattern file format
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1 = Input file (extract, shows the first two and the last row)
H, V = Horizontal and vertical polarization values
a = Convert angle value for 0° to 360 ° to <az_values> = -180° to 179°
b = Convert magnitude values [dBm] to power [dB]
c = Interpolate the values
2 = Converted and interpolated values to achieve azimuth resolution of 1°
<horizontal_power_values>,
<vertical_power_values>

= Power values > 0 dB

The example shows how to create the antenna pattern file of antenna #2.
An extract of antenna pattern file content is listed in Example"Antenna pattern with
polarization and relative phase information (extract)" on page 351. The created file
contains relative phase information and the description of the vertical and the hori-
zontal polarizations (<antenna hasPhaseInfo="1" hasPolInfo="1"/>).

Create the antenna pattern file of antenna #1 in the same way but set the
<vertical_phase_values> = <horizontal_phase_values> = 0.
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Glossary: Specifications and references
Symbols

[1]: http://www.ist-winner.org

[2]: Laurent Schumacher, et al, "Closed-Form Expressions for the Correlation Coeffi-
cient of Directive Antennas Impinged by a Multimodal Truncated Laplacian PAS"
IEEE Transactions on wireless communications, P.1351-1359, Vol. 4, No. 4, 2005

[3]: 3GPP TSG RAN
R4-136801 "Analysis of relative phase impact on two-stage results"

T
TGac: IEEE 802.11-09/0308r3
IEEE P802.11 Wireless LAN "TGac Channel Model Addendum"

TGn: IEEE 802.11-03/940r
IEEE P802.11 Wireless LAN "TGn Channel Models"

TR 25.996: "Spatial channel model for Multiple Input Multiple Output (MIMO) simula-
tions"

TR 36.873: "Study on channel model for frequency spectrum above 6 GHz"

TR 37.977: "Verification of radiated multi-antenna reception performance of User
Equipment (UE)"

TR 38.827: "Study on radiated metrics and test methodology for the verification of
multi-antenna reception performance of NR User Equipment (UE)"

TS 34.114: "User Equipment (UE) / Mobile Station (MS) Over The Air (OTA) antenna
performance; Conformance testing"

TS 38.101-4: "User Equipment (UE) radio transmission and reception; Part 4: Perfor-
mance requirements"

TS 38.104: " Base Station (BS) radio transmission and reception"

TS 38.141-1: "Base Station (BS) conformance testing Part 1: Conducted conformance
testing"

TS 38.141-2: "Base Station (BS) conformance testing Part 2: Radiated conformance
testing"

TS 38.181: "Satellite Access Node (SAN) conformance testing (Release 17) "

 

http://www.ist-winner.org
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